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Neue Funktionen
 
Weitere Informationen finden Sie in den folgenden empfohlenen Onlineressourcen.

Brennen und Importieren von CDs
video2brain (7. Mai 2012)
Video
Problemlos CDs in Profiqualität produzieren.

Hardware-Controller und Automatisierung von Aufnahmen
video2brain (7. Mai 2012)
Video
Perfekte Abmischungen.

Tonhöhenkorrektur
video2brain (7. Mai 2012)
Video
Intuitive automatische und visuelle Steuerung.

Übung zu Sessionvorlagen
Durin Gleaves (7. Mai 2012)
Video
Schnelles Erstellen von Multitrack-Elementen

Verbesserungen bei Effekten
video2brain (7. Mai 2012)
Video
Audiobearbeitung mit einer Vielzahl kreativer Werkzeuge.

Verbesserungen bei der Multitrack-Bearbeitung
video2brain (7. Mai 2012)
Video
Ausrichten von Sprache, Seitenketteneffekten und vielem mehr.

Speichern von Multitrack-Sessions
video2brain (7. Mai 2012)
Video
Projekte für maximale Effizienz optimieren.

Verbesserungen bei der Wellenformbearbeitung
video2brain (7. Mai 2012)
Video
Optimierter Arbeitsablauf durch Verbesserungen bei Vorschau, Transport und Markierungssteuerung.

Ein Teil des auf dieser Seite verlinkten Inhalts ist möglicherweise nur in englischer Sprache verfügbar.

http://www.adobe.com/go/CHLvid60804_au_de
http://www.adobe.com/go/CHLvid60805_au_de
http://www.adobe.com/go/CHLvid60803_au_de
http://vimeo.com/40323195
http://www.adobe.com/go/CHLvid60807_au_de
http://www.adobe.com/go/CHLvid60801_au_de
http://www.adobe.com/go/CHLvid60806_au_de
http://www.adobe.com/go/CHLvid60802_au_de
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Gruppieren von Multitrack-Clips

Zuschneiden von Multitrack-Clips auf Zeitauswahlen

Prüfen von Multitrack-Clips

Vorschau auf Bearbeitungen mit „Auswahl auslassen“

Mehrere Zwischenablagen im Wellenformeditor
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Schnellere, präzisere Audiobearbeitung
Multitrack-Clipdehnung
Automatische Sprachausrichtung
Unterstützung einer Steuerungsoberfläche mit Parameterautomatisierung
Leistungsstarke Tonhöhensteuerung
Effiziente Dateiverwaltung
Erweiterte Audio- und Videoformate
Brennen von CDs
Mehr Effekte, flexible Weiterleitung und VST3-Unterstützung
Integrierte Radioautomation
Verbesserte Stapelverarbeitung
Konfigurierbares Metronom
Verbesserte Tastaturbefehle

Schnellere, präzisere Audiobearbeitung

Wählen Sie mehrere Clips aus und wählen Sie Clip > Gruppen > Clips gruppieren. Sie können gruppierte
Clips gemeinsam verschieben und bearbeiten und sie sogar proportional dehnen, wenn die Clipdehnung aktiviert ist. Die Optionen für das Dehnen,
Verstärken, Kolorieren sowie andere Einstellungen finden Sie im Eigenschaftenbedienfeld (Fenster > Eigenschaften).

Um alle gruppierten Clips vorübergehend unabhängig voneinander zu bearbeiten, wählen Sie Clip > Gruppen > Gruppen deaktivieren. Um
Gruppen während einer Session schnell wieder anzuwenden, deaktivieren Sie den Befehl „Gruppen deaktivieren“.
Um einen Clip in einer Gruppe unabhängig zu bearbeiten, klicken Sie mit der rechten Maustaste darauf und wählen Sie Fokus-Clip aus Gruppe
entfernen.

Der Befehl Zuschneiden auf Zeitauswahl schneidet nicht genutzte Teile aus Clips zu und
hilft so dabei, sie an zugehörigen Video- oder Musikelementen in einer Session auszurichten.

1. Wählen Sie mit dem Zeitauswahlwerkzeug einen Zeitbereich und mindestens einen Clip aus .
2. Wählen Sie Clip > Zuschneiden auf Zeitauswahl.

Geben Sie im Bereich Info des Eigenschaftenbedienfelds die Anfangs- und Endzeiten der gewählten Clips ein, um
sie exakt zu platzieren.

Klicken Sie in den Transportsteuerungen unten im Editor auf die Schaltfläche Auswahl
auslassen , um das ausgewählte Audio während der Wiedergabe auszulassen und so eine präzise Vorschau von Bearbeitungen anzuzeigen.

Positionieren Sie den Playhead vor der Auswahl, um die standardmäßige Preroll- und Postroll-Stärke festzulegen. Audition verwendet bei der
nächsten Vorschau die gleiche Einstellung, wenn Sie die Auswahl überspringen.

Wählen Sie Bearbeiten > Aktuelle Zwischenablage wählen, um Audio aus bis zu fünf
verschiedenen Zwischenablagen zu kopieren und einzufügen. Wenn Sie bestimmtes Material einfügen möchten, dass Sie öfter verwenden, ist es
so immer verfügbar.

Multitrack-Clipdehnung
Dehnen Sie Clips schnell auf die nötige Länge, und prüfen Sie das Ergebnis während der Wiedergabe in einer Vorschau. Wählen Sie Im Editor
mehrere Clips aus, um sie proportional zu dehnen. Im Fenster „Eigenschaften“ können Sie aus einer Reihe von Dehnungstypen auswählen, die für
verschiedene Audioinhalte optimiert sind.

Ausführliche Informationen finden Sie unter Multitrack-Clipdehnung in CS6.

Automatische Sprachausrichtung
Um Overdub-Dialog schnell am Audio aus der ursprünglichen Produktion auszurichten, verwenden Sie die automatische Sprachausrichtung.
Audition passt das Timing jedes einzelnen Wortes an, auch wenn das ursprüngliche Audio Rauschen enthält oder sich in der Gesamtlänge

http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
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unterscheidet.

Wählen Sie im Multitrack-Editor zwei Clips mit dem gleichen Dialog und mit der gleichen Länge aus. Wählen Sie anschließend Clip >
Automatische Sprachausrichtung aus.

Wählen Sie in den Menüs Referenzkanal die Kanäle aus, in denen der Dialog am klarsten ist. Um die Ausrichtung weiter zu verbessern,
schneiden Sie jegliche vorangestellte oder nachgestellte Pause in den Clips zu.

Unterstützung einer Steuerungsoberfläche mit Parameterautomatisierung
Mischen Sie Audio interaktiv in beliebten Steuerungsoberflächen mit den EUCON-, Mackie MCU- oder Logic-Control-Protokollen (einschließlich
der Avid Artist-Serie, die bisher von Euphonix hergestellt wurde). Alternativ können Sie Tablet-basierte Controller von Drittanbietern verwenden,
die diese Protokolle unterstützen. Sie können sogar mehrere Geräte gleichzeitig verwenden.

Um Ihren Controller mit Audition zu verbinden, wählen Sie Bearbeiten > Voreinstellungen > Steuerungsoberfläche. Wählen Sie im Menü
Geräteklasse das Controllerprotokoll aus. Klicken Sie dann auf Konfigurieren, um die MIDI-Ins und -Outs (bei Mackie- und Logic-Controller)
anzugeben oder auf Schaltflächenzuordnung (bei Mackie- und Red Rover-Controllern).

Audition CS6 unterstützt die komplette Palette an Automatisierungsmodi (Lesen, Schreiben, Verriegelung und Tasten) für sämtliche Spurebenen-,
Balance- und Effektparameter. Wählen Sie den Automatisierungsmodus im Editor im Menü unter den Track-Steuerungen oder im Mixer über dem
Fader.

Weitere Informationen zu den einzelnen Automatisierungsmodi finden Sie unter Trackautomatisierungsoptionen.

Leistungsstarke Tonhöhensteuerung
Nehmen Sie mit der automatischen und manuellen Tonhöhensteuerung exakte Korrekturen an der Tonhöhe vor oder manipulieren Sie Audio auf
kreative Weise, um ein innovatives Sounddesign zu erzielen.

Die besten Ergebnisse erhalten Sie, wenn Sie die Tonhöhenkorrektur auf einzelne Gesangs- oder Instrumentalspuren anwenden.

Effekt „Manuelle Tonhöhenkorrektur“ (nur Wellenformeditor)
Mit dem Effekt Manuelle Tonhöhenkorrektur können Sie die Tonhöhe mit der Spektraltonhöhenanzeige visuell anpassen. Die
Spektraltonhöhenanzeige zeigt die grundsätzliche Tonhöhe als hellblaue Linie und Obertöne als rote Schattierungen. Die korrigierte Tonhöhe wird
als hellgrüne Linie angezeigt.

Wählen Sie Effekte > Zeit und Tonhöhe > Manuelle Tonhöhenkorrektur. Detaillierte Anweisungen finden Sie unter Effekt „Manuelle
Tonhöhenkorrektur“.

Sie können die Tonhöhe jederzeit visuell überwachen, ohne den Effekt Manuelle Tonhöhenkorrektur zu verwenden. Klicken Sie einfach in der
Optionsleiste auf das Symbol Spektraltonhöhe.

Effekt „Automatische Tonhöhenkorrektur“
Der Effekt Automatische Tonhöhenkorrektur ist sowohl im Wellenform- als auch im Multitrack- Editor verfügbar. In Letzterem können die Parameter
mit Keyframes und externen Steuerungsoberflächen über einen Zeitverlauf automatisiert werden.

Wählen Sie Effekte > Zeit und Tonhöhe > Automatische Tonhöhenkorrektur. Weitere Anweisungen finden Sie unter Effekt „Automatische
Tonhöhenkorrektur“.

Effiziente Dateiverwaltung

Medienbrowser
Wählen Sie Fenster > Medienbrowser, um die Dateien auf lokalen Laufwerken und Netzwerklaufwerken zusammen mit hilfreichen Datei-
Metadaten und -Spezifikationen anzuzeigen. Klicken Sie unten im Bedienfeld auf die Schaltfläche Wiedergabe , um eine Audiovorschau
anzuzeigen und auf die Schaltfläche Endloswiedergabe , um die Details zu erfassen. Ziehen Sie die Dateien anschließend direkt in den
Dateibereich, in das Bedienfeld „Gleiche Lautstärke“, in Multitrack-Sessions oder CD-Layouts.

Um einen Ordner, den Sie häufig verwenden, den Favoriten hinzuzufügen, navigieren Sie im Medienbrowser zum Ordner, und klicken Sie
rechts oben in der Ecke des Bedienfelds auf das Symbol „Verknüpfung hinzufügen“ .

Dateibereich
Im Dateibereich können Sie schnell Dateien suchen, indem Sie in das Suchfeld Daten wie z. B. Name, Kanäle oder Medientyp eingeben. Klicken
Sie unten im Bedienfeld auf die Schaltfläche Wiedergabe  bzw. Endloswiedergabe .

http://idiom-q-win-1/content/help/en/audition/using/manual-pitch-correction-effect--.html
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Um Platz im Medienbrowser und im Dateibereich zu sparen, klicken Sie rechts oben auf die Schaltfläche für das Bedienfeldmenü, und
deaktivieren Sie die Option „Transportoptionen in Vorschau anzeigen“. Oben wird eine kleinerer Wiedergabe-Schaltfläche angezeigt, und die
Befehle für die automatische Wiedergabe und die Loopvorschau bleiben im Bedienfeldmenü verfügbar.

Marker-Bedienfeld
Das Marker-Bedienfeld verfügt über ein ähnliches Suchfeld und die folgenden Funktionen:

Klicken Sie rechts oben im Bedienfeld auf das Symbol Marker für alle Dateien anzeigen , um die Marker für alle geöffneten Dateien und
Sessions anzuzeigen. Fügen Sie mit den Symbolen oben im Bedienfeld ausgewählte Markerbereiche in Multitrack-Sessions, CD-Layouts oder
Playlists ein.

Klicken Sie auf das Symbol In Multitrack einfügen , um entweder einer bereits vorhandenen Multitrack-Session Markerbereiche hinzuzufügen
oder eine komplett neue Session zu erstellen.

Neue Markentypen umfassen:

Clipkopie für Bereiche einer Datei, die in Adobe Premiere Pro im Projektfenster als separate Clips angezeigt werden sollen.
CD-Track. Siehe Brennen von CDs.
Cart-Timer für Rundfunkautomatisierungssysteme. Siehe Integrierte Radioautomation.

Sessionvorlagen, Archive und Abmischungen
Wählen Sie Datei > Exportieren > Session als Vorlage, um Multitrack-Vorlagen zu erstellen, die wiederkehrende Projekte mit ähnlichen
Einstellungen, Aufgaben und Quelldateien beschleunigen. Um eine Vorlage auf eine neue Session anzuwenden, wählen Sie Datei > Neu >
Multitrack-Session und anschließend eine der Optionen unter Vorlage.

Um ganze Sitzungen zu archivieren oder diese mit Markern, Metadaten und Quelldateien auf andere Systeme zu verschieben, wählen Sie Datei >
Exportieren > Sitzung. Passen Sie im Dialogfeld Session exportieren die exportierten Quelldateien an, indem Sie die Option Kopien der
zugehörigen Dateien speichern auswählen und anschließend auf Optionen klicken. Um das Dateiformat zu ändern, wählen Sie Dateien
konvertieren. Um vollständige oder zugeschnittene Quelldateien zu exportieren, wählen Sie Medienoptionen.

Wählen Sie Datei > Exportieren > Abmischen, und prüfen Sie denn Abschnitt Abmischungsoptionen. Klicken Sie auf Ändern, um Tracks als
separate Dateien auszugeben, oder geben Sie Mono-, Stereo- und 5.1-Mustervorlagen gleichzeitig aus.

Erweiterte Audio- und Videoformate
Importieren Sie und geben Sie HD-Videos in einer Vielzahl von Frameraten wieder, einschließlich 23,976 und 59,94 Drop-Frame und 59,94 Non-
Drop-Frame. Das Lineal und andere Timecodeanzeigen werden automatisch abgeglichen.

Die unterstützten Importformate umfassen jetzt FLV, Shockwave und RED R3D sowie Monkey's Audio und eine Vielzahl von Audioformaten, die
den libsndfile-Standard nutzen.

Exportformate beinhalten auch die Formate Monkey's Audio und libsndfile sowie FLAC, OGG und MPEG-1 Audio Layer II (MP2).

Hinweis: Zum Aktivieren einiger Formate müssen Sie „Unterstützung für DLMS-Format aktivieren“ in den Voreinstellungen „Medien- und Disk-
Cache“ auswählen.

Eine vollständige Liste von Formaten und zugehörigen Einstellungen finden Sie unter Unterstützte Importformate und Exportformateinstellungen.

Brennen von CDs
Wählen Sie Datei > Neu > CD-Layout, um die Dateien zusammenzustellen, die Sie auf die Redbook-Standard-Audio-CDs brennen möchten. Oder
fügen Sie Tracks direkt aus den Bedienfeldern Dateien bzw. Marker hinzu: Klicken Sie mit der rechten Maustaste und wählen Sie In CD-Layout
einfügen. (Um diese Option für Markerbereiche verfügbar zu machen, wählen Sie in der Spalte Typ die Option CD-Track.)

Drücken Sie während der Wiedergabe „Umschalttaste + M“, um die Start- und Endpunkte der CD-Tracks schnell zu markieren. Wählen Sie
dann im Marker-Bedienfeld naheliegende Punkte aus, und klicken Sie auf das Symbol „Ausgewählte Marker zusammenfügen“ , um
Zeitbereiche für jeden Track zu erstellen.

Sie können mehrere CD-Layoutdateien gleichzeitig zusammenstellen und im Datei-Bedienfeld zwischen ihnen wählen. Geben Sie im
Eigenschaftenbedienfeld die Disc-Eigenschaften wie Medienkatalognummer (MCN), Titel und Künstler an.

Wenn Sie mit dem CD-Layout fertig sind, wählen Sie Datei > Exportieren, Audio auf CD brennen aus. (Wählen Sie im Dialogfeld „Audio brennen“
die Optionen „Schreibmodus“ > „Test“, um sicherzustellen, dass die Datenübertragung schnell genug ist und keine Fehler auftreten.)

Um eine einzelne Datei einschließlich der Track-Marker schnell zu brennen, wählen Sie im Wellenform-Editor die Option „Datei“ > „Export“
>„Audio auf CD brennen“. (Alle Track-Marker müssen Zeitbereiche statt Punkte sein.)

Mehr Effekte, flexible Weiterleitung und VST3-Unterstützung
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Bevorzugte Effekte
In Audition CS6 sind einige wichtige Effekte wieder vorhanden. Wählen Sie im Menü Effekte eine der folgenden Optionen:

Töne generieren bietet Ihnen die Möglichkeit, eine Wellenform auszuwählen, Harmonien hinzuzufügen, einen Frequenzhub zu
erstellen und die Phase anzupassen, um Sounddesignelemente zu erstellen und Töne zu testen.
Spezial > Doppler-Verschiebung (nur Wellenformeditor) erzeugt den Effekt eines Sounds, der sich am Hörer vorbeibewegt
oder sogar um ihn herumwirbelt.
Stereodarstellung > Grafischer Phasenschieber bietet Ihnen die Möglichkeit, jeden Phasengrad in jedem Teil des
Frequenzspektrums exakt zu steuern.
Filter und EQ > Leitungsrauschen bietet Ihnen die Möglichkeit, bestimmte Frequenzen anzupassen, um Rauschen, extreme
EQ-Effekte oder starkes Echo zu beheben.

Flexible Effektweiterleitung und Seitenketten
Durch verbesserte Weiterleitungsmöglichkeiten können Sie Effekteingänge und -ausgänge bestimmten Kanälen zuweisen. Diese Technik ist bei
5.1-Surround-Abmischungen besonders flexibel. (Beispielsweise können Sie Mono- oder Stereo-Effekte auf 5.1-Quellen anwenden.) Klicken Sie
rechts oben im Effektfenster auf das Symbol Kanalzuordnungs-Editor .

Mit Seitenketten für die kompatiblen Plug-ins und den integrierten Effekt Dynamikverarbeitung können Sie die Amplitude basierend auf einem
externen Signal anpassen. Bei der beliebtesten Technik werden die Musik bzw. Hintergrundgeräusche automatisch reduziert, wenn der Ansager
spricht:

1. Öffnen Sie eine Multitrack-Session.

2. Wenden Sie auf die Hintergrundspur, die Sie komprimieren möchten, den Effekt Amplitude und Komprimierung >
Dynamikverarbeitung an.

3. Doppelklicken Sie im Effekte-Rack auf den Effekt, um die Einstellungen zu bearbeiten.

4. Klicken Sie rechts oben im Fenster Dynamikverarbeitung auf das Symbol „Seitenketteneingang festlegen“ . Wählen Sie
anschließend die Kanalkonfiguration für das Quellaudio aus: Mono, Stereo oder 5.1.

5. Navigieren Sie zur Voice-Over-Spur der Kommentare. Wählen Sie im Bereich Sends  des Editors die Optionen Seitenkette
> Dynamikverarbeitung [Name der Zielspur].

Unterstützung von VST3 und grundsolide Stabilität
Die Unterstützung von VST3-Effekten bietet Zugang zu einer neuen Welt voller Drittanbietereffekte. Das separate Scannen von Effekten von
Drittanbietern sorgt dafür, dass Audition auch dann noch läuft, wenn ein Plug-In instabil wird.

Integrierte Radioautomation
Audition CS6 lässt sich vollständig mit Systemen für die Radioautomation integriert.

1. Um AES-CART-Timer in einer Audio-Wellenform visuell einzustellen, positionieren Sie den Playhead im Editorbereich, und
drücken Sie die Taste „C “. (Um Timer schnell, allgemein zu platzieren, drücken Sie während der Wiedergabe die Taste „C “.)

2. Klicken Sie im Fenster „Marker“ auf die Popup-Menüs der Spalte „Name “, um die Standard-Cart-Codes auszuwählen. (Sie
können benutzerdefinierte Codes für Ihr System eingeben, die maximal vier Zeichen umfassen dürfen.)

Cart-Systems lesen nur die ersten acht Zeitgeber in einer Datei, alle nachfolgenden werden ignoriert.

Wählen Sie Fenster >Metadaten, um auf die Optionen zuzugreifen, die sich auf Radio beziehen:

Auf der Registerkarte CART können Sie schnell IDs Ausblendsignale, Start- und Enddatum und weitere Apsekte bearbeiten.
(Die gleichen Metadaten wird im Bereich „AES-CART“ der Registerkarte XMP angezeigt.)
Wählen Sie auf der Registerkarte RIFF die Optionen Anzeigen als > Radiobranche, um ein optimiertes Subset der RIFF-
Metadaten anzuzeigen.

Verbesserte Stapelverarbeitung
Wenden Sie im Bedienfeld Stapelprozess jederzeit, also nicht nur beim Export, Favoriten auf mehrere Dateien an. Um beim Export aus den
Bedienfeldern Stapelprozess oder Gleiche Lautstärke schnell übliche Dateibenennungskonventionen anzugeben, klicken Sie auf
Exporteinstellungen und wählen Sie anschließend Vorlage.

http://idiom-q-win-1/content/help/de/audition/using/doppler-shifter-effect---waveform.html
http://idiom-q-win-1/content/help/de/audition/using/doppler-shifter-effect---waveform.html
http://idiom-q-win-1/content/help/de/audition/using/doppler-shifter-effect---waveform.html
http://idiom-q-win-1/content/help/de/audition/using/graphic-phase-shifter-effect.html
http://idiom-q-win-1/content/help/de/audition/using/graphic-phase-shifter-effect.html
http://idiom-q-win-1/content/help/de/audition/using/graphic-phase-shifter-effect.html
http://idiom-q-win-1/content/help/de/audition/using/notch-filter-effect.html
http://idiom-q-win-1/content/help/de/audition/using/notch-filter-effect.html
http://idiom-q-win-1/content/help/de/audition/using/notch-filter-effect.html
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Wählen Sie „Datei“ > „Alle Audiodaten als Stapelprozess speichern“ aus, um alle geöffneten Dateien zu verarbeiten. Weitere Informationen
finden Sie unter Stapelverarbeitung von Dateien.

Konfigurierbares Metronom
Ein konfigurierbares Metronom bietet eine Vielzahl an Taktmustern und Sounds. Wählen Sie Bearbeiten > Metronom > Muster bearbeiten oder
Soundtyp ändern.

Um das Metronom zu aktivieren, klicken Sie im Fenster Eigenschaften oder im Editor auf das Metronomsymbol . Passen Sie in der Spur
Metronom, die oben im Editor angezeigt wird, die Lautstärke und die Balance an.

Um das Tempo und die Zeitsignatur für die aktuelle Session zu ändern, passen Sie die Einstellungen im Eigenschaftenbedienfeld im Bereich
Zeitanzeige an.

Für den Metronom-Track können Sie genau wie bei Audiotracks Effekte hinzufügen, Sends und Hardwareausgaben zuweisen und die
Mischung automatisieren.

Verbesserte Tastaturbefehle
Wählen Sie Bearbeiten > Tastaturbefehle und geben Sie für schnellen Zugriff die Befehle in das Suchfeld ein oder klicken Sie auf In
Zwischenablage kopieren, um aus einem Textbearbeitungsprogramm zu drucken.

http://creativecommons.org/licenses/by-nc-sa/3.0/deed.de
http://help.adobe.com/de_DE/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_de


Neuheiten
Hinweis: Einige Eigenschaften der Windows-Version von Adobe Audition 3.0 sind nicht in CS5.5 verfügbar. Dazu gehören das Brennen von CDs,
MIDI, das Metronom, einige Dateiformate und Effekte, die Gruppierung von Clips und das Dehnen der Zeit sowie die Unterstützung einer
Steuerungsoberfläche. Eine vollständige Liste finden Sie unter Adobe Audition 3.0 features replaced or not implemented in CS5.5 (Funktionen aus
Adobe Audition 3.0, die in CS5.5 ersetzt oder nicht implementiert wurden).
Adobe Audition CS5.5 führt die besten Funktionen aus den Adobe-Audioprodukten in einem plattformübergreifenden Paket zusammen. Dieses
Paket umfasst herausragende Tools zum Bearbeiten und Mischen von Multitrack-Sessions, effiziente Optionen zur Audioverbesserung und extrem
zuverlässige Leistung.

Mac OS-Unterstützung Nutzen Sie die Multicore-Verarbeitung, das native Audio und die DSP-Power von Apple Macintosh-Computern optimal
aus.
Hochleistungs-Audio-Engine Erleben Sie effizientes Multitasking mit dramatisch verbesserten Reaktionszeiten unabhängig von der
Projektgröße. Öffnen Sie Dateien bis zu dreimal schneller. Arbeiten Sie gleichzeitig an mehreren Multitrack-Sessions und Audiodateien.
Importieren Sie Dateien und führen Sie im Hintergrund Stapelbearbeitungen durch, während Sie gleichzeitig Audiodaten bearbeiten.
Beschleunigen Sie die Effektverarbeitung auf Systemen mit mehreren Prozessoren.
Parallele Bearbeitungen in Videoanwendungen wie Adobe Premiere Pro Starten Sie Audiobereinigungs- und Verarbeitungstools direkt aus
Adobe Premiere Pro und bearbeiten und mischen Sie parallel. Tauschen Sie OMF- und XML-Dateien mit digitalen Audio-Workstations und nicht-
linearen Editoren wie Avid Pro Tools und Apple Final Cut Pro aus. Siehe Arbeiten mit Videoanwendungen und Exportieren von Sessions in das
OMF- oder Final Cut Pro Interchange-Format.
Integrierte 5.1-Surround-Abmischung und -Bearbeitung Mischen Sie 5.1-Surrounddateien direkt im Multitrack-Editor. Das Spurtonschwenk-
Bedienfeld bietet intuitive Steuerungen und visuelles Feedback, mit dem Sie Klänge im Surround-Feld präzise lokalisieren können. Öffnen Sie 5.1-
Abmischdateien im Wellenform-Editor, um ausgewählte Kanäle zu bearbeiten. Siehe 5.1 Surroundsound.
Verbesserte Effekt-Workflows Passen Sie Effektparameter an, während Sie Auswahlen erstellen, Audio wiedergeben oder sogar komplexe
Rauschminderung anwenden. Wenden Sie Multitrack-Effekte auf einzelne Clips an. Erweitern Sie die Audio-Verarbeitungsmöglichkeiten mit VST-
und Audio Units-Plug-Ins von Drittherstellern. Siehe Anwenden von Effekten.
Neue Effekte Adobe Audition CS5.5 enthält neue Effekte von für 5.1-Dateien optimiertem Surround-Hall bis zu einer Reihe von Diagnose-
Effekten, mit denen Sie häufige Audioprobleme korrigieren können. Weitere Informationen finden Sie in den folgenden Abschnitten:

Der Effekt „Surround-Hall“

Der Effekt „Stimmoptimierung“

Der Effekt „Sprachaussteuerung“

Der Effekt „Einzelband-Komprimierung“

Diagnoseeffekte (nur Wellenform-Editor)

Der Effekt „DeHummer“

Der Effekt „DeEsser“

Der Effekt „Chorus/Flanger“

Der Effekt „Phaser“

Erweiterte Bibliothek lizenzfreier Musikhintergründe und Soundeffekte Peppen Sie Ihren Soundtrack mit über 10.000 lizenzfreien Dateien aus
dem Bedienfeld „Resource Central“ auf. Suchen Sie schnell nach Dateien, spielen Sie eine Vorschau ab und ziehen Sie die Dateien einfach aus
dem Bedienfeld in Ihre Audioprojekte, um professionelle Soundtracks mit mehreren Ebenen zu produzieren.
Rationalisierter Metadaten-Workflow mit Broadcast Wave-Unterstützung Vereinfachen Sie die Bearbeitung und Verwaltung von Metadaten
mit dem XMP-basierten Metadaten-Bedienfeld. Die XMP-Unterstützung schließt das Broadcast WAV-Format (BWF) ein, so dass Sie
automatisierte Workflows für Radio- und TV-Produktionssysteme nutzen können. SieheAnzeigen und Bearbeiten von XMP-Metadaten.
Natives XML-Session-Format Speichern Sie Multitrack-Sessions im flexiblen XML-Format, einem Klarschrift-Standard, der die Konvertierung in
proprietäre Formate verschiedener Hersteller ermöglicht. XML-Sessions aus Adobe Audition können in Texteditoren geöffnet und bearbeitet oder
programmgesteuert aus Skripten und anderen Tools erstellt werden. SieheSpeichern von Multitrack-Sessions
Anpassen der Lautstärke von Multitrack-Clips Mischen Sie problemlos Audiodaten aus verschiedensten Quellen. Siehe Anpassen der
Lautstärke von Multitrack-Clips.
Multitrack-Audioanalyse Analysieren Sie mit dem Phasenmesser und dem Frequenzanalyse-Bedienfeld Phasenverhältnisse und
Frequenzgänge in Echtzeit. Siehe Analysieren der Phase und Analysieren des Frequenzbereichs.
Gleichzeitiges Anzeigen von Wellenform und Spektralanzeige Analysieren Sie Audio-Amplituden und Frequenzen mit maximaler Präzision.
Siehe Audio-Wellenformen und -spektren.
Aufzeichnung von Favoriten Speichern Sie Kombinationen aus Effekten, Überblendungen und Amplitudenanpassungen und weisen Sie sie im
Handumdrehen beliebigen Dateien und Auswahlen im Wellenform-Editor zu. SieheFavoriten.
Protokollfenster Stellen Sie problemlos frühere Bearbeitungs- und Mischungszustände wieder her und vergleichen Sie so verschiedene Effekte,
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Rauschminderung, Signalfluss usw. Stellen Sie mit einem einzigen Mausklick den ursprünglichen Zustand wieder her. Siehe Rückgängigmachen,
Wiederherstellen und Protokoll.
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Multitrack-Clipdehnung in CS6
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Modus

Typ

Dauer, Dehnung und Tonhöhe

Erweiterte Einstellungen

1. Wählen Sie Clip > Dehnen > Globale Clipdehnung aktivieren.

2. Ziehen Sie im Editor die weißen Dreiecke rechts bzw. links oben in den Clips.

Wählen Sie mehrere Clips aus, um sie proportional zu dehnen.

Um die Dehnungseinstellungen für ausgewählte Clips anzupassen, passen Sie im Eigenschaftenbedienfeld unter Eigenschaften die folgenden
Optionen an:

Wählen Sie eine der folgenden Optionen:
Aus deaktiviert die Dehnung und setzt den Clip auf die ursprüngliche Länge zurück.
Echtzeit lässt Sie das Ergebnis der Dehnung hören, während Sie Clips ziehen. Dieser Modus ist gut für die Verwendung
während des Bearbeitungsprozesses geeignet.
Gerendert (hohe Qualität) erfordert eine längere Bearbeitungsdauer, kann jedoch dabei helfen, hörbare Artefakte zu
vermeiden. Wählen Sie diesen Modus, wenn im Echtzeit-Modus die Wiedergabe langsam oder die Leistung eingeschränkt ist.

Wählen Sie eine der folgenden Optionen:
Monophon ist ideal für Solo-Musikinstrumente oder Dialoge.
Polyphon ist ideal für Musik mit mehreren Instrumenten oder für komplexe Umgebungsgeräusche.
Varispeed ändert neben der Dauer auch die Tonhöhe, ähnlich wie die Beschleunigung oder Verlangsamung an analogen
Bandgeräten.

Um denselben Modus schnell auf alle Clips anzuwenden, wählen Sie Clip > Dehnen > Alle gedehnten Clips in Echtzeit oder Alle gedehnten
Clips rendern.

Verwenden Sie für Anpassungen, die genauer sind als das Ziehen von Clips im Editor numerische Eingaben.

Legen Sie die folgenden Optionen fest:
Übergangsempfindlichkeit (verfügbar im Modus Polyphon) setzt die Empfindlichkeit auf Übergänge wie z. B. Trommelschläge
oder die Anfänge von Noten, die als Ankerpunkte für die Dehnung verwendet werden. Erhöhen Sie diesen Wert, wenn
Übergänge unnatürlich klingen.
Fenstergröße bestimmt die Größe (in Millisekunden) für jeden Teil der verarbeiteten Audiodaten. Passen Sie diesen Wert nur
an, wenn ein Echo oder flanschende Artefakte auftreten.
Die Einstellungen für Präzision (verfügbar im Modus Gerendert) bestimmen den Kompromiss zwischen Qualität und
Verarbeitungsgeschwindigkeit.
Formanten beibehalten (verfügbar, wenn Gerendert und Monophon ausgewählt sind) passt die Klangfarbe von Instrumenten
und Stimmen an und sorgt dafür, dass das Ergebnis bei der Transponierung realitätsnah bleibt.

Um männliche Stimmen weiblich klingen zu lassen und umgekehrt, wählen Sie „Formanten beibehalten“ aus, und führen Sie eine starke
Transponierung durch.
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Digitale Audiodaten - Grundlagen
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Digitalisieren von Audiodaten

Nach oben

Nach oben

Vergleich analoger und digitaler Audiodaten
Abtastrate – Grundlagen
Bittiefe – Grundlagen
Messen der Amplitude in dBFS
Inhalt und Größe von Audiodateien
So werden Audiodaten von Adobe Audition digitalisiert

Vergleich analoger und digitaler Audiodaten
Der Übertragungs- und Speicherungsprozess von Sound ist bei analogen und digitalen Audiodaten sehr unterschiedlich.

Analoge Audiodaten: positive und negative Spannung
Ein Mikrofon konvertiert die Druckwellen des Klangs in Spannungsänderungen in einem Draht: hoher Druck wird zu positiver Spannung und
niedriger Druck zu negativer Spannung. Wenn diese Spannungsänderungen durch einen Mikrofondraht geleitet werden, können sie als
Änderungen der Magnetfeldstärke auf Band aufgenommen oder als Änderung der Rillengröße auf Vinylplatten aufgenommen werden. Ein
Lautsprecher funktioniert genau umgekehrt wie ein Mikrofon. Er wandelt die Spannungssignale von einer Audioaufnahme in Schwingungen um
und erzeugt wieder Druckwellen.

Digitale Audiodaten: Nullen und Einsen
Im Unterschied zu analogen Speichermedien (wie Magnetbändern oder Vinylschallplatten) speichern Computer Audiodaten digital in Form von
Nullen und Einsen. Bei der digitalen Speicherung wird die ursprüngliche Wellenform in einzelne Samples zerlegt. Dieser Vorgang wird als
Digitalisierung oder Sampling von Audiodaten bezeichnet. Manchmal wird in diesem Zusammenhang auch der Begriff Analog-Digital-Konvertierung
verwendet.

Wenn Sie Audiodaten von einem Mikrofon auf einem Computer aufnehmen, konvertieren Analog-zu-digital-Konverter beispielsweise das
Analogsignal in digitale Samples, die auf dem Computer gespeichert und verarbeitet werden können.

Abtastrate – Grundlagen
Die Abtastrate ist die Anzahl der Samples, die pro Sekunde von einem Audiosignal abgetastet werden. Die Abtastrate bestimmt den
Frequenzbereich einer Audiodatei. Je höher die Abtastrate ist, desto ähnlicher ist die digitale Wellenform der analogen Quellwellenform. Niedrige
Abtastraten begrenzen den Bereich der Frequenzen, die aufgezeichnet werden können. Dies kann zu einer Aufnahme führen, die den
ursprünglichen Klang nur sehr schlecht wiedergibt.

Zwei Abtastraten
A.  Niedrige Abtastrate - die ursprüngliche Klangwelle wird verzerrt. B.  Hohe Abtastrate - die ursprüngliche Klangwelle wird perfekt
wiedergegeben.

Zur Reproduktion einer bestimmten Frequenz muss die Abtastrate mindestens doppelt so hoch sein wie die Frequenz. CDs verfügen
beispielsweise über eine Abtastrate von 44.100 Samples pro Sekunde, sodass sie Frequenzen von bis zu 22.050 Hz reproduzieren können; das
menschliche Ohr kann jedoch nur Frequenzen bis zu 20.000 Hz wahrnehmen.

Nachfolgend finden Sie die häufigsten Abtastraten für digitale Audiodaten:
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Abtastrate Qualitätspegel Frequenzbereich

11,025 Hz Schlechte Mittelwellenqualität (Low-End-
Multimedia)

0–5,512 Hz

22,050 Hz Annähernd UKW-Qualität (High-End-
Multimedia)

0–11,025 Hz

32,000 Hz Besser als UKW (Standardrate für
Rundfunk)

0–16,000 Hz

44,100 Hz CD 0–22,050 Hz

48,000 Hz Standard-DVD 0–24,000 Hz

96,000 Hz Blu-ray-DVD 0–48,000 Hz

Bittiefe – Grundlagen
Die Bittiefe bestimmt den dynamischen Bereich. Beim Sampling einer Klangwelle wird jedem Sample der Amplitudenwert zugewiesen, der der
analogen Originalwelle am nächsten kommt. Eine höhere Bittiefe bietet mehr mögliche Amplitudenwerte, was zu einem größeren Dynamikbereich,
geringerem Hintergrundrauschen und höherer Qualität führt.

Für die optimale Audioqualität wandelt Adobe Audition alle Audiodaten in den 32-Bit-Modus um und konvertiert anschließend beim Speichern
der Dateien in die angegebene Bittiefe.

Bittiefe Qualitätspegel Amplitudenwerte Dynamikbereich

8 Bit Telefon 256 48 dB

16 Bit Audio-CD 65,536 96 dB

24 Bit Audio-DVD 16,777,216 144 dB

32 Bit Beste 4,294,967,296 192 dB

Höhere Bittiefen stellen einen größeren Dynamikbereich zur Verfügung.

Messen der Amplitude in dBFS
Bei digitalem Audio wird die Amplitude in Dezibel unter Full Scale bzw. dBFS gemessen. Die maximal mögliche Amplitude ist 0 dBFS; alle
Amplituden darunter werden als negative Zahlen ausgedrückt.

Hinweis: Ein gegebener dBFS-Wert entspricht nicht unmittelbar dem Schalldruckpegel, der mit dB(A) gemessen wird.

Inhalt und Größe von Audiodateien
Eine Audiodatei auf der Festplatte (beispielsweise eine WAV-Datei) besteht aus einem kleinen Header, in dem Abtastrate und Bittiefe angegeben
sind, und aus einer langen Reihe von Zahlen (eine Zahl für jedes Sample). Diese Dateien können sehr groß sein. Bei einer Abtastrate von
44.100 Samples pro Sekunde und 16 Bit pro Sample sind für eine Monodatei 86 KB pro Sekunde erforderlich, d. h. ca. 5 MB pro Minute. Diese
Zahl verdoppelt sich auf 10 MB pro Minute für eine Stereodatei, die über zwei Kanäle verfügt.



 

Nach obenSo werden Audiodaten von Adobe Audition digitalisiert
Wenn Sie mit Adobe Audition Audiodaten aufnehmen, wird die Aufnahme von der Soundkarte gestartet. Die Soundkarte legt auch die zu
verwendende Abtastrate und Bittiefe fest. Über die Line-in- oder Mikrofonanschlüsse empfängt die Soundkarte analoge Audiodaten und tastet
diese digital mit der angegebenen Rate ab. Adobe Audition speichert die Samples, bis Sie die Aufnahme anhalten.

Bei der Wiedergabe einer Datei in Adobe Audition läuft dieser Prozess in umgekehrter Richtung ab. Adobe Audition sendet eine Reihe digitaler
Samples an die Soundkarte. Die Soundkarte rekonstruiert die originale Wellenform und sendet sie als analoges Signal an den
Lautsprecherausgang.

Eine Zusammenfassung: Der Prozess des Samplings bzw. der Digitalisierung beginnt mit einer Druckwelle in der Luft. Ein Mikrofon wandelt diese
Druckwelle in unterschiedliche Spannungen um. Eine Soundkarte konvertiert diese Spannungsänderungen in digitale Samples. Nachdem analoger
Sound in digitale Audiodaten umgewandelt wurde, kann er mit Adobe Audition aufgezeichnet, bearbeitet, verarbeitet und abgemischt werden. Ihrer
Fantasie sind hierbei keine Grenzen gesetzt.

  |  
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Klang – Grundlagen
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Schallwellen
Wellenform-Messungen
Interaktion von Klangwellen

Schallwellen
Klang beginnt mit Vibrationen in der Luft, wie die, die von Gitarrensaiten, Stimmbändern oder Lautsprechermembranen erzeugt werden. Diese
Vibrationen pressen in der Nähe befindliche Luftmoleküle zusammen, wodurch der Luftdruck leicht erhöht wird. Die unter Druck stehenden
Luftmoleküle pressen dann die Luftmoleküle zusammen, die sie umgeben. Diese Luftmoleküle pressen dann die nächsten Moleküle zusammen
usw. Wenn sich Hochdruckbereiche durch die Luft bewegen, hinterlassen sie Tiefdruckbereiche. Erreichen uns diese Wellen mit Druckänderungen,
versetzen sie im menschlichen Ohr vorhandene Rezeptoren in Vibrationen, die als Klang wahrgenommen werden.

Eine visuelle Wellenform, die für Audiosignale steht, stellt diese Luftdruckwellen dar. Die Nulllinie der Wellenform ist der Luftdruck im
Ruhezustand. Wenn die Linie eine Wellenformspitze bildet, stellt sie höheren Druck dar; wenn die Linie ein Wellenformtal bildet, stellt sie
niedrigeren Druck dar.

Eine Klangwelle, dargestellt als sichtbare Wellenform
A.  Nulllinie B.  Tiefdruckbereich C.  Hochdruckbereich

Wellenform-Messungen
Wellenformen können durch verschiedene Messungsmethoden beschrieben werden:

Amplitude Bildet die Änderung des Drucks zwischen der Spitze und dem Tal der Wellenform ab. Wellenformen mit einer hohen Amplitude stellen
laute Klänge dar; Wellenformen mit einer niedrigen Amplitude stellen leise Klänge dar.
Zyklus Beschreibt eine einzelnen, wiederholte Folge von Druckänderungen, angefangen bei Null über hohen Druck zu niedrigem Druck und
zurück auf Null.
Frequenz Wird in Hertz (Hz) gemessen und beschreibt die Anzahl der Zyklen pro Sekunde. (Eine Wellenform mit 1000 Hz hat 1000 Zyklen pro
Sekunde.) Je höher die Frequenz, desto höher die musische Tonhöhe.
Phase Wird in 360 Grad gemessen und gibt die Position einer Wellenform in einem Zyklus an. Der Anfangspunkt liegt bei 0°, gefolgt von 90° bei
hohem Druck, 180° bei der Hälfte, 270° bei niedrigem Druck und 360° am Endpunkt.
Wellenlänge Wird in Maßeinheiten wie z. B. Zentimeter gemessen und gibt den Abstand zwischen zwei Punkten mit dem gleichen Grad der
Phase an. Während die Frequenz sich erhöht, nimmt die Wellenlänge ab.

Links ein einzelner Zyklus, rechts eine vollständige 20 Hz-Wellenform
A.  Wellenlänge B.  Grad der Phase C.  Amplitude D.  Eine Sekunde

Interaktion von Klangwellen



 

Wenn zwei oder mehr Klangwellen aufeinander treffen, werden addieren bzw. subtrahieren sie von einander. Wenn ihre Spitzen und Täler
genauphasengleich sind, verstärken sie sich gegenseitig, wodurch eine Wellenform mit einer höhere Amplitude als die einzelnen Wellenformen
entsteht.

Phasengleiche Wellen verstärken einander.

Wenn die Spitzen und Täler zweier Wellenformen genau phasenverschoben sind, heben sie sich gegenseitig auf, wodurch keine Wellenform
entsteht.

Phasenverschobene Wellen heben sich gegenseitig auf.

In dem meisten Fällen sind Wellen jedoch unterschiedlich phasenverschoben, wodurch eine kombinierte Wellenform entsteht, die komplexer als
die einzelnen Wellenformen ist. Eine komplexe Wellenform, die zum Beispiel Musik, Stimme, Rauschen und andere Klänge darstellt, kombiniert die
Wellenformen der einzelnen Klänge.

Aufgrund seiner einzigartigen physischen Struktur kann ein einzelnes Instrument sehr komplexe Wellen erzeugen. Deshalb klingen eine Violine
und eine Trompete verschieden, auch wenn mit ihnen die gleiche Note gespielt wird.

Zwei einfache Wellen ergeben eine komplexe Welle.

  |  
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Arbeitsbereich und Einrichtung

Ein Teil des auf dieser Seite verlinkten Inhalts ist möglicherweise nur in englischer Sprache verfügbar.



Viewing, zooming, and navigating audio

To the top

Comparing the Waveform and Multitrack editors
Zoom audio in the Editor panel
Navigate through time

Comparing the Waveform and Multitrack editors
Adobe Audition provides different views for editing audio files and creating multitrack mixes. To edit individual files, use the Waveform Editor. To
mix multiple files and integrate them with video, use the Multitrack Editor.

The Waveform and Multitrack editors use different editing methods, and each has unique advantages. The Waveform Editor uses a destructive
method, which changes audio data, permanently altering saved files. Such permanent changes are preferable when converting sample rate and bit
depth, mastering, or batch processing. The Multitrack Editor uses a nondestructive method, which is impermanent and instantaneous, requiring
more processing power, but increasing flexibility. This flexibility is preferable when gradually building and reevaluating a multilayered musical
composition or video soundtrack.

You can combine destructive and nondestructive editing to suit the needs of a project. If a multitrack clip requires destructive editing, for example,
simply double-click it to enter the Waveform Editor. Likewise, if an edited waveform contains recent changes that you dislike, use the Undo
command to revert to previous states—destructive edits aren’t applied until you save a file.

For more information about the Waveform Editor, see Editing audio files; for more information about the Multitrack Editor, see Mixing multitrack
sessions.

Basic components of the editors
Though available options differ in the Waveform and Multitrack editors, both views share basic components, such as the tool and status bars, and
the Editor panel.

Basic components of Waveform and Multitrack editors (Waveform shown) 
A. View buttons and toolbar B. Editor panel with zoom navigator at top C. Various other panels D. Status bar 

Switch editors
Do one of the following:

From the View menu, choose Waveform or Multitrack Editor.

In the toolbar, click the Waveform  or Multitrack Editor  button.

In the Multitrack Editor, double-click an audio clip to open it in the Waveform Editor. Alternatively, double-click a file in the
Files panel.

In the Waveform Editor, choose Edit > Edit Original to open the multitrack session that created a mixdown file. (This
command requires embedded metadata in the file. See Embed edit-original data in exported mixdown files.)

http://help.adobe.com/en_US/audition/cs/using/WS58a04a822e3e5010548241038980c2c5-7e43.html#WS58a04a822e3e5010548241038980c2c5-7e41
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Zoom audio in the Editor panel

To zoom into a specific time range, right-click and drag. 
A. Zoom navigator B. Timeline ruler 

Zoom into a specific time range

In either the zoom navigator or the timeline ruler, right-click and drag. The magnifying glass icon  creates a selection showing the range that will
fill the Editor panel.

Zoom into a specific frequency range

In the vertical ruler for the spectral display, right-click and drag. (See View audio waveforms and spectrums.)

Extend or shorten the displayed range

Place the pointer over the left or right edge of the highlighted area in the zoom navigator, and then drag the magnifying glass icon .

Gradually zoom in or out

In the lower right of the Editor panel, click the Zoom In  or Zoom Out  button.

You can set the Zoom Factor in the General section of the Preferences dialog box. (See Customize preferences.)

Zoom with the mouse wheel or Mac trackpad

Place the pointer over the zoom navigator or ruler, and either roll the wheel or drag up or down with two fingers. (In the Waveform Editor, this
zoom method also works when the pointer is over the waveform.)

Roll or drag over the spectral display, and press Shift to switch between logarithmic and linear frequency scales. (Logarithmic better reflects
human hearing; linear makes individual frequencies more visually distinct.)

Magnify selected audio

In the lower right of the Editor panel, click the Zoom In At In Point , Zoom In At Out Point , or Zoom To Selection  buttons.

Display the entire audio file or multitrack session

In the lower right of the Editor panel, click the Zoom Out Full button .

To display zoom buttons in a separate panel, choose Window > Zoom.

Navigate through time
At higher zoom levels, you can navigate to different audio content in the Editor panel.

Navigate by scrolling

Scrolling with the zoom navigator

In the zoom navigator, drag left or right.

To scroll through audio frequencies in the spectral display, drag up or down in the vertical ruler. (See View audio waveforms
and spectrums.)

Navigate with the Selection/View panel
The Selection/View panel shows the start and end of the current selection and view in the Editor panel. The panel displays this information in the
current time format, such as Decimal or Bars And Beats. (See Change the time display format.)

1. To display the Selection/View panel, choose Window > Selection/View Controls.
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2. (Optional) Enter new values into the Begin, End, or Duration boxes to change the selection or view.

Dock, group, or float panels
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Herstellen von Verbindungen zu Audiogeräten
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Konfigurieren von Audio-Eingängen und -Ausgängen
Wenden Sie rechnerspezifische Hardwareeinstellungen für Netzwerkbenutzer an (Audition CS6)
Zuweisen von Dateikanälen zu Eingängen und Ausgängen

Adobe Audition unterstützt eine Vielzahl von Hardware-Eingabe- und Ausgabegeräten. Mit Soundkarten-Eingängen können Sie Audiodateien von
verschiedenen Quellen (z. B. von Mikrofonen, Bandgeräten und Geräten für digitale Effekte) auf Ihrem Computer speichern. Die Soundkarten-
Ausgänge ermöglichen das Audio-Monitoring über Lautsprecher oder Kopfhörer.

A.  An die Soundkarten-Eingänge werden Mikrofone und Bandgeräte
angeschlossen. B.  An die Soundkarten-Ausgänge werden Lautsprecher und Kopfhörer angeschlossen.

Konfigurieren von Audio-Eingängen und -Ausgängen
Wenn Sie Eingänge und Ausgänge für die Wiedergabe oder Aufnahme von Audio konfigurieren, können Sie in Adobe Audition folgende
Soundkartentreiber verwenden:

Unter Windows unterstützen ASIO-Treiber professionelle Soundkarten, MME-Treiber unterstützen in der Regel
Standardkarten.

Unter Mac OS unterstützen CoreAudio-Treiber sowohl professionelle als auch Standardkarten.

ASIO- und CoreAudio-Treiber sind generell vorzuziehen, da sie eine bessere Leistung und eine niedrigere Latenz bieten. Sie können auch ein
Monitoring der Audioaufnahme durchführen und Änderungen der Lautstärke, der Balance oder der Effekte sofort während der Wiedergabe hören.

1. Wählen Sie „Bearbeiten“ > „Voreinstellungen“ > „Audiogeräte“ (Windows) bzw. „Audition“ > „Voreinstellungen“ > „Audiogeräte“
(Mac OS).

2. Wählen Sie im Menü „Geräteklasse“ den Treiber für die gewünschte Soundkarte aus.
3. Wählen Sie einen Standardeingang und einen Standardausgang für die Karte aus.

Im Multitrack-Editor können Sie die Standardeinstellungen für bestimmte Tracks übersteuern. Siehe Zuweisen von Audio-
Eingängen und -Ausgängen zu Tracks.

4. (MME und CoreAudio) Wählen Sie unter „Master-Takt“ dein Eingang oder Ausgang, mit dem Sie andere Audiogeräte
synchronisieren möchten (damit die Samples präzise ausgerichtet sind).

5. Geben Sie unter „I/O-Puffergröße“ (ASIO und CoreAudio) bzw. „Wartezeit“ (MME) die niedrigste mögliche Einstellung, bei der
es nicht zu Aussetzern kommt. Die ideale Einstellung ist von der Geschwindigkeit des Systems abhängig, Sie müssen also
ggf. etwas experimentieren.

6. Wählen Sie eine Abtastrate für das Audiogerät. (Übliche Abtastraten für verschiedene Ausgabemedien finden Sie unter
Abtastrate – Grundlagen.)

7. (Optional) Wenn Sie die Leistung von ASIO- und CoreAudio-Karten weiter optimieren möchten, klicken Sie auf
„Einstellungen“. Weitere Informationen finden Sie in der Dokumentation für die Soundkarte.

Hinweis: Standardmäßig werden ASIO-Soundkarten bei der Wiedergabe oder dem Monitoring von Audio durch Adobe Audition gesteuert. Wenn
Sie über eine andere Anwendung auf die Karte zugreifen möchten, wählen Sie „ASIO-Treiber im Hintergrund freigeben“. (Während Aufnahmen
wird die Karte trotzdem noch von Audition gesteuert, damit Aufnahmen nicht unerwartet gestoppt werden.)

Wenden Sie rechnerspezifische Hardwareeinstellungen für Netzwerkbenutzer an (Audition
CS6)
In der Netzwerkumgebung werden die Voreinstellungen von Adobe Audition in Verbindung mit den einzelnen Benutzerkonten gespeichert. So kann
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der Benutzer seine Bearbeitungsoptionen, die Oberfläche und andere Einstellungen an seine Wünsche anpassen. Voreinstellungen für das
Audiogerät sollten auf einem Computer in der Regel einheitlich sein. So ist sichergestellt, dass Ein- und Ausgaben der installierten
Audioschnittstelle in Adobe Audition verfügbar sind.

1. Wählen Sie „Bearbeiten“ > „Voreinstellungen“ > „Audiogeräte“ (Windows) bzw. „Audition“ > „Voreinstellungen“ > „Audiogeräte“
(Mac OS).

2. Aktivieren Sie am unteren Rand der Einstellungen zur Audio-Hardware die Option „Computerspezifische Gerätestandards
verwenden“. (Deaktivieren Sie diese Option nur, wenn ein Benutzer eine zugewiesene Audioschnittstelle zwischen zwei
Computern verschiebt).

Um Hardwareeinstellungen von einem Computer auf einen anderen zu kopieren, suchen Sie die Datei „MachineSpecificSettings.xml“ und
kopieren Sie diese.

Zuweisen von Dateikanälen zu Eingängen und Ausgängen
1. Wählen Sie „Bearbeiten“ > „Voreinstellungen“ > „Audiokanalzuordnung“ (Windows) bzw. „Audition“ > „Voreinstellungen“ >

„Audiokanalzuordnung“ (Mac OS).

2. Klicken Sie rechts neben den Einträgen in den Listen für Eingang und Ausgang auf die Pfeile, um für jeden Dateikanal einen
Hardware-Anschluss auszuwählen.

Mit dieser Methode legen Sie auch die Standardausgänge für den Master-Track im Multitrack-Editor fest. Informationen zum Übersteuern der
Standardeinstellungen finden Sie unter Zuweisen von Audio-Eingängen und -Ausgängen zu Tracks.

Verwandte Hilfethemen
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Anpassen von Voreinstellungen
Wiederherstellen der standardmäßigen Voreinstellungen
Exportieren und Importieren benutzerdefinierter Anwendungseinstellungen

Anpassen von Voreinstellungen
Im Dialogfeld „Voreinstellungen“ können Sie die Anzeige und den Bearbeitungsmodus von Adobe Audition, die Nutzung des Festplattenspeichers
und weitere Einstellungen festlegen.

 Wählen Sie „Bearbeiten“ > „Voreinstellungen“ (Windows) bzw. „Audition“ > „Voreinstellungen“ (Mac OS). Wählen Sie anschließend den Bereich
aus, den Sie anpassen möchten.

Informationen zu einer bestimmten Option erhalten Sie, wenn Sie mit der Maus darauf zeigen, bis eine QuickInfo eingeblendet wird.

Wählen Sie unter „Medien- und Disk-Cache“ das schnellste Laufwerk für den primären Temp-Ordner aus und geben Sie ein anderes Laufwerk
für den sekundären Temp-Ordner an. Aktivieren Sie die Option „Peak-Dateien speichern“, um Informationen zur Anzeigemethode von WAV-
Dateien zu speichern. (Ohne Peak-Dateien erfolgt das erneute Öffnen großer WAV-Dateien langsamer.)

Wiederherstellen der standardmäßigen Voreinstellungen
Unerwartetes Verhalten der Anwendung kann auf beschädigte Voreinstellungsdateien hindeuten. Um die Voreinstellungsdateien
wiederherzustellen, gehen Sie wie folgt vor:

 Halten Sie die Umschalttaste gedrückt und starten Sie Adobe Audition.

Exportieren und Importieren benutzerdefinierter Anwendungseinstellungen
In Dateien mit Anwendungseinstellungen werden alle aktuellen Voreinstellungen, Effekteinstellungen und Arbeitsbereiche gespeichert. Exportieren
und importieren Sie diese Dateien, um Gruppen von benutzerdefinierten Einstellungen für bestimmte Workflows zu speichern oder bevorzugte
Einstellungen auf andere Computer zu übertragen.

1. Wählen Sie „Datei“ > „Exportieren“ > „Anwendungseinstellungen“. Geben Sie einen Dateinamen und einen Speicherort an.

2. Um die Einstellungen später wieder anzuwenden, wählen Sie „Datei“ > „Importieren“ > „Anwendungseinstellungen“.

Wenn Sie Voreinstellungen aus Audition 2.0 oder 3.0 importieren möchten, suchen Sie nach der Datei „audition_settings.xml“. Diese Datei
können Sie in Audition CS sowohl unter Mac OS als auch unter Windows importieren.

Verwandte Hilfethemen
Arbeiten mit Markern

Anpassen der Spektralanzeige

Ändern des Zeitanzeigeformats

Navigieren in der Zeit und Wiedergeben von Audio
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Wissenswertes zu Arbeitsbereichen
Wählen eines Arbeitsbereichs
Angedockte, gruppierte und schwebende Bedienfelder
Ändern der Größe von Bedienfeldgruppen
Öffnen, Schließen und Auswählen von Bedienfeldern
Arbeiten mit mehreren Monitoren
Anzeigen der Werkzeugleiste
Anzeigen der Statusleiste
Ändern der Farben, Helligkeit und Leistung der Benutzeroberfläche
Speichern, Zurücksetzen oder Löschen von Arbeitsbereichen

Wissenswertes zu Arbeitsbereichen
Die Video- und Audioanwendungen von Adobe haben einen einheitlichen, anpassbaren Arbeitsbereich. Jede Anwendung verfügt zwar über eigene
Bedienfelder (wie z. B. den Projektbereich, das Metadatenbedienfeld, die Zeitleiste usw.), das Verschieben und Gruppieren der Bedienfelder
erfolgt jedoch in allen Anwendungen auf die gleiche Weise.

Das Hauptfenster eines Programms ist das Anwendungsfenster. Die verschiedenen Bedienfelder in diesem Fenster sind in einem so genannten
Arbeitsbereich angeordnet. Der Standardarbeitsbereich enthält Bedienfeldgruppen sowie separate Bedienfelder.

Sie passen den Arbeitsbereich an, indem Sie die Bedienfelder so anordnen, wie es Ihren spezifischen Anforderungen entspricht. Beim Anordnen
der Bedienfelder wird die Größe der anderen Bedienfelder automatisch angepasst, damit alle Bedienfelder in das Fenster passen. Sie können
mehrere benutzerdefinierte Arbeitsbereiche für unterschiedliche Aufgaben, z. B. für die Bearbeitung oder Vorschau, erstellen und speichern.

Mit schwebenden Fenstern kann ein Arbeitsbereich erstellt werden, der denen aus früheren Adobe-Anwendungen ähnelt. Es ist auch möglich,
Bedienfelder auf diese Weise auf mehreren Monitoren zu platzieren.

Beispiel für einen Arbeitsbereich
A.  Anwendungsfenster B.  Gruppierte Bedienfelder C.  Einzelnes Bedienfeld

Wählen eines Arbeitsbereichs
Alle Video- und Audio-Anwendungen von Adobe enthalten mehrere vordefinierte Arbeitsbereiche, die das Layout der enthaltenen Bedienfelder für
bestimmte Aufgaben optimieren. Wenn Sie einen dieser Arbeitsbereiche oder einen von Ihnen gespeicherten benutzerdefinierten Arbeitsbereich
wählen, wird der aktuelle Arbeitsbereich entsprechend aktualisiert.

 Öffnen Sie das zu bearbeitende Projekt, wählen Sie „Fenster“ > „Arbeitsbereich“ und klicken Sie dann auf den gewünschten Arbeitsbereich.
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Sie können Bedienfelder andocken, sie in Gruppen organisieren und nicht angedockte Bedienfelder beliebig über dem Anwendungsfenster
positionieren. Wenn Sie Bedienfelder verschieben, werden Ablagebereiche hervorgehoben, die als Ziele für die Bedienfelder verwendet werden
können. Je nachdem, in welchen Ablagebereich Sie ein Bedienfeld ablegen, wird das Bedienfeld entweder an andere Bedienfelder angedockt oder
oder mit anderen Bedienfeldern gruppiert.

Andockbereiche
Andockbereiche befinden sich entlang der Ränder von Bedienfeldern, Gruppen oder Fenstern. Beim Andocken eines Bedienfelds wird das
Bedienfeld neben der vorhandenen Gruppe eingefügt, wobei die Größe aller Gruppen entsprechend geändert wird, damit das neue Bedienfeld in
den Bereich hineinpasst.

Ziehen eines Bedienfels (A) in einen Andockbereich (B), um es dort anzudocken (C)

Gruppierungsbereiche
Gruppierungsbereiche befinden sich in der Mitte eines Bedienfelds oder einer Gruppe sowie entlang des Registerkartenbereichs eines Bedienfelds.
Beim Ablegen von Bedienfeldern in einem Gruppierungsbereich werden die Bedienfelder zu einer Gruppe zusammengefasst.

Ziehen eines Bedienfelds (A) in einen Gruppierungsbereich (B), um es mit vorhandenen Bedienfeldern zu gruppieren (C)

Andocken oder Gruppieren von Bedienfeldern

1. Wenn das anzudockende oder zu gruppierende Bedienfeld nicht sichtbar ist, wählen Sie es aus dem Menü „Fenster“ aus.

2. Führen Sie einen der folgenden Schritte aus:

Um ein einzelnes Bedienfeld zu verschieben, ziehen Sie den Ziehpunkt oben links auf der Registerkarte des Bedienfelds
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auf den gewünschten Ablagebereich.

Den Ziehpunkt ziehen, um ein einzelnes Bedienfeld zu verschieben

Um eine gesamte Gruppe zu verschieben, ziehen Sie den Gruppenziehpunkt oben rechts auf den gewünschten
Ablagebereich.

Den Gruppenziehpunkt ziehen, um eine gesamte Gruppe zu verschieben

Je nach Ablagebereich wird das Bedienfeld angedockt oder gruppiert.

Abdocken eines Bedienfelds in einem schwebenden Fenster
Wenn Sie ein Bedienfeld in einem frei verschiebbaren Fenster loslösen, können Sie Bedienfelder in das Fenster einfügen oder andere Änderungen
vornehmen, ähnlich wie im Anwendungsfenster. Mit schwebenden Fenstern können Sie einen zweiten Monitor einsetzen oder einen Arbeitsbereich
erstellen, der denen in früheren Versionen von Adobe-Anwendungen ähnelt.

 Aktivieren Sie das abzudockende Bedienfeld (wenn es nicht angezeigt wird, können Sie es im Menü „Fenster“ auswählen) und führen Sie einen
der folgenden Schritte aus:

Wählen Sie aus dem Bedienfeldmenü den Befehl zum Abdocken des Bedienfelds oder des Rahmens. Mit dem Befehl zum
Abdocken des Rahmens wird die Bedienfeldgruppe abgedockt.

Halten Sie beim Ziehen des Bedienfelds oder der Gruppe die Strg-Taste (Windows®) bzw. die Befehlstaste (Mac OS®)
gedrückt. Wenn Sie die Maustaste loslassen, wird das Bedienfeld bzw. die Gruppe in einem neuen schwebenden Fenster
angezeigt.

Ziehen Sie das Bedienfeld bzw. die Gruppe aus dem Anwendungsfenster heraus. (Wenn das Anwendungsfenster maximiert
ist, ziehen Sie das Bedienfeld auf die Windows-Taskleiste.)

Ändern der Größe von Bedienfeldgruppen
Wenn Sie den Mauszeiger über einer Trennlinie zwischen Bedienfeldgruppen positionieren, können Sie die Größe über die eingeblendeten
Symbole anpassen. Wenn Sie diese Symbole ziehen, wird die Größe aller Gruppen an dieser Trennlinie angepasst. Ein Beispiel: Der
Arbeitsbereich enthält drei vertikal angeordnete Bedienfeldgruppen. Wenn Sie die Trennlinie zwischen den beiden unteren Gruppen ziehen, wird
deren Größe angepasst. Die Größe der oberen Gruppe wird nicht geändert.

Drücken Sie die Akzenttaste, um ein Bedienfeld unterhalb des Mauszeigers schnell zu maximieren. (Drücken Sie nicht die Umschalttaste.)
Durch erneutes Drücken der Akzenttaste wird die ursprüngliche Größe des Bedienfelds wiederhergestellt.

1. Führen Sie einen der folgenden Schritte aus:
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Um die Größe entweder horizontal oder vertikal zu verändern, positionieren Sie den Mauszeiger zwischen zwei
Bedienfeldgruppen. Der Zeiger wird zu einem Doppelpfeilzeiger .

Um die Größe gleichzeitig in beide Richtungen anzupassen, positionieren Sie den Mauszeiger über einem Schnittpunkt

von drei oder mehr Bedienfeldgruppen. Der Zeiger wird zu einem Vierfachpfeil .

2. Halten Sie die Maustaste gedrückt und ziehen Sie die Bedienfeldgruppen auf die gewünschte Größe.

Ziehen der Trennlinie zwischen Bedienfeldgruppen zur horizontalen Anpassung der Größe
A.  Ursprüngliche Gruppe mit Vergrößerungssymbol B.  Gruppen nach der Größenänderung

Öffnen, Schließen und Auswählen von Bedienfeldern
Beim Schließen einer Bedienfeldgruppe im Anwendungsfenster wird die Größe der verbleibenden Gruppen an den frei werdenden Platz
angepasst. Wenn Sie ein schwebendes Fenster schließen, werden die dazugehörigen Bedienfelder ebenfalls geschlossen.

Um ein Bedienfeld zu öffnen oder zu schließen, wählen Sie es im Menü „Fenster“ aus.
Um ein Bedienfeld oder Fenster zu schließen, klicken Sie auf die Schaltfläche „Schließen“ .
Um in einer schmalen Bedienfeldgruppe alle Registerkarten von Bedienfeldern zu sehen, ziehen Sie die horizontale
Bildlaufleiste.
Führen Sie einen der folgenden Schritte aus, um ein Bedienfeld in den Vordergrund einer Gruppe von Bedienfeldern zu
bringen:

Klicken Sie auf die Registerkarte des Bedienfelds, das Sie in den Vordergrund bringen möchten.

Führen Sie den Cursor über den Registerkartenbereich, und drehen Sie am Bildlaufrad der Maus. Durch jedes Drehen
werden die einzelnen Bedienfelder nacheinander in den Vordergrund gebracht.

Ziehen Sie die Registerkarten in horizontaler Richtung, um ihre Reihenfolge zu ändern.

Um die in einer schmalen Bedienfeldgruppe ausgeblendeten Bedienfelder anzuzeigen, ziehen Sie die Bildlaufleiste über der
Bedienfeldgruppe.

Um in einer schmalen Bedienfeldgruppe alle Bedienfelder zu sehen, ziehen Sie die horizontale Bildlaufleiste.

Arbeiten mit mehreren Monitoren
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Setzen Sie bei Bedarf mehrere Monitore ein, um den verfügbaren Bildschirmplatz zu vergrößern. Wenn Sie mit mehreren Monitoren arbeiten, wird
das Anwendungsfenster auf einem Monitor und das frei verschiebbare Fenster auf dem zweiten Monitor angezeigt. Die Monitorkonfigurationen
werden im Arbeitsbereich gespeichert.

Anzeigen der Werkzeugleiste
Über die Symbolleiste haben Sie schnellen Zugriff auf Werkzeuge, das Menü „Arbeitsbereich“ sowie auf Schaltflächen zum Umschalten zwischen
Wellenform- und Multitrack-Editor. Einige Werkzeuge stehen nur in jeweils einer Ansicht zur Verfügung. Ebenso sind einige Werkzeuge des
Wellenform-Editors nur in der Spektralanzeige verfügbar.

Die Symbolleiste ist standardmäßig direkt unter der Menüleiste verankert. Sie können die Verankerung der Symbolleiste jedoch aufheben und sie
so in den Werkzeugbereich umwandeln, den Sie wie jeden anderen Bereich verwenden können.

Wählen Sie zum Ein- bzw. Ausblenden der Symbolleiste „Fenster“ > „Werkzeuge“. Ein Häkchen neben dem Werkzeugbefehl
gibt an, dass er ausgewählt ist.
Um die Verankerung der Symbolleiste an der Standardposition zu lösen, ziehen Sie den Griff am linken Ende an eine andere
Stelle im Arbeitsbereich.
Um den Werkzeugbereich an der Standardposition erneut anzudocken, ziehen Sie den Reiter des Werkzeugbereichs in den
Ablagebereich unterhalb der Menüleiste, der sich über die gesamte Breite des Fensters von Adobe Audition erstreckt.

Die verfügbaren Werkzeuge hängen von der jeweiligen Ansicht ab.
A.  Werkzeuge für die Spektralanzeige im Wellenform-Editor B.  Werkzeuge im Multitrack-Editor

Anzeigen der Statusleiste
Die Statusleiste befindet sich am unteren Rand des Arbeitsbereiches von Adobe Audition. Ganz links in der Statusleiste wird die Zeit, die zum
Öffnen, Speichern oder Verarbeiten einer Datei erforderlich ist, sowie der aktuelle Transportstatus (Wiedergabe, Aufnahme oder Gestoppt)
angegeben. Ganz rechts in der Statusleiste werden verschiedene Informationen angezeigt, die Sie individuell anpassen können.

Statusleiste
A.  Erforderliche Zeit zum Öffnen, Speichern oder Verarbeiten der Datei B.  Framerate des Videos C.  Dateistatus D.  Sampletyp E.
Unkomprimierte Audiogröße F.  Dauer G.  Freier Speicherplatz H.  Entfallene Samples erkennen

Wählen Sie zum Ein- oder Ausblenden der Statusleiste „Ansicht“ > „Statusleiste“ > „Anzeigen“. Ein Häkchen gibt an, dass die
Statusleiste angezeigt wird.
Um die ganz rechts in der Statusleiste angezeigten Informationen zu ändern, wählen Sie „Ansicht“ > „Statusleiste“ oder klicken
Sie mit der rechten Maustaste auf die Statusleiste. Wählen Sie anschließend eine der folgenden Optionen aus:
Framerate des Videos Zeigt die aktuelle und die Ziel-Framerate der im Multitrack-Editor geöffneten Videodateien an.

Dateistatus Zeigt Informationen an, wenn Verarbeitungsvorgänge für Effekte oder Amplitudenanpassungen durchgeführt
werden.

Sampletyp Zeigt Sample-Informationen über die aktuell geöffnete Wellenform (Wellenform-Editor) oder Sessiondatei
(Multitrack-Editor) an. Eine Stereodatei mit 44.100 Hz und 16 Bit wird z. B. als „44100 Hz • 16-Bit • Stereo“ angezeigt.

Unkomprimierte Audiogröße Gibt entweder die Größe der aktiven Audiodatei, wenn diese in einem unkomprimierten Format
wie WAV und AIFF gespeichert würde, oder die Gesamtgröße einer Multitrack-Session an.

Dauer Zeigt die Länge der aktuellen Wellenform oder Session an. 0:01:247 bedeutet z. B., dass die Wellenform oder Session
eine Länge von 1,247 Sekunden hat.

Freier Speicherplatz Zeigt den auf der Festplatte verfügbaren freien Speicherplatz an.

Freier Speicherplatz (Zeit) Zeigt die für Aufnahmen verbleibende Zeit basierend auf der aktuell ausgewählten Abtastrate an.
Dieser Wert wird in Minuten, Sekunden und Tausendstel Sekunden angezeigt. Ist in Adobe Audition z. B. die Audio-Aufnahme
mit 8 Bit und 11.025 Hz ausgewählt, kann als verbleibende Zeit ein Wert wie „4399:15,527 frei“ angezeigt werden. Ändern Sie
die Aufnahmeoptionen in Stereo mit 16 Bit bei 44.100 Hz, wird als verbleibende Zeit „680:44,736 frei“ angezeigt.

Standardmäßig sind die Informationen für „Freier Speicherplatz (Zeit)“ ausgeblendet. Zum Einblenden klicken Sie mit der
rechten Maustaste auf die Statusleiste und aktivieren Sie im Popup-Menü die Option „Freier Speicherplatz (Zeit)“.

Entfallene Samples erkennen Zeigt an, dass während der Aufnahme oder der Wiedergabe Samples entfallen sind. Wenn
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diese Anzeige zu sehen ist, nehmen Sie die Datei erneut auf, um hörbare Aussetzer zu vermeiden.

Ändern der Farben, Helligkeit und Leistung der Benutzeroberfläche
1. Wählen Sie „Bearbeiten“ > „Voreinstellungen“ > „Darstellung“ (Windows) bzw. „Audition“ > „Voreinstellungen“ > „Darstellung“

(Mac OS).

2. Passen Sie die folgenden Optionen an und klicken Sie auf „OK“:
Vorgaben Ermöglicht das Anwenden, Speichern oder Löschen einer Kombination aus Farb- und Helligkeitseinstellungen.

Farben Klicken Sie auf eines der Farbfelder, um die Farben von Wellenformen, Auswahlen oder der Zeitmarke zu ändern.

Helligkeit Ändert die Helligkeit von Bereichen, Fenstern und Dialogfeldern.

Verläufe verwenden Wenn diese Option deaktiviert ist, werden Bedienfelder, Schaltflächen und Messbalken ohne Licht- und
Schatteneffekte dargestellt.

Speichern, Zurücksetzen oder Löschen von Arbeitsbereichen

Speichern eines benutzerdefinierten Arbeitsbereichs
Wenn Sie einen Arbeitsbereich anpassen, protokolliert die Anwendung Ihre Änderungen und speichert das letzte Layout. Um ein bestimmtes
Layout wiederholt zu nutzen, können Sie Ihren benutzerdefinierten Arbeitsbereich speichern. Gespeicherte benutzerdefinierte Arbeitsbereiche
werden im Menü „Arbeitsbereich“ angezeigt, wo Sie sie jederzeit wieder aufrufen und zurücksetzen können.

 Ordnen Sie die Frames und Bedienfelder wie gewünscht an. Wählen Sie dann „Fenster“ > „Arbeitsbereich“ > „Neuer Arbeitsbereich“. Geben Sie
einen Namen für den Arbeitsbereich ein und klicken Sie auf „OK“.

Hinweis: (After Effects, Premiere Pro, Encore) Wenn ein mit einem benutzerdefinierten Arbeitsbereich gespeichertes Projekt auf einem anderen
System geöffnet wird, sucht die Anwendung nach einem Arbeitsbereich mit dem entsprechenden Namen. Wird kein entsprechender Arbeitsbereich
gefunden (oder stimmt die Monitorkonfiguration nicht überein), wird stattdessen der aktuelle lokale Arbeitsbereich verwendet.

Zurücksetzen eines Arbeitsbereichs
Setzen Sie den aktuellen Arbeitsbereich zurück, um das ursprüngliche Layout der enthaltenen Bedienfelder wiederherzustellen.

 Wählen Sie „Fenster“ > „Arbeitsbereich“ > „Bereichsname zurücksetzen“.

Löschen eines Arbeitsbereichs

1. Wählen Sie „Fenster“ > „Arbeitsbereich“ > Arbeitsbereich löschen.

2. Wählen Sie den Arbeitsbereich aus, der gelöscht werden soll, und klicken Sie auf „OK“.

Hinweis: Der momentan ausgewählte Arbeitsbereich kann nicht gelöscht werden.

Verwandte Hilfethemen
Vergleich zwischen Wellenform- und Multitrack-Editor
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Unterstützte Importformate

Zum Seitenanfang

Hinweis:

Audioimportformate
Videoimportformate

Zusätzliche Videoimportformate in Audition CS6

Audioimportformate
Adobe Audition kann Audiodateien in folgenden Formaten öffnen:

AAC (einschließlich HE-AAC in Audition CS6)
AIF, AIFF, AIFC (einschließlich Dateien mit bis zu 32 Kanälen)

Es gibt viele verschiedene Varianten des AIFF-Formats. Audition kann alle unkomprimierten AIFF-Dateien und die gängigsten komprimierten
Versionen öffnen.

Um Metadaten über den Autor einer AIFF-Datei anzuzeigen, verwenden Sie im Metadaten-Bedienfeld in der Registerkarte „XMP“ das
Feld „Dublin Core: Ersteller“. (Siehe Anzeigen und Bearbeiten von XMP-Metadaten.)

APE (Audition CS6)
AU
AVR
BWF
CAF (alle unkomprimierten und die meisten komprimierten Versionen)
FLAC
HTK
IFF
M4A
MAT
MPC
MP2
MP3 (einschließlich MP3-Surrounddateien)
OGA, OGG
PAF
PCM
PVF
RAW
RF64
SD2
SDS
SF
SND
VOC
VOX
W64
WAV (einschließlich Dateien mit bis zu 32 Kanälen)

Es gibt viele verschiedene Varianten des WAV-Formats. Adobe Audition kann alle unkomprimierten WAV-Dateien und die meisten gängigen
komprimierten Versionen öffnen.

WMA (mit aktivierter DLMS-Format-Unterstützung in den Voreinstellungen „Medien- und Disk-Cache“)
WVE
XI
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Zum SeitenanfangVideoimportformate
Im Wellenform-Editor können Sie die Audiodaten aus Videodateien der unten stehenden Formate öffnen. Im Multitrack-Editor können Sie
dieselben Dateitypen einfügen und außerdem eine Vorschau im Video-Bedienfeld anzeigen.

Damit Sie auf diese Videoformate zugreifen können, muss QuickTime installiert sein. Um zusätzliche Formate zu importieren, benötigen Sie
erweiterte QuickTime-Unterstützung. Weitere Informationen finden Sie unter diesem Artikel auf der Apple-Website.

AVI
DV
MOV (einschließlich Dateien mit bis zu 32 Audiokanälen)
MPEG-1
MPEG-4
3GPP und 3GPP2

Zusätzliche Videoimportformate in Audition CS6
MPEG-2 (bei Installation von CS6 Production Premium oder Master Collection)

Um die folgenden Formate zu aktivieren, wählen Sie in den Voreinstellungen für den Medien und Disk-Cache die Unterstützung für DLMS-
Formate. (Diese Option ist für maximale Leistung standardmäßig deaktiviert.)

AVI (nur Windows)
FLV
R3D
SWF
WMV

Einfügen einer Videodatei in eine Multitrack-Session

Exportieren einer Multitrack-Mischung nach Premiere Pro CS5.5
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Navigating time and playing audio

Note:

To the top

To the top

Pause

Monitoring time
Position the current-time indicator
Preview audio by scrubbing
Play audio linearly or in a loop
Synchronize the current-time indicator across files or views
Change the time display format

Some features in the Windows version of Adobe Audition 3.0 are not available in CS5.5. Examples include CD burning, MIDI, the
metronome, some file formats and effects, clip grouping and time stretching, and control surface support. For a complete list, see Adobe Audition
3.0 features replaced or not implemented in CS5.5.

Monitoring time
In the Editor panel, the following features help you monitor time:

In the timeline near the top of the panel, the current-time indicator  lets you start playback or recording at a specific point.

In the lower left of the panel, the time display shows the current time in numerical format. The default time format is Decimal,
but you can easily change it. (See Change the time display format.) The same format is used by the timeline.

To show the time display in separate panel, choose Window > Time.

Features that help you monitor time 
A. Current-time indicator  B. Timeline  C. Time display 

Position the current-time indicator

In the Editor panel, do any of the following:

In the timeline, drag the indicator  or click a specific time point.

In the time display at lower left, drag across the numbers, or click to enter a specific time.

At the bottom of the panel, click one of the following buttons:

To display these buttons in a separate panel, choose Window > Transport.

 Temporarily stops the current-time indicator. Click the Pause button again to resume playback or recording.

http://kb2.adobe.com/cps/895/cpsid_89588.html
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Move CTI to Previous

Rewind

Fast Forward

Move CTI to Next

To the top

To the top

Return CTI to Start Position on Stop

Play Spectral Selection Only

Note:

To the top

 Places the current-time indicator at the beginning of the next marker. If there are no markers,
the current-time indicator moves to the beginning of the waveform or session.

 Shuttles the current-time indicator backward in time.

Right-click the Rewind button to set the rate at which the cursor moves.

 Shuttles the current-time indicator forward in time.

Right-click the Fast Forward button to set the rate at which the cursor moves.

 Moves the current-time indicator to the next marker. If there are no markers, the current-time
indicator moves to the end of the waveform or session.

Preview audio by scrubbing
To scrub audio (producing an audible preview as you shuttle across a file), do any of the following:

Drag the current-time indicator .

Press the Rewind  or Fast Forward  buttons.

Press the J, K, and L keys to shuttle backward, stop, or shuttle forward. Repeatedly pressing the J or L key gradually increases
shuttle speed. (To change the default, set JKL Shuttle Speed in the Playback preferences.)

Play audio linearly or in a loop
To quickly start and stop playback, press the spacebar.

1. In the Editor panel, position the current-time indicator, or select a range.

2. (Optional) At the bottom of the panel, right-click the Play button , and select one of the following:

Reflects the behavior of Audition 3.0 and earlier. (Press Shift+X to toggle this option
on and off.)

Plays only frequencies you’ve selected with the Marquee , Lasso , or Paintbrush

Selection  tool.

3. (Optional) Click the Loop Playback button  if you want to fine-tune a selected range or experiment with different effects
processing.

4. To start playback, click the Play button.

By default, the Editor panel scrolls when playback extends beyond the visible section of a waveform. In the Playback area of the
Preferences dialog box, you can disable auto-scrolling.

Synchronize the current-time indicator across files or views

In the Waveform Editor, you can maintain the position of the current-time indicator when you switch between files—a useful technique when editing
different versions of the same waveform. In the Multitrack Editor, you can maintain the position of the current-time indicator when you switch to the
Waveform Editor—a useful technique when applying edits and effects in both views.

Synchronize the current-time indicator between files in the Waveform Editor

1. Choose Edit > Preferences > General (Windows) or Adobe Audition Preferences > General (Mac OS).

http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
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Decimal (mm:ss.ddd)

Compact Disc 75 fps

SMPTE 30 fps

SMPTE Drop (29.97 fps)

SMPTE 29.97 fps

SMPTE 25 fps (EBU)

SMPTE 24 fps (Film)

Samples

Bars and Beats

Custom (X frames per second)

2. Select Synchronize Selection, Zoom Level, and CTI Across Files In The Waveform Editor.

Synchronize the current-time indicator between the Multitrack and Waveform Editors

1. Choose Edit > Preferences > Multitrack (Windows) or Adobe Audition Preferences > Multitrack (Mac OS).

2. Select Synchronize Clips With Waveform Editor.

Change the time display format
By default, all audio files and multitrack sessions use the same time display format. To customize the format for an open file or session, choose
Window > Properties, expand the Advanced settings, and deselect Synchronize With Time Display Preferences.

Choose View > Display Time Format, and choose the desired option:

Displays time in minutes, seconds, and thousandths of a second.

Displays time in the same format used by audio compact discs, where each second equals 75 frames.

Displays time in the SMPTE format, where each second equals 30 frames.

Displays time in the SMPTE drop-frame format, where each second equals 29.97 frames.

Displays time in the SMPTE non-drop-frame format, where each second equals 29.97 frames.

Displays time using the European PAL television frame rate, where each second equals 25 frames.

Displays time in a format where each second equals 24 frames, suitable for film.

Displays time numerically, using as a reference the actual number of samples that have passed since the beginning
of the edited file.

Displays time in a musical measures format of bars:beats:subdivisions. To customize settings, choose Edit
Tempo, and set the following options in the Properties panel:

Tempo

Specifies beats per minute.

Time Signature

Specifies the number of beats per measure, and the note that represents full beats. For example, with a signature of 3/8, there
are three notes per measure, and eighth-notes represent full beats.

Subdivisions

Specifies the number of sections each beat is divided into, or the value after the decimal point. For example, if you enter 32
subdivisions per beat, a time setting of 4:2:16 represents an eighth note halfway between beats 2 and 3 in 4/4 time.

Displays time in a custom format. To modify a custom format, choose Edit Custom Frame
Rate, and enter a number of frames per second. Valid values are whole numbers from 2 to 1000.

Customize start offset and time display for multitrack sessions
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Importing with the Files panel
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Import files into the Files panel
Insert from the Files panel into a multitrack session
Change displayed metadata in the Files panel

The Files panel displays a list of open audio and video files for easy access.

Double-click an empty area of the file list to quickly access the Open File dialog box.

Import files into the Files panel
Import files into the Files panel if you want to retain the currently open file in the Editor panel. This technique is particularly helpful when
assembling files for a multitrack session.

1. Do either of the following:

In the Files panel, click the Import File button .

Choose File > Import > File.

2. Select an audio or video file. (See Supported import formats.)

Insert from the Files panel into a multitrack session
1. In the Files panel, select the files you want to insert.

To select multiple adjacent files, click the first file in the desired range, and then Shift-click the last. To select nonadjacent
files, Ctrl-click (Windows) or Command-click (Mac OS).

2. At the top of the Files panel, click the Insert Into Multitrack button . Then choose either New Multitrack Session (see
Create a new multitrack session) or an open session.

The files are inserted on separate tracks at the current time position.

Change displayed metadata in the Files panel
1. In the upper right of the Files panel, click the menu icon , and choose Metadata Display.
2. Select the metadata you want to display, and click OK
3. To move metadata columns left or right, drag column headers such as Name or Duration.

To change the sort order of files, click column headers.

http://creativecommons.org/licenses/by-nc-sa/3.0/
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Hinweis:

Extrahieren von CD-Tracks mit dem Befehl „Audio von CD extrahieren“
Konfigurieren von Trackinformationen und CD-Datenbanken (Audition CS6)

Extrahieren von CD-Tracks mit dem Befehl „Öffnen“ (Mac OS)

Extrahieren von CD-Tracks mit dem Befehl „Audio von CD extrahieren“
Der Befehl „Audio von CD extrahieren“ ist schneller und bietet mehr Kontrolle. Sie können z. B. die der Laufwerksgeschwindigkeit optimieren und
Tracks umbenennen.

1. Legen Sie eine Audio-CD in das CD-ROM-Laufwerk des Computers ein.
2. Wählen Sie „Datei“ > „Audio von CD extrahieren“.
3. Wählen Sie unter „Laufwerk“ das Laufwerk aus, in dem sich die Audio-CD befindet.
4. Wählen Sie unter „Geschwindigkeit“ eine der vom Laufwerk unterstützten Lesegeschwindigkeiten. Die Option „Maximale

Geschwindigkeit“ bietet in der Regel zufriedenstellende Ergebnisse. Sollten jedoch Fehler auftreten, wählen Sie eine
niedrigere Geschwindigkeit.

5. Führen Sie einen der folgenden Schritte aus:
Um eine Vorschau eines Tracks wiederzugeben, klicken Sie auf die zugehörige Wiedergabeschaltfläche.

Um Tracks ein- oder auszuschließen, klicken Sie links neben den Tracknummern auf die Kontrollkästchen oder klicken Sie
auf „Alle ein/aus“.

Doppelklicken Sie auf einen Track, um ihn umzubenennen.

Konfigurieren von Trackinformationen und CD-Datenbanken (Audition CS6)
In der Mitte des Dialogfelds „Audio von CD extrahieren“ werden Informationen zum Interpreten, Album, Genre und Jahr standardmäßig von der
festgelegten CD-Datenbank eingeholt. Um diese Einträge anzupassen, führen Sie einen der folgenden Schritte aus:

Um Informationen anzupassen, überschreiben Sie aktuelle Einträge.
Um Originalinformationen aus der Datenbank einzufügen, klicken Sie auf das Symbol „Titel laden“ .
Wenn eine Meldung mehrere entsprechende Datensätze anzeigt, klicken Sie auf die Pfeile, um verschiedene Datensätze
einzufügen.
Um eine andere Datenbank und Dateinamenskonvention festzulegen, klicken Sie auf das Symbol „Titel-Einstellungen“ .
Weitere Informationen zu den einzelnen Titel-Einstellungsoptionen erhalten Sie, wenn Sie den Mauszeiger darüber
positionieren, bis eine QuickInfo angezeigt wird.

Hinweis: Wenn mehrere Künstlereinträge erkannt werden, wählt Audition automatisch die Option „Compilation“. Geben Sie im Dialogfeld
„Titeleinstellungen“ unter „Trennzeichen für Compilations“ ein Zeichen ein, mit dem Sie bei jedem Track Künstler und Track-Titel trennen möchten.

Extrahieren von CD-Tracks mit dem Befehl „Öffnen“ (Mac OS)
Diese Extrahierungsmethode kann beeinträchtigt u. U. die Leistung von Audition erheblich. Der Befehl „Audio von CD extrahieren“ " ist in

der Regel besser geeignet.

Mit dem Befehl „Öffnen“ können Sie Tracks im AIFF-Format extrahieren. Allerdings muss Audition hierbei kontinuierlich Audiodaten von CD lesen,
wodurch der Import und die Bearbeitung verlangsamt werden.

1. Legen Sie eine Audio-CD in das CD-ROM-Laufwerk des Computers ein.
2. Wählen Sie „Datei“ > „Öffnen“.
3. Wählen Sie „QuickTime“ als Dateityp und navigieren Sie zum CD-ROM-Laufwerk.
4. Wählen Sie die Tracks aus, die Sie extrahieren möchten, und klicken Sie auf „Öffnen“.
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Monitoring der Aufnahme- und Wiedergabepegel

Nach oben

Nach oben

Nach oben

Pegelmesser
Anpassen von Pegelmessern
Anpassen der Aufnahmepegel für Standardsoundkarten

Pegelmesser
Zum Monitoring der Amplitude der eingehenden und ausgehenden Signale während der Aufnahme und Wiedergabe stehen Pegelmesser zur
Verfügung. Im Wellenform-Editor sind diese Werte nur im Pegelmessbereich sichtbar. Im Multitrack-Editor sind die Werte sowohl im
Pegelmessbereich als Amplitude des Master-Ausgangs als auch in den Track-Fenstern als Amplituden der einzelnen Tracks verfügbar.

Sie können den Pegelmessbereich horizontal oder vertikal fixieren. Bei einem horizontal angedockten Fenster stellt der obere Messbalken den
linken und der untere den rechten Kanal dar.

Um das Fenster ein- oder auszublenden, wählen Sie „Fenster“ > „Pegelmesser“.

Pegelmessbereich, horizontal angedockt
A.  Linker Kanal B.  Rechter Kanal C.  Spitzenanzeigen D.  Clip-Anzeigen

Die Signalpegel werden von den Pegelmessern in dBFS (dB Full Scale) angezeigt. Ein Pegel von 0 dB entspricht der Maximalamplitude, ab der
ein Clipping erfolgt. Die gelben Spitzenanzeigen werden 1,5 Sekunden lang eingeblendet, so dass die Spitzenamplitude problemlos bestimmt
werden kann.

Eine zu niedrige Amplitude beeinträchtigt die Klangqualität. Bei zu hohen Amplituden kommt es zum Clipping und zu einer Verzerrung. Die rote
Clip-Anzeige rechts neben den Pegelmessern leuchtet auf, wenn Pegel das Maximum von 0 dB überschreiten.

Um die Anzeigen zurückzusetzen, klicken Sie entweder auf die einzelnen Anzeigen oder klicken Sie mit der rechten Maustaste auf die Messer
und wählen Sie „Anzeigen zurücksetzen“.

Anpassen von Pegelmessern
Klicken Sie mit der rechten Maustaste auf die Messer und wählen Sie eine der folgenden Optionen:

Eingangssignal messen Zeigt den Pegel des Standard-Hardware-Eingangs im Wellenform-Editor an. (Siehe Konfigurieren von Audio-Eingängen
und -Ausgängen.) Um diese Option schnell zu aktivieren bzw. zu deaktivieren, doppelklicken Sie auf die Messer.
Optionen für „Bereich“ Ändert den angezeigten Dezibel-Bereich.
Valleys anzeigen Zeigt Täler für flache Amplituden an.

Liegen die Täler nahe an den Spitzen, ist die Dynamik (der Abstand zwischen den Tönen mit höchster und niedrigster Lautstärke) gering.
Liegen Täler und Spitzen weit auseinander, ist die Dynamik groß.

Farbverlauf anzeigen Zeigt die Messer mit einem Farbverlauf von Grün über Gelb bis Rot an. Deaktivieren Sie diese Option, um bei –18 dBFS
einen abrupten Farbwechsel nach Gelb und bei –6 dBFS nach Rot anzuzeigen.
LED-Messbalken anzeigen Zeigt für jeden vollen Dezibelwert einen separaten Balken an.
Dynamische oder statische Spitzen Ändern den Modus der Spitzenanzeigen. Bei dynamischen Spitzen werden die Spitzenwerte 1,5 Sekunden
lang angezeigt. Die aktuelle Spitzenamplitude lässt sich mit dieser Einstellung gut ablesen. Sobald die Audioausgabe leiser wird, geht die
Spitzenanzeige zurück. Bei der Option „Statische Spitzen“ bleiben die Spitzenanzeigen erhalten. Sie können so die Maximalamplitude des Signals
seit Beginn von Monitoring, Wiedergabe und Aufnahme bestimmen. Sie können die Spitzenanzeigen jedoch nach wie vor manuell zurücksetzen,
indem Sie auf die Clip-Anzeigen klicken.

Um vor der Aufnahme festzustellen, wie laut die Audioausgabe sein wird, wählen Sie die Option „Statische Spitzen“. Überwachen Sie dann die
Eingangspegel. Die Spitzenanzeigen stellen den Pegel der lautesten Passage dar.

Anpassen der Aufnahmepegel für Standardsoundkarten
Passen Sie die Pegel an, wenn die Aufnahmen zu leise sind (und Hintergrundgeräusche verursachen) oder zu laut sind (und Verzerrung
verursachen). Die beste Wiedergabe erzielen Sie, wenn Sie bei der Aufnahme den größtmöglichen Lautstärkepegel einstellen, bei dem noch kein
Clipping auftritt. Beachten Sie beim Einstellen der Aufnahmepegel die Messanzeigen. Die lauteste Spitze sollte im gelben Bereich unter –3 dB
gehalten werden.



 

Die Aufnahmepegel einer Soundkarte werden nicht direkt von Adobe Audition gesteuert. Bei einer professionellen Soundkarte können Sie diese
Pegel mit der Mischeranwendung anpassen, die mit der Karte geliefert wird. (Anleitungen finden Sie in der Dokumentation für die Karte.) Bei einer
Standardsoundkarte können Sie den Mischer von Windows oder Mac OS verwenden.

Anpassen der Soundkartenpegel in Windows 7 und Vista

1. Klicken Sie mit der rechten Maustaste auf das Lautsprechersymbol in der Taskleiste und wählen Sie „Aufnahmegeräte“.

2. Doppelklicken Sie auf die zu verwendende Quelle.

3. Klicken Sie auf die Registerkarte „Lautstärkeregelung“ und stellen Sie die Regler nach Bedarf ein.

Anpassen der Soundkartenpegel in Windows XP

1. Doppelklicken Sie auf das Lautsprechersymbol in der Taskleiste.

2. Wählen Sie „Optionen“ > „Eigenschaften“.

3. Markieren Sie „Aufnahme“ und klicken Sie auf „OK“.

4. Wählen Sie die gewünschte Eingangsquelle aus und passen Sie den Lautstärkeregler an Ihre Bedürfnisse an.

Anpassen der Soundkartenpegel in Mac OS

1. Wählen Sie im Apfelmenü die Option „Systemeinstellungen“.

2. Klicken Sie auf „Ton“ und klicken Sie dann auf die Registerkarte „Eingabe“.

3. Wählen Sie das gewünschte Gerät aus und passen Sie den Regler für die Eingabelautstärke an Ihre Bedürfnisse an.

  |  
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Audioaufnahme
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Aufnehmen von Audio im Wellenform-Editor
Korrigieren des DC-Offsets
Aufnahme direkt in Datei im Multitrack-Editor
Aufnehmen von Audio-Clips im Multitrack-Editor
Punch-In in einen ausgewählten Bereich im Multitrack-Editor
Punch-In während der Wiedergabe im Multitrack-Editor
Auswählen von Punch-In-Takes

Hinweis: Einige Eigenschaften der Windows-Version von Adobe Audition 3.0 sind nicht in CS5.5 verfügbar. Dazu gehören getimte Aufnahmen,
das Brennen von CDs, MIDI, das Metronom, einige Dateiformate und Effekte sowie die Unterstützung einer Steuerungsoberfläche. Eine
vollständige Liste finden Sie unter Adobe Audition 3.0 features replaced or not implemented in CS5.5 (Funktionen aus Adobe Audition 3.0, die in
CS5.5 ersetzt oder nicht implementiert wurden).

Aufnehmen von Audio im Wellenform-Editor
Sie können Audiodaten mit Hilfe von allen Geräten (Mikrofone eingenommen) aufnehmen, die an den Eingang der Soundkarte angeschlossen
werden können. Vor der Aufnahme müssen Sie u. U. das Eingangssignal anpassen, um das beste Signal-Rausch-Verhältnis zu erzielen. (Weitere
Informationen finden Sie unter Anpassen der Aufnahmepegel für Standardsoundkarten. Bei professionellen Soundkarten konsultieren Sie die
zugehörige Dokumentation.)

1. Legen Sie die Audio-Eingänge fest. (Siehe Konfigurieren von Audio-Eingängen und -Ausgängen.)
2. Führen Sie einen der folgenden Schritte aus:

Erstellen Sie eine neue Datei.

Öffnen Sie eine vorhandene Datei, um sie zu überschreiben, oder fügen Sie neue Audiodaten hinzu und platzieren Sie die
Marke für die aktuelle Zeit  an der Position, an der die Aufnahme beginnen soll.

3. Klicken Sie unten im Editor auf die Aufnahme-Schaltfläche , um die Aufnahme zu starten bzw. zu stoppen.

Korrigieren des DC-Offsets
Einige Soundkarten nehmen mit einem leichten DC-Offset auf. Dadurch wird die Wellenform des Signals von der Mittellinie versetzt. Der DC-Offset
kann ein Klick- oder Knackgeräusch am Anfang und am Ende der Datei produzieren.

 Wählen Sie im Wellenform-Editor „Favoriten“ > „DC-Offset reparieren“ aus.
Nähere Informationen zum Messen des DC-Offsets finden Sie unter Analysieren der Amplitude.

Aufnahme direkt in Datei im Multitrack-Editor
Im Multitrack-Editor werden alle aufgenommenen Clips automatisch direkt in einer WAV-Datei gespeichert. Mit Hilfe direkt gespeicherter
Aufnahmen können Sie einfach und schnell mehrere Clips aufnehmen und speichern, wodurch Ihnen große Flexibilität gewährt wird.

Im Session-Ordner befinden sich die aufgenommenen Clips im Ordner „[Sessionname]_Aufgenommen“. Die Namen der Clip-Dateien beginnen mit
dem Track-Namen gefolgt von der Take-Nummer (z. B. Track 1_003.wav).

Nach der Aufnahme können Sie die Takes bearbeiten, um eine optimale Endmischung zu erzielen. So können Sie beispielsweise mehrere Takes
eines Gitarrensolos erstellen und dann die besten Auszüge aus den Soli miteinander kombinieren. (Siehe Zuschneiden und Verlängern von Clips.)
Oder Sie verwenden eine Version des Solos für einen Video-Soundtrack und eine andere für eine Audio-CD.

Aufnehmen von Audio-Clips im Multitrack-Editor
Im Multitrack-Editor können Sie Audiodaten durch Überlagern mehrerer Tracks aufnehmen. Dieses Verfahren wird Overdubbing genannt. Beim
Overdubbing hören Sie die zuvor aufgenommenen Tracks und können diese manipulieren, um ausgefeilte, vielschichtige Kompositionen zu
erzeugen. Jede Aufnahme wird zu einem neuen Audio-Clip in einem Track.

1. Wählen Sie im Eingangs-/Ausgangsbereich des Editors eine Quelle im Eingangsmenü eines Tracks.
Hinweis: Wenn Sie die verfügbaren Eingänge ändern möchten, wählen Sie „Audiogeräte“ und klicken Sie auf
„Einstellungen“.

http://kb2.adobe.com/cps/895/cpsid_89588.html
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2. Klicken Sie auf die Schaltfläche „Für Aufnahme vorbereiten“  für den Track.

In den Track-Fenstern wird der Eingang angezeigt, so dass Sie die Pegel optimieren können. (Wenn Sie diese
Standardeinstellung deaktivieren möchten, so dass Pegel nur während der Aufnahme angezeigt werden, deaktivieren Sie in
den Voreinstellungen im Bereich „Multitrack“ die Option „Eingangsmessung für Tracks in Aufnahmebereitschaft aktivieren“.)

3. Um Hardware-Eingänge zu hören, die durch beliebige Track-Effekte oder Sends geleitet werden, klicken Sie auf die
Schaltfläche „Eingang überwachen“ .
Hinweis: Das Leiten von Eingängen durch Effekte und Sends benötigt erhebliche Verarbeitungsleistung. Informationen zum
Reduzieren der Latenz (hörbare Verzögerung), durch die das Timing gestört wird, finden Sie unter Konfigurieren von Audio-
Eingängen und -Ausgängen.

4. Um gleichzeitig in mehrere Tracks aufzunehmen, wiederholen Sie die Schritte 1–3.

5. Verschieben Sie im Editor die Marke für die aktuelle Zeit  an die gewünschte Startposition oder wählen Sie einen Bereich
für den neuen Clip aus.

6. Klicken Sie unten im Fenster auf die Aufnahme-Schaltfläche , um die Aufnahme zu starten bzw. zu stoppen.

Punch-In in einen ausgewählten Bereich im Multitrack-Editor
Wenn Sie mit einem Zeitbereich eines aufgenommenen Clips nicht zufrieden sind, können Sie diesen Bereich auswählen und über die Punch-In-
Funktion eine neue Aufnahme einfügen, ohne dass dabei der ursprüngliche Clip verändert wird. Sie können zwar auch ohne Punch-In in einen
bestimmten Bereich aufnehmen, bei der Punch-In-Funktion können Sie jedoch die Audiodaten unmittelbar vor und nach dem betreffenden Bereich
wiedergeben. So erhalten Sie einen Kontext, der für natürliche musikalische Übergänge unentbehrlich ist.

Bei besonders wichtigen oder schwierigen Passagen können Sie mit Hilfe von Punch-In auch mehrere Takes einfügen und diese dann auswählen
und bearbeiten, bis Sie ein optimales Ergebnis erzielt haben.

Mit Punch-In erstellter Take

1. Ziehen Sie im Editor das Zeitauswahlwerkzeug  im gewünschten Track, um einen Zeitbereich für den Clip auszuwählen.
2. Wählen Sie den korrekten Track-Eingang. (Siehe Zuweisen von Audio-Eingängen und -Ausgängen zu Tracks.)

3. Klicken Sie auf die Schaltfläche „Für Aufnahme vorbereiten“  für den Track.

4. Positionieren Sie die Marke für die aktuelle Zeit  einige Sekunden vor dem ausgewählten Bereich.

5. Klicken Sie unten im Editor auf die Aufnahme-Schaltfläche .

Audition gibt die Audiodaten vor der Auswahl wieder, nimmt für die Dauer des ausgewählten Bereichs auf und setzt anschießend die Wiedergabe
fort.

Punch-In während der Wiedergabe im Multitrack-Editor
Falls der Punch nicht in einem bestimmten Bereich vorgenommen werden soll, können Sie während der Wiedergabe schnell und einfach einen
Punch in einem allgemeinen Bereich durchführen.

1. Aktivieren Sie mindestens einen Track für die Aufnahme. (Siehe Aufnehmen von Audio-Clips im Multitrack-Editor.)

2. Klicken Sie unten im Editor auf die Wiedergabeschaltfläche .
3. Sobald Sie auf einen Bereich treffen, an dem die Aufnahme begonnen werden soll, klicken Sie auf die Aufnahme-Schaltfläche 

. Klicken Sie abschließend erneut auf diese Schaltfläche.



 

Auswählen von Punch-In-Takes
Wenn Sie einen Punch-In für mehrere Takes verwenden, ordnet Audition die Takes im Editor übereinander in Ebenen an. So wählen Sie einzelne
Takes aus:

1. Wählen Sie mit dem Zeitauswahlwerkzeug  einen Bereich aus, der am Anfang und Ende der Punch-In-Takes einrastet.
(Siehe Einrasten an Clip-Endpunkten.)

2. Positionieren Sie im Track den Mauszeiger auf der Kopfzeile des Clips. (Die Kopfzeile enthält den Tracknamen gefolgt von
der Take-Nummer.)

3. Ziehen Sie den obersten Take an eine andere Position (normalerweise das Ende der Session, um eine unerwünschte
Wiedergabe zu vermeiden.)

4. Spielen Sie die Session ab. Wenn Sie einen zuvor verschobenen Take verwenden möchten, ziehen Sie ihn zurück in den
ausgewählten Bereich.

Um den Originalclip während des Punch-In-Bereichs stummzuschalten, passen Sie die Lautstärke-Hüllkurve an. (Siehe Automatisieren von
Clip-Einstellungen.)

Verwandte Hilfethemen
Erstellen einer neuen, leeren Audiodatei

Positionieren Markers für aktuelle Zeit

  |  
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Copying, cutting, pasting, and deleting audio

Note:

To the top

To the top

To the top

Copied and Existing Audio

Invert Copied Audio

Modulate

Crossfade

To the top

Copy or cut audio data
Paste audio data
Mix audio data when pasting
Delete or crop audio

Some features in the Windows version of Adobe Audition 3.0 are not available in CS5.5. Examples include Audition-specific clipboards, CD
burning, MIDI, the metronome, some file formats and effects, and control surface support. For a complete list, see Adobe Audition 3.0 features
replaced or not implemented in CS5.5.

Copy or cut audio data
1. In the Waveform Editor, select the audio data you want to copy or cut. Or, to copy or cut the entire waveform, deselect all

audio data.
2. Choose one of the following:

Edit > Copy to copy audio data to the clipboard.

Edit > Copy To New to copy and paste the audio data into a newly created file.

Edit > Cut to remove audio data from the current waveform and copy it to the clipboard.

Paste audio data
Do either of the following:

To paste audio into the current file, place the current-time indicator  where you want to insert the audio or select existing
audio you want to replace. Then choose Edit > Paste.

To paste audio data into a new file, choose Edit > Paste To New. The new file automatically inherits the sample type (rate
and bit depth) from the original clipboard material.

Mix audio data when pasting
The Mix Paste command mixes audio data from the clipboard with the current waveform.

1. In the Editor panel, place the current-time indicator  where you want to start mixing the audio data. Alternately, select the
audio data you want to replace.

2. Choose Edit > Mix Paste.
3. Set the following options:

Adjust the percentage of each.

Reverses the phase of copied audio, either exaggerating or reducing phase cancellation if the existing
audio contains similar content. (To understand phase cancellation, see How sound waves interact.)

Modulates the amount of copied and existing audio, producing more audible variation.

Applies a crossfade to the beginning and end of the pasted audio, producing smoother transitions. Specify the
fade length in milliseconds.

Delete or crop audio
Do one of the following:

Select audio you want to delete, and choose Edit > Delete.

Select audio you want to keep, and choose Edit > Crop. (Unwanted audio at the beginning and end of the file is removed.)

Convert a waveform between surround, stereo, and mono

Channel Mixer effect
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Displaying audio in the Waveform Editor

To the top

To the top

View audio waveforms and spectrums
About the waveform display
About the spectral display
View layered or uniquely colored waveform channels
Customize the spectral display
Change the vertical scale

View audio waveforms and spectrums
In the Waveform Editor, the Editor panel provides a visual representation of sound waves. Below the panel’s default waveform display, which is
ideal for evaluating audio amplitude, you can view audio in the spectral display, which reveals audio frequency (low bass to high treble).

To view the spectral display, do either of the following:.
In the toolbar, click the Spectral Display  button.

In the Editor panel, drag the divider between the waveform and spectral displays to change the proportion of each. To
instantly show or hide the spectral display, double-click the handle or click the triangle to its right.

Viewing the waveform and spectral displays 
A. Drag the divider to change the proportion of each. B. Click the triangle to show or hide the spectral display. 

To identify specific channels in stereo and 5.1 surround files, note the indicators in the vertical ruler.

About the waveform display
The waveform display shows a waveform as a series of positive and negative peaks. The x-axis (horizontal ruler) measures time, and the y-axis
(vertical ruler) measures amplitude—the loudness of the audio signal. Quiet audio has both lower peaks and lower valleys (near the center line)
than loud audio. You can customize the waveform display by changing the vertical scale and colors.

With its clear indication of amplitude changes, the waveform display is perfect for identifying percussive changes in vocals, drums, and more. To
find a particular spoken word, for example, simply look for the peak at the first syllable and the valley after the last.

Stereo file in waveform display
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Windowing Function

Spectral Resolution

About the spectral display
The spectral display shows a waveform by its frequency components, where the x-axis (horizontal ruler) measures time and the y-axis (vertical
ruler) measures frequency. This view lets you analyze audio data to see which frequencies are most prevalent. Brighter colors represent greater
amplitude components. Colors range from dark blue (low-amplitude frequencies) to bright yellow (high-amplitude frequencies).

The spectral display is perfect for removing unwanted sounds, such as coughs and other artifacts.

Spectral display, with high frequencies selected

View layered or uniquely colored waveform channels
For stereo and 5.1 surround files, you can view layered or uniquely colored channels. Layered channels better reveal overall volume changes.
Uniquely colored channels help you visually distinguish them.

Choose View > Waveform Channels, and then select Layered or Uniquely Colored.

Channel View options 
A. Uniquely Colored B. Layered (with Uniquely Colored still selected) 

Customize the spectral display
The Spectral Display preferences help you enhance different details and better isolate artifacts.

1. Choose Edit > Preferences > Spectral Display (Windows) or Audition > Preferences > Spectral Display (Mac OS).

2. Set the following options

Determines the Fast Fourier transform shape. These functions are listed in order from narrowest to
widest. Narrower functions include fewer surrounding frequencies but less precisely reflect center frequencies. Wider functions
include more surrounding frequencies but more precisely reflect center frequencies. The Hamming and Blackman options
provide excellent overall results.

Specifies the number of vertical bands used to draw frequencies. As you increase resolution, frequency
accuracy increases, but time accuracy decreases. Experiment to find the right balance for your audio content. Highly
percussive audio, for example, may be better reflected by low resolution.

To adjust resolution directly in the Editor panel, right-click the vertical ruler next to the spectral display, and choose
Increase or Decrease Spectral Resolution.
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Decibel Range

Play Only Selected Frequencies When A Spectral Selection Exists

To the top

Decibels

Percentage

Sample Values

Normalized Values

More Logarithmic or Linear

Full Logarithmic or Linear

Changes the amplitude range over which frequencies are displayed. Increasing the range intensifies colors,
helping you see more detail in quieter audio. This value simply adjusts the spectral display; it does not change audio
amplitude.

Deselect this option to hear all frequencies in the
same time range as a selection.

Change the vertical scale
In the Waveform Editor, you can change the amplitude or frequency scale of the vertical ruler.

Change the amplitude scale of the waveform display

In the waveform display, right-click the vertical ruler and select one of the following:

Indicates amplitude on a decibel scale that ranges from –Infinity to zero dBFS.

Indicates amplitude on a percentage scale that ranges from –100% to 100%.

Indicates amplitude on a scale that shows the range of data values supported by the current bit depth. (See
Understanding bit depth.) 32-bit float values reflect the normalized scale below.

Indicates amplitude on a normalized scale that ranges from –1 to 1.

Change the frequency scale of the spectral display

In the spectral display, right-click the vertical ruler and select one of the following:

Gradually displays frequencies in a more logarithmic scale (reflecting human hearing) or a more
linear scale (making high frequencies more visually distinct).

Hold down Shift and roll the mouse wheel over the spectral display to show frequencies more logarithmically (up) or linearly
(down).

Displays frequencies completely logarithmically or linearly.

Sound waves

Change interface colors, brightness, and performance

Select spectral ranges

Techniques for restoring audio
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Erstellen und Öffnen von Dateien
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Vorlage (CS6)

Abtastrate

Hinweis:

Bittiefe

Erstellen einer neuen, leeren Audiodatei
Erstellen einer neuen Multitrack-Session
Öffnen von vorhandenen Audiodateien und Multitrack-Abmischungen
Anhängen von Audiodateien an andere (Audition CS6)
Importieren einer Datei als Raw-Daten
Einfügen einer Audiodatei in eine Multitrack-Session
Einfügen einer Broadcast Wave-Datei in eine Session

Erstellen einer neuen, leeren Audiodatei
Neue, leere Audiodateien sind perfekt für die Aufnahme neuer Audiodaten oder das Zusammenfügen vorhandener Audiodaten geeignet.

1. Wählen Sie „Datei“ > „Neu“ > „Audiodatei“.

Um schnell eine Datei anhand ausgewählter Audiodaten in einer bereits geöffneten Datei zu erstellen, wählen Sie
„Bearbeiten“ > „In Neue kopieren“. (Siehe Kopieren oder Ausschneiden von Audiodaten.)

2. Geben Sie einen Dateinamen an, und legen Sie folgende Optionen fest:

Bestimmt den Frequenzbereich der Datei. Zur Reproduktion einer bestimmten Frequenz muss die Abtastrate
mindestens doppelt so hoch sein wie die Frequenz. (Siehe Abtastrate – Grundlagen.)

Legt fest, ob die Wellenform in Mono, Stereo oder 5.1-Surround erzeugt wird.

Bei reinen Sprachaufnahmen ist eine Mono-Datei gut geeignet, da die Verarbeitung beschleunigt und die Dateigröße
reduziert wird.

Bestimmt den Amplitudenbereich der Datei. Eine Tiefe von 32 Bit bietet die maximale Verarbeitungsflexibilität in
Adobe Audition. Um die Kompatibilität mit häufig verwendeten Anwendungen zu gewährleisten, sollten Sie die Datei nach der
Bearbeitung jedoch in eine geringere Bittiefe umwandeln. (Siehe Bittiefe – Grundlagen und Ändern der Bittiefe einer Datei.)

Erstellen einer neuen Multitrack-Session
Sessiondateien (*.sesx) enthalten selbst keine Audiodaten, sondern sind kleine XML-basierte Dateien, die auf Audiodateien auf der Festplatte
verweisen. In einer Sessiondatei wird festgehalten, welche Dateien in der Session verwendet werden, wo sie eingefügt wurden, welche Hüllkurven
und Effekte angewendet werden und vieles mehr.

Um die Einstellungen detailliert zu untersuchen, können Sie SESX-Dateien in einem Texteditor öffnen oder in Versionskontrollsystemen
speichern (z. B. Perforce, das in der Spieleindustrie weit verbreitet ist).

1. Wählen Sie „Datei“ > „Neu“ > „Multitrack-Session“.
2. Geben Sie einen Dateinamen und den Speicherort an und legen Sie folgende Optionen fest:

Gibt entweder eine Standardvorlage oder eine von Ihnen erstellte Vorlage an. Sessionvorlagen legen
Quelldateien und Einstellungen wie Abtastrate und Farbtiefe fest.

Bestimmt den Frequenzbereich der Session. Zur Reproduktion einer bestimmten Frequenz muss die Abtastrate
mindestens doppelt so hoch sein wie die Frequenz. (Siehe Abtastrate – Grundlagen.)

Alle einer Session hinzugefügten Dateien müssen dieselbe Abtastrate aufweisen. Wenn Sie versuchen, Dateien mit
unterschiedlichen Abtastraten zu importieren, werden Sie aufgefordert, ein Resampling durchzuführen. Dies kann die
Tonqualität beeinträchtigen. Um die Resampling-Qualität zu ändern, passen Sie in den Voreinstellungen unter „Daten“ die
Einstellung für „Abtastrate konvertieren“ an.

Bestimmt den Amplitudenbereich der Session einschließlich der Aufnahmen und Dateien, die mit dem Befehl
„Multitrack“ > „In neuer Datei abmischen“ erstellt wurden. (Siehe Bittiefe – Grundlagen.)
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Wählen Sie die Bittiefe mit Bedacht, da sie nach dem Erstellen der Session nicht mehr geändert werden kann.
Idealerweise sollten auf schnellen Systemen mit einer Tiefe von 32 Bit arbeiten. Sollte Ihr System stark verlangsamt werden,
reduzieren Sie die Bittiefe.

Bestimmt, ob die Tracks in einen Mono-, Stereo- oder 5.1-Master-Track abgemischt werden. (Siehe Audio an Busse,
Sends und den Master-Track leiten.)

Öffnen vorhandener Audiodateien und Multitrack-Abmischungen
Die folgenden Dateitypen werden im Multitrack-Editor geöffnet: Audition-Session, Adobe Premiere Pro Sequence-XML, Final Cut Pro XML-
Interchange und OMF.

Alle anderen unterstützten Dateitypen werden im Wellenform-Editor geöffnet. Dies gilt auch für Audiodaten aus Videodateien.

SES-Sessiondateien aus Audition 3.0 und früheren Versionen werden nicht unterstützt. Wenn Sie Adobe Audition 3.0 besitzen,
speichern Sie Sessions im XML-Format, damit Sie diese in CS-Versionen öffnen können. Beachten Sie jedoch, dass ältere Effekte in CS6 nicht
vorhanden sind und dass Effekte und Dehnung in CS5.5 nicht vorhanden sind .

Wenn Sie mehrere Dateien öffnen, können Sie im Bedienfeldmenü des Editors auswählen, welche Datei angezeigt werden soll.

1. Wählen Sie „Datei“ > „Öffnen“.
2. Wählen Sie eine Audio- oder Videodatei. (Siehe Unterstützte Importformate.)

Wenn die gewünschte Datei nicht angezeigt wird, wählen Sie aus dem Menü unten im Dialogfeld die Option „Alle
unterstützten Medien“.

Anhängen von Audiodateien an andere (Audition CS6)
Hängen Sie Dateien mit CD Track-Markern an, um Audiodaten schnell zusammenzustellen und eine konsistente Verarbeitung anzuwenden.

1. Führen Sie im Wellenform-Editor einen der folgenden Schritte durch:

Um der aktiven Datei einen Anhang hinzuzufügen, wählen Sie „Datei“ > „Öffnen und anfügen“ > „an aktuelle Datei“ aus.
Um einer neuen Datei einen Anhang hinzuzufügen, wählen Sie „Datei“ > „Öffnen und anfügen“ > „an neue Datei“ aus.

2. Wählen Sie im Dialogfeld „Öffnen und anfügen“ die gewünschten Dateien aus.

Falls die ausgewählten Dateien eine andere Abtastrate, Bittiefe oder einen anderen Kanaltyp aufweisen als die
bereits geöffnete Datei, werden die ausgewählten Dateien automatisch von Audition an die geöffnete Datei angepasst. Um ein
optimales Ergebnis zu erzielen, sollten vorzugsweise Dateien mit demselben Sample-Typ angefügt werden.

3. Klicken Sie auf „Öffnen“.

Importieren einer Datei als Raw-Daten
Wenn Sie eine bestimmte Datei nicht öffnen können, fehlen möglicherweise erforderliche Header-Informationen, in denen der Sampletyp
beschrieben wird. Um diese Informationen manuell anzugeben, können Sie die Datei als Raw-Daten importieren.

1. Wählen Sie „Datei“ > „Importieren“ > „Raw-Daten“.
2. Wählen Sie die Datei aus und klicken Sie auf „Öffnen“.
3. Folgende Optionen sind verfügbar:

Diese sollte möglichst mit der bekannten Abtastrate der Datei übereinstimmen. Beispiele für gebräuchliche
Einstellungen finden Sie unter Abtastrate – Grundlagen. Adobe Audition kann Raw-Daten mit Abtastraten von 1 bis
10.000.000 Hz importieren. Wiedergabe und Aufnahme werden jedoch nur zwischen 6000 Hz und 192.000 Hz unterstützt.

Geben Sie einen Wert zwischen 1 und 32 an.

Gibt das Datenspeicherschema für die Datei an. Wenn Sie nicht sicher sind, welche Kodierung die Datei
verwendet, setzen Sie sich mit dem Anbieter der Datei in Verbindung oder lesen Sie die Dokumentation der Anwendung, in
der die Datei erstellt wurde. In vielen Fällen haben Sie keine andere Wahl als verschiedene Kodierungen auszuprobieren.

Gibt die numerische Reihenfolge für die Datenbytes an. Die Little-Endian-Methode ist bei WAV-Dateien
üblich, die Big-Endian-Methode bei AIFF-Dateien. Die Option „Standard-Bytereihenfolge“ wendet automatisch den für Ihren
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Systemprozessor gültigen Standard an und ist in der Regel die beste Wahl.

Gibt den Datenpunkt in der Datei an, an dem der Importvorgang beginnen soll.

Einfügen einer Audiodatei in eine Multitrack-Session
Wenn Sie eine Audiodatei im Multitrack-Editor einfügen, wird sie zu einem Audio-Clip im ausgewählten Track. Wenn Sie mehrere Dateien auf
einmal bzw. eine einzelne Datei, die den im ausgewählten Track verfügbaren Platz überschreitet, einfügen, werden die neuen Clips von Adobe
Audition in die am nächsten gelegenen leeren Tracks eingefügt.

1. Wählen Sie im Multitrack-Editor einen Track aus, und platzieren Sie den Playhead  an der gewünschten Zeitposition.

2. Wählen Sie „Multitrack“ > „Datei einfügen“.
3. Wählen Sie eine Audio- oder Videodatei. (Siehe Unterstützte Importformate.)

Ziehen Sie in CS6 Bereiche aus dem Marker-Bedienfeld in den Multitrack-Editor, um sie automatisch in Clips zu konvertieren.

Einfügen einer Broadcast Wave-Datei in eine Session
Wenn Sie eine Broadcast Wave-Datei (BWF) in eine Multitrack-Session einfügen, kann Adobe Audition die Datei anhand des eingebetteten
Zeitstempels an der Position für die angegebene Zeit platzieren. Dies wird häufig als punktuelles Einfügen bezeichnet.

1. Wählen Sie „Bearbeiten“ > „Voreinstellungen“ > „Multitrack“ (Windows) bzw. „Audition“ > „Voreinstellungen“ > „Multitrack“
(Mac OS).

2. Aktivieren Sie die Option „Eingebetteten Timecode beim Einfügen von Clips in Multitrack verwenden“.
3. Wählen Sie im Multitrack-Editor einen Track aus.
4. Wählen Sie „Multitrack“ > „Datei einfügen“ und wählen Sie eine BWF-Datei aus.

Adobe Audition fügt an der gewünschten Startzeit einen Audio-Clip ein.

Zum Anzeigen oder Bearbeiten des Zeitstempels für einen BWF-Clip öffnen Sie den Clip im Wellenform-Editor und wählen Sie „Fenster“ >
„Metadaten“. In der Registerkarte „BWF“ wird der Zeitstempel unter „Zeitreferenz“ angezeigt.

Multitrack-Sessions

Einfügen einer Videodatei in eine Multitrack-Session
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Favoriten
Angleichen der Lautstärke mehrerer Dateien
Stapelverarbeitung von Dateien

Favoriten
Favoriten sind Kombinationen aus Effekten, Überblendungen und Amplitudenanpassungen, die Sie speichern und schnell auf Dateien oder
Auswahlen im Wellenform-Editor anwenden können. Im Menü „Favoriten“ sind zunächst einige Standardeinträge aufgelistet, denen Sie eigene
Favoriten hinzufügen können.

Informationen zum Zuweisen von Tastenkombinationen für Favoriten finden Sie unter Anpassen von Tastenkombinationen.

Erstellen eines Favoriten aus einer Kombination von Anpassungen

1. Wählen Sie im Wellenform-Editor „Favoriten“ > „Favoritenaufzeichnung starten“.

2. Wenden Sie die Effekte, Überblendungen und Amplitudenanpassungen an, die Sie speichern möchten.

3. Wählen Sie „Favoriten“ > „Favoritenaufzeichnung beenden“ und geben Sie einen Namen für den Favoriten ein.

Erstellen eines Favoriten aus einem bestimmten Effekt

1. Passen Sie die Effekteinstellungen wie gewünscht an.

2. Klicken Sie rechts oben im Dialogfeld des Effekts auf das Symbol „Favorit“ . Geben Sie einen Namen für den Favoriten
ein.

Erstellen eines Favoriten aus dem Effekte-Rack (CS6)

1. Passen Sie im Effekte-Rack die Einstellungen und die Reihenfolge der Effekte an.

2. Klicken Sie rechts oben im Effekte-Rack auf das Symbol „Favorit“ . Geben Sie einen Namen für den Favoriten ein.

Löschen eines Favoriten

1. Wählen Sie „Favoriten“ > „Favorit löschen“.

2. Wählen Sie den Namen des Favoriten aus und klicken Sie auf „OK“.

Angleichen der Lautstärke mehrerer Dateien
Wenn Sie mehrere Audiodateien gemeinsam veröffentlichen möchten, z. B. auf einer CD oder im Internet, können Sie mit dem Bedienfeld
„Gleiche Lautstärke“ für einen konsistenten Klang sorgen.

Informationen zum Anpassen von Multitrack-Clips ohne Änderung der Quelldateien finden Sie unter Anpassen der Clip-Lautstärke.

1. Wählen Sie im Wellenform-Editor „Fenster“ > „Gleiche Lautstärke“.

2. Ziehen Sie Dateien aus dem Dateibereich in das Bedienfeld „Gleiche Lautstärke“. Oder klicken Sie im Bedienfeld auf die
Schaltfläche „Dateien hinzufügen“ , um nach Dateien zu suchen, die auf dem System gespeichert sind.

Um optimale Leistung zu gewährleisten, werden durch „Gleiche Lautstärke“ standardmäßig nur wenige Dateien
gleichzeitig verarbeitet. Wenn Sie mehr als drei Dateien verarbeiten möchten, ändern Sie in den Voreinstellungen unter
„Daten“ den Wert für „Maximale Anzahl gleichzeitig verarbeiteter Dateien“.

3. (Optional) Um Amplitudenstatistiken wie wahrgenommene und Spitzenlautstärke für jede Datei anzuzeigen, klicken Sie auf
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Spitze
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Begrenzung verwenden

Lookahead-Zeit

Hinweis:

Nachklingzeit

das Symbol „Berechnen“ . Klicken Sie anschließend auf „Einstellungen“, um Zielwerte basierend auf diesen Statistiken
anzugeben.

4. Führen Sie einen der folgenden Schritte aus:

Um vorhandene Dateien zu verarbeiten, aber später zu speichern, deaktivieren Sie die Option „Exportieren“ am unteren
Rand des Bedienfelds. 
Um neue Dateien verarbeiten, aktivieren Sie die Option „Exportieren“. (Informationen zum Anpassen von
Exporteinstellungen finden Sie unter Stapelverarbeitung von Dateien.) 

5. Klicken Sie auf „Ausführen“.

Grundlagen zu den Statistiken für „Gleiche Lautstärke“

Der durchschnittliche Amplitudenwert. (Für Audition CS6 gibt dies den Standard ITU-R BS.1770-2 wieder und gewährleistet die
Konsistenz der Sendepegel und die Kompatibilität mit EBU R 128.)

Der durchschnittliche Amplitudenwert unter Berücksichtigung der Empfindlichkeit des menschlichen Gehörs für mittlere
Frequenzen.

Der in der gesamten Datei am häufigsten vorkommende quadratische Mittelwert (Root Mean Square) der Amplitude. Beispiel:
Wenn zwei Dateien überwiegend Abschnitte mit –50 dBFS enthalten, bilden die RMS-Werte dies ab, selbst wenn eine Datei lautere Passagen
enthält.

Die RMS-Amplitude stellt die wahrgenommene Lautstärke oft besser dar als die absolute Durchschnittsamplitude.

Die maximale Amplitude.

Die maximale Amplitude (wie im Standard ITU-R BS.1770-2 definiert).

Der Prozentsatz, der als Ergebnis der Normalisierung von der Wellenform abgeschnitten würde. Wenn Sie Begrenzung verwenden,
erfolgt kein Beschneiden. Im Idealfall sollten Sie jedoch das Beschneiden vor dem Anwenden der Begrenzung vermeiden. Sollten anzupassende
Dateien eine Beschneidung von mehr als 0 % aufweisen, klicken Sie auf „Rückgängig“ und passen Sie die Amplitude auf einen etwas geringeren
Wert an.

Anpassen von Einstellungen für „Gleiche Lautstärke“

Klicken Sie im Bedienfeld „Gleiche Lautstärke“ auf „Einstellungen“, um folgende Optionen anzupassen:

Legt fest, wie die Amplitude mathematisch verglichen wird:

Führt die Anpassung basierend auf einer angegebenen Gesamtlautstärke durch.

Führt die Anpassung basierend auf der Gesamtlautstärke einer ausgewählten Datei durch. Wählen Sie diese
Option, wenn eine Datei die gewünschte Ziellautstärke aufweist.

Führt die Anpassung basierend auf einer angegebenen Durchschnittslautstärke durch.

Führt die Anpassung basierend auf einer wahrgenommen Lautstärke durch, wobei die
Empfindlichkeit des menschlichen Gehörs für mittlere Frequenzen besonders berücksichtigt wird. Diese Option eignet
sich gut, sofern die Frequenzbetonung einer Datei nicht stark variiert (wenn beispielsweise in einer kurzen Passage
Frequenzen im mittleren Bereich stark ausgeprägt sind, Bassfrequenzen dagegen an einer anderen Stelle).

Führt die Anpassung basierend auf einer angegebenen Spitzenamplitude durch und normalisiert
die Dateien. Da durch diese Option der Dynamikbereich erhalten bleibt, eignet sie sich gut für Dateien, die weiter
verarbeitet werden sollen, oder für hochdynamische Audiodaten wie klassische Musik.

Wendet Hard Limiting an, um das Beschneiden von Spitzen zu vermeiden. (Wenn Sie Audio
verstärken, überschreiten einige Samples möglicherweise den Beschneidungspunkt.)

Gibt die Zeit in Millisekunden für die Dämpfung der Audiodaten an, bevor die lauteste Spitze erreicht
wird.

Ist dieser Wert zu klein, können hörbare Störungen auftreten. Stellen Sie sicher, dass der Wert bei mindestens 5
Millisekunden liegt. 

Gibt die Zeit in Millisekunden für die Rücksetzung der Dämpfung auf 12 dB an (in etwa die Zeit, die
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Dateinamen-Präfix und Dateinamen-Postfix

Vorlage

Speicherort

Wie Speicherort der Quelldatei

Vorhandene Dateien überschreiben

Format

Sampletyp

Neuer Sampletyp

Entfernen von Dateien aus dem Bedienfeld nach Abschluss

Marker und andere Metadaten einschließen

nach Auftreten einer extrem lauten Spitze bis zur Wiederherstellung der normalen Lautstärke benötigt wird).

Mit einer Einstellung von 200 Millisekunden lassen sich niedrige Bassfrequenzen beibehalten. Ist der Wert zu groß,
bleibt die Audiowiedergabe möglicherweise recht lange unter dem normalen Niveau.

Stapelverarbeitung von Dateien
Mit der Stapelverarbeitung können Sie problemlos für mehrere Dateien Favoriten verarbeiten, ein Resampling durchführen oder die Dateien in
einem neuen Format speichern. So können Sie häufige Aufgaben automatisieren, z. B. Dateien nach MP3 exportieren oder identische Effekte auf
zusammengehörige Dateien anwenden.

1. Wählen Sie im Wellenform-Editor „Fenster“ > „Stapelprozess“.

2. Klicken Sie im Stapelprozessfenster auf die Schaltfläche „Dateien hinzufügen“ , um die Dateien auf Ihrem System zu
durchsuchen. (Um schnell alle geöffneten Dateien hinzuzufügen, wählen Sie „Datei“ > „Alle Audiodaten als Stapelprozess
speichern“ aus.)

Um optimale Leistung zu gewährleisten, ist die Stapelverarbeitung standardmäßig auf maximal drei Dateien
gleichzeitig beschränkt. Wenn Sie mehr als drei Dateien verarbeiten möchten, ändern Sie in den Voreinstellungen unter
„Daten“ den Wert für „Maximale Anzahl gleichzeitig verarbeiteter Dateien“.

3. Wählen Sie im Menü „Favoriten“ eine Verarbeitungsoption aus. Führen Sie dann einen der folgenden Schritte aus:

Um die vorhandenen Dateien zu verarbeiten, deaktivieren Sie die Option „Exportieren“ am unteren Rand des Bedienfelds,
und klicken Sie auf „Ausführen“.
Um neue Dateien zu verarbeiten, aktivieren Sie die Option „Exportieren“, und klicken Sie auf „Ausführen“. (Informationen
zum Anpassen der Exporteinstellungen finden Sie im folgenden Schritt.)

4. Klicken Sie auf „Exporteinstellungen“, und stellen Sie folgende Optionen ein:

Erleichtern das Ermitteln von Dateien für die Stapelverarbeitung.

Gibt eine Namenskonvention für verarbeitete Dateien wie z. B. Künstler, Datum, Musiktitel (%a/%d/%s/) an.

Gibt den Zielordner für die verarbeiteten Dateien an.

Speichert geänderte Dateien im Ordner der Quelldatei.

Ersetzt automatisch vorhandene Dateien mit demselben Namen.

Gibt das Dateiformat an. Im Bereich „Formateinstellungen“ unten werden die Modi für die Datenkomprimierung und
die Speicherung angezeigt. Um diese Einstellungen zu ändern, klicken Sie auf „Ändern“. (Siehe Audioformateinstellungen.)

Gibt die Abtastrate und Bittiefe an. Um diese Optionen anzupassen, klicken Sie auf „Ändern“. (Siehe Konvertieren
der Abtastrate einer Datei.)

Gibt die Abtastrate und Bittiefe nach dem Exportieren an. Wenn in Quelldateien verschiedene
Sampletypen vorhanden sind, klicken Sie auf das Popupmenü, um zu sehen, wie jede Datei konvertiert wird. (Über das Menü
werden keine Konvertierungsoptionen angewendet. Um diese anzupassen, klicken Sie auf „Ändern für Sampletyp“.)

Entfernt nach dem Exportieren die Dateinamen aus dem
Stapelprozessfenster.

Fügt Audiomarker und Informationen aus dem Metadaten-Bedienfeld in die
verarbeiteten Dateien ein. (Siehe Arbeiten mit Markern und Anzeigen und Bearbeiten von XMP-Metadaten.)

Auswählen von Audio

Effekt „Normalisieren“ (nur Wellenform-Editor)

Analysieren der Amplitude
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Automating common tasks (CS5.5)

To the top

To the top

Note:

Loudness

Perceived

Favorites
Match volume across multiple files
Batch process files

Favorites
Favorites are combinations of effects, fades, and amplitude adjustments that you can save and quickly reapply to any file or selection in the
Waveform Editor. The Favorites menu lists some defaults to get you started, plus any additional favorites you create.

To assign favorites to keyboard shortcuts, see Customize shortcuts.

Create a favorite from a combination of adjustments

1. In the Waveform Editor, choose Favorites > Start Recording Favorite.

2. Apply the effects, fades, and amplitude adjustments you want to save.

3. Choose Favorite > Stop Recording Favorite, and name the favorite.

Create a favorite from a specific effect

1. Adjust effect settings as desired.

2. In the upper right of the effect dialog box, click the Favorite icon . Then name the favorite.

Delete a favorite

1. Choose Favorites > Delete Favorite.

2. Select the favorite name, and click OK.

Match volume across multiple files
If you plan to present a group of audio files on CD, the web, or elsewhere, use the Match Volume panel to make them sound consistent.

To match multitrack clips without changing source files, see Match clip volume

1. In the Waveform Editor, choose Window > Match Volume.

2. Drag files from the Files panel to the Match Volume panel. Or click the Add Files button  in the panel to browse to files on
your system.

By default, Match Volume processes at most three files at a time for optimal performance. To process more files,
change the value for Maximum Number Of Concurrent File Processes in the Data preferences.

3. (Optional) To display amplitude statistics such as perceived and peak volume for each file, click the Compute icon . Then
click Settings to specify target values based on these statistics.

4. Click Match Volume to apply the necessary amplitude changes. Or click Batch Process to apply those changes and export to
the same file format and sample type. (See Batch process files.)

Understanding Match Volume statistics

Is the average amplitude value.

Is the average amplitude value adjusted for the human ear’s greater sensitivity to midrange frequencies.
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Match To

Total RMS

File
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Perceived Loudness

Peak Volume

Use Limiting

Lookahead Time

Note:

Release Time

Note:

To the top

Note:

Apply Favorite

Filename Prefix and Postfix

Location

Is the most common root-mean-square amplitude across the entire file. For example, if the majority of two files is -50 dBFS, the total
RMS values would reflect that, even if one file contains more loud passages.

RMS amplitude often better reflects perceived amplitude than the absolute Loudness average.

Is the maximum amplitude.

Is the percentage of the waveform that would be clipped as a result of normalization. Clipping won’t occur if limiting is used. However,
clipping should ideally be avoided prior to limiting. If any matched files show more than 0% clipping, click Undo, and match to a slightly lower
amplitude.

Adjust Match Volume settings

In the Match Volume panel, click Settings to adjust the following options:

Determines how amplitude is mathematically compared:

Matches an overall loudness you specify.

Matches the overall loudness of a selected file. Choose this option if one file reflects the target volume you want
to achieve.

Matches an average loudness you specify.

Matches the perceived loudness level, accounting for middle frequencies that the ear is most
sensitive to. This option works well unless frequency emphasis varies greatly in a file (for example, midrange
frequencies are pronounced in a short passage, but bass frequencies are elsewhere).

Matches a maximum amplitude you specify, normalizing the files. Because this option retains dynamic
range, it’s a good choice for files you plan to process further, or for highly dynamic audio like classical music.

Applies hard limiting to keep peaks from being clipped. (When you amplify audio, some samples may extend
beyond the clipping point.)

Specifies the number of milliseconds to attenuate audio before reaching the loudest peak.

If this value is too small, audible distortion might occur. Make sure that the value is at least 5 milliseconds.

Specifies the number of milliseconds for attenuation to rebound 12 dB (roughly the amount needed to
resume normal volume after an extremely loud peak is encountered).

A setting of 200 milliseconds works well to preserve low bass frequencies. If the setting is too high, audio may stay
below normal levels for a while.

Batch process files
Batch process groups of files to quickly apply favorite processing, resample, or save to a new format. Quickly automate common tasks like
exporting to mp3 format or applying identical effects to related files.

1. In the Waveform Editor, choose Window > Batch Process.

2. In the Batch Process panel, click the Add Files button  to browse to files on your system.

By default, batch processing is limited to three files at a time for optimal performance. To process more files, change
the value for Maximum Number Of Concurrent File Processes in the Data preferences.

3. Click Batch Process, and set the following options:

Applies a combination of effects, fades, and amplitude adjustments. (See Favorites.)

Help you identify batched files.

Specifies the destination folder for processed files.
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Same As Source File Location

Overwrite Existing Files

Format

Sample Type

Clear Batch Process Panel Upon Completion

Include Markers and Other Metadata

Saves modified files in the same folder as the file’s source file.

Automatically replaces existing files with the same name.

Specifies the file format. The Format Settings area below indicates data compression and storage modes; to adjust
these, click Change. (See Audio format settings.)

Indicates the sample rate and bit depth. To adjust these options, click Change. (See Convert the sample rate
of a file.)

Removes filenames from the source list after the files are converted
successfully.

Includes audio markers and information from the Metadata panel in processed files.
(See Working with markers and Viewing and editing XMP metadata.)

Selecting audio

Normalize effect (Waveform Editor only)

Analyze amplitude
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Working with markers

Note:

To the top

Add, select, and rename markers
Adjust, merge, convert, or delete markers
Save audio between markers to new files
Creating playlists

Markers (sometimes called cues) are locations that you define in a waveform. Markers make it easy to navigate within a waveform to make a
selection, perform edits, or play back audio.

In Adobe Audition, a marker can be either a point or a range. A point refers to a specific time position within a waveform (for instance, 1:08.566
from the start of the file). A range has both a start time and an end time (for example, all of the waveform from 1:08.566 to 3:07.379). You can
drag start and end markers for a range to different times.

In the timeline at the top of the Editor panel, markers have white handles you can select, drag, or right-click to access additional commands.

Examples of markers 
A. Marker point B. Marker range 

To preserve markers when you save a file, select Include Markers and Other Metadata.

Add, select, and rename markers
Though you can add markers directly in the Editor panel, you use the Markers panel (Windows > Markers) to define and select markers.

To hide or show information such as Duration and Type, choose Markers Display from the panel menu .

Add a marker

1. Do one of the following:

Play audio.

Place the current-time indicator  where you want a marker point to be.

Select the audio data you want to define as a marker range.

2. Either press the M key, or click the Add Marker button  in the Markers panel.

To automatically create markers where silence occurs, see Delete Silence and Mark Audio options.

Select markers

Click a marker in the Editor or Markers panel. Or double-click to move the current-time indicator  to that location and select
the area for range markers.

To select adjacent markers, click the first marker you want to select in the Markers panel, and then Shift-click the last.

To select nonadjacent markers, Ctrl-click (Windows) or Command-click (Mac OS) them in the Markers panel.

To move the current-time indicator to the nearest marker, choose Edit > Marker > Move CTI to Next or Previous.

Rename a marker

1. In the Markers panel, select the marker.

2. Click the marker name, and enter a new name.



To the top

To the top

Use Marker Names In Filename

Prefix

Postfix Starting #

Location

Format

Sample Type

Include Markers and Other Metadata

To the top

Adjust, merge, convert, or delete markers
After creating markers, you can fine-tune them to best address the needs of an audio project.

Reposition markers

In the Editor panel, drag marker handles to a new location.

In the Markers panel, select the marker, and enter new Start values for point markers, or Start, End, and Duration values for
range markers.

Merge individual markers

In the Markers panel, select the markers you want to merge, and click the Merge button .

The new merged marker inherits its name from the first marker. Merged point markers become range markers.

Convert a point marker to a range marker

Right-click the marker handle, and choose Convert to Range.

The marker handle splits into two handles.

Convert a range marker to a point marker

Right-click a marker handle, and choose Convert to Point.

The two parts of the range marker handle merge into a single handle, with the start time of the range becoming the time for the
point marker.

Delete markers

Select one or more markers, and click the Delete button  in the Markers panel.

Right-click the marker handle in the Editor panel, and choose Delete Marker.

Save audio between markers to new files

1. In the Waveform Editor, choose Window > Markers.

2. Select one or more marker ranges. (See Working with markers .)

3. Click the Export Audio button  in the Markers panel.

4. Set the following options:

Uses the marker name as the prefix for the filename.

Specifies a filename prefix for the new files.

Specifies the number to begin with when adding numbers to the filename prefix. Adobe Audition
automatically adds numbers after the prefix (for example, prefix02, prefix03) to distinguish saved files.

Specifies the destination folder for saved files. Click Browse to specify a different folder.

Specifies the file format. The Format Settings area below indicates and data compression and storage modes; to
adjust these, click Change. (See Audio format settings.)

Indicates the sample rate and bit depth. To adjust these options, click Change. (See Convert the sample rate
of a file.)

Includes audio markers and information from the Metadata panel in processed files.
(See Viewing and editing XMP metadata.)

Creating playlists
A playlist is an arrangement of marker ranges that you can play back in any order and loop a specified number of times. A playlist lets you try
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Note:

different versions of an arrangement before you commit to edits. You create playlists in the Playlist panel (Window > Playlist).

To store a playlist with a file, you must save in WAV format. (See Save audio files.)

Create a playlist

1. In the Playlist panel, click the Open Markers Panel button .

2. In the Markers panel, select marker ranges you want to add to the playlist. Then click the Insert Selected Range Markers Into
Playlist button , or drag the range markers to the Playlist panel.

Change the order of items in a playlist

Drag the item up or down.

Play items in a playlist

To play all or part of the list, select the first item you want to play. Then click the Play button  at the top of the panel.

To play a specific item, click the Play button to the left of the item name.

Loop an item in a playlist

Select an item, and enter a number in the Loops column. Each item can loop a different number of times.

Delete items from a playlist

Select the items, and click the Remove button .

Delete Silence and Mark Audio options

Batch process files
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Analysieren der Phase, Frequenz und Amplitude
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Analysieren der Phase
Analysieren des Frequenzbereichs
Analysieren der Amplitude

Adobe Audition bietet mehrere Möglichkeiten zum Analysieren von Audiodaten. Um Phasenverhältnisse zwischen zwei beliebigen Kanälen zu
vergleichen, verwenden Sie das Phasenmesser-Bedienfeld. Um den Ton- und Dynamikbereich zu analysieren, verwenden Sie die Bedienfelder
„Frequenzanalyse“ und „Amplitudenstatistik“.

Der Wellenform-Editor bietet außerdem eine Spektralfrequenzanzeige, die Sie in Verbindung mit den oben genannten Analysemethoden
verwenden können. (Siehe Anzeigen von Audio im Wellenform-Editor.)

Analysieren der Phase
Im Phasenmesser-Bedienfeld können Sie phasenverschobene Kanäle für Stereo- und Surroundwellenformen identifizieren und mit dem Befehl
„Effekte“ > „Umkehren“ korrigieren. (Siehe Invertieren einer Wellenform.) In diesem Bedienfeld können Sie auch hochgradig phasengleiche Kanäle
identifizieren, deren Klang sich kaum verändert, wenn Sie sie zu einem Mono-Kanal zusammenfassen. (Siehe Umwandeln einer Wellenform
zwischen Surround, Stereo und Mono.)

Nähere Informationen zur Audiophase finden Sie unter Interaktion von Klangwellen.

1. Wählen Sie „Fenster“ > „Phasenmesser“.
2. Klicken Sie mit der rechten Maustaste auf das Phasenmesser-Bedienfeld und wählen Sie Kanäle aus den Menüs „Kanal“ und

„Vergleichen mit“.
3. Wählen Sie ggf. im Editor einen Bereich aus und starten Sie die Wiedergabe.

Im Phasenmesser wird phasenverschobenes Audio weiter links und phasengleiches Audio weiter rechts angezeigt. –1,0 bedeutet völlige
Phasenannullierung, während 1,0 bedeutet, dass jeder Kanal identische Audioinhalte aufweist.

Um die Darstellung des Phasenmessers anzupassen, klicken Sie mit der rechten Maustaste auf die Anzeige und wählen Sie „Farbverlauf
anzeigen“ oder „LED-Messbalken anzeigen“.

Analysieren des Frequenzbereichs
Im Fenster „Frequenzanalyse“ können Sie problematische Frequenzbänder ermitteln und mit einem Filtereffekt korrigieren.

1. Wählen Sie „Fenster“ > „Frequenzanalyse“.
2. Klicken Sie im Editor auf einen Zeitpunkt, wählen Sie einen Bereich aus oder starten Sie die Wiedergabe.
3. Im Fenster „Frequenzanalyse“ wird die Frequenz auf der horizontalen Achse und die Amplitude auf der vertikalen Achse

angezeigt.
Wenn Sie einen Bereich ausgewählt haben, analysiert Adobe Audition nur den Mittelpunkt. Um die Gesamtfrequenz des
Bereichs zu analysieren, klicken Sie auf „Auswahl durchsuchen“.

Frequenzanalyse-Optionen
Skalierung Zeigt die Frequenzskala entweder logarithmisch (entsprechend der menschlichen Wahrnehmung) oder linear (mit mehr Details für
höhere Frequenzen) an.

Alle Diagrammdaten kopieren Kopiert einen Bericht über die Frequenzdaten im Textformat in die Zwischenablage.
Halten-Schaltflächen Ermöglichen die Erstellung von bis zu acht Frequenz-Stichproben, während eine Wellenform abgespielt wird. Der
Frequenzumriss wird in der Farbe der verwendeten Schaltfläche im Diagramm „eingefroren“ und über die anderen Frequenzumrisse gelegt. Sie
können einen Frequenzumriss entfernen, indem Sie erneut auf die entsprechende Halten-Schaltfläche klicken.
Anzeige Ändert die Graphenanzeige. Wählen Sie einen der folgenden Stile:

Linien  Zeigt die Amplitude für jede Frequenz mit einfachen Linien an. Standardmäßig ist der linke Kanal grün und der rechte blau.
Bereich  Zeigt ebenfalls Linien für die Amplitude an, füllt den Bereich unterhalb der Linien aber mit einer Farbe aus und glättet
Amplitudendifferenzen im selben Bereich.
Balken  Zeigt den Effekt der Analyseauflösung an, indem die Anzeige in rechteckige Segmente unterteilt wird. Je höher die FFT-Größe,
desto größer die Analyseauflösung und desto schmaler die Balken.

Oberer Kanal Legt fest, welcher Kanal einer Stereo- oder Surrounddatei im Diagramm über den anderen Kanälen angezeigt wird. Wenn Sie die
angezeigten Kanäle kombinieren möchten, wählen Sie „Durchschnitt“.
Durchsuchen oder Auswahl durchsuchen Durchsucht die gesamte Datei oder Auswahl und zeigt die durchschnittlichen Frequenzdaten im
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Diagramm an. (Standardmäßig zeigt das Diagramm die Daten des Mittelpunkts der Datei bzw. Auswahl an.)

Erweiterte Optionen
FFT-Größe Gibt die FFT-Größe (Fast Fourier Transform) an. Je höher die FFT-Größe, desto exakter werden die Frequenzdaten analysiert,
allerdings nimmt auch die Verarbeitungszeit zu.
Fenster Legt die FFT-Form (Fast Fourier Transform) fest. Die Optionen werden sortiert von engster nach breitester Einstellung angegeben. Bei
engeren Funktionen sind weniger Umgebungsfrequenzen enthalten, die Center-Frequenzen werden jedoch weniger präzise abgebildet. Bei
breiteren Funktionen sind mehr Umgebungsfrequenzen enthalten, die Center-Frequenzen werden jedoch präziser abgebildet. Die Optionen
„Hamming“ und „Blackman“ bieten hervorragende Gesamtergebnisse.
0 dB Referenz Bestimmt die Amplitude, mit der Audiodaten bei 0 dBFS angezeigt werden. Ein Wert von 0 zeigt z. B. Audiodaten mit 0 dBFS bei 0
dB an. Ein Wert von 30 zeigt Audiodaten mit 0 dBFS bei -30 dB an. Dieser Wert verschiebt lediglich den Graphen nach oben oder unten. Die
Amplitude der Audiodaten wird nicht geändert.

Passen Sie die 0 dB Referenz an, um diese Anzeige auf eine andere Dezibelreferenz (z. B. Schalldruckpegel) zu kalibrieren.

Wert bei [x] Hz Zeigt die exakte Amplitude für bestimmte Frequenzen, wenn Sie den Mauszeiger über das Diagramm bewegen.
Frequenz gesamt Gibt die durchschnittliche Frequenz für den Startpunkt eines ausgewählten Bereichs an.
Note gesamt Gibt die Keyboard-Position und die Abweichung von der Standardstimmung (A440) für den Startpunkt eines ausgewählten Bereichs
an. A2 +7 entspricht z. B. dem zweittiefsten A auf einem Keyboard, das 7 % höher als normal gestimmt ist.

Zoomen in Frequenzdiagrammen
Im Fenster „Frequenzanalyse“ können Sie die Graphen zoomen, um die Frequenzen detaillierter zu analysieren.

 Führen Sie einen der folgenden Schritte aus:

Um einen Graphen zu vergrößern, klicken Sie mit der rechten Maustaste auf das vertikale oder horizontale Lineal und ziehen
Sie das Lupensymbol.

Um in einem vergrößerten Graphen zu navigieren, klicken Sie mit der linken Maustaste auf das vertikale oder horizontale
Lineal und ziehen Sie das Handsymbol .

Um einen vergrößerten Graphen zu verkleinern, klicken Sie mit der rechten Maustaste auf das vertikale oder horizontale Lineal
und wählen Sie „Auszoomen“, um zur vorherigen Vergrößerung zu wechseln, oder „Voll verkleinern“, um vollständig
auszuzoomen.

Zoomen und Navigieren im Frequenzanalysegraphen

Analysieren der Amplitude
1. Wählen Sie im Wellenform-Editor „Fenster“ > „Amplitudenstatistik“.
2. Um die Statistik für eine gesamte Datei oder Auswahl zu berechnen, klicken Sie auf „Durchsuchen“ oder „Auswahl

durchsuchen“. (Standardmäßig wird die Statistik vom Mittelpunkt der Datei bzw. Auswahl berechnet.)
Sie können eine Auswahl im Editor anpassen. Klicken Sie erneut auf „Auswahl durchsuchen“, um die Statistik neu zu
berechnen.

3. Analysieren Sie die Amplitude mit folgenden Registerkarten:

Die Registerkarte „Allgemein“ enthält numerische Statistiken, die den Dynamikbereich angeben, abgeschnittene Samples
identifizieren und DC-Offsets melden.

Die Registerkarte „RMS-Histogramm“ zeigt einen Graphen für die relative Häufigkeit jeder Amplitude an. Das horizontale
Lineal misst die Amplitude in Dezibel, das vertikale Lineal misst die Häufigkeit entsprechend der RMS-Formel. Wählen Sie
den anzuzeigenden Kanal aus dem Menü „Kanal anzeigen“.

Mit der Registerkarte „RMS-Histogramm“ können Sie vorherrschende Amplituden identifizieren und diese
komprimieren, beschränken oder mit einem Amplitudeneffekt normalisieren.

Allgemeine Optionen



 

Klicken Sie rechts neben den Werten auf die Symbole, um zur entsprechenden Position in der Datei zu navigieren.

Spitzenamplitude Zeigt das Sample mit der höchsten Amplitude in Dezibel an.
Max. Messwert Zeigt das Sample mit der höchsten Amplitude an.
Min. Messwert Zeigt das Sample mit der geringsten Amplitude an.
Möglicherweise geclippte Samples Zeigt die Anzahl der Samples an, die wahrscheinlich 0 dBFS überschritten haben. Klicken Sie rechts neben
diesem Wert auf das Symbol , um zum ersten geclippten Sample in der Audiodatei zu navigieren. (Klicken Sie ggf. erneut auf das Symbol, um
nachfolgende geclippte Samples anzuzeigen.)
RMS-Amplitude insgesamt, Maximale, Minimale und Durchschnittliche RMS-Amplitude Zeigt die quadratischen Mittelwerte der Auswahl.
RMS-Werte basieren auf der Häufigkeit bestimmter Amplituden, wodurch die wahrgenommene Lautstärke meist besser abgebildet wird als durch
absolute oder durchschnittliche Amplituden.
DC-Offset Zeigt jeden direkten aktuellen Offset, der während der Aufzeichnung auf die Wellenform angewendet wird. Positive Werte liegen über
der Mittellinie, negative Werte darunter. (Siehe Korrigieren des DC-Offsets.)
Gemessene Bittiefe Gibt die Bittiefe der Wellenform an. (32 gibt an, dass die Wellenform den gesamten 32-Bit-Gleitkommabereich nutzt.)
Dynamikbereich Gibt den Unterschied zwischen maximaler und minimaler RMS-Amplitude an.
Verwendeter Dynamikbereich Zeigt den Dynamikbereich abzüglich ungewöhnlich langer Abschnitte mit niedriger RMS-Amplitude, z. B.
Pausen.
Lautstärke Zeigt die durchschnittliche Amplitude an.
Wahrgenommene Lautstärke Berücksichtigt die höhere Empfindlichkeit des menschlichen Gehörs für mittlere Frequenzen.
Kopieren Kopiert alle Statistiken in der Registerkarte „Allgemein“ in die Zwischenablage.

RMS-Einstellungen
Sie können die Berechnung der RMS-Statistiken mit folgenden Optionen anpassen:

0 dB = FS-Sinuswelle Gleicht den dB-Pegel an eine volle Sinuswelle an, bei der die Spitzenamplitude etwa 3,01 dB leiser als eine volle
Rechteckwelle ist.
0 dB = FS-Rechteckwelle Gleicht den dB-Pegel an eine volle Rechteckwelle an, bei der die Spitzenamplitude etwa 3,01 dB lauter als eine volle
Sinuswelle ist.
DC berücksichtigen Ignoriert etwaigen DC-Offset in den Messungen.
Fensterbreite Gibt die Anzahl der Millisekunden in jedem RMS-Fenster an. Ein ausgewählter Bereich enthält eine Folge solcher Fenster, die
Adobe Audition zur Berechnung des kleinsten und des größten RMS-Werts heranzieht. Um möglichst genaue RMS-Werte zu ermitteln, sollten Sie
für Audiodaten mit großem Dynamikbereich eine große Fensterbreite und für Audiodaten mit kleinem Dynamikbereich eine kleine Fensterbreite
verwenden.

  |  
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Anhören einer Datei mit einer anderen Abtastrate
Ändern der Abtastrate einer Datei
Umwandeln einer Wellenform zwischen Surround, Stereo und Mono
Ändern der Bittiefe einer Datei
Verwenden von Vorgaben für die Abtastratenkonvertierung

Anhören einer Datei mit einer anderen Abtastrate
Mit dem Befehl „Abtastrate interpretieren“ können Sie überprüfen, wie eine Audiodatei bei einer anderen Abtastrate klingt. (Siehe Abtastrate –
Grundlagen.) Mit diesem Befehl können Sie Dateien identifizieren, bei denen im Header eine fehlerhafte Abtastrate angegeben wird. Um die
Abtastrate anschließend dauerhaft umzuwandeln, wählen Sie „Bearbeiten“ > „Sample-Typ umwandeln“.

1. Wählen Sie im Wellenform-Editor „Bearbeiten“ > „Abtastrate interpretieren“.
2. Geben Sie eine Abtastrate in das Textfeld ein oder wählen Sie eine der Standardabtastraten in der Liste.

Hinweis: Sie können in Adobe Audition mit beliebigen Abtastraten von 6000 bis 192.000 Hz arbeiten. Unter Umständen kann Ihre Soundkarte
jedoch nur bestimmte Raten korrekt wiedergeben. Die unterstützten Abtastraten finden Sie in der Dokumentation zur Soundkarte.

Ändern der Abtastrate einer Datei
Die Abtastrate einer Datei bestimmt den Frequenzbereich einer Wellenform. Beachten Sie beim Umwandeln der Abtastrate, dass die meisten
Soundkarten nur bestimmte Abtastraten unterstützen.

1. Wählen Sie im Wellenform-Editor „Bearbeiten“ > „Sample-Typ umwandeln“.
Um das Dialogfeld „Sample-Typ umwandeln“ schnell aufzurufen, doppelklicken Sie in der Statusleiste auf den Bereich
„Sample-Typ“. (Siehe Anzeigen der Statusleiste.)

2. Wählen Sie eine Abtastrate aus der Liste oder geben Sie eine benutzerdefinierte Abtastrate in das Textfeld ein.
3. Ziehen Sie im Bereich „Erweitert“ den Schieberegler „Qualität“, um die Qualität der Umwandlung anzupassen.

Bei höheren Werten bleiben mehr hohe Frequenzen erhalten, allerdings dauert die Verarbeitung länger. Niedrigere Werte
erfordern weniger Verarbeitungszeit, verringern aber den Anteil hoher Frequenzen.

Nutzen Sie höhere Qualitätswerte für das Downsampling hoher in niedrigere Abtastraten. Beim Upsampling wirken sich
höhere Werte kaum aus.

4. Wählen Sie für optimale Ergebnisse die Option „Pre/Post-Filter“, um Störungen durch Signalverkennungen zu verhindern.

Umwandeln einer Wellenform zwischen Surround, Stereo und Mono
Der Befehl „Sample-Typ umwandeln“ bietet die schnellste Methode, die Anzahl der Kanäle einer Wellenform umzuwandeln.

1. Wählen Sie im Wellenform-Editor „Bearbeiten“ > „Sample-Typ umwandeln“.
2. Wählen Sie aus dem Menü „Kanäle“ die Option „Mono“, „Stereo“ oder „5.1“.
3. Geben Sie im Bereich „Erweitert“ Prozentwerte für „Mischung links“ und „Mischung rechts“ an:

Wenn Sie von Mono nach Stereo konvertieren, können Sie in den Feldern „Links mischen“ und „Rechts mischen“ die
relative Amplitude angeben, mit der das Monosignal in die beiden Kanäle des neuen Stereosignals eingefügt werden soll.
Sie können die Monoquelle beispielsweise nur in den linken oder nur in den rechten Kanal bzw. an jedem Punkt
dazwischen einfügen.

Wenn Sie von Stereo nach Mono konvertieren, können Sie in den Feldern „Links mischen“ und „Rechts mischen“
angeben, welcher Anteil des jeweiligen Kanals Eingang in die anschließende Monowellenform finden soll. Bei der
gängigsten Mischmethode werden jeweils 50 % der beiden Kanäle verwendet.

Informationen über andere Methoden zur Kanalkonvertierung erhalten Sie in folgenden Themen:

Extrahieren von Audiokanälen in Monodateien

Mix audio data when pasting

Der Effekt „Kanalmischer“

http://helpx.adobe.com/en/audition/using/saving-exporting-files.html#extract_audio_channels_to_mono_files
http://helpx.adobe.com/en/audition/using/copying-cutting-pasting-deleting-audio.html#mix_audio_data_when_pasting
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Die Bittiefe einer Datei bestimmt die Dynamik eines Audiosignals. (Siehe Bittiefe – Grundlagen.) Adobe Audition unterstützt bis zu 32 Bit. Sie
können die Bittiefe einer Datei erhöhen, um die Dynamik zu verbessern. Bei geringerer Bittiefe sind dagegen die Dateien kleiner.

Hinweis: Einige Anwendungen und Media Player benötigen Bittiefen von 16 Bit oder niedriger.
1. Wählen Sie im Wellenform-Editor „Bearbeiten“ > „Sample-Typ umwandeln“.
2. Wählen Sie im Menü „Bittiefe“ einen Wert aus oder geben Sie eine benutzerdefinierte Bittiefe in das Textfeld ein.
3. Geben Sie im Bereich „Erweitert“ folgende Optionen an:

Dithering Aktiviert bzw. deaktiviert das Dithering beim Umwandeln in niedrigere Bittiefen. Wenn Dithering deaktiviert ist, wird
die Bittiefe abrupt abgeschnitten, so dass in leisen Passagen ein durch Quantisierungsverzerrung verursachtes Knistern
entsteht.

Obwohl durch das Dithering in geringem Umfang Rauschen entsteht, ist das Resultat doch weit besser als alles, was
andernfalls bei niedrigen Signalpegeln an Störungen hörbar ist. Durch das Dithering werden Töne hörbar, die durch das
Rauschen und die Störungen in Audiodaten mit geringer Bittiefe überlagert würden.

Dither-Typ Steuert die Verteilung der Dithering-Störgeräusche im Verhältnis zu den ursprünglichen Amplitudenwerten. In der
Regel bietet die Option „Dreieckig“ den besten Kompromiss zwischen Rauschabstand, Verzerrung und Rauschmodulation.

Dither-Typ Reduktion des Rauschabstands Rauschmodulation

Dreieckig 4.8 dB Nein

Gaußsche 6.0 dB Vernachlässigbar

Hinweis: „Dreieckig (Geformt)“ und „Gauß-Kurve (Geformt)“ verschieben etwas mehr Rauschen in die höheren Frequenzen.
Stellen Sie zur präzisen Steuerung die Optionen unter „Rauschformung“ ein.

Rauschformung Legt fest, welche Frequenzen Dithering-Störgeräusche enthalten. Wenn Sie Rauschformung einsetzen,
können Sie möglicherweise geringere Dither-Tiefen verwenden, ohne dass es zu hörbaren Artefakten kommt. Die optimale
Formung hängt von der Audioquelle, der endgültigen Abtastrate und der Bittiefe ab.
Hinweis: Bei Abtastraten unter 32 kHz ist die Rauschformung deaktiviert, da sämtliches Rauschen in den hörbaren
Frequenzen verbleiben würde.

Hochpass  Wenn Sie für „Übergang“ den Wert 7,3 kHz einstellen, werden die Dithering-Störgeräusche auf –180 dB
bei 0 Hz und auf –162 dB bei 100 Hz abgesenkt.

Leichte Steigung  Wenn Sie für „Übergang“ den Wert 11 kHz einstellen, werden die Störgeräusche auf –3 dB bei
0 Hz und auf –10 dB bei 5 kHz abgesenkt.

Neutral Mit der Option „Leicht“ bleibt das Rauschen flach bis 14 kHz, steigt bis zum Maximum bei 17 kHz an und
bleibt anschließend wieder flach bei höheren Frequenzen. Das Hintergrundrauschen klingt genauso wie ohne
Rauschformung, ist aber etwa 11 dB leiser.

Die Option „Stark“ bleibt flach bis 15,5 kHz und verschiebt alle Dithering-Störgeräusche in den Bereich oberhalb von
16 kHz (bzw. über den Wert, den Sie unter „Übergang“ festgelegt haben). Wenn der Übergang zu niedrig eingestellt
ist, hören Menschen mit empfindlichem Gehör möglicherweise ein hohes Klingeln. Wenn Sie Audio mit 48 oder 96 kHz
konvertieren, können Sie den Übergang allerdings weit über 20 kHz festlegen.

Wählen Sie eine neutrale Formung, um zu verhindern, dass im Hintergrundrauschen Klangfarben entstehen. Das
Hintergrundrauschen ist bei dieser Rauschformung allerdings lauter als bei anderen Formen.

U-förmig  Die Option „Flach“ bleibt von 2 kHz bis 14 kHz weitgehend flach, wird aber im Bereich von 0 Hz lauter, da
tiefe Frequenzen deutlich schlechter hörbar sind. Die Option „Mittel“ führt zu etwas mehr Rauschen in den Höhen über
9 kHz, damit das Rauschen unterhalb dieser Frequenz reduziert werden kann. Die Option „Tief“ erhöht das Rauschen
über 9 kHz noch stärker, senkt es dafür aber im Bereich zwischen 2 und 6 kHz auch stärker ab.

Gewichtet  Die Option „Leicht“ versucht der menschlichen Wahrnehmung leiser Töne gerecht zu werden, indem das
Rauschen vor allem im Bereich von 2 bis 6 kHz reduziert und im Bereich von 10 bis 14 kHz angehoben wird. Bei
hohen Lautstärken ist das Rauschen möglicherweise deutlicher hörbar. Die Option „Stark“ reduziert den
empfindlichsten Bereich zwischen 2 und 6 kHz gleichmäßiger, führt aber zu stärkerem Rauschen oberhalb von
8 kHz.

Übergang Legt die Frequenz fest, ab der die Rauschformung einsetzt.

Stärke Gibt die maximale Amplitude des Rauschens an, die einer Frequenz hinzugefügt wird.

Adaptiver Modus Variiert die Rauschverteilung über die Frequenzen.
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Möchten Sie eine bestimmte Umwandlung für mehrere Dateien durchführen, können Sie Zeit sparen, indem Sie eine Vorgabe für die
Abtastratenkonvertierung verwenden.

1. Wählen Sie „Bearbeiten“ > „Sample-Typ umwandeln“.
2. Passen Sie die Einstellungen nach Bedarf an.

3. Klicken Sie auf die Schaltfläche „Neue Vorgabe“ .

Nachdem Sie eine Vorgabe erstellt haben, wird sie oben im Dialogfeld in der Liste der Vorgaben angezeigt. Wenn Sie eine
Vorgabe löschen möchten, wählen Sie sie aus der Liste aus und klicken Sie auf die Schaltfläche „Löschen“ .
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Invertieren einer Wellenform
Umkehren einer Wellenform
Erstellen von Pausen

Invertieren einer Wellenform
Mit dem Effekt „Invertieren“ wird die Audiophase um 180 Grad umgekehrt. (Nähere Informationen zu Phasenwinkeln finden Sie unter Wellenform-
Messungen.)

Durch das Invertieren ergibt sich für eine einzelne Wellenform keine hörbare Änderung; der Unterschied wird erst dann hörbar, wenn Sie
Wellenformen kombinieren. Sie können zum Beispiel eingefügte Audiodaten invertieren, um sie besser an vorhandene Audiodaten anpassen zu
können. Sie können auch einen Kanal einer Stereodatei invertieren, um eine phasenverschobene Aufnahme zu korrigieren.

1. Möchten Sie einen Teil einer Wellenform invertieren, wählen Sie den gewünschten Bereich. Um die gesamte Wellenform zu
invertieren, müssen Sie die Auswahl aller Audiodaten aufheben.

2. Wählen Sie „Effekte“ > „Invertieren“.

Umkehren einer Wellenform
Durch den Effekt „Rückwärts“ wird die Wellenform von rechts nach links wiedergegeben, also rückwärts. Mit dieser Operation lassen sich sehr
spezielle Effekte erzielen.

1. Möchten Sie einen Teil der Wellenform rückwärts wiedergeben, wählen Sie den gewünschten Bereich. Um die gesamte
Wellenform umzukehren, müssen Sie die Auswahl aller Audiodaten aufheben.

2. Wählen Sie „Effekte“ > „Rückwärts“.

Erstellen von Pausen
Das Erstellen einer Pause ist hilfreich, um Pausen einzufügen und unerwünschte Störgeräusche aus einer Audiodatei zu entfernen. In Adobe
Audition gibt es mehrere Möglichkeiten, Pausen zu erzeugen:

Um vorhandene Audiodaten im Wellenform-Editor stummzuschalten, markieren Sie den gewünschten Bereich und wählen Sie
„Effekte“ > „Pause“. Im Gegensatz zum Löschen oder Ausschneiden, wodurch das umgebende Audio zusammengefügt wird,
bleibt beim Stummschalten die Dauer der Auswahl erhalten.

Um Pausen im Wellenform- oder Multitrack-Editor einzufügen, positionieren Sie entweder die Marke für die aktuelle Zeit 
oder wählen Sie vorhandene Audiodaten aus. Wählen Sie anschließend „Bearbeiten“ > „Einfügen“ > „Pause“ und geben Sie
die Dauer in Sekunden ein. Sämtliche Audiodaten rechts von der Marke für die aktuelle Zeit werden in der Zeit verschoben, so
dass sich die Dauer insgesamt erhöht. Multitrack-Clips werden ggf. geteilt.

Verwandte Hilfethemen
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Auswählen von Zeitbereichen
Auswählen von Spektralbereichen
Auswählen und automatisches Reparieren von Artefakten
Auswählen der gesamten Wellenform
Angeben der zu bearbeitenden Kanäle
Ausrichten einer Auswahl an Nullübergangspunkten
Einrasten bei Markern, Linealen, Frames und Nullübergängen

Auswählen von Zeitbereichen

1. Wählen Sie in der Symbolleiste das Zeitauswahlwerkzeug .
2. Führen Sie einen der folgenden Schritte aus:

Ziehen Sie im Editor, um einen Bereich auszuwählen.

Auswahl von Zeitbereichen durch Ziehen

Ziehen Sie die Ränder der Auswahl, um sie zu erweitern oder zu kürzen. (Klicken Sie bei gedrückter Umschalttaste
jenseits der Ränder, um eine Auswahl schnell bis zu einer bestimmten Position zu erweitern.)

Hinweis: Alternativ können Sie zum Erweitern und Kürzen auch mit der rechten Maustaste klicken. Um diese Funktion zu
aktivieren, wählen Sie im Dialogfeld „Voreinstellungen“ im Abschnitt „Allgemein“ die Option „Auswahl erweitern“.

Auswählen von Spektralbereichen
Wenn Sie in einer Spektralanzeige arbeiten, können Sie mit dem Marquee-, Lasso- oder Pinsel-Auswahlwerkzeug Audiodaten innerhalb
bestimmter Spektralbereiche auswählen. Mit dem Marquee-Auswahlwerkzeug können Sie einen rechteckigen Bereich auswählen. Mit dem Lasso-
und Pinsel-Auswahlwerkzeug können Sie freie Auswahlen vornehmen. Alle drei Werkzeuge ermöglichen detaillierte Bearbeitungs- und
Verarbeitungsvorgänge und bieten eine unglaubliche Flexibilität beim Wiederherstellen von Audiodaten. Wenn Sie beispielsweise einen
akustischen Artefakt entdecken, können Sie die Auswahl auf die betroffenen Frequenzen beschränken und diese dann bearbeiten. Auf diese
Weise erzielen Sie bessere Ergebnisse bei einer schnelleren Verarbeitung.

Das Pinsel-Auswahlwerkzeug bietet spezielle Auswahlmöglichkeiten, die die Intensität der angewendeten Effekte festlegen. Zum Anpassen der
Intensität überlagern Sie Pinselstriche oder ändern die Einstellung „Deckkraft“ in der Symbolleiste. Je höher die Deckkraft im weißen,
ausgewählten Bereich ist, desto intensiver sind die angewendeten Effekte.
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Arten der Spektralauswahl
A.  Marquee B.  Lasso C.  Pinsel

1. Klicken Sie in der Symbolleiste auf das Marquee- , Lasso-  oder Pinsel-Auswahlwerkzeug .
2. Ziehen Sie im Editor in der Spektralanzeige mit der Maus, um die gewünschten Audiodaten auszuwählen.

Hinweis: Wenn Sie eine Auswahl in einer Stereowellenform erstellen, gilt die Auswahl standardmäßig für alle Kanäle. Um
Audiodaten in bestimmten Kanälen auszuwählen, wählen Sie die gewünschten Kanäle im Menü „Bearbeiten“ > „Kanäle
aktivieren“ aus.

3. Gehen Sie zum Anpassen der Auswahl wie folgt vor:

Um die Auswahl zu verschieben, positionieren Sie den Mauszeiger auf die Auswahl und ziehen ihn an die gewünschte
Position.

Um die Größe der Auswahl zu ändern, positionieren Sie den Mauszeiger auf eine Ecke oder Kante der Auswahl und
ziehen die Auswahl auf die gewünschte Größe. (Bei Paintbrush-Auswahlen können Sie auch die Einstellung „Größe“ in der
Symbolleiste ändern.)

Um eine Lasso- oder Paintbrush-Auswahl hinzuzufügen, drücken Sie die Umschalttaste und ziehen sie. Um die Auswahl
zu verkleinern, drücken Sie die ALT-Taste und ziehen sie.

Um die Intensität des Effekts festzulegen, der auf die Paintbrush-Auswahlen angewendet wird, ändern Sie die Einstellung
„Deckkraft“ in der Symbolleiste.

Standardmäßig werden in Adobe Audition nur die Audiodaten in der Spektralauswahl wiedergegeben. Um das gesamte Audio im selben
Zeitbereich zu hören, klicken Sie mit der rechten Maustaste auf die Wiedergabeschaltfläche  und deaktivieren Sie die Option „Nur
Spektralauswahl wiedergeben“.

Auswählen und automatisches Reparieren von Artefakten
Verwenden Sie den Bereichsreparatur-Pinsel für die schnelle Reparatur kleiner, vereinzelter akustischer Artefakte (z. B. vereinzelt auftretende
Klick- oder Knackgeräusche). Wenn Sie Audiodaten mit diesem Werkzeug auswählen, wird automatisch der Befehl „Favoriten“ > „Autom.
Korrektur“ angewendet.

Hinweis: Die automatische Korrektur ist für kleine Audio-Artefakte optimiert und daher auf Auswahlen von maximal vier Sekunden begrenzt.

1. Klicken Sie in der Symbolleiste auf das Bereichsreparatur-Pinsel-Werkzeug .
2. Um den Pixeldurchmesser zu ändern, passen Sie die Einstellung unter „Größe“ an. Alternativ können Sie die eckigen

Klammern auf der Tastatur drücken.
3. Halten Sie im Editor die Maustaste auf einem Audio-Artefakt in der Spektralanzeige gedrückt oder ziehen Sie mit der Maus

darüber.
Hinweis: Wenn Sie klicken, ohne die Maustaste gedrückt zu halten, verschiebt Audition die Marke für die aktuelle Zeit, damit
Sie eine Audiovorschau abspielen können, führt aber keine Reparatur durch. Wenn Sie Audio durch Klicken reparieren
möchten, aktivieren Sie in den Voreinstellungen unter „Allgemein“ die Option „Beim Drücken der Maustaste runde Auswahl
erstellen“.
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Sofortiges Entfernen eines Artefakts mit dem Bereichsreparatur-Pinsel
A.  Vor B.  Nach

Auswählen der gesamten Wellenform
 Führen Sie eine der folgenden Operationen aus:

Um den sichtbaren Bereich einer Wellenform auszuwählen, doppelklicken Sie im Editor.

Um die gesamte Wellenform auszuwählen, klicken Sie dreimal im Editor.

Angeben der zu bearbeitenden Kanäle
Standardmäßig gelten in Adobe Audition Auswahl- und Bearbeitungsoperationen in Stereo- oder Surround-Wellenformen für alle Kanäle. Sie
können jedoch problemlos bestimmte Kanäle auswählen und bearbeiten.

 Klicken Sie rechts im Editor im Amplitudenlineal auf die Kanalschaltflächen. Klicken Sie z. B. in einer Stereo-Datei auf die Schaltfläche für den
linken  oder den rechten  Kanal.

Wenn Sie einen Stereokanal einfach durch Ziehen am oberen oder unteren Rand des Editors auswählen möchten, aktivieren Sie im Dialogfeld
„Voreinstellungen“ im Bereich „Allgemein“ die Option „Kontextsensitive Kanalbearbeitung erlauben“.

Auswählen bestimmter Kanäle einer 5.1-Surround-Datei

Ausrichten einer Auswahl an Nullübergangspunkten
Bei vielen Bearbeitungsaufgaben, z. B. beim Löschen oder Einfügen von Audio, sind Nullübergänge (Punkte, an denen die Amplitude den Wert
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Null hat) am besten für die Definition von Auswahlen geeignet. Wenn Auswahlen an Nullübergängen beginnen und enden, wird die Gefahr von
hörbaren Knack- und Klickgeräuschen nach Bearbeitungsvorgängen reduziert.

 Um eine Auswahl an den nächsten Nullübergängen auszurichten, wählen Sie „Bearbeiten“ > „Nullübergänge“. Wählen Sie anschließend eine
Option aus dem Untermenü, z. B. „Auswahl nach innen“ (wodurch beide Kanten nach innen zum nächsten Nullübergang verschoben werden).

Alle Bearbeitungen werden überblendet, damit Knack- und Klickgeräusche weiter reduziert werden. Sie können die Dauer der Überblendungen
im Dialogfeld „Voreinstellungen“ im Bereich „Daten“ ändern.

Einrasten bei Markern, Linealen, Frames und Nullübergängen
Die Funktion „Einrasten“ stellt sicher, dass die Auswahlgrenzen und die aktuelle Zeitanzeige an Elementen wie Markern, Linealmarkierungen,
Nullübergangspunkten und Frames ausgerichtet werden. Mit der Funktion „Einrasten“ ist eine exakte Auswahl gewährleistet. Sie können die
Funktion aber jederzeit deaktivieren.

1. Um das Einrasten für ausgewählte Elemente zu aktivieren, klicken Sie oben im Editor auf das Symbol „Einrasten ein/aus“ .
2. Um die Elemente anzugeben, an denen eingerastet werden soll, wählen Sie „Bearbeiten“ > „Einrasten“ und anschließend eine

der folgenden Optionen:
Einrasten bei Markern Rastet an einem Markerpunkt ein. Weitere Informationen zum Definieren von Markern finden Sie
unter Arbeiten mit Markern.

Einrasten bei Lineal (Grob) Rastet nur bei den größeren numerischen Einteilungen in der Zeitleiste ein (z. B. Minuten und
Sekunden).
Hinweis: Sie können jeweils nur einen „Einrasten bei Lineal“-Befehl aktivieren.

Einrasten bei Lineal (Fein) Rastet an Unterteilungen in der Zeitleiste ein (z. B. Millisekunden). Vergrößern Sie die Zeitleiste
(indem Sie bei gedrückter rechter Maustaste in der Zeitleiste ziehen), um feinere Unterteilungen anzuzeigen und den Cursor
präziser zu platzieren.

Einrasten bei Nullübergängen Rastet in der Nähe der Stelle ein, an der die Audiodaten die Mittellinie schneiden (Nullpunkt
der Amplitude).

Einrasten bei Frames Rastet an einer Frame-Grenze ein, wenn das Zeitformat in Frames gemessen wird (z. B. Compact
Disc und SMPTE).

Sie können auch auf die „Einrasten“-Befehle zugreifen, indem Sie mit der rechten Maustaste auf die Zeitleiste klicken.

Verwandte Hilfethemen
Die Spektralanzeige

Anpassen der Spektralanzeige

Einrasten an Clip-Endpunkten
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Rückgängigmachen oder Wiederherstellen von Änderungen
Vergleichen von Protokollstatuszuständen

Rückgängigmachen oder Wiederherstellen von Änderungen
Adobe Audition verfolgt die Änderungen, die Sie vornehmen. Änderungen werden erst permanent, wenn Sie eine Datei speichern und schließen.
Bis dahin können Sie die Änderungen beliebig oft rückgängig machen oder wiederherstellen.

 Wählen Sie eine der folgenden Möglichkeiten, um Änderungen rückgängig zu machen oder wiederherzustellen:

Wählen Sie zum Rückgängigmachen einer Änderung „Bearbeiten“ > „Rückgängig: [Änderungsname]“.

Um eine Änderung wiederherzustellen, wählen Sie „Bearbeiten“ > „Wiederholen: [Änderungsname]“.

Um den letzten Befehl im Wellenform-Editor zu wiederholen, wählen Sie „Bearbeiten“ > „Letzten Befehl wiederholen“. Die
meisten Befehle können wiederholt werden, es gibt jedoch einige Ausnahmen (z. B. Löschen).

Um den letzten Befehl zu wiederholen, ohne das zugehörige Dialogfeld zu öffnen, drücken Sie Strg+R (Windows) oder
Befehlstaste+R (Mac OS).

Vergleichen von Protokollstatuszuständen
Während die Befehle „Rückgängig“ und „Wiederholen“ Sie auf inkrementelle Änderungsfolgen einschränken, können Sie im Protokollfenster eine
beliebige Änderung wiederherstellen. Verwenden Sie diesen Bereich, um verarbeitete und ursprüngliche Audiodaten schnell zu vergleichen oder
eine Reihe von Änderungen, die unerwünschte Ergebnisse erzielten, zu verwerfen.

Hinweis: Beim Schließen einer Datei wird der Protokollstatus gelöscht.

Wiederherstellen eines Status

Klicken Sie auf einen Protokollstatus, um ihn wiederherzustellen.

Um inkrementell durch die Statuszustände zu navigieren, drücken Sie die Nach-oben- bzw. Nach-unten-Taste auf der
Tastatur.

Löschen von Status
Löschen Sie beim Arbeiten mit sehr großen Audiodateien nicht benötigte Protokollstatuszustände, um Festplattenspeicher freizugeben und die
Leistung zu verbessern.

Um alle Statuszustände zu löschen, wählen Sie im Bedienfeldmenü die Option „Protokoll löschen“ .

Um einen bestimmten Statuszustand zu löschen, wählen Sie ihn aus und klicken Sie dann auf das Papierkorbsymbol .

Hinweis: Durch das Löschen der Protokollstatuszustände werden auch zugehörige „Rückgängig“-Befehle entfernt.
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Überblenden und Ändern der Amplitude
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Visuelles Ein- oder Ausblenden
Visuelles Erhöhen oder Verringern der Amplitude
Fixieren oder Ausblenden der visuellen Amplitudensteuerung

Sie können zwar auch Effekte verwenden, um die Amplitude zu ändern oder Überblendungen zu erzeugen, mit visuellen Überblendungs- und
Verstärkungssteuerungen kann diese Aufgabe jedoch schnell und intuitiv ausgeführt werden. Wenn Sie diese Steuerungen im Editor ziehen,
können Sie Audiodaten anhand einer Vorschau präzise anpassen.

Visuelle Steuerungen im Editor
A.  Überblendungssteuerungen B.  Verstärkungssteuerungen (HUD)

Um ausgewähltes Audio schnell ein- oder auszublenden, wählen Sie „Favoriten“ > „Einblenden“ oder „Ausblenden“.

Visuelles Ein- oder Ausblenden
Adobe Audition bietet drei Arten von visuellen Überblendungen:

Lineare Überblendungen erzeugen eine gleichmäßige Lautstärkeänderung, die sich für viel Material eignet. Falls sich diese
Überblendung zu abrupt anhört, versuchen Sie eine der anderen Optionen.

Logarithmische Überblendungen ändern die Lautstärke langsam und dann schnell oder umgekehrt.

Kosinus-Überblendungen sind wie eine S-Kurve geformt und ändern die Lautstärke zunächst langsam, dann schnell für den
Großteil der Überblendung und am Ende erneut langsam.

Hinweis: Im Wellenform-Editor werden die Audiodaten durch Überblendungen dauerhaft geändert. Informationen zum Anwenden von
Überblendungen, die Sie nachträglich im Multitrack-Editor anpassen können, finden Sie unter Überblenden von Multitrack-Clips.

Überblendungsarten
A.  Linear B.  Logarithmisch C.  Kosinus

 Ziehen Sie links oder rechts oben in der Wellenform den Ziehpunkt „Einblenden“  oder „Ausblenden“  nach innen und führen Sie einen der
folgenden Schritte aus:

Ziehen Sie den Ziehpunkt für eine lineare Überblendung horizontal.

Ziehen Sie den Ziehpunkt für eine logarithmische Überblendung nach oben oder unten.

Für eine Überblendung vom Typ „Kosinus (S-Kurve)“ halten Sie die Strg-Taste (Windows) bzw. die Befehlstaste (Mac OS)
gedrückt.

Wenn Sie standardmäßig Kosinus-Überblendungen erstellen und lineare oder logarithmische Überblendungen mit den oben genannten Tasten
erstellen möchten, ändern Sie in den allgemeinen Voreinstellungen die Einstellung unter „Standard-Fade-Kurventyp“.
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Visuelles Erhöhen oder Verringern der Amplitude
1. Wählen Sie im Editor einen bestimmten Audiobereich aus. Wenn Sie die gesamte Datei anpassen möchten, wählen Sie nichts

aus.
2. Ziehen Sie in der Verstärkungssteuerung, die abgedockt über dem Editor angezeigt wird, den Regler oder die Zahlen.

Die Zahlen stellen einen Vergleich zwischen der neuen Amplitude und der vorhandenen Amplitude dar. Wenn Sie die
Maustaste loslassen, wird der Wert wieder auf 0 dB zurückgesetzt, sodass Sie weitere Anpassungen vornehmen können.

Ändern der Lautstärke eines ausgewählten Bereichs

Fixieren oder Ausblenden der visuellen Amplitudensteuerung
Standardmäßig wird die visuelle Amplitudensteuerung in einem HUD angezeigt, das abgedockt über allen Wellenformen liegt. Falls Sie das HUD
als störend empfinden, führen Sie einen der folgenden Schritte aus:

Um das HUD an einer Position zu fixieren, klicken Sie auf die Schaltfläche „Fixieren“ .

Wenn Sie das HUD nur über markierten Auswahlen einblenden möchten, aktivieren Sie in den allgemeinen Voreinstellungen
die Option „HUD nur für Bereichsauswahl anzeigen“.

Um das HUD vollständig auszublenden, deaktivieren Sie im Menü „Ansicht“ die Option „HUD anzeigen“.

Verwandte Hilfethemen

  |  
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Anwenden von Effekten

Ein Teil des auf dieser Seite verlinkten Inhalts ist möglicherweise nur in englischer Sprache verfügbar.



Effects controls

To the top

Note:

Effects Rack overview
Use effect presets
Control effect settings with graphs
About spline curves for graphs

Effects Rack overview
The Effects Rack lets you insert, edit, and reorder up to 16 effects, optimize mix levels, and store favorite presets. Most rack controls appear in
both the Waveform and Multitrack editors.

Controls shared by the Waveform and Multitrack editors 
A. Rack Preset controls B. Effect slots C. Level controls D. Main Power button 

Controls unique to the Waveform Editor
In the Waveform Editor, the Effects Rack provides a Process menu that that lets you modify a selection or the entire file, and an Apply button that
permanently applies effects.

Controls unique to the Waveform Editor 
A. Apply button permanently applies effects B. Process menu lets you modify selection or entire file 

Controls unique to the Multitrack Editor
The Effects Rack provides Pre-render Track and FX Pre/Post-Fader buttons that you use to optimize and route effects. Each clip and track has its
own Effects Rack, which is saved with the session.

Buses and the Master track lack a Pre-render option because processing effects from all source tracks would reduce performance.

Controls unique to the Multitrack Editor 
A. FX Pre/Post-Fader B. Pre-render 

Set input, output, and mix levels in racks
To optimize volume, adjust Input and Output levels so their meters peak without clipping.
To change the percentage of processed audio, drag the Mix slider. 100% (Wet) equals fully processed audio; 0% (Dry) equals
original, unprocessed audio.

Insert, bypass, reorder, or remove effects in racks
In the Effects Rack, you manage groups of effects by using individual effect slots.

In the Multitrack Editor, the fx section of the Editor panel or Mixer provides quick access to slots in the Effects Rack.
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Reordering and inserting effects in racks: 
A. Reorder by dragging B. Insert with the slot menu 

To insert an effect, choose it from a slot’s pop-up menu. Then adjust effect settings as desired.

To later reaccess effect settings, double-click the effect name in the rack.

To bypass an effect, click its Power button .

To bypass all effects, click the main Power button in the lower left corner of a rack, or the fx power button in the Editor panel or
Mixer.

To bypass a selected group of effects, choose Toggle Power State of Selected Effects from the panel menu .

Bypass effects to quickly compare processed and unprocessed audio.

To remove a single effect, choose Remove Effect from a slot’s pop-up menu. Or select the slot, and press Delete.

To remove all effects, choose Remove All Effects from the panel menu .

To reorder effects, drag them to different slots.

Reordering effects produces different sonic results. (For an example, place Reverb prior to Phaser, and vice versa.)

Use effect presets
Many effects provide presets that let you store and recall favorite settings. In addition to effect-specific presets, the Effects Rack provides rack
presets that store groups of effects and settings.

To apply a preset, choose it from the Presets menu.

1. To save current settings as a preset, click the New Preset button .

To delete a preset, select it, and click the Delete button .

To modify an existing preset, apply it, adjust settings as desired, and then save a new preset with the same name.

Control effect settings with graphs
Many Adobe Audition effects provide graphs where you can adjust parameters. By adding and moving control points on the graph, you can
precisely tailor effect settings.

Graph control points function together with related numerical settings. If you change or disable a numerical setting, the related graph control
follows suit.
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Moving a control point changes the related settings, and vice versa.

To move a point on a graph, drag it to a new location.

The following techniques don’t apply to the DeHummer, Mastering, Full Reverb, Parametric Equalizer, and Track EQ
graphs.

To add a control point to a graph, click in the grid at the location where you want to place the point.

To enter numeric values for a control point, right-click it, and choose Edit Point

To remove a point from a graph, drag it off the graph.

To return a graph to its default state, click the Reset button .

About spline curves for graphs
By default, graphs display straight lines between control points. However, some graphs provide a Spline Curves option that creates a curve
between control points for smoother transitions.

When you use spline curves, lines don’t travel directly through control points. Instead, the points control the shape of the curve. To move the
curve closer to a control point, click near it to create a cluster of control points.

Graph with straight lines compared to graph with spline curves

Apply groups of effects in the Waveform Editor

Favorites
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Applying effects in the Multitrack Editor
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Apply effects to clips or tracks
Pre-render track effects to improve performance
Insert effects before or after sends and EQ

Apply effects to clips or tracks
In the Multitrack Editor, you can apply up to 16 effects to each clip, track, and bus and adjust them while a mix plays. (Apply clip effects if a track
contains multiple clips that you want to process independently.)

You can insert, reorder, and remove effects in the Editor, Mixer, or Effects Rack panel. Only in the Effects Rack, however, can you save favorite
settings as presets, which you can apply to multiple tracks.

In the Multitrack Editor, effects are nondestructive, so you can change them at any time. To readapt a session for different projects, for example,
simply reopen it and change effects to create new sonic textures.

Revealing effect slots in the Editor panel

1. Do any of the following:
Select a clip, and click Clip Effects at the top of the Effects Rack.

Select a track, and click Track Effects at the top of the Effects Rack.

Display the fx section of the Editor or Mixer. (In the Editor panel, click the button  in the upper-left corner.)

2. Choose effects for up to 16 slots in the list. (See Insert, bypass, reorder, or remove effects in racks.)
3. Press the spacebar to play the session, and then edit, reorder, or remove effects as needed.

To change effect settings over time, use envelopes. (See Automating mixes with envelopes.)

Pre-render track effects to improve performance
In the Multitrack Editor, pre-render track effects to address heavy CPU usage, improving performance for complex mixes or low-latency recording.
(Latency measures the delay between user input and sound output from a computer. If latency is high, it produces an audible echo during
recording, disrupting timing for musicians.)

You can continue to edit track settings normally; pre-rendering processes audio when pauses occur in playback or editing.

In the Editor panel, Effects Rack, or Mixer, click the Pre-Render Track button .

Insert effects before or after sends and EQ
On each track, you can insert effects either pre- or post-fader. Pre-fader effects process audio before sends and EQ. Post-fader effects process
audio after sends and EQ. For most mixes, the default, pre-fader setting works well. The post-fader setting offers signal-routing flexibility for
particularly complex mixes.

In the fx section of the Editor panel or Mixer, click the Pre-Fader/Post-Fader button to insert effects either before sends and



  Twitter™ and Facebook posts are not covered under the terms of Creative Commons.

Legal Notices   |   Online Privacy Policy

EQ , or after .

If you’re editing effect settings in the Effects Rack, click the Pre-Fader/Post-Fader button in the lower-left corner.

Pre- and post-fader effect and send routing for each track: 
A. Input B. EQ C. Volume D. Mute E. Send F. Effects Rack 

Routing audio to buses, sends, and the Master track

Set up a send
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Hinzufügen von Plug-Ins von Drittherstellern

 

Plug-Ins von Drittanbietern ergänzen die bereits sehr leistungsfähigen Effekte im Lieferumfang von Adobe Audition. Die Anwendung unterstützt
VST-Plug-Ins auf beiden Plattformen und Audio Units-Plug-Ins auf Mac OS.

Das Anwenden von Plug-In-Effekten unterscheidet sich nicht von der Anwendung integrierter Effekte. Weitere Informationen über die Plug-Ins
finden Sie in der Dokumentation von Ihrem Plug-In-Hersteller.

Aktivieren von VST- und Audio Units-Plug-Ins
Damit Sie in Adobe Audition auf Plug-Ins von Drittanbietern zugreifen können, müssen Sie diese zunächst aktivieren. Standardmäßig sind alle
Plug-Ins von Drittanbietern deaktiviert. Zum Optimieren der Systemleistung aktivieren Sie nur die Plug-Ins, die Sie in Adobe Audition verwenden
möchten.

Hinweis: Wenn Effekte in einer Multitrack-Session verwendet werden, schließen Sie die Session.

1. Wählen Sie „Effekte“ > „Audio-Plug-In-Manager“.

2. Klicken Sie im Bereich „VST-Plug-In-Ordner“ auf „Hinzufügen“, um benutzerdefinierte Ordner anzugeben, die Sie nach Plug-
Ins durchsuchen möchten. Klicken Sie auf „Standard“, um den VST-Standardordner für Ihr Betriebssystem anzugeben.

3. Klicken Sie im Bereich „Verfügbare Plug-Ins“ auf die Schaltfläche „Nach Plug-Ins suchen“.

Wenn Sie ein Plug-In kürzlich aktualisiert haben, aktivieren Sie die Option „Vorhandene Plug-Ins neu analysieren“.

4. Wählen Sie die Plug-Ins aus, auf die Sie in Adobe Audition zugreifen möchten, und klicken Sie auf „OK“.

Hinweis: Wenn ein Effekt eines Drittherstellers nicht kompatibel ist, wird er in Adobe Audition in den Effektmenüs in ein Untermenü für nicht
unterstützte Effekte hinzugefügt.

Verwandte Hilfethemen
Anwenden von Effekten im Multitrack-Editor

Automatisieren von Track-Einstellungen
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Anwenden von Effekten im Wellenform-Editor
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Anwenden von Gruppen von Effekten im Wellenform-Editor
Anwenden einzelner Effekte im Wellenform-Editor
Prozesseffekte

Während der Vorschau von Effekten können Sie im Editor die Auswahlen und die Marke für die aktuelle Zeit anpassen. (Ausnahmen sind die
Effekte „Normalisieren“ und „Dehnen“.)

Anwenden von Gruppen von Effekten im Wellenform-Editor
Im Wellenform-Editor können Sie mit dem Effekte-Rack Gruppen von Effekten anwenden. (Es bietet keine Prozesseffekte wie z. B.
Rauschunterdrückung, die einzeln angewendet werden muss.)

1. Wählen Sie „Fenster“ > „Effekte-Rack“.
2. Wählen Sie in der nummerierten Liste Effekte für bis zu 16 Slots aus. (SieheEinfügen, Umgehen, Neuordnen oder Löschen

von Effekten in Racks.)
3. Starten Sie die Wiedergabe, um eine Effektvorschau wiederzugeben, und bearbeiten, mischen und ordnen Sie die Effekte

anschließend wie gewünscht.
Um die verarbeiteten Audiodaten mit den ursprünglichen Audiodaten zu vergleichen, aktivieren bzw. deaktivieren Sie die
Hauptschaltfläche „Ein/Aus“ links unten im Fenster bzw. die Ein/Aus-Schaltflächen für einzelne Effekte.

4. Um den Audiodaten die Änderungen zuzuweisen, klicken Sie auf „Anwenden“.
Speichern Sie zum Sichern von Einstellungen eine Rack-Vorgabe. (See Verwenden von Effektvorgaben.)

Anwenden einzelner Effekte im Wellenform-Editor
1. Wählen Sie aus einem Untermenü des Menüs „Effekte“ einen Effekt aus.

2. Klicken Sie auf die Schaltfläche „Vorschau“  und bearbeiten Sie die Einstellungen wie gewünscht.
Beobachten Sie beim Bearbeiten der Einstellungen den Pegelbereich, um die Amplitude zu optimieren.

3. Um das ursprüngliche mit dem bearbeiteten Audiosignal zu vergleichen, aktivieren bzw. deaktivieren Sie die Power-
Schaltfläche .

4. Um den Audiodaten die Änderungen zuzuweisen, klicken Sie auf „Anwenden“.

Prozesseffekte
Prozesseffekte erkennen Sie am Wort Prozess in den Menübefehlen. Diese verarbeitungsintensiven Effekte stehen nur offline im Wellenform-
Editor zur Verfügung. Im Gegensatz zu Echtzeiteffekten können Sie Prozesseffekte nur einzeln anwenden. Daher sind sie im Effekte-Rack nicht
verfügbar.

Verwandte Hilfethemen
Das Effekte-Rack

Verwenden von Effektvorgaben

Steuern von Effekteinstellungen mit Graphen
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Effekte-Referenz

Einige von dieser Seite verknüpfte Inhalte werden ggf. nur in Englisch angezeigt.



Amplituden- und Komprimierungseffekte
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Der Effekt „Verstärken“
Der Effekt „Kanalmischer“
Der Effekt „DeEsser“
Der Effekt „Dynamikverarbeitung“
Der Effekt „Hard Limiter“
Der Effekt „Multiband-Komprimierung“
Effekt „Normalisieren“ (nur Wellenform-Editor)
Der Effekt „Einzelband-Komprimierung“
Der Effekt „Sprachaussteuerung“
Effekt „Röhren-modellierter Kompressor“
Effekt „Lautstärke-Hüllkurve“ (nur CS5.5 Wellenform-Editor)

Der Effekt „Verstärken“
Mit dem Effekt „Amplitude und Komprimierung“ > „Verstärken“ wird ein Audiosignal verstärkt oder gedämpft. Da dieser Effekt in Echtzeit arbeitet,
können Sie ihn mit anderen Effekten im Effekte-Rack kombinieren.

Verstärkungsregler Verstärken oder dämpfen die einzelnen Audiokanäle.
Regler verbinden Legt fest, dass die beiden Kanalregler synchron bewegt werden.

Der Effekt „Kanalmischer“
Der Effekt „Amplitude und Komprimierung“ > „Kanalmischer“ ändert die Balance von Stereo- oder Surroundkanälen. So können Sie die scheinbare
Position von Klängen ändern, falsche Pegel korrigieren oder Phasenprobleme beheben.

Kanal-Registerkarten Wählen den Ausgangskanal aus.
Eingangskanalregler Legen den Prozentsatz der aktuellen Kanäle fest, der in den Ausgangskanal gemischt werden soll. Beispiel: Wenn Sie bei
einer Stereodatei den L-Wert und den R-Wert auf 50 einstellen, enthält der Ausgangskanal zu gleichen Teilen Audio aus beiden aktuellen
Kanälen.
Umkehren Kehrt die Phase eines Kanals um. (Nähere Informationen zu diesem grundlegenden Audiokonzept finden Sie unter Interaktion von
Klangwellen.) Das Umkehren aller Kanäle ändert die Klangwahrnehmung nicht. Wenn Sie jedoch nur einen Kanal umkehren, kann dies den Klang
erheblich verändern.

Der Effekt „DeEsser“
Der Effekt „Amplitude und Komprimierung“ > „DeEsser“ entfernt Zischen, also „S“-Laute in Sprache und Gesang, die in hohen Frequenzen zu
Verzerrungen führen können.

Der Graph zeigt die verarbeiteten Frequenzen an. Klicken Sie auf die Schaltfläche „Vorschau“ , um zu prüfen, wie viele Audioinhalte im
verarbeiteten Bereich vorhanden sind.

Modus Wählen Sie „Breitband“, um alle Frequenzen zu komprimieren, oder „Multiband“, um nur den Zischbereich zu komprimieren. „Multiband“ ist
für die meisten Audioinhalte am besten geeignet, erfordert aber etwas mehr Verarbeitungszeit.
Schwellwert Legt die Amplitude fest, über der die Komprimierung angewendet wird.
Center-Frequenz Gibt die Frequenz an, bei der das Zischen am intensivsten ist. Passen Sie diese Einstellung während der Wiedergabe an, um
den geeigneten Wert zu finden.
Bandbreite Bestimmt den Frequenzbereich, der den Kompressor auslöst.

Sie können die Center-Frequenz und die Bandbreite grafisch anpassen, indem Sie im Diagramm die Kanten der Auswahl ziehen.

Nur Ausgangszischen Ermöglicht die Wiedergabe des erkannten Zischens. Starten Sie die Wiedergabe und passen Sie die oben genannten
Einstellungen an.
Pegelabsenkung Zeigt die Stärke der Komprimierung in den verarbeiteten Frequenzen an.

Der Effekt „Dynamikverarbeitung“
Der Effekt „Amplitude und Komprimierung“ > „Dynamikverarbeitung“ kann als Kompressor, Begrenzer oder Expander verwendet werden. Als
Kompressor und Begrenzer verringert dieser Effekt den Dynamikbereich und erzeugt so einheitliche Lautstärkepegel. Als Expander erhöht der



Effekt den Dynamikbereich, indem der Pegel der niedrigen Signale verringert wird. (Mit extremen Expander-Einstellungen können Sie ein Noise
Gate erstellen, das Rauschen unterhalb einer bestimmten Amplitudenschwelle vollständig eliminiert.)

Der Effekt „Dynamikverarbeitung“ kann feine Änderungen generieren, die erst nach mehrmaligem Hören deutlich werden. Wenn Sie diesen Effekt
im Wellenform-Editor anwenden, sollten Sie eine Kopie der ursprünglichen Datei bearbeiten, damit Sie ggf. das Original wiederherstellen können.

Verwenden Sie die Voreinstellung „Broadcast Limiter“, um den Sound eines modernen Radiosenders zu simulieren.

Registerkarte „Dynamik“
Diagramm Zeigt den Eingangspegel am horizontalen Lineal (x-Achse) und den neuen Ausgangspegel am vertikalen Lineal (y-Achse) an. Das
Standarddiagramm mit einer geraden Linie von unten links nach oben rechts zeigt ein unverändertes Signal, da jeder Eingangspegel exakt dem
Ausgangspegel entspricht. Durch Anpassen des Diagramms ändern Sie das Verhältnis zwischen Eingangs- und Ausgangspegel und damit den
Dynamikbereich.
Wenn beispielsweise bei etwa –20 dB ein erwünschtes Klangelement auftritt, können Sie das Eingangssignal auf diesen Pegel verstärken und
alles andere unverändert lassen. Außerdem können Sie eine inverse Linie zeichnen (von links oben nach rechts unten), damit kleine Pegel
drastisch verstärkt und große Pegel deutlich gedämpft werden.

Punkt hinzufügen Fügt dem Diagramm einen Steuerungspunkt basierend auf numerischen Werten hinzu, die Sie für Eingangs- und
Ausgangspegel eingeben. Diese Methode ist exakter, als wenn Sie Punkte durch Klicken auf das Diagramm hinzufügen.

Um einen vorhandenen Steuerungspunkt mithilfe numerischer Werte anzupassen, klicken Sie mit der rechten Maustaste auf den Punkt und
wählen Sie „Punkt bearbeiten“.

Punkt löschen Löscht den ausgewählten Punkt aus dem Diagramm.

Umkehren Spiegelt das Diagramm, so dass Komprimierung in Ausdehnung umgewandelt wird und umgekehrt.
Hinweis: Sie können ein Diagramm nur umkehren, wenn es Punkte in den beiden Standardecken aufweist (–100, –100 und 0, 0) und wenn der
Ausgangspegel von links nach rechts ansteigt (jeder Steuerungspunkt muss also höher liegen als der jeweils links davon befindliche).

Zurücksetzen Setzt das Diagramm auf die Standardwerte zurück.
Spline-Kurven Erstellt sanftere, rundere Übergänge zwischen den Steuerungspunkten anstelle der abrupteren linearen Übergänge. (Siehe Spline-
Kurven für Graphen.)
Makeup-Verstärkung Verstärkt das verarbeitete Signal.

Registerkarte „Einstellungen“
Allgemein Ermöglicht globale Einstellungen.

Vorwärtsregelzeit  Behandelt Übergangsspitzen, die zu Beginn extrem lauter Signale auftreten können, die sich über die Ansprechzeit
des Kompressors hinaus erstrecken. Wenn Sie die Vorwärtsregelzeit erhöhen, setzt die Komprimierung ein, bevor das Signal laut wird. So
stellen Sie sicher, dass die Amplitude einen bestimmten Pegel nicht überschreitet. Umgekehrt ist eine geringere Vorwärtsregelzeit
möglicherweise wünschenswert, um die Wirkung perkussiver Musik wie Trommelschläge zu verbessern.
Noise-Gating  Blendet Signale, die unter ein Verhältnis von 50:1 ausgedehnt wurden, vollständig aus.

Pegelmesser Bestimmt die ursprüngliche Eingangsamplitude.

Eingangsverstärkung  Wendet Verstärkung auf das Signal an, bevor es den Pegelmesser erreicht.
Ansprechzeit  Legt fest, wie viele Millisekunden vergehen, bis das Eingangssignal einen geänderten Amplitudenpegel registriert. Beispiel:
Wenn das Audio plötzlich um 30 dB abfällt, vergeht die angegebene Ansprechzeit, bevor das Eingangssignal eine Amplitudenänderung
registriert. Dies verhindert fehlerhafte Amplitudenwerte aufgrund von vorübergehenden Änderungen.
Nachklingzeit  Legt fest, für wie viele Millisekunden der aktuelle Amplitudenpegel beibehalten wird, bevor die nächste
Amplitudenänderung eintreten kann.

Verwenden Sie bei Audiodaten mit schnellen Übergängen schnelle Einstellungen für Ansprech- und Nachklingzeit. Verwenden Sie
langsamere Einstellungen für weniger perkussives Audio.

Modus „Spitze“  Bestimmt die Pegel basierend auf Amplitudenspitzen. Dieser Modus ist etwas schwieriger zu verwenden als der RMS-
Modus, da die Spitzen im Dynamikdiagramm nicht exakt abgebildet werden. Der Modus kann jedoch hilfreich sein, wenn das Audio laute
Übergangsspitzen aufweist, die Sie unterdrücken möchten.
RMS-Modus  Bestimmt die Pegel basierend auf der Formel zur Berechnung des quadratischen Mittelwerts. Diese Methode stimmt
genauer mit der menschlichen Lautstärkewahrnehmung überein. Bei diesem Modus werden die Amplituden im Dynamikdiagramm präzise
abgebildet. Beispiel: Ein Limiter (flache horizontale Linie) bei –10 dB bildet eine durchschnittliche RMS-Amplitude von –10 dB ab.

Gain-Prozessor Verstärkt oder dämpft das Signal abhängig von der ermittelten Amplitude.

Ausgangsverstärkung  Verstärkt das Ausgangssignal nach allen Dynamikverarbeitungen.
Ansprechzeit  Legt fest, wie viele Millisekunden vergehen, bis das Ausgangssignal den angegebenen Pegel erreicht. Beispiel: Wenn das
Audio plötzlich um 30 dB abfällt, vergeht die angegebene Ansprechzeit, bevor sich das Ausgangssignal ändert.
Nachklingzeit  Legt fest, wie viele Millisekunden der aktuelle Ausgangspegel beibehalten wird.
Hinweis: Wenn die Summe aus Ansprech- und Nachklingzeit zu kurz ist (kürzer als etwa 30 Millisekunden), sind hörbare Artefakte
wahrnehmbar. Sie können gute Beispiele für Ansprech- und Nachklingzeiten für verschiedene Arten von Audioinhalten anzeigen, indem
Sie die zahlreichen Optionen im Menü „Vorgaben“ wählen.
Kanäle verbinden  Verarbeitet alle Kanäle gleich und behält die Stereo- oder Surroundbalance bei. Ein komprimierter Trommelschlag im
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linken Kanal führt beispielsweise dazu, dass der Pegel im rechten Kanal um denselben Wert reduziert wird.
Bandbegrenzung Schränkt die Dynamikverarbeitung auf einen bestimmten Frequenzbereich ein.

Hochpassfilter  Die niedrigste Frequenz, die von der Dynamikverarbeitung betroffen ist.
Tiefpassfilter  Die höchste Frequenz, die von der Dynamikverarbeitung betroffen ist.

Der Effekt „Hard Limiter“
Mit dem Effekt „Amplitude und Komprimierung“ > „Hard Limiter“ können Sie Audio, das über einen festgelegten Schwellenwert ansteigt, erheblich
dämpfen. Normalerweise wird ein Limiter in Verbindung mit einer Eingangsverstärkung verwendet, bei der die Gesamtlautstärke verzerrungsfrei
erhöht wird.

Maximale Amplitude Stellt die maximal zulässige Sample-Amplitude ein.
Um bei der Arbeit mit 16-Bit-Audiodaten Clipping zu vermeiden, stellen Sie diesen Wert höchstens auf –0,3 dB ein. Wenn Sie ihn noch
niedriger einstellen, auf –3 db, haben Sie etwas mehr Spielraum für zukünftige Bearbeitungen.

Eingangsverstärkung Erzeugt eine Vorverstärkung der Audiodaten vor der Begrenzung, so dass die Auswahl ohne Clipping lauter wird. Bei der
Erhöhung dieses Pegels nimmt auch die Komprimierung zu. Probieren Sie extreme Einstellungen, um den lauten, hochwirksamen Klang moderner
Popmusik zu erzielen.
Vorwärtsregelzeit Stellt die Zeit in Millisekunden ein, die normalerweise zum Dämpfen der Audiodaten benötigt wird, bevor die lauteste Spitze
erreicht wird.
Hinweis: Stellen Sie sicher, dass der Wert bei mindestens 5 Millisekunden liegt. Ist dieser Wert zu klein, können hörbare Störungen auftreten.
Nachklingzeit Stellt die Zeit in Millisekunden ein, die zur Rücksetzung der Dämpfung auf 12 dB benötigt wird (bzw. die ungefähre Zeit bis zur
Wiederherstellung der normalen Lautstärke, nachdem eine extrem laute Spitze aufgetreten ist). Normalerweise funktioniert eine Einstellung von ca.
100 (Standardwert) gut und erhält auch sehr tiefe Bassfrequenzen.
Hinweis: Ist dieser Wert zu groß, bleibt die Audiowiedergabe möglicherweise für einen recht langen Zeitraum sehr leise.
Kanäle verbinden Verknüpft die Laustärke aller Kanäle und behält die Stereo- oder Surroundbalance bei.

Der Effekt „Multiband-Komprimierung“
Mit dem Effekt „Amplitude und Komprimierung“ > „Multiband-Komprimierung“ können Sie vier verschiedene Frequenzbänder unabhängig
voneinander komprimieren. Da jedes Band normalerweise eigenen dynamischen Inhalt enthält, ist die Multiband-Komprimierung ein besonders
leistungsstarkes Werkzeug für das Audio-Mastering.

Mit den Steuerungen der Multiband-Komprimierung können Sie Übergangsfrequenzen genau definieren und bandspezifische
Komprimierungseinstellungen anwenden. Klicken Sie auf die Solo-Schaltflächen, um die Bänder getrennt als Vorschau anzuzeigen, oder auf die
Bypass-Schaltflächen, um Bänder ohne Verarbeitung zu umgehen. Nachdem Sie eine Feineinstellung der einzelnen Bänder vorgenommen haben,
wählen Sie für die globale Anpassung die Option zum Verknüpfen der Bandsteuerungen und optimieren Sie dann die Gesamtlautstärke mit dem
Schieberegler für die Ausgangsverstärkung und den Begrenzereinstellungen.

Um die Komprimierungseinstellungen im Zeitverlauf zu ändern, verwenden Sie Automatisierungsspuren im Multitrack-Editor. (Siehe
Automatisieren von Track-Einstellungen.)

Anpassen einer Übergangsfrequenz in der Multiband-Komprimierung
A.  Frequenzbänder B.  Übergangsmarkierungen C.  Umgangenes Band (keine Verarbeitung) D.  Amplitudenmaßstab E.  Frequenzmaßstab

Übergang Legt die Übergangsfrequenzen fest, die wiederum die Breite der einzelnen Bänder bestimmen. Geben Sie entweder explizit niedrige,
mittlere oder hohe Frequenzen an oder ziehen Sie die Übergangsmarkierungen über den Graphen.

http://helpx.adobe.com/en/audition/using/automating-mixes-envelopes1.html#automating_track_settings
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Bandspezifische Steuerungen in der Multiband-Komprimierung
A.  Solo B.  Bypass C.  Schwellenwert-Schieberegler D.  Eingangspegelmesser E.  Verstärkungsminderungsanzeigen

Solo-Schaltflächen Ermöglicht es Ihnen, bestimmte Frequenzbänder anzuhören. Aktivieren Sie jeweils eine Solo-Schaltfläche, um die Bänder
einzeln zu hören, oder mehrere Schaltflächen, um zwei oder mehr Bänder zusammen zu hören.
Bypass-Schaltflächen Umgehen Sie einzelne Bänder, so dass diese ohne Verarbeitung durchgehen.

Klicken Sie bei gedrückter Alt-Taste (Windows) bzw. Wahltaste (Mac OS) auf die Solo- oder Bypass-Schaltflächen, um einem einzelnen Band
schnell eine eindeutige Einstellung zuzuweisen.

Schwellenwert-Schieberegler Legen Sie den Eingangspegel fest, an dem die Komprimierung beginnt. Mögliche Werte reichen von -60 bis 0 dB.
Die optimale Einstellung ist vom Audio-Inhalt und der Musikrichtung abhängig. Um nur extreme Spitzen zu komprimieren und einen größeren
Dynamikbereich zu erhalten, probieren Sie Schwellenwerte um 5 dB unterhalb des Spitzen-Eingangspegels aus; um die Audiodaten stark zu
komprimieren und den Dynamikbereich erheblich zu verringern, probieren Sie Einstellungen um 15 dB unterhalb des Spitzen-Eingangspegels
aus.
Eingangspegelmesser Messen die Eingangsamplitude. Doppelklicken Sie auf die Anzeigen, um die Spitzen- und Clipanzeigen zurückzusetzen.
Verstärkungsminderungsanzeigen Messen die Amplitudenverringerung mit roten Anzeigen, die sich von oben (minimale Verringerung) nach
unten (maximale Verringerung) erstrecken.
Verstärkung Verstärkt oder senkt die Amplitude nach der Komprimierung. Mögliche Werte reichen von -18 bis +18 dB, wobei 0 gleiche
Verstärkung darstellt.
Verhältnis Legt ein Kompressionsverhältnis zwischen 1:1 und 30:1 fest. Bei einer Einstellung von 3,0 wird 1 dB für jede Erhöhung um 3 dB über
dem Komprimierungsschwellenwert ausgegeben. Normale Einstellungen reichen von 2,0 bis 5,0; höhere Einstellungen erzeugen einen extrem
komprimierten Sound, der häufig bei Popmusik gehört werden kann.
Ansprechzeit Gibt an, wie schnell die Komprimierung angewendet wird, wenn die Audiodaten den Schwellenwert überschreiten. Mögliche Werte
reichen von 0 bis 500 Millisekunden. Die Standardeinstellung von 10 Millisekunden eignet sich für eine große Bandbreite von Audiodaten.
Schnellere Einstellungen eignen sich möglicherweise besser für schnelle Transienten, hören sich bei weniger perkussiven Audiodaten jedoch
unnatürlich an.
Abklingzeit Legt fest, wie schnell die Komprimierung stoppt, wenn die Audiodaten unter den Schwellenwert fallen. Mögliche Werte reichen von 0
bis 5000 Millisekunden. Die Standardeinstellung von 100 Millisekunden eignet sich für eine große Bandbreite von Audiodaten. Probieren Sie
schnellere Einstellungen für Audiodaten mit schnelleren Transienten aus und langsamere Einstellungen für weniger perkussive Audiodaten.
Ausgangsverstärkung Hebt den Ausgangspegel nach der Komprimierung an oder senkt ihn ab. Mögliche Werte reichen von -18 bis +18 dB,
wobei 0 gleiche Verstärkung darstellt. Doppelklicken Sie auf die Anzeigen, um die Spitzen- und Clipanzeigen zurückzusetzen.
Begrenzer Wendet Begrenzung nach der Ausgangsverstärkung, am Ende des Signalpfads an, und optimiert so die Gesamtpegel. Geben Sie
Schwellenwert-, Ansprechzeit- und Nachklingeinstellungen an, die weniger aggressiv als ähnliche, Band-spezifische Einstellungen sind. Geben Sie
dann eine Randeinstellung an, um die absolute Höhe relativ zu 0 dBFS festzulegen.

Um extrem komprimierte Audiodaten zu erstellen, aktivieren Sie den Begrenzer und probieren Sie dann sehr hohe Einstellungen für die
Ausgangsverstärkung aus.

Spektrum bei Eingang Zeigt das Frequenzspektrum des Eingangssignals, anstatt des Ausgangssignals, im Multiband-Graphen an. Aktivieren
bzw. deaktivieren Sie diese Option, um die auf jedes Band angewendete Komprimierung schnell anzuzeigen.
Brickwall-Begrenzer Wendet sofortiges Hard-Limiting an der aktuellen Randeinstellung an. (Deaktivieren Sie diese Option, um ein langsameres
Soft-Limiting anzuwenden, das weniger komprimiert klingt, jedoch die Randeinstellung überschreiten kann.)
Hinweis: Die maximale Ansprechzeit für Brickwall-Limiting beträgt 5 ms.
Bandsteuerungen verknüpfen Ermöglicht die globale Anpassung der Komprimierungseinstellungen für alle Bänder, wobei die relativen
Unterschiede zwischen den Bändern beibehalten werden.

Um die Bandsteuerungen vorübergehend zu verknüpfen, halten Sie Alt+Umschalttaste (Windows) bzw. Wahltaste+Umschalttaste (Mac OS)
gedrückt. Um eine Steuerung in allen Bändern zurückzusetzen, halten Sie Strg+Alt+Umschalttaste (Windows) bzw.
Befehlstaste+Wahltaste+Umschalttaste (Mac OS) gedrückt und klicken Sie auf die Steuerung.

Effekt „Normalisieren“ (nur Wellenform-Editor)
Hinweis: Dieser Effekt erfordert Offline-Verarbeitung. Während der Effekt geöffnet ist, können Sie weder die Wellenform bearbeiten, noch
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Auswahlen anpassen oder die Marke für die aktuelle Zeit verschieben.
Mit dem Effekt „Amplitude und Komprimierung“ > „Normalisieren“ können Sie einen Spitzenpegel für eine Datei oder Auswahl einstellen. Wenn Sie
die Audiodaten auf 100 % normalisieren, erreichen Sie die maximale Amplitude, die für digitale Audiodaten zulässig ist (0 dBFS). Wenn Sie die
Audiodaten jedoch an einen Mastering-Ingenieur senden, normalisieren Sie die Audiodaten auf Werte zwischen –3 und –6 dBFS, um einen
Spielraum für die weitere Verarbeitung zu gewährleisten.

Der Effekt „Normalisieren“ verstärkt die gesamte Datei oder Auswahl gleichmäßig. Erreichen die ursprünglichen Audiodaten eine Lautstärkespitze
von 80 % und leise Stellen 20 %, führt eine Normalisierung auf 100 % dazu, dass die Lautstärkespitze auf 100 % und die leisen Stellen auf 40 %
angehoben werden.

Um RMS-Normalisierung anzuwenden, wählen Sie „Effekte“ > „Gleiche Lautstärke“. Diesen Befehl können Sie ggf. auch auf einzelne Dateien
anwenden. (Siehe Angleichen der Lautstärke mehrerer Dateien.)

Normalisieren auf Stellt den Prozentsatz der höchsten Spitze relativ zur maximal möglichen Amplitude ein.
Aktivieren Sie die Option „dB“, um den Normalisierungswert nicht als Prozentsatz, sondern in Dezibel einzugeben.

Alle Kanäle gleichmäßig normalisieren Verwendet alle Kanäle einer Stereo- oder Surround-Wellenform für die Berechnung des
Verstärkungsbetrags. Wenn diese Option deaktiviert ist, wird der Wert für jeden Kanal separat berechnet. Dadurch wird ein Kanal möglicherweise
deutlich höher verstärkt als andere.
DC Bias-Einst. Ermöglicht die Einstellung der Position der Wellenform in der Wellenformanzeige. Einige Aufnahmegeräte weisen möglicherweise
einen DC-Bias auf, der dazu führt, dass die aufgenommene Wellenform über oder unter der normalen Mittellinie in der Wellenformanzeige liegt.
Weisen Sie als Prozentsatz Null zu, um die Wellenform zu zentrieren. Sie können die gesamte ausgewählte Wellenform über oder unter die
Mittellinie verschieben, indem Sie einen positiven oder negativen Prozentwert eingeben.

Der Effekt „Einzelband-Komprimierung“
Der Effekt „Amplitude und Komprimierung“ > „Einzelband-Komprimierung“ reduziert den dynamischen Bereich, wodurch konsistente
Lautstärkepegel entstehen und die wahrgenommene Lautstärke erhöht wird. Die Einzelband-Komprimierung ist besonders für Sprachkommentare
sinnvoll, da sie sicherstellt, dass der Sprecher über Musiksoundtracks und Hintergrundaudio hinweg hörbar ist.

Hoch komprimierte Audiodaten sind beispielsweise Aufnahmen moderner Popmusik. Die meisten Jazz-Aufnahmen weisen hingegen nur eine
geringe Komprimierung auf und herkömmliche Klassikaufnahmen sind gar nicht komprimiert.

Schwellwert Legt den Eingangspegel fest, bei dem die Komprimierung beginnt. Die optimale Einstellung ist von Inhalt und Stil der Audiodaten
abhängig. Um nur extreme Spitzen zu komprimieren und einen größeren Dynamikbereich zu erhalten, probieren Sie Schwellenwerte um 5 dB
unterhalb des Spitzen-Eingangspegels aus. Um die Audiodaten stark zu komprimieren und den Dynamikbereich erheblich zu verringern, probieren
Sie Einstellungen um 15 dB unterhalb des Spitzen-Eingangspegels aus.
Verhältnis Legt ein Kompressionsverhältnis zwischen 1:1 und 30:1 fest. Beispielsweise wird bei einer Einstellung von 3 1 dB für jede Erhöhung
um 3 dB über den Schwellenwert ausgegeben. Normale Einstellungen reichen von 2 bis 5. Höhere Einstellungen erzeugen einen extrem
komprimierten Sound, der häufig bei Popmusik zu hören ist.
Ansprechzeit Legt fest, wie schnell die Komprimierung startet, wenn Audiodaten den Schwellwert überschreiten. Die Standardeinstellung von 10
Millisekunden eignet sich für unterschiedlichstes Quellmaterial. Verwenden Sie kürzere Werte nur für Audiodaten mit schnellen Transienten, also
z. B. Schlagzeugaufnahmen.
Abklingzeit Legt fest, wie schnell die Komprimierung stoppt, wenn die Audiodaten unter den Schwellwert fallen. Die Standardeinstellung von 100
Millisekunden eignet sich für eine große Bandbreite von Audiodaten. Probieren Sie schnellere Einstellungen für Audiodaten mit schnelleren
Transienten aus und langsamere Einstellungen für weniger perkussive Audiodaten.
Ausgangsverstärkung Verstärkt oder senkt die Amplitude nach der Komprimierung. Mögliche Werte reichen von -30 dB bis +30 dB, wobei 0
einem Verstärkungsfaktor Eins entspricht.

Der Effekt „Sprachaussteuerung“
Der Effekt „Amplitude und Komprimierung“ > „Sprachaussteuerung“ ist ein Komprimierungseffekt, der die Sprachausgabe optimiert, indem Pegel
ausgeglichen und Hintergrundrauschen entfernt werden.

Führen Sie folgende Schritte durch, um die besten Ergebnisse zu erzielen:

1. Wählen Sie das Audio mit dem geringsten Pegel aus. Ziehen Sie die Schieberegler „Ziellautstärkepegel“ und „Aussteuern auf“
ganz nach links. Starten sie die Wiedergabe und erhöhen Sie allmählich den Wert für „Aussteuern auf“, bis die Sprache gut
hörbar ist, ohne dass das Hintergrundrauschen lauter wird.

2. Wählen Sie das Audio mit dem höchsten Pegel aus und starten Sie die Wiedergabe. Passen Sie den Wert für
„Ziellautstärkepegel“ an, bis die Lautstärke mit der leisen Passage übereinstimmt, sie Sie zuvor bearbeitet haben.

3. Passen Sie bei Bedarf den Wert für „Aussteuern auf“ an, um einen überkomprimierten Klang zu vermeiden.

Im Folgenden finden Sie weitere Details zu den einzelnen Optionen:

Ziellautstärkepegel Gibt den gewünschten Ausgangspegel relativ zu 0 dBFS an. (Siehe Messen der Amplitude in dBFS.)
Aussteuern auf Bei niedrigen Einstellungen wird die Sprache leicht verstärkt, ohne dass das Hintergrundrauschen erhöht wird. Bei hohen
Einstellungen wird das gesamte Signal mehr verstärkt, wenn das Signal näher in Richtung Hintergrundrauschen abfällt.

http://helpx.adobe.com/en/audition/using/automating-common-tasks-cs6.html#match_volume_across_multiple_files
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Leise Signale verstärken Interpretiert kurze, leise Passagen als Sprache, die verstärkt werden soll. Bei den meisten Audioinhalten sollten Sie
diese Option deaktivieren, um einen weicheren Klang zu erzielen.
Erweiterte Einstellungen Klicken Sie auf das Dreieck, um auf folgende Optionen zuzugreifen:

Kompressor  Behält einen starken Pegel bei, wenn das verarbeitete Signal unter einen Schwellenwert relativ zu 0 dBFS fällt.
Gate  Entfernt Hintergrundgeräusche, indem der Ausgangspegel drastisch abgesenkt wird, wenn das Signal um einen angegebenen
Offset abfällt.

Effekt „Röhren-modellierter Kompressor“
Mit dem Effekt „Amplitude und Komprimierung“ > „Röhren-modellierter Kompressor“ wird die Klangwärme alter Hardware-Kompressoren simuliert.
Verwenden Sie diesen Effekt, um feine Verzerrungen hinzuzufügen, die Audiodaten leicht untermalen.

Schwellenwert-Schieberegler Legt den Eingangspegel fest, bei dem die Komprimierung beginnt. Mögliche Werte reichen von -60 bis 0 dB. Die
optimale Einstellung ist vom Audio-Inhalt und der Musikrichtung abhängig. Um nur extreme Spitzen zu komprimieren und einen größeren
Dynamikbereich zu erhalten, probieren Sie Schwellenwerte um 5 dB unterhalb des Spitzen-Eingangspegels aus; um die Audiodaten stark zu
komprimieren und den Dynamikbereich erheblich zu verringern, probieren Sie Einstellungen um 15 dB unterhalb des Spitzen-Eingangspegels
aus.
Eingangspegelmesser Links neben dem Schieberegler befindlich können Sie mit diesen Messern die Eingangsamplitude messen. Doppelklicken
Sie auf die Anzeigen, um die Spitzen- und Clipanzeigen zurückzusetzen.
Verstärkungsminderungsanzeigen Rechts neben dem Schieberegler befinden sich Messer, mit denen Sie die Amplitudenverringerung messen
können. Rote Anzeigen erstrecken sich von oben (minimale Verringerung) nach unten (maximale Verringerung).
Verstärkung Verstärkt oder senkt die Amplitude nach der Komprimierung. Mögliche Werte reichen von -18 bis +18 dB, wobei 0 gleiche
Verstärkung darstellt.
Verhältnis Legt ein Kompressionsverhältnis zwischen 1:1 und 30:1 fest. Bei einer Einstellung von 3,0 wird 1 dB für jede Erhöhung um 3 dB über
dem Komprimierungsschwellenwert ausgegeben. Normale Einstellungen reichen von 2,0 bis 5,0; höhere Einstellungen erzeugen einen extrem
komprimierten Sound, der häufig bei Popmusik gehört werden kann.
Ansprechzeit Gibt an, wie schnell die Komprimierung angewendet wird, wenn die Audiodaten den Schwellenwert überschreiten. Mögliche Werte
reichen von 0 bis 500 Millisekunden. Die Standardeinstellung von 10 Millisekunden eignet sich für eine große Bandbreite von Audiodaten.
Schnellere Einstellungen eignen sich möglicherweise besser für schnelle Transienten, hören sich bei weniger perkussiven Audiodaten jedoch
unnatürlich an.
Abklingzeit Legt fest, wie schnell die Komprimierung stoppt, wenn die Audiodaten unter den Schwellenwert fallen. Mögliche Werte reichen von 0
bis 5000 Millisekunden. Die Standardeinstellung von 100 Millisekunden eignet sich für eine große Bandbreite von Audiodaten. Probieren Sie
schnellere Einstellungen für Audiodaten mit schnelleren Transienten aus und langsamere Einstellungen für weniger perkussive Audiodaten.

Effekt „Lautstärke-Hüllkurve“ (nur CS5.5 Wellenform-Editor)
Mit dem Effekt „Amplitude und Komprimierung“ > „Lautstärke-Hüllkurve“ können Sie die Lautstärke über die Zeit mit Verstärkungen und
Ausblendungen ändern. Ziehen Sie einfach im Editor die gelbe Linie. Der obere Rand des Bedienfelds steht für 100 % (normale) Verstärkung, der
untere Rand steht für 100 % Dämpfung (Stille).

Der Effekt „Lautstärke-Hüllkurve“ ist im Multitrack-Editor zwar nicht verfügbar, Sie können jedoch denselben Effekt mit Automatisierungsspuren
erzielen. (See Automatisieren von Track-Einstellungen.)

Ziehen eines Ankerpunkts im Editor

Gelbe Hüllkurven-Linie im Editor Ziehen Sie diese Linie, um den Amplitudenprozentsatz anzupassen, und klicken Sie, um Keyframes für weitere
Verstärkungen und Fades hinzuzufügen. Informationen zum schnellen Auszuwählen, Repositionieren oder Löschen mehrere Keyframes finden Sie
unter Anpassen der Automatisierung mit Keyframes.
Spline-Kurven Erstellt sanftere, rundere Übergänge zwischen den Keyframes anstelle der linearen Übergänge. Siehe Spline-Kurven für
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Der Effekt „Analogverzögerung“
Der Effekt „Verzögerung“
Der Effekt „Echo“

Verzögerungen sind separate Kopien eines Originalsignals, die innerhalb von Millisekunden erneut auftreten. Echos sind Klänge, bei denen die
Kopie so weit vom Original entfernt wurde, dass das menschliche Ohr sie als separaten Sound wahrnimmt.. Wenn Hall- oder Chorus-Effekte die
Mischung möglicherweise verwischen würden, sind Verzögerungen und Echos eine gute Möglichkeit, einem Track Atmosphäre zu verleihen.

Um auf bekannte Optionen aus Hardware-Verzögerungen zuzugreifen, verwenden Sie den Echo-Effekt von Adobe Audition.

Der Effekt „Analogverzögerung“
Mit dem Effekt „Verzögerung und Echo“ > „Analogverzögerung“ wird die Klangwärme von älteren Hardware-Verzögerungsgeräten simuliert. Über
einzigartige Optionen können Sie charakteristische Verzerrungseffekte anwenden und die Stereostreuung anpassen. Um schnelle Echos zu
erzielen, geben Sie Verzögerungszeiten von mehr als 35 Millisekunden an. Feinere Effekte können Sie mit kürzeren Zeiten erzielen.

Modus Gibt den Typ der Hardware-Emulation an und bestimmt die Equalizer-Korrektur sowie Verzerrungsmerkmale. „Band“ und „Röhre“
repräsentieren die Klangmerkmale alter Verzögerungsgeräte, „Analog“ bildet dagegen die Merkmale späterer elektronischer Gerätelinien nach.
Ausgang – Direktsignal Bestimmt den Pegel der unverarbeiteten Audiodaten.
Ausgang – Effektsignal Bestimmt den Pegel der verzögerten, verarbeiteten Audiodaten.
Verzög. Gibt die Verzögerungsdauer in Millisekunden an.
Rückkopplung Erstellt wiederholende Echos, indem verzögerte Audiodaten wieder über die Verzögerungsleitung eingespeist werden. Bei einem
Wert von 20 % werden die verzögerten Daten z. B. mit einem Fünftel der ursprünglichen Lautstärke wieder eingespeist. Dadurch entstehen Echos,
die langsam ausblenden. Bei einem Wert von 200 % werden die verzögerten Daten z. B. mit der doppelten ursprünglichen Lautstärke wieder
eingespeist. Dadurch entstehen Echos, die schnell an Intensität zunehmen.
Hinweis: Wenn Sie sehr hohe Rückkopplungseinstellungen verwenden, sollten Sie die Systemlautstärke senken.
Beimengungen Steigert Verzerrungen und hebt tiefe Frequenzen an, um die Klangwärme zu steigern.
Verteilen Bestimmt die Stereobreite des verzögerten Signals.

Der Effekt „Verzögerung“
Mit dem Effekt „Verzögerung und Effekte“ > „Verzögerung“ können einzelne Echos sowie eine Reihe weiterer Effekte erzeugt werden.
Verzögerungen von 35 Millisekunden und mehr erzeugen wahrnehmbare Echos, während Werte zwischen 15 und 34 Millisekunden eine Chorus-
oder Flanger-Wirkung erzeugen. (Die Ergebnisse sind nicht so gut wie bei Verwendung der Effekte „Chorus“ und „Flanger“ in Adobe Audition, da
sich die Verzögerungseinstellungen im Zeitverlauf nicht ändern.)

Durch weitere Reduzierung der Verzögerung auf einen Wert zwischen 1 und 14 Millisekunden können Sie einen Monosound so im Raum
platzieren, als ob der Sound von links oder rechts zu kommen scheint, obwohl die Lautstärkepegel für beide Kanäle identisch sind.

Verzögerungszeit Stellt die Verzögerung für den linken und den rechten Kanal zwischen -500 und +500 Millisekunden ein. Durch Eingabe eines
negativen Werts wird der betreffende Kanal nicht verzögert, sondern frühzeitig ausgegeben. Wenn Sie z. B. 200 Millisekunden für den linken Kanal
eingeben, wird der verzögerte Teil der betreffenden Wellenform vor dem ursprünglichen Teil hörbar.
Mischen Legt das Verhältnis des verarbeiteten Effektsignals zum ursprünglichen Direktsignal für die Mischung in der Endausgabe fest. Ein Wert
von 50 mischt die beiden Signale zu gleichen Anteilen.
Umkehren Kehrt die Phase des verzögerten Signals um, so dass ähnlich wie bei Kammfiltern der Effekt einer Phasenannullierung entsteht.
(Nähere Informationen zur Phasenannullierung finden Sie unter Interaktion von Klangwellen.)

Der Effekt „Echo“
Mit dem Effekt „Verzögerung und Echo“ > „Echo“ wird dem Sound eine Reihe wiederholter, abklingender Echos hinzugefügt. (Verwenden Sie für
ein einzelnes Echo stattdessen den Effekt „Verzögerung“.) Sie können Effekte wie ein einfaches Talecho („Hallo-allo-llo-lo-o“), aber auch
metallisch klingelnde Regenrohreffekte erzeugen, indem Sie den Verzögerungswert ändern. Durch Entzerren der Verzögerungen können Sie die
Soundcharakteristika eines Raums mit reflektierenden Oberflächen (dadurch entstehen Echos mit hellerem Sound) in die eines Raumes mit stark
absorbierenden Oberflächen ändern (dunkler klingende Echos).

Hinweis: Stellen Sie sicher, dass die Audiodatei lang genug ist, damit das Echo vollständig ausklingen kann. Wird das Echo kurz vor dem
Ausklingen abrupt abgeschnitten, machen Sie den Effekt „Echo“ rückgängig. Fügen Sie einige Sekunden Pause hinzu, indem Sie „Generieren“ >
„Pause“ wählen. Wenden Sie dann den Effekt „Echo“ erneut an.
Verzögerungszeit Gibt die Millisekunden, Anzahl der Beats oder Samples zwischen den einzelnen Echos an. Ein Wert von 100 Millisekunden



 

definiert eine Verzögerung von einer zehntel Sekunde zwischen den Echos.
Rückkopplung Bestimmt die Abklinggeschwindigkeit des Echos. Jedes folgende Echo beginnt mit einem etwas geringeren Prozentsatz als das
vorherige. Ein Wert von 0 % für „Ausklang“ erzeugt kein Echo. Bei 100 % wird das Echo nie schwächer.
Echopegel Stellt den Prozentsatz des Echosignals (Effektsignal) ein, der mit dem ursprünglichen Signal (Direktsignal) in das resultierende Signal
gemischt werden soll.

Sie können bemerkenswerte Stereo-Echoeffekte erzeugen, indem Sie unterschiedliche Werte für den linken und den rechten Kanal in den
Steuerungen „Verzögerungszeit“, „Rückkopplung“ und „Echopegel“ angeben.

Links und Rechts gleich Verknüpft die Schieberegler der Optionen „Ausklang“, „Verzögerung“ und „Anfangsecholautstärke“, damit beiden
Kanälen dieselben Werte zugewiesen werden.
Echo-Bounce Lässt das Echo zwischen dem linken und dem rechten Kanal hin- und herspringen. Wenn Sie ein hin- und herspringendes Echo
erstellen möchten, wählen Sie eine Anfangsecholautstärke von 100 % für einen und 0 % für den anderen Kanal. Anderenfalls werden die
Einstellungen für den jeweils anderen Kanal übernommen und es entstehen zwei identische Echos.
Allmählicher Echoausgleich Sendet jedes nachfolgende Echo durch einen 8-Band-Equalizer, so dass Sie die natürliche Klangabsorption eines
Raums simulieren können. Eine Einstellung von 0 lässt das Frequenzband unverändert. Bei der maximalen Einstellung von -15 wird die Frequenz
um 15 dB gesenkt. Und da -15 dB die Differenz jeweils aufeinander folgender Echos ist, verschwinden einige Frequenzen viel schneller als
andere.
Einheiten für Verzögerungszeit Legt als Einheit für die Verzögerungszeit-Einstellung Millisekunden, Beats oder Samples fest.
Verwandte Hilfethemen
Anwenden von Effekten im Multitrack-Editor

Verwenden von Effektvorgaben
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Diagnoseeffekte (nur Wellenform-Editor)
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Diagnostizieren, Reparieren, Löschen oder Markieren von Audio
DeClicker
DeClipper
Pause löschen und Audio markieren

Auf Diagnoseeffekte können Sie entweder im Menü „Effekte“ oder direkt im Diagnose-Bedienfeld („Fenster“ > „Diagnose“) zugreifen. Mit diesen
Werkzeugen können Sie Klicks, Verzerrungen oder Pausen aus Audiodaten löschen und Marker an Pausen hinzufügen.

Für die optimale Widerherstellung von Audiodaten verwenden Sie die Diagnose in Verbindung mit den Werkzeugen der Spektralanzeige und
mit Rauschminderungseffekten. Siehe Techniken für die Audio-Wiederherstellung.

Adobe empfiehlt Verfügen Sie über eine Schulung,
die Sie anderen anbieten möchten?

Geclipptes Audio von DSLR-
Kameras wiederherstellen
Jason Levine
Verlorenen Dynamikbereich mit dem Effekt
„DeClipper“ wiederherstellen.

Diagnostizieren, Reparieren, Löschen oder Markieren von Audio
Im Gegensatz zu herkömmlichen Rauschminderungseffekten, bei denen sämtliches ausgewähltes Audio verarbeitet wird, analysiert die Diagnose
problematische oder leise Passagen und lässt Sie anschließend auswählen, welche Probleme Sie behandeln möchten.

1. Wählen Sie im Diagnose-Bedienfeld eine Option aus dem Menü „Effekt“.

2. Klicken Sie auf „Durchsuchen“.

3. Führen Sie unten im Bedienfeld beliebige der folgenden Schritte durch:

Wählen Sie eines oder mehrere der erkannten Probleme aus und klicken Sie auf „Reparieren“, „Löschen“ oder
„Kennzeichnen“. (Welche Optionen angezeigt werden, hängt vom gewählten Diagnose-Effekt ab.)

Um erkannte Clicks oder aufgetretenes Clipping zu kennzeichnen, klicken Sie mit der rechten Maustaste auf das
gewünschte Element und wählen Sie „Marker erstellen“ aus dem Popup-Menü. (Siehe Arbeiten mit Markern.)

Klicken Sie auf „Alle reparieren“, „Alle löschen“ oder „Alles markieren“, um alle erkannten Elemente zu behandeln.

Klicken Sie auf das Lupensymbol , um im Editor auf das markierte Problem zu zoomen. Klicken Sie erneut auf das
Symbol, um wieder auszuzoomen.

Klicken Sie auf „Reparierte löschen“, „Gelöschte entfernen“ oder „Markierung löschen“, um zuvor behandelte Probleme
aus der Liste zu entfernen.

DeClicker
Der Effekt „Diagnose“ > „DeClicker“ erkennt und entfernt Klick- und Knackgeräusche von Drahtlosmikrofonen, Vinylschallplatten und anderen
Quellen.

Die DeClicker-Optionen entsprechen denen des Effekts „Automatischer Klick-Entferner“, den Sie mit anderen Effekten im Effekte-Rack
kombinieren und dann im Multitrack-Editor anwenden können. (Siehe Der Effekt „Automatischer Klick-Entferner“.) Außerdem wendet dieser Effekt
automatisch mehrere Analyse- und Reparaturdurchläufe an. Um denselben Betrag an Klick-Entfernung mit dem DeClicker zu erreichen, müssen
Sie ihn manuell mehrmals anwenden. Andererseits können Sie mit dem DeClicker die erkannten Klicks bewerten und selbst wählen, welche
Probleme repariert werden sollen.

Klicken Sie im Diagnose-Bedienfeld auf „Einstellungen“, um folgende Optionen einzublenden:

Schwellwert Bestimmt die Empfindlichkeit gegenüber Störgeräuschen. Bei niedrigeren Werten werden mehr Klick- und Knackgeräusche erkannt,
gegebenenfalls werden aber auch Teile des Nutzsignals entfernt. Die Werte liegen im Bereich von 30 bis 100. Der Standardwert ist 1.
Komplexität Gibt die Komplexität des Störgeräusches an. Höhere Werte steigern die Anzahl der Verarbeitungsschritte und können die

http://www.adobe.com/community/publishing/download.html
http://www.adobe.com/community/publishing/download.html
http://tv.adobe.com/watch/short-and-suite/batch-processing-with-ame-adobe-media-encoder-adobe-audition-cs55/
http://tv.adobe.com/watch/short-and-suite/batch-processing-with-ame-adobe-media-encoder-adobe-audition-cs55/
http://tv.adobe.com/show/adobe-evangelists-jason-levine/
http://helpx.adobe.com/en/audition/using/markers.html
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Audioqualität reduzieren. Die Werte liegen im Bereich von 16 bis 100. Der Standardwert ist 1.
Um Klicks visuell zu identifizieren, zoomen Sie und verwenden Sie die Spektralfrequenzanzeige mit einer Auflösung von 256 Bändern. (Diese
Einstellung nehmen Sie in den Voreinstellungen im Bereich „Spektralanzeige“ vor.) Die meisten Klickgeräusche werden als helle vertikale
Balken angezeigt, die von oben in Richtung Unterkante der Anzeige verlaufen.

DeClipper
Der Effekt „Diagnose“ > „DeClipper“ repariert beschnittene Wellenformen, indem die betreffenden Bereiche mit neuen Audiodaten aufgefüllt
werden. Clipping tritt auf, wenn die Audio-Amplitude den maximalen Pegel für die aktuelle Bittiefe überschreitet. Normalerweise tritt Clipping auf,
wenn die Aufnahmepegel zu hoch sind. Während der Aufnahme oder Wiedergabe wird das Clipping durch die rot aufleuchtenden Felder rechts
von den Pegelmessern gemeldet.

Ein geclippter Audiodatenbereich ist ein breiter flacher Bereich oben in der Wellenformanzeige. Diese Bereiche hören sich wie statisch verzerrte
Daten an.

Hinweis: Wenn Sie den DC-Offset geclippter Audiodaten korrigieren müssen, verwenden Sie zuvor den Effekt „DeClipper“. Falls Sie zuerst den
DC-Offset korrigieren, erkennt der Effekt „DeClipper“ geclippte Bereiche unterhalb von 0 dBFS nicht mehr richtig.
Klicken Sie im Diagnose-Bedienfeld auf „Einstellungen“, um folgende Optionen einzublenden:

Verstärkung Gibt den Umfang der Dämpfung an, die vor der Verarbeitung erfolgen soll. Aktivieren Sie die Option „Auto“, wenn Sie die
Verstärkungseinstellung basierend auf der durchschnittlichen Eingangsamplitude bestimmen möchten.
Toleranz Gibt die Amplitudenvarianz in geclippten Bereichen an. Bei 0 % wird Clipping nur in perfekt horizontalen Linien bei der maximalen
Amplitude erkannt. Bei 1 % wird Clipping ab 1 % unterhalb der maximalen Amplitude erkannt usw. (Das meiste Clipping wird mit dem Wert „1 %“
erkannt.)
Min. Clip-Größe Gibt die Mindestlänge eines Clipping-Bereichs an, damit dieser repariert wird. Bei niedrigeren Werten wird ein größerer
Prozentsatz geclippter Samples repariert. Bei höheren Werten werden geclippte Samples nur repariert, wenn unmittelbar davor oder danach
ebenfalls geclippte Samples vorhanden sind.
Interpolation Die Option „Cubic“ verwendet Spline-Kurven, um die Frequenzinhalte geclippter Audiopassagen wiederherzustellen. Diese Methode
ist in den meisten Situationen schneller, fügt aber möglicherweise störende neue Frequenzen hinzu. Die Option „FFT“ verwendet Fast Fourier-
Transformationen zum Wiederherstellen geclippter Audiodaten. Diese Methode ist in der Regel langsamer, eignet sich jedoch am Besten für
starkes Clipping. Wählen Sie im Menü „FFT-Größe“ die Anzahl der Frequenzbänder, die analysiert und ersetzt werden sollen. (Mehr Bänder
erhöhen die Präzision, aber auch die Verarbeitungszeit.)

Um die Amplitude beim Wiederherstellen von geclipptem Audio beizubehalten, wenden Sie den Effekt „DeClipper“ mit einer Verstärkung von
Null und anschließend den Effekt „Hard Limiting“ mit einer Eingangsverstärkung von Null und einer maximalen Amplitude von –0,2 dB an.

Pause löschen und Audio markieren
Die Diagnose-Effekte „Pause löschen“ und „Audio markieren“ identifizieren Pausen und entfernen oder markieren die entsprechenden Passagen.
(Siehe Arbeiten mit Markern.) Das automatische Löschen von Pausen ist hilfreich, um Tracks zu straffen, ohne dass dadurch die Audiodaten für
den Vordergrund beeinträchtigt werden. Das automatische Markieren von Pausen ist hilfreich, um schnell zu Audio-Cues für die Bearbeitung zu
navigieren.

Klicken Sie im Diagnose-Bedienfeld auf „Einstellungen“, um folgende Optionen einzublenden:

Pause definieren als Gibt die Amplitude und Dauer an, die als Pause identifiziert werden.
Audio definieren als Gibt die Amplitude und Dauer an, die als Audioinhalte identifiziert werden.
Pegel suchen Berechnet basierend auf den Inhalten der Datei automatisch die Signalpegel von Pausen und Audio.
Reparieren durch (nur bei „Pause löschen“) Wählen Sie „Pause zuschneiden“, um die Dauer von Pausen auf die angegebene Anzahl von
Millisekunden zu reduzieren. Wählen Sie „Pause löschen“, um Pausen stummzuschalten, aber die Dateilänge unverändert beizubehalten. („Pause
löschen“ ist hilfreich, wenn Sie Audio-Clips mit Videos in Anwendungen zur Videobearbeitung synchron halten müssen.)

Sie können durch Pausen getrennte Abschnitte von Klängen oder Sprache in verschiedene Dateien aufteilen, indem Sie den Effekt „Audio
markieren“ anwenden und anschließend auf „Alles markieren“ klicken. Siehe anschließend Speichern von Audiodaten zwischen Markern in
neuen Dateien.

Verwandte Hilfethemen
Verwenden von Effektvorgaben
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Techniken für die Audio-Wiederherstellung
Der Effekt „Rauschminderung“ (nur Wellenform-Editor)
Der Effekt „Adaptive Rauschreduktion“
Der Effekt „Automatischer Klick-Entferner“
Der Effekt „Automatische Phasenkorrektur“
Der Effekt „DeHummer“
Der Effekt „Zischminderung“ (nur Wellenform-Editor)

Adobe empfiehlt Verfügen Sie über eine Schulung,
die Sie anderen anbieten möchten?

Einführung in die
Rauschminderung und
Erweiterte Rauschminderung
Colin Smith
Entfernen Sie automatisch Klicks, stellen Sie
geclipptes Audio wieder her und reparieren Sie
einzelne Artefakte. Alternativ können Sie komplexes
Rauschen mit zwei leistungsstarken Effekten
beheben.

Techniken für die Audio-Wiederherstellung
Sie können zahlreiche Audioprobleme beheben, indem Sie zwei leistungsstarke Funktionen verbinden. Verwenden Sie zunächst die
Spektralanzeige, um Störgeräusche und einzelne Artefakte visuell ermitteln und auswählen zu können. (Siehe Auswählen von Spektralbereichen
und Auswählen und automatisches Reparieren von Artefakten.) Verwenden Sie anschließend Diagnose- oder Rauschminderungseffekte, um
Probleme wie die folgenden zu beheben:

Knacksen durch drahtlose Mikrofone oder alte Vinylplatten. (Siehe Der Effekt „Automatischer Klick-Entferner“.)

Hintergrundgeräusche wie Windheulen, Bandrauschen oder Leitungsbrummen. (Siehe Der Effekt „Adaptive Rauschreduktion“
und Der Effekt „DeHummer“.)

Phasenannullierung durch schlecht platzierte Stereomikrofone oder falsch justierte Tonköpfe von Bandmaschinen. (Siehe Der
Effekt „Automatische Phasenkorrektur“.)

Mithilfe der oben genannten Echtzeit-Wiederherstellungseffekte, die sowohl im Wellenform- als auch im Multitrack-Editor verfügbar sind, können
Sie häufig auftretende Probleme im Umgang mit Audiodaten mühelos beheben. Bei ungewöhnlich stark verrauschten Audiodaten sollten Sie
jedoch die spezifischen Offline-Prozesseffekte des Wellenform-Editors wie Zischminderung und Rauschminderung verwenden.

Auswählen verschiedener Störgeräuschtypen in der Spektralanzeige
A.  Rauschen B.  Knistern C.  Rumpeln

http://www.adobe.com/community/publishing/download.html
http://www.adobe.com/community/publishing/download.html
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Der Effekt „Rauschminderung“ (nur Wellenform-Editor)
Der Effekt „Rauschminderung/Wiederherstellung“ > „Rauschminderung“ reduziert Hintergrund- und Breitbandrauschen deutlich, beeinträchtigt die
Signalqualität aber nur minimal. Dieser Effekt kann unterschiedlichste Störgeräusche entfernen: Bandrauschen, Mikrofonhintergrundrauschen,
Leitungsbrummen oder sonstiges Rauschen, das in seiner Wellenform konstant bleibt.

Der genaue Umfang der Störgeräuschminderung hängt vom Typ des Hintergrundrauschens sowie vom akzeptablen Qualitätsverlust im
verbleibenden Signal ab. Normalerweise können Sie das Signal-Rausch-Verhältnis um 5 bis 20 dB verbessern, ohne die Audioqualität
nennenswert zu beeinträchtigen.

Um mit dem Effekt „Rauschminderung“ optimale Ergebnisse zu erzielen, sollten Sie ihn auf Audiodaten ohne DC-Offset anwenden. Mit einem DC-
Offset können durch diesen Effekt Klickgeräusche in leisen Passagen entstehen. (Um einen DC-Offset zu entfernen, wählen Sie „Favoriten“ >
„DC-Offset reparieren“.)

Analysieren und Anpassen von Rauschen mit dem Rauschminderungsdiagramm:
A.  Steuerungspunkte ziehen, um die Minderung in verschiedenen Frequenzbereichen zu variieren. B.  Rauschen mit geringer Amplitude. C.
Rauschen mit hoher Amplitude. D.  Schwellenwert, unterhalb dessen die Rauschminderung einsetzt.

Anwenden des Effekts „Rauschminderung“
1. Wählen Sie im Wellenform-Editor einen Bereich, der nur Rauschen enthält und mindestens eine halbe Sekunde dauert.

Wählen Sie Rauschen in einem bestimmten Frequenzbereich mit dem Marquee-Auswahlwerkzeug aus. (Siehe Auswählen
von Spektralbereichen.)

2. Wählen Sie „Effekte“ > „Rauschminderung/Wiederherstellung“ > „Geräuschmuster speichern“.
3. Wählen Sie im Editor Bereich aus, aus dem das Rauschen entfernt werden sollen.
4. Wählen Sie „Effekte“ > „Rauschminderung/Wiederherstellung“ > „Rauschminderung“.
5. Stellen Sie die gewünschten Optionen ein.

Wenn Sie in lauten Umgebungen aufnehmen, zeichnen Sie einige Sekunden mit repräsentativen Störgeräuschen auf, die Sie später als
Geräuschmuster verwenden können.

Optionen für „Rauschminderung“
Geräuschmuster speichern Extrahiert ein Geräuschprofil aus einem ausgewählten Bereich, um nur das Hintergrundrauschen zu identifizieren.
Adobe Audition sammelt statistische Daten über das Hintergrundrauschen, damit dieses auch aus den übrigen Teilen der Wellenform entfernt
werden kann.

Ist der ausgewählte Bereich zu kurz, kann „Geräuschmuster speichern“ nicht ausgewählt werden. Reduzieren Sie den Wert für „FFT-Größe“
oder wählen Sie einen längeren Bereich mit Störgeräuschen aus. Existiert kein längerer Bereich, kopieren Sie den aktuell ausgewählten
Bereich und fügen Sie ihn gegebenenfalls mehrfach ein, um einen Bereich der benötigten Länge zu erstellen. (Sie können das eingefügte
Störgeräusch später mit dem Befehl „Bearbeiten“ > „Löschen“ entfernen.)

Aktuelles Geräuschmuster speichern Speichert das Geräuschmuster als FFT-Datei, die Daten zu Sample-Typ, FFT-Größe (Fast Fourier
Transform) und drei Sätze von FFT-Koeffizienten enthält: einen für die geringste gefundene Geräuschmenge, einen für die höchste gefundene
Geräuschmenge und einen für den Leistungsdurchschnitt.

Rauschmuster von Festplatte laden Öffnet ein Rauschmuster, das zuvor in Adobe Audition im FFT-Format gespeichert wurde.
Rauschmuster können jedoch nur auf identische Sample-Typen angewendet werden. (Sie können beispielsweise kein 22-kHz-Mono-Profil auf 44-
kHz-Stereo-Samples anwenden.)
Hinweis: Da Rauschmuster sehr spezifisch sind, ergeben sich mit einem Muster für einen Geräuschtyp keine guten Ergebnisse für andere
Typen. Wenn Sie regelmäßig ähnliche Störgeräusche entfernen müssen, können Sie mit einem gespeicherten Profil jedoch die Effizienz deutlich
erhöhen.
Diagramm Zeigt die Frequenzen an der x-Achse (horizontal) und den Umfang der Störgeräuschminderung an der y-Achse (vertikal) an.
Die blaue Steuerkurve legt den Betrag der Rauschminderung in verschiedenen Frequenzbereichen fest. Wenn Sie beispielsweise nur in den
höheren Frequenzen Rauschminderung benötigen, passen Sie die Steuerkurve im rechten Teil des Diagramms nach unten an.
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Wenn Sie auf die Schaltfläche „Zurücksetzen“  klicken, um die Steuerkurve wieder zu begradigen, richtet sich der Betrag der Rauschminderung
ausschließlich nach dem Geräuschmuster.

Damit Sie sich besser auf das Hintergrundrauschen konzentrieren können, klicken Sie rechts oben über dem Diagramm auf die
Menüschaltfläche  und deaktivieren Sie die Optionen „Steuerkurve anzeigen“ und „QuickInfo über Diagramm anzeigen“.

Hintergrundrauschen „Hoch“ zeigt die höchste Amplitude des erkannten Rauschens bei jeder Frequenz. „Tief“ zeigt die niedrigste Amplitude.
„Schwellenwert“ zeigt die Amplitude an, unterhalb derer die Rauschminderung erfolgt.

Diese drei Elemente des Hintergrundrauschens können sich im Diagramm überlappen. Damit Sie sie besser unterscheiden können, klicken Sie
auf die Menüschaltfläche  und aktivieren Sie im Untermenü „Hintergrundrauschen anzeigen“ die gewünschten Optionen.

Skalierung Legt fest, wie die Frequenzen auf der horizontalen x-Achse angeordnet werden:

Um niedriger Frequenzen präziser steuern zu können, wählen Sie „Logarithmisch“. Eine logarithmische Skalierung bildet die
menschliche Klangwahrnehmung besser ab.

Um hohe Frequenzen mit gleichmäßig verteilten Intervallen detailliert zu bearbeiten, wählen Sie „Linear“.

Kanal Zeigt den ausgewählten Kanal im Diagramm an. Der Betrag der Rauschminderung ist stets für alle Kanäle gleich.
Gesamte Datei auswählen Ermöglicht die Anwendung eines gespeicherten Geräuschmusters auf die gesamte Datei.
Rauschminderung Legt den Prozentsatz der Rauschminderung im Ausgangssignal fest. Führen Sie die Feineinstellung dieses Reglers während
der Wiedergabe durch, um maximale Rauschminderung bei minimalen Artefakten zu erzielen. (Übermäßig hohe Werte bei der Rauschminderung
führen manchmal zu Flanger-Effekten oder phasenverschobenem Audio.)
Mindern um Gibt die Amplitudenabsenkung für das erkannte Rauschen an. Werte zwischen 6 und 30 dB funktionieren gut. Um blubbernde
Artefakte zu vermindern, geben Sie niedrigere Werte ein.
Nur Ausgangsrauschen Gibt nur Rauschen wieder, damit Sie prüfen können, ob der Effekt auch erwünschtes Audio entfernt.
Erweiterte Einstellungen Klicken Sie auf das Dreieck, um die folgenden Optionen anzuzeigen:

Spektralabklingzeit  Gibt den Prozentsatz der verarbeiteten Frequenzen an, wenn die Audiodaten unter das Hintergrundrauschen
abfallen. Die Optimierung dieses Prozentsatzes ermöglicht eine bessere Störgeräuschminderung bei weniger Artefakten. Werte zwischen
40 % und 75 % funktionieren am besten. Unterhalb dieser Werte sind häufig blubbernde Artefakte hörbar. Über diesen Werten bleiben
normalerweise deutliche Störgeräusche hörbar.
Glättung  Berücksichtigt die Varianzen des Rauschsignals in jedem Frequenzband. Bänder mit großen Unterschieden in der Analyse
(z. B. weißes Rauschen), werden anders geglättet als konstante Bänder (z. B. 60-Hz-Brummen). Grundsätzlich führt eine Erhöhung des
Glättungswerts (bis ca. 2) zu einer Reduzierung blubbernder Hintergrundartefakte, allerdings auf Kosten einer Anhebung des
Breitbandrauschpegels im Hintergrund.
Präzisionsfaktor  Steuert die Amplitudenänderungen. Werte von 5–10 sind gut geeignet, ungerade Zahlen sind ideal für symmetrische
Verarbeitung. Bei Werten unterhalb von 3 erfolgt die Fast Fourier-Transformation in riesigen Blöcken, zwischen denen Lautstärkeverluste
oder -spitzen auftreten können Werte über 10 verbessern die Qualität nicht hörbar, erhöhen aber die Verarbeitungsdauer.
Übergangsbreite  Legt den Amplitudenbereich zwischen Rauschen und erwünschtem Audio fest. Beispielsweise wendet eine Breite von
Null auf jedes Frequenzband ein scharfes Noise Gate an. Audio oberhalb des Schwellenwerts bleibt erhalten, Audio darunter wird
vollständig abgeschnitten. Alternativ können Sie einen Bereich angeben, über dem Audiodaten basierend auf dem Eingangspegel in Stille
ausgeblendet werden. Beträgt die Übergangsbreite z. B. 10 dB und liegt der Störgeräuschpegel für das Band bei –60 dB, bleiben die
Audiodaten bei –60 dB identisch, Audiodaten bei –62 dB werden leicht abgesenkt, und Audiodaten bei –70 dB werden vollständig entfernt.
FFT-Größe  Bestimmt, wie viele Frequenzbänder analysiert werden. Diese Option wirkt sich am deutlichsten auf die Qualität aus. Das
Rauschen wird in jedem Frequenzband separat behandelt. Je mehr Bänder vorhanden sind, desto feinere Frequenzdetails werden für die
Rauschminderung verwendet. Gute Ergebnisse erzielen Sie mit Werten von 4096 bis 8192.
Die FFT-Größe bestimmt den Kompromiss zwischen Frequenz- und Zeitpräzision. Bei höheren FFT-Größen können zischende oder
verhallte Artefakte entstehen, die Rauschfrequenzen werden jedoch sehr präzise entfernt. Niedrigere FFT-Werte führen zu einer besseren
Reaktionszeit (also z. B. weniger Zischen vor dem Schlag eines Beckens), können aber zu einer schlechteren Auflösung über die
Frequenzen führen, also hohl klingen.

Rauschmuster-Schnappschüsse  Bestimmt die Anzahl der Störgeräusch-Stichproben, die in das Profil aufgenommen werden sollen. Ein
Wert von 4000 ist optimal zum Generieren genauer Daten geeignet.
Sehr kleine Werte beeinträchtigen die Qualität der verschiedenen Störgeräuschminderungspegel drastisch. Mit mehr Schnappschüssen
führt ein Rauschminderungspegel von 100 normalerweise zum Entfernen von mehr Störgeräuschen, gleichzeitig aber auch von größeren
Teilen des ursprünglichen Signals. Ein geringer Rauschminderungspegel mit mehr Schnappschüssen führt ebenfalls zum Entfernen von
mehr Störgeräuschen, beeinträchtigt aber das Nutzsignal wahrscheinlich kaum.

Der Effekt „Adaptive Rauschreduktion“
Mit dem Effekt „Rauschminderung/Wiederherstellung“ > „Adaptive Rauschreduktion“ können Sie mühelos unterschiedliches Breitbandrauschen,
z. B. Hintergrundgeräusche, Rumpeln und Wind entfernen. Da dieser Effekt in Echtzeit arbeitet, können Sie ihn mit anderen Effekten im Effekte-
Rack kombinieren und dann im Multitrack-Editor anwenden. Im Gegensatz dazu ist der Standardeffekt „Rauschminderung“ nur als Offline-Prozess
im Wellenform-Editor verfügbar. Dieser Effekt ist jedoch gelegentlich wesentlich effektiver, um konstante Geräusche wie Surren und Zischen oder
Brummen zu entfernen.

Um die besten Resultate zu erzielen, wenden Sie den Effekt „Adaptive Rauschreduktion“ auf Auswahlen an, die mit Rauschen gefolgt von
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erwünschtem Audio beginnen. Der Effekt identifiziert Rauschen anhand der ersten Sekunden des Audios.

Wichtig: Dieser Effekt benötigt eine erhebliche Verarbeitungsleistung. Sollte Ihr System stark verlangsamt werden, senken Sie die FFT-Größe
und deaktivieren Sie die Option „Hohe Qualität“.
Rauschen mindern um Legt den Pegel der Störgeräuschminderung fest. Werte zwischen 6 und 30 dB funktionieren gut. Um blubbernde
Hintergrundeffekte zu vermindern, geben Sie niedrigere Werte ein.
Rauschen Gibt den Prozentsatz der ursprünglichen Audiodaten an, der Rauschen enthält.
Feinabstimmung des Hintergrundrauschens Passt das Hintergrundrauschen manuell dem automatisch ermittelten Rauschen an.
Signalschwellenwert Passt den Schwellenwert des gewünschten Audios über und unter dem automatisch berechneten Schwellenwert manuell
an.
Spektralabklingzeit Legt fest, wie schnell die Rauschminderung um 60 Dezibel abgesenkt wird. Die Optimierung dieses Werts ermöglicht eine
bessere Rauschminderung bei weniger Artefakten. Zu kurze Werte erzeugen blubbernde Klänge, zu lange Werte erzeugen Halleffekte.
Breitbanderhaltung Erhält gewünschte Audiodaten in den angegebenen Frequenzbändern zwischen gefundenen Artefakten. Bei der Einstellung
100 Hz wird beispielsweise sichergestellt, dass keine Audiodaten 100 Hz über oder unter den gefundenen Artefakten entfernt werden. Niedrigere
Einstellungen entfernen möglicherweise mehr Störgeräusche, können aber hörbare Verarbeitungsgeräusche verursachen.
FFT-Größe Bestimmt, wie viele Frequenzbänder analysiert werden. Wählen Sie einen hohen Wert, um die Frequenzauflösung zu erhöhen, und
eine niedrige Einstellung, um die Zeitauflösung zu erhöhen. Hohe Werte sind ideal für Artefakte langer Dauer (z. B. Quietschen oder
Leitungsbrummen), mit niedrigeren Werten können Sie jedoch besser transiente Artefakte (z. B. Klicken und Knacken) beheben.
Hohe Qualität Die Verarbeitung nimmt mehr Zeit in Anspruch, erzielt jedoch bessere Ergebnisse.

Der Effekt „Automatischer Klick-Entferner“
Um mühelos Knistern und Statik von Vinylaufnahmen zu entfernen, verwenden Sie den Effekt „Rauschminderung/Wiederherstellung“ >
„Automatischer Klick-Entferner“. Sie können ein einzelnes Störgeräusch oder einen großen Audiodatenbereich korrigieren.

Dieser Effekt bietet dieselben Optionen wie der DeClicker-Effekt, bei dem Sie wählen können, welche der erkannten Klicks bearbeitet werden
sollen (siehe DeClicker). Da der Effekt „Automatischer Klick-Entferner“ jedoch in Echtzeit arbeitet, können Sie ihn mit anderen Effekten im Effekte-
Rack kombinieren und dann im Multitrack-Editor anwenden. Der Effekt „Automatischer Klick-Entferner“ wendet ferner automatisch mehrere
Analyse- und Reparaturdurchläufe an. Um denselben Betrag an Klick-Entfernung mit dem DeClicker zu erreichen, müssen Sie den DeClicker
manuell mehrmals anwenden.

Schwellwert Bestimmt die Empfindlichkeit gegenüber Störgeräuschen. Bei niedrigeren Werten werden mehr Klick- und Knackgeräusche erkannt,
gegebenenfalls werden aber auch Teile des Nutzsignals entfernt. Die Werte liegen im Bereich von 30 bis 100. Der Standardwert ist 1.
Komplexität Gibt die Komplexität des Störgeräusches an. Höhere Werte steigern die Anzahl der Verarbeitungsschritte und können die
Audioqualität reduzieren. Die Werte liegen im Bereich von 16 bis 100. Der Standardwert ist 1.

Der Effekt „Automatische Phasenkorrektur“
Mit dem Effekt „Rauschminderung/Wiederherstellung“ > „Automatische Phasenkorrektur“ können Sie aufgrund falsch ausgerichteter Bandköpfe
entstehende Azimut-Fehler, aufgrund einer fehlerhaften Mikrofonplatzierung verursachte Stereoverzerrungen und viele andere phasenbezogene
Probleme beheben.

Globale Zeitverschiebung Aktiviert die Schieberegler „Linke Kanalverschiebung“ und „Rechte Kanalverschiebung“, über die Sie eine einheitliche
Phasenverschiebung auf alle ausgewählten Audiodaten anwenden können.
„Autom. Kanalausrichtung“ und „Auto-Center-Balance“ Richten Sie die Phasen und Balance für mehrere kurze Zeitintervalle aus, die Sie
über die folgenden Optionen festlegen können:

Zeitauflösung  Gibt die Anzahl der Millisekunden in jedem verarbeiteten Intervall an. Kleinere Werte erhöhen die Genauigkeit, größere
Wert erhöhen die Leistung.
Ansprechempfindlichkeit  Bestimmt die Gesamtgeschwindigkeit für die Verarbeitung. Langsame Einstellungen erhöhen die Genauigkeit,
schnelle Einstellungen erhöhen die Leistung.
Kanal  Gibt die Kanäle an, auf die die Phasenkorrektur angewendet wird.
Analysegröße  Bestimmt die Anzahl an Samples in jeder analysierten Audioeinheit.

Verwenden Sie für die genaueste und effektivste Phasenkorrektur die Option „Autom. Kanalausrichtung“. Aktivieren Sie die Schieberegler
„Globale Zeitverschiebung“ nur, wenn Sie ganz genau wissen, dass eine einheitliche Anpassung notwendig ist, oder wenn Sie die
Phasenkorrektur manuell im Multitrack-Editor vornehmen möchten.

Der Effekt „DeHummer“
Der Effekt „Rauschminderung/Wiederherstellung“ > „DeHummer“ entfernt enge Frequenzbänder und deren Obertöne. Am häufigsten wird dieser
Effekt angewendet, um Leitungsbrummen von Lichtanlagen und elektronischen Geräten zu eliminieren. Der DeHummer kann jedoch auch einen
Kerbfilter anwenden, mit dem übermäßig resonierende Frequenzen aus dem Quellsignal entfernt werden.

Für typische Audioprobleme finden Sie eine Reihe passender Optionen im Menü „Vorgaben“.

Frequenz Legt die Quellfrequenz des Brummens fest. Wenn Sie die exakte Frequenz nicht kennen, schieben Sie diesen Regler während der
Wiedergabe hin und her.
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Um die Quellfrequenz und die Verstärkung grafisch anzupassen, ziehen Sie direkt im Diagramm.

Q Legt die Breite der Quellfrequenz und der darüberliegenden Obertöne fest. Höhere Werte beeinflussen einen schmaleren Frequenzbereich und
niedrigere Werte einen breiteren.
Verstärkung Legt den Dämpfungsbetrag für das Brummen fest.
Anzahl der Obertöne Gibt an, wie viele Obertonfrequenzen bearbeitet werden.
Obertonkurve Ändert das Dämpfungsverhältnis für Obertonfrequenzen.
Nur Ausgangsbrummen Ermöglicht die Wiedergabe einer Vorschau des Brummens. So können Sie prüfen, ob auch erwünschtes Audio im
Brummen enthalten ist.

Der Effekt „Zischminderung“ (nur Wellenform-Editor)
Der Effekt „Rauschminderung/Wiederherstellung“ > „Zischminderung“ reduziert das Zischen von Audioquellen wie Kassetten, Vinylplatten oder
Mikrofon-Vorverstärkern. Dieser Effekt senkt die Amplitude eines Frequenzbereichs ab, wenn die Amplitude einen Schwellenwert namens
Geräuschmusterwert überschreitet. Audiodaten in Frequenzbereichen, die lauter als dieser Schwellenwert sind, bleiben unberührt. Weisen
Audiodaten ein konstantes Hintergrundrauschen auf, kann es vollständig entfernt werden.

Für andere Störgeräuschtypen mit breiterem Frequenzbereich sollten Sie den Effekt „Störgeräuschminderung“ verwenden. (Siehe Der Effekt
„Rauschminderung“ (nur Wellenform-Editor).)

Verwenden des Diagramms „Rauschminderung“ zum Korrigieren des Hintergrundrauschens

Hintergrundrauschen erfassen Stellt eine Schätzung des Hintergrundrauschens dar. Diese Schätzung wird vom Effekt „Zischminderung“
verwendet, um effizienter nur das Zischen zu entfernen, ohne das Nutzsignal zu beeinträchtigen. Diese Option ist die leistungsstärkste Funktion
der Zischminderung.
Um ein Diagramm zu erstellen, das das Hintergrundrauschen möglichst präzise darstellt, markieren Sie einen Audiobereich, der nur Rauschen
enthält, und klicken Sie auf „Hintergrundrauschen erfassen“. Oder wählen Sie einen Bereich aus, der den geringsten Anteil erwünschter
Audiodaten und den geringsten Anteil hochfrequenter Informationen enthält. (Suchen Sie in der Spektralanzeige einen Bereich ohne jede Aktivität
in den oberen 75 % der Anzeige.)

Nachdem Sie das Hintergrundrauschen erfasst haben, müssen Sie ggf. die Steuerungspunkte auf der linken Seite (die tiefen Frequenzen)
absenken, um das Diagramm möglichst flach zu gestalten. Ist in einer beliebigen Frequenz Musik vorhanden, liegen die zugehörigen
Steuerungspunkte höher als sie sollten.

Diagramm Stellt das geschätzte Hintergrundrauschen für jede Frequenz in den Quelldaten dar. Die Frequenz wird auf der horizontalen Skala (x-
Achse), die Amplitude des Hintergrundrauschens auf der vertikalen Skala (y-Achse) angezeigt. Diese Informationen erleichtern die Unterscheidung
des Rauschens vom Nutzsignal.
Der tatsächlich für die Rauschminderung verwendete Wert ergibt sich aus der Kombination des Diagramms und des Schiebereglers
„Hintergrundrauschen“, der die Grenze für als Hintergrundrauschen erkannte Daten nach oben oder unten verschiebt.

Um die QuickInfos für Frequenz und Amplitude zu deaktivieren, klicken Sie rechts oben über dem Diagramm auf die Menüschaltfläche  und
deaktivieren Sie die Option „QuickInfo über Diagramm anzeigen“.

Skalierung Legt fest, wie die Frequenzen auf der horizontalen x-Achse angeordnet werden:

Um niedriger Frequenzen präziser steuern zu können, wählen Sie „Logarithmisch“. Eine logarithmische Skalierung bildet die
menschliche Klangwahrnehmung besser ab.

Um hohe Frequenzen mit gleichmäßig verteilten Intervallen detailliert zu bearbeiten, wählen Sie „Linear“.

Kanal Zeigt den ausgewählten Audiokanal im Diagramm an.

Zurücksetzen Setzt das geschätzte Hintergrundrauschen zurück. Um das Hintergrundrauschen auf höhere oder niedrigere Werte
zurückzusetzen, klicken Sie rechts oben über dem Diagramm auf die Menüschaltfläche  und wählen Sie eine Option aus dem Menü
„Steuerkurve zurücksetzen“.

Eine schnelle und normalerweise völlig ausreichende Rauschminderung lässt sich auch ohne das vollständige Diagramm erzielen. Setzen Sie
das Diagramm einfach auf einen gleichmäßigen Pegel zurück und stellen Sie den Schieberegler „Hintergrundrauschen“ nach Bedarf ein.

Hintergrundrauschen Passt das Hintergrundrauschen an, bis eine Zischminderung im gewünschten Umfang und bei angemessener Qualität
erreicht ist.
Mindern um Stellt den Pegel der Zischminderung für Audiodaten unterhalb des Hintergrundrauschens ein. Mit höheren Werten (vor allem mit
Werten über 20 dB) lassen sich dramatische Rauschminderungen erzielen. Möglicherweise kommt es aber zu Verzerrungen in den verbleibenden



 

Audiodaten. Mit kleineren Werten werden weniger Störgeräusche entfernt und das ursprüngliche Audiosignal bleibt fast unverändert.
Nur Ausgangszischen Ermöglicht eine Vorschau des Zischens. So können Sie ermitteln, ob durch den Effekt auch erwünschte Audiodaten
entfernt werden.
Erweiterte Einstellungen Klicken Sie auf das Dreieck, um folgende Optionen einzublenden:

Spektralabklingzeit  Existieren Audiodaten über dem geschätzten Hintergrundrauschen, bestimmt dieser Wert, wie viele Audiodaten im
selben Frequenzband anschließend erwartet werden. Niedrige Werte geben an, dass nur wenige Audiodaten folgen. Außerdem schneidet
die Zischminderung näher an den beizubehaltenden Frequenzen.
Werte zwischen 40 % und 75 % funktionieren am besten. Ist der Wert zu hoch (über 90 %), werden ggf. unnatürlich langer Nachklang und
Hall hörbar. Ist der Wert zu niedrig, werden ggf. blubbernde Effekte im Hintergrund hörbar und die Musik klingt möglicherweise künstlich.

Präzisionsfaktor  Legt die Zeitgenauigkeit der Zischminderung fest. Typische Werte liegen zwischen 7 und 14. Niedrigere Werte können
zu einigen wenigen Millisekunden Zischen vor und nach lauteren Bereichen in den Audiodaten führen. Größere Werte produzieren
normalerweise bessere Ergebnisse, allerdings auf Kosten der Verarbeitungsgeschwindigkeit. Werte über 20 verbessern die Qualität meist
nicht mehr.
Übergangsbreite  Erzeugt einen langsamen Übergang in der Zischminderung anstelle einer abrupten Änderung. Werte von 5 bis 10
liefern normalerweise gute Ergebnisse. Ist der Wert zu hoch, bleibt dagegen etwas Zischen hörbar. Ist der Wert zu klein, werden
möglicherweise Hintergrundartefakte hörbar.
FFT-Größe Gibt eine FFT-Größe (Fast Fourier Transform) an, mit der der Kompromiss zwischen Frequenz- und Zeitpräzision bestimmt
wird. Normalerweise sind Werte zwischen 2048 und 8192 gut geeignet.
Niedrigere FFT-Werte (2048 und kleiner) führen zu einer besseren Reaktionszeit (also z. B. weniger Zischen vor dem Schlag eines
Beckens), können aber zu einer schlechteren Auflösung über die Frequenzen führen, also hohl klingen.

Größere FFT-Werte (8192 und höher) können Zischen, Hall und gezogene Hintergrundtöne verursachen, die Frequenzauflösung ist jedoch
extrem genau.

Steuerungspunkte  Gibt die Anzahl der Punkte an, die beim Klicken auf „Hintergrundrauschen erfassen“ in das Diagramm eingefügt
werden.

Verwandte Hilfethemen
Die Spektralanzeige

Steuern von Effekteinstellungen mit Graphen

Anwenden von Effekten im Multitrack-Editor

Verwenden von Effektvorgaben
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Faltungshall, Effekt
Der Effekt „Voller Hall“
Der Effekt „Hall“
Studio-Hall, Effekt
Der Effekt „Surround-Hall“

In einem Raum werden Schallwellen von Wänden, Decke und Boden reflektiert und gelangen anschließend in das Ohr des Hörers. Alle
reflektierten Schallwellen erreichen das Ohr in so enger zeitlicher Folge, dass sie nicht als separate Echos wahrgenommen werden, sondern einen
Höreindruck produzieren, der einem deutlich größeren Raum zu entsprechen scheint. Dieser reflektierte Schall wird auch als Hall bezeichnet. Mit
Adobe Audition können Sie Hall-Effekte zum Simulieren verschiedener Raumumgebungen verwenden.

Um den Halleffekt flexibel und effizient im Multitrack-Editor zu verwenden, fügen Sie ihn zu Bussen hinzu und stellen Sie die Ausgangspegel
auf 100 % Effektsignal ein. Leiten Sie dann Tracks an diese Busse und verwenden Sie Sends zum Steuern des Verhältnisses von Direktsignal
zum Hallklang.

Faltungshall, Effekt
Mit dem Effekt „Hall“ > „Faltungshall“ werden Räume vom Wandschrank bis hin zu Konzertsälen simuliert. Beim Faltungshall kommen
Impulsdateien zum Einsatz, die die unterschiedlichen akustischen Räume simulieren. Die Ergebnisse sind unglaublich realistisch und lebensnah.

Quellen für Impulsdateien sind beispielsweise Umgebungsaufnahmen oder online angebotene Impuls-Sammlungen. Die besten Ergebnisse
erzielen Sie mit unkomprimierten Impulsdateien mit 16 oder 32 Bit, deren Abtastraten denen der aktuellen Audiodatei entsprechen. Die
Impulslänge sollte 30 Sekunden nicht übersteigen. Zum Entwerfen von Klängen probieren Sie unterschiedliche Quellaudiodaten, um einzigartige,
faltungsbasierte Effekte zu erzeugen.

Hinweis: Da der Effekt „Faltungshall“ sehr verarbeitungsintensiv ist, können bei der Vorschau auf langsameren Systemen Klick- und
Knackgeräusche auftreten. Diese Artefakte sind jedoch nicht mehr vorhanden, nachdem Sie den Effekt angewendet haben.
Impuls Gibt eine Datei an, die einen akustischen Raum simuliert. Klicken Sie auf „Laden“, um eine benutzerdefinierte Impulsdatei im WAV- oder
AIFF-Format hinzuzufügen.
Mischen Steuert das Verhältnis zwischen Originalsound und reflektierten Schallwellen.
Raumgröße Gibt den Prozentsatz des gesamten Raums an, der durch die Impulsdatei definiert wird. Je größer der Prozentsatz, desto länger der
Hall.
NF-Dämpfung Reduziert die niedrigfrequenten, basslastigen Komponenten im Hall, um einen verschwommenen Klang zu vermeiden und einen
klaren, artikulierteren Sound zu erzielen.
HF-Dämpfung Reduziert die hochfrequenten, transienten Komponenten im Hall, um einen harten Klang zu vermeiden und einen wärmeren,
volleren Sound zu erzielen.
Vorverzögerung Gibt an, wie viele Millisekunden es dauert, bis der Hall die maximale Amplitude erreicht. Um einen natürlichen Klang zu erzielen,
geben Sie einen Wert zwischen 0 und 10 Millisekunden für „Vorverzögerung“ an. Verwenden Sie Werte von 50 Millisekunden oder mehr, um
interessante Spezialeffekte zu erzielen.
Breite Steuert die Stereostreuung. Eine Einstellung von 0 generiert ein Mono-Hallsignal.
Verstärkung Verstärkt oder senkt die Amplitude nach der Verarbeitung.

Der Effekt „Voller Hall“
Der Effekt „Hall“ > „Voller Hall“ basiert auf dem Faltungseffekt, so dass Klingelgeräusche, metallisch klingende und andere künstlich klingende
Artefakte verhindert werden.

Dieser Effekt verfügt über einige einzigartige Optionen, wie z. B. „Wahrnehmung“, wodurch Unregelmäßigkeiten eines Raumes, die Position von
Links/Rechts (Platzierung der Quelle versetzt von der Mitte) sowie die Raumgröße und -maße simuliert werden. Auf diese Weise lassen sich
Räume realistisch simulieren und anpassen. Um Wandoberflächen und Resonanz zu simulieren, können Sie die Frequenzabsorption des Halls mit
Hilfe eines parametrischen Equalizers mit drei Bändern im Abschnitt „Färbung“ ändern.

Wenn Sie die Einstellungen für Hall ändern, erstellt dieser Effekt eine temporäre Impuls-Datei, in der die von Ihnen angegebene akustische
Umgebung simuliert wird. Die Größe dieser Datei kann mehrere Megabyte umfassen und die Verarbeitung einige Sekunden dauern, so dass Sie
eventuell warten müssen, bevor Sie sie hören. Die Ergebnisse sind jedoch äußerst realistisch und einfach auf Ihre Anforderungen zuzuschneiden.

Wichtig: Der Effekt „Voller Hall“ erfordert eine sehr hohe Verarbeitungsleistung. Wenn Sie in Echtzeit im Multitrack-Editor arbeiten möchten,
führen Sie entweder ein Vor-Rendern des Effekts durch oder ersetzen Sie ihn durch Studio-Hall. (Siehe Vor-Rendern von Track-Effekten zum
Verbessern der Leistung.)

http://helpx.adobe.com/en/audition/using/applying-effects-multitrack-editor.html#pre_render_track_effects_to_improve_performance
http://helpx.adobe.com/en/audition/using/applying-effects-multitrack-editor.html#pre_render_track_effects_to_improve_performance
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Hall-Einstellungen
Abklingzeit Gibt an, wie viele Millisekunden es dauert, bis der Hall 60 dB erreicht. In Abhängigkeit von den Parametern unter „Färbung“ kann es
bei bestimmten Frequenzen deutlich länger als bei anderen Frequenzen dauern, bis diese auf 60 dB abklingen. Höhere Werte bieten längeren
Nachhall, erfordern aber auch mehr Verarbeitung. Das effektive Limit liegt bei etwa 6000 Millisekunden (6 Sekunden Nachhall), der tatsächlich
generierte Hall ist jedoch deutlich länger, damit ein Abklingen bis ins Hintergrundrauschen erfolgen kann.
Vor-Abklingzeit Gibt an, wie viele Millisekunden es dauert, bis der Hall seine maximale Amplitude erreicht. Im Allgemeinen baut sich Hall schnell
auf und klingt anschließend deutlich langsamer ab. Mit extrem langen Vor-Abklingzeiten (400 Millisekunden und mehr) lassen sich interessante
Effekte erzielen.
Streuung Steuert die Rate, mit der sich Echos aufbauen. Hohe Streuungswerte (über 900 Millisekunden) erzeugen einen weichen Hall ohne
hörbare Echos. Kleinere Werte generieren unterscheidbare Echos. Die anfängliche Echo-Intensität ist zwar geringer, baut sich aber in der
Abklingzeit des Halls auf.

Echo-Pralleffekte können Sie mit einem niedrigen Streuungs- und einem hohen Wahrnehmungswert erzielen. Mit langem Nachhall, niedrigen
Streuungswerten und relativ niedrigen Wahrnehmungswerten können Sie den Effekt eines Fußballstadions oder einer vergleichbaren Arena
erzeugen.

Wahrnehmung Simuliert Unregelmäßigkeiten in der Umgebung (Objekte, Wände, Verbindungsgänge usw.). Niedrige Werte generieren einen
weich abklingenden Hall ohne Unregelmäßigkeiten. Größere Werte produzieren unterscheidbare Echos (die aus unterschiedlichen Richtungen
kommen).

Ist ein Hall zu weich, klingt er möglicherweise unnatürlich. Wahrnehmungswerte bis zu 40 simulieren typische Raumtypen.

Raumgröße Legt das Volumen des virtuellen Raums in Kubikmetern fest. Je größer der Raum, desto länger der Hall. Mit diesem Steuerelement
können Sie virtuelle Räume mit wenigen Quadratmetern, aber auch riesige Hallen konstruieren.
Maße Gibt das Verhältnis von Breite (links nach rechts) zu Tiefe (vorne nach hinten) des Raums an. Eine klanglich entsprechende Höhe wird
berechnet und unten im Dialogfeld unter „Tatsächliche Raumabmessungen“ angezeigt. Grundsätzlich liefern Räume mit einem Breite-/Tiefe-
Verhältnis zwischen 0,25 und 4 den am besten klingenden Hall.
Position Links/Rechts (nur für Stereo-Audio) Ermöglicht die Verschiebung der Frühreflexionen nach links oder rechts. Aktivieren Sie im
Bereich „Ausgangspegel“ die Option „Richtung einschließen“, um das Direktsignal an derselben Position zu platzieren. Hiermit sind sehr schöne
Effekte möglich, wenn Sie Sänger um 5–10 % nach links oder rechts verschieben.
Tiefpassfilter Verhindert den Verlust niederfrequenter Töne (100 Hz oder weniger) z. B. von Bass oder Schlagzeug. Dieser Schall kann
außerphasig werden, wenn Sie kleine Räume nutzen, weil sich die Frühreflexionen möglicherweise mit dem Originalsignal vermischen. Geben Sie
eine Frequenz über der des zu erhaltenden Sounds an. Ideale Werte liegen normalerweise zwischen 80 Hz und 150 Hz. Ist die
Schwellenwertabgrenzung zu hoch, wirkt die Abbildung der Raumgröße unrealistischer.
Hall basierend auf Raumgröße einstellen Stellt Abklingzeit und Vor-Abklingzeit entsprechend der angegebenen Raumgröße ein und generiert
einen authentischeren Hall. Falls gewünscht, können Sie anschließend die Abklingzeit und Vor-Abklingzeit manuell feinabstimmen.

Optionen für „Färbung“
Ziehen Sie direkt im Diagramm, um Färbungsoptionen grafisch anzupassen.

Frequenz Gibt die Eckfrequenzen für Tiefen- und Höhenanhebung oder die Center-Frequenz des mittleren Bands an. Sie können beispielsweise
die Wärme des Halls erhöhen, indem Sie die Frequenz für die Höhenanhebung und gleichzeitig deren Verstärkung senken.
Verstärkung Verstärkt oder dämpft den Hall in verschiedenen Frequenzbereichen.

Um das Audio dezent zu verbessern, verstärken Sie die Hallfrequenzen in der Umgebung der natürlichen Frequenzen eines wesentlichen
Klangelements. Verstärken Sie beispielsweise bei einer Gesangsstimme die Frequenzen von 200–800 Hz, um die Resonanz in diesem Bereich
zu verbessern.

Q Legt die Breite des mittleren Bands fest. Höhere Werte beeinflussen einen schmaleren Frequenzbereich und niedrigere Werte einen breiteren.
Für deutlich unterscheidbare Resonanzen verwenden Sie Werte ab 10. Um einen breiten Frequenzbereich zu verstärken oder zu dämpfen,
verwenden Sie niedrigere Werte wie 2 oder 3.

Ausklang Legt fest, wie viele Millisekunden der Hall abklingt, bevor die Färbungskurve angewendet wird. Werte bis 700 funktionieren gut. Einen
reicheren Hall erzielen Sie mit niedrigen Werten zwischen 100 und 250.

Optionen für „Ausgangspegel“
Direktsignal Steuert den Pegelanteil des ursprünglichen Signals im Hall. Verwenden Sie einen niedrigen Pegel, um entfernte Klänge zu erzeugen.
Verwenden Sie einen hohen Pegel (annähernd 100 %) in Verbindung mit niedrigen Werten für Hall und Frühreflexionen, damit die Quelle klingt,
als wäre sie ganz in der Nähe.
Hall Steuert die Lautstärke des dichten Hall-Layers. Die Balance zwischen Direktsignal und Hall bestimmt die Entfernungswahrnehmung.
Frühreflexionen Steuert den Pegel der ersten Echos, die das Ohr erreichen, damit ein Eindruck der Gesamtgröße des Raums entsteht. Zu große
Werte können zu einem künstlich wirkenden Klang führen, während ein zu niedriger Wert dazu führt, dass hörbare Hinweise auf die Raumgröße
verloren gehen. Die halbe Lautstärke des Direktsignals ist ein guter Ausgangspunkt.
Richtung einschließen Führt eine leichte Phasenverschiebung der linken und rechten Kanäle des ursprünglichen Signals durch, um die
Positionen von Frühreflexionen abzubilden (wie in der Registerkarte „Hall-Einstellungen“ unter „Position Links/Rechts“ eingestellt).
Eingänge summieren Kombiniert die Kanäle einer Stereo- oder Surround-Wellenform vor der Verarbeitung. Aktivieren Sie diese Option, wenn
Sie die Verarbeitung beschleunigen möchten. Deaktivieren Sie sie, wenn Sie einen volleren, satteren Hall erzeugen möchten.

Der Effekt „Hall“
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Mit dem Effekt „Hall“ > „Hall“ können Sie akustische Räume mit Verarbeitung auf Faltungshall-Basis simulieren. Er kann Umgebungen wie einen
Wandschrank, eine geflieste Dusche, einen Konzertsaal oder ein großes Amphitheater reproduzieren. Sie können die Echos so nah aneinander
anordnen, dass der Hall eines Signals sanft ausklingt, wodurch ein warmer, natürlicher Klang entsteht. Alternativ können Sie die Vor-Abklingzeit
anpassen, um einen Eindruck der Raumgröße zu vermitteln.

Im Vergleich zum Effekt „Hall“ bietet der Effekt „Voller Hall“ mehr Optionen und ein besseres Audio-Rendering. Um Anpassungen schnell
vornehmen zu können, eignen sich die eingeschränkten Optionen des Hall-Effekts besser.

Wichtig: Der Hall-Effekt erfordert eine sehr hohe Verarbeitungsleistung. Wenn Sie in Echtzeit im Multitrack-Editor arbeiten möchten, führen Sie
entweder ein Vor-Rendern des Effekts durch oder ersetzen Sie ihn durch Studio-Hall. (Siehe Vor-Rendern von Track-Effekten zum Verbessern der
Leistung.)
Abklingzeit Legt fest, nach wie vielen Millisekunden der Hall in die Unhörbarkeit (etwa –96 dB) abgeklungen ist. Verwenden Sie Werte unter 400
für kleine Räume, Werte zwischen 400 und 800 für mittelgroße Räume und Werte über 800 für sehr große Räume wie Konzerthallen. Geben Sie
z. B. 3000 Millisekunden ein, um den Hall zu erstellen, der einem riesigen Amphitheater entspricht.

Um Räume mit Echo und Hall zu simulieren, verwenden Sie zunächst den Effekt „Echo“, um die Größe des Raums akustisch darzustellen. Mit
dem Effekt „Hall“ können Sie das Ergebnis dann natürlicher gestalten. Schon mit einer Abklingzeit von nur 300 Millisekunden kann bei einem
Direktsignal ein räumlicher Eindruck erzeugt werden.

Vor-Abklingzeit Gibt an, wie viele Millisekunden es dauert, bis der Hall seine maximale Amplitude erreicht. Wenn Sie eine kurze Abklingzeit
verwenden, sollte auch die Vor-Abklingzeit entsprechend kleiner sein. Im Allgemeinen klingen Werte von etwa 10 % der Abklingzeit am
realistischsten. Sie können jedoch interessante Effekte erzielen, wenn Sie eine längere Vor-Abklingzeit mit einer kürzeren Abklingzeit
kombinieren.
Streuung Simuliert natürliche Absorption durch Reduzierung der hohen Frequenzen, während der Hall abklingt. Schnellere Absorptionszeiten
simulieren Räume mit vielen Menschen, Möbeln und Teppichen, z. B. Nachtclubs und Theater. Langsamere Streuung (über 1000 Millisekunden)
simulieren leere Räume wie Hörsäle, wo Reflexionen hoher Frequenzen vorherrschen.
Wahrnehmung Ändert die Charakteristika von Reflexionen in einem Raum. Kleinere Werte erzeugen einen weicheren Hall mit wenigen
unterscheidbaren Echos. Höhere Werte simulieren größere Räume, bewirken mehr Variationen in der Amplitude des Halls und stellen
Räumlichkeit mithilfe der im Zeitverlauf auftretenden, unterscheidbaren Echos dar.

Ein Wahrnehmungswert von 100 und eine Abklingzeit von mindestens 2.000 Millisekunden erzeugen interessante Canyon-Effekte.

Direktsignal Legt den Prozentsatz des auszugebenden Quellaudios fest. In den meisten Fällen ist 90 % ein geeigneter Wert. Für eine subtile
Räumlichkeit stellen Sie das Direktsignal höher ein. Um Spezialeffekte zu erzielen, wählen Sie kleinere Werte für das Direktsignal.
Effektsignal Legt den Prozentsatz des auszugebenden Halls fest. Um einem Track subtile Räumlichkeit hinzuzufügen, verwenden Sie für das
Effektsignal geringere Werte als für das Direktsignal. Erhöhen Sie das Effektsignal, um größere Entfernungen von der Audioquelle zu simulieren.
Eingänge summieren Kombiniert die Kanäle einer Stereo- oder Surround-Wellenform vor der Verarbeitung. Aktivieren Sie diese Option, wenn
Sie die Verarbeitung beschleunigen möchten. Deaktivieren Sie sie, wenn Sie einen volleren, satteren Hall erzeugen möchten.

Studio-Hall, Effekt
Wie die anderen Hall-Effekte simuliert der Effekt „Hall“ > „Studio-Hall“ akustische Räume. Dieser Effekt ist schneller und beansprucht den
Prozessor weniger als die anderen Hall-Effekte, er basiert dafür jedoch nicht auf Faltimpulsen. Sie können daher Echtzeitänderungen im
Multitrack-Editor schneller und effizienter vornehmen, ohne die Effekte für einen Track vorrendern zu müssen.

Raumgröße Stellt die Raumgröße ein.
Ausklang Stellt die Dauer des Hallabklangs in Millisekunden ein.
Frühreflexionen Steuert den Prozentsatz der Echos, die das Ohr zuerst erreichen, damit ein Eindruck der Gesamtgröße des Raums entsteht. Zu
große Werte können zu einem künstlich wirkenden Klang führen, während ein zu niedriger Wert dazu führt, dass Audio-Cues für die Größe des
Raums verloren gehen. Die Hälfte der Lautstärke des Originalsignals ist ein guter Ausgangspunkt.
Stereobreite Steuert die Verteilung über die Stereokanäle. 0 % erzeugt ein Mono-Hallsignal, 100 % erzeugt maximale Stereotrennung.
Hochfrequenzbeschneidung Gibt die höchste Frequenz an, bei der noch ein Hall auftreten kann.
Niederfrequenzbeschneidung Gibt die tiefste Frequenz an, bei der noch ein Hall auftreten kann.
Dämpfung Stellt den Umfang der Dämpfung ein, die im Zeitverlauf auf die hohen Frequenzen des Hallsignals angewendet werden soll. Höhere
Prozentwerte veranlassen eine stärkere Dämpfung und erzeugen einen wärmeren Hall.
Streuung Simuliert die Absorption des Hallsignals bei der Reflexion durch Oberflächen wie Teppiche und Vorhänge. Niedrigere Werte erzeugen
mehr Echos, höhere Werte führen dagegen zu einem weicheren Hall mit weniger Echos.
Direktsignal Stellt den Prozentsatz des Originalsignals ein, der mit dem Effekt ausgegeben werden soll.
Effektsignal Legt den Prozentsatz des auszugebenden Halls fest.

Der Effekt „Surround-Hall“
Der Effekt „Hall“ > „Surround-Hall“ wurde hauptsächlich für 5.1-Quellen entwickelt, kann aber auch Mono- und Stereoquellen eine
Surroundumgebung verleihen. Im Wellenform-Editor können Sie mit dem Befehl „Bearbeiten“ > „Sample-Typ umwandeln“ eine Mono- oder
Stereodatei in 5.1 konvertieren und anschließend einen Surround-Hall anwenden. Im Multitrack-Editor können Sie Mono- oder Stereo-Tracks an
einen 5.1-Bus oder -Master mit Surround-Hall senden.

Eingang, Center Bestimmt den Prozentsatz des Center-Kanals im verarbeiteten Signal.
Eingang, LFE Bestimmt den Prozentsatz des Subwoofer-Kanals, der zum Auslösen von Hall für andere Kanäle verwendet wird. (Auf das LFE-
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Signal selbst wird kein Hall angewendet.)
Hinweis: Der Effekt verwendet im Eingangssignal immer 100 % des linken und rechten Kanals sowie der hinteren Surroundkanäle.
Impuls Gibt eine Datei an, die einen akustischen Raum simuliert. Klicken Sie auf „Laden“, um eine benutzerdefinierte 6-Kanal-Impulsdatei im
WAV- oder AIFF-Format hinzuzufügen.
Raumgröße Gibt den Prozentsatz des gesamten Raums an, der durch die Impulsdatei definiert wird. Je größer der Prozentsatz, desto länger der
Hall.
NF-Dämpfung Reduziert die niedrigfrequenten, basslastigen Komponenten im Hall, um einen verschwommenen Klang zu vermeiden und einen
klaren, artikulierteren Sound zu erzielen.
HF-Dämpfung Reduziert die hochfrequenten, transienten Komponenten im Hall, um einen harten Klang zu vermeiden und einen wärmeren,
volleren Sound zu erzielen.
Vorverzögerung Gibt an, wie viele Millisekunden es dauert, bis der Hall die maximale Amplitude erreicht. Um einen natürlichen Klang zu erzielen,
geben Sie einen Wert zwischen 0 und 10 Millisekunden für „Vorverzögerung“ an. Verwenden Sie Werte von 50 Millisekunden oder mehr, um
interessante Spezialeffekte zu erzielen.
Breite vorne Steuert die Stereoverteilung über die drei vorderen Kanäle.
Eine Breite von 0 generiert ein Mono-Hallsignal.

Surround-Breite Steuert die Stereobreite zwischen den hinteren Surroundkanälen (Ls und Rs).
Wet-Pegel Center Steuert den Betrag des Halls, der dem Center-Kanal hinzugefügt wird. (Da dieser Kanal normalerweise Sprache enthält, sollte
der Hall hier meist geringer sein.)
Bal. li/re Steuert die Balance zwischen links und rechts für die vorderen und hinteren Lautsprecher. Der Wert 100 gibt das Signal ausschließlich
links aus, –100 ausschließlich rechts.
Bal. vo/hi Steuert die Balance zwischen vorne und hinten für die linken und rechten Lautsprecher. Der Wert 100 gibt das Signal ausschließlich
vorne aus, –100 ausschließlich hinten.
Mix Eff/Dir Steuert das Verhältnis zwischen Originalsound und verhallten Klängen. Bei der Einstellung 100 wird nur der Hall ausgegeben.
Verstärkung Verstärkt oder senkt die Amplitude nach der Verarbeitung.
Verwandte Hilfethemen
Anwenden von Effekten im Multitrack-Editor

Verwenden von Effektvorgaben

Steuern von Effekteinstellungen mit Graphen
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Der Effekt „Center-Kanal-Extractor“

Sie können mit verschiedenen Effekten die vermeintliche Position, also die Stereoabbildung der Sounds aus den Lautsprechern ändern.

Der Effekt „Center-Kanal-Extractor“
Der Effekt „Stereoabbildung“ > „Center-Kanal-Extractor“ erhält oder entfernt Frequenzen, die beiden Kanälen (links und rechts) gemeinsam sind,
bezieht sich also auf Sounds, die mittig balanciert sind. Gesang, Bass und Lead-Instrumente werden oft auf diese Weise aufgenommen. Im
Ergebnis können Sie diesen Effekt einsetzen, um die Lautstärke der Stimme, des Basses oder der Basstrommel anzuheben bzw. die betreffenden
Signale aus dem Karaokemix zu entfernen.

Registerkarte „Extrahierung“ Begrenzt die Extrahierung auf Audiodaten, die bestimmte Eigenschaften aufweisen.

Extrahieren  Wählen Sie entweder Audio im Center-, linken, rechten oder Surroundkanal oder wählen Sie „Benutzerdefiniert“ und geben
Sie exakte Werte für Phasenwinkel, Balance und Verzögerung für das Audio an, das Sie extrahieren oder entfernen möchten. (Die Option
„Surround“ extrahiert Audio, das vollständig außerhalb der Phase zwischen dem linken und rechten Kanal liegt.)
Frequenzbereich  Legt den Bereich fest, der extrahiert oder entfernt werden soll. Vordefinierte Bereiche: „Männliche Stimme“, „Weibliche
Stimme“, „Bass“ und „Volles Spektrum“. Wählen Sie „Benutzerdefiniert“, um einen Frequenzbereich zu definieren.

Registerkarte „Unterscheidung“ Enthält Einstellungen zur Ermittlung des Center-Kanals.

Crossover-Übergang  Bewegen Sie den Schieberegler nach links, um die Menge der Obertöne zu erhöhen und den Sound weniger
künstlich klingen zu lassen. Bewegen Sie den Schieberegler nach rechts, um das Center-Kanal-Material im Mix weiter zu trennen.
Phasenunterscheidung  Grundsätzlich funktionieren höhere Werte beim Extrahieren des Center-Kanals besser, kleinere Werte sind
dagegen zum Entfernen des Center-Kanals geeignet. Kleinere Werte lassen mehr Obertöne zu und trennen Stimmen möglicherweise nicht
vollständig aus einem Mix, erfassen aber ggf. das Center-Material vollständiger. Normalerweise funktioniert ein Bereich von 2 bis 7 gut.
Amplitudenunterscheidung und Amplitudenbandbreite Summieren den linken und den rechten Kanal und erstellen einen dritten
Kanal, der zu 100 % außerphasig ist und von Audition verwendet wird, um ähnliche Frequenzen zu entfernen. Ist die Amplitude jeder
Frequenz vergleichbar, werden auch innerphasige Audiodaten berücksichtigt, die beide Kanäle gemeinsam haben. Niedrigere Werte für
„Amplitudenunterscheidung“ und „Amplitudenbandbreite“ schneiden mehr Material aus der Mischung, möglicherweise auch Gesang.
Höhere Werte führen zu einer stärkeren Abhängigkeit der Extraktion von der Phase des Materials und zu einer geringeren Abhängigkeit
von der Kanalamplitude. Für „Amplitudenunterscheidung“ sind Werte zwischen 0,5 und 10 sowie für „Amplitudenbandbreite“ zwischen 1
und 20 gut geeignet.
Spektralabklingzeit  Behalten Sie den Wert 0 bei, um die Verarbeitung zu beschleunigen. Stellen Sie Werte zwischen 80 % und 98 %
ein, um Hintergrundverzerrungen zu entfernen.

Center- und Seitenkanalpegel Gibt an, in welchem Umfang das ausgewählte Signal extrahiert oder entfernt werden soll. Schieben Sie die Regler
nach oben, um zusätzliches Material hinzuzufügen.
Erweiterte Optionen Klicken Sie auf das Dreieck, um folgende Einstellungen einzublenden:

FFT-Größe  Gibt die FFT-Größe (Fast Fourier Transform) an. Niedrige Einstellungen verbessern die Verarbeitungsgeschwindigkeit, hohe
Einstellungen verbessern die Qualität. Normalerweise funktionieren Werte zwischen 4096 und 8192 gut.
Overlays  Definiert die Anzahl der FFT-Fenster, die sich überlappen. Hohe Werte produzieren weichere Ergebnisse bzw. chorusähnliche
Effekte, die Verarbeitung dauert jedoch länger. Kleinere Werte produzieren blubbernd klingende Störgeräusche im Hintergrund. Werte
zwischen 3 und 9 funktionieren gut.
Fensterbreite  Legt den Prozentsatz für jedes FFT-Fenster fest. Werte zwischen 30 % und 100 % sind gut geeignet.

Verwandte Hilfethemen
Anwenden von Effekten im Multitrack-Editor

Verwenden von Effektvorgaben
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Special effects

Note:

To the top

Link 

Positive and Negative graphs

Reset 

Curve Smoothing

Time Smoothing

dB Range

Linear Scale

Post-filter DC Offset

To the top

Compressor

Filter

Type

Freq

Resonance

Distortion

Amplifier

Distortion effect
Guitar Suite effect
Mastering effect
Vocal Enhancer effect

Special effects require mono or stereo audio; they do not support 5.1 surround.

Distortion effect
Use the Special > Distortion effect to simulate blown car speakers, muffled microphones, or overdriven amplifiers.

Creates identical curves in the Positive and Negative graphs.

Specify separate distortion curves for positive and negative sample values. The horizontal ruler (x-axis) indicates
input level in decibels; the vertical ruler (y-axis) indicates output level. The default diagonal line depicts an undistorted signal, with a one-to-one
relationship between input and output values.
Click and drag to create and adjust points on the graphs. Drag points off a graph to remove them.

To copy one graph to another, click the arrow buttons between them.

Returns a graph to its default, undistorted state.

Creates curved transitions between control points, sometimes producing a more natural distortion than the default linear
transitions.

Determines how quickly distortion reacts to changes in input levels. Level measurements are based on low-frequency content,
creating softer, more musical distortion.

Changes the amplitude range of the graphs, limiting distortion to that range.

Changes the amplitude scales of the graphs from logarithmic decibels to normalized values.

Compensates for any sample offset introduced by distortion processing. To understand this concept, see Correct DC offset.
Such offsets can cause audible pops and clicks when edited.

Guitar Suite effect
The Special > Guitar Suite effect applies a series of processors that optimize and alter the sound of guitar tracks. The Compressor stage reduces
dynamic range, producing a tighter sound with greater impact. Filter, Distortion, and Box Modeler stages simulate common effects that guitarists
use to create expressive, artistic performances.

Apply the Guitar Suite to vocals, drums, or other audio to create textured effects.

Reduces dynamic range to maintain consistent amplitude and help guitar tracks stand out in a mix.

Simulates guitar filters ranging from resonators to talk boxes. Choose an option from this menu, and then set options below:

Determines which frequencies are filtered. Specify Lowpass to filter high frequencies, Highpass to filter low frequencies, or
Bandpass to filter frequencies above and below a center frequency.

Determines the cutoff frequency for Lowpass and Highpass filtering, or the center frequency for Bandpass filtering.

Feeds back frequencies near the cutoff frequency, adding crispness with low settings and whistling harmonics with high
settings.

Adds a sonic edge often heard in guitar solos. To change the distortion character, choose an option from the Type menu.

Simulates various amplifier and speaker combinations that guitarists use to create unique tones.
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Controls the ratio of original to processed audio.

Mastering effect
Mastering describes the complete process of optimizing audio files for a particular medium, such as radio, video, CD, or the web. In Adobe
Audition, you can quickly master audio with the Special > Mastering effect.

Before mastering audio, consider the requirements of the destination medium. If the destination is the web, for example, the file will likely be
played over computer speakers that poorly reproduce bass sounds. To compensate, you can boost bass frequencies during the equalization stage
of the mastering process.

Adjusts the overall tonal balance.

Shows frequency along the horizontal ruler (x-axis) and amplitude along the vertical ruler (y-axis), with the curve representing the
amplitude change at specific frequencies. Frequencies in the graph range from lowest to highest in a logarithmic fashion (evenly spaced by
octaves).

Drag control points in the graph to visually adjust the settings below.

Activate shelving filters at either end of the frequency spectrum.

Activates a peaking filter in the center of the frequency spectrum.

Indicates the center frequency of each frequency band.

Indicates the level of each frequency band.

Controls the width of the affected frequency band. Low Q values (up to 3) affect a larger range of frequencies and are best for overall
audio enhancement. High Q values (6–12) affect a very narrow band and are ideal for removing a particular, problematic frequency, like
60-Hz hum.

Adds ambience. Drag the Amount slider to change the ratio of original to reverberant sound.

Exaggerates high-frequency harmonics, adding crispness and clarity. Mode options include Retro for light distortion, Tape for bright tone,
and Tube for quick, dynamic response. Drag the Amount slider to adjust the level of processing.

Adjusts the stereo image (disabled for mono audio). Drag the Width slider to the left to narrow the image and increase central focus.
Drag the slider to the right to expand the image and enhance spatial placement of individual sounds.

Applies a limiter that reduces dynamic range, boosting perceived levels. A setting of 0% reflects original levels; 100%
applies maximum limiting.

Determines output levels after processing. For example, to compensate for EQ adjustments that reduce overall level, boost the
output gain.

Vocal Enhancer effect
The Special > Vocal Enhancer effect quickly improves the quality of voice-over recordings. The Male and Female modes automatically reduce
sibilance and plosives, as well as microphone handling noise such as low rumbles. Those modes also apply microphone modeling and
compression to give vocals a characteristic radio sound. The Music mode optimizes soundtracks so they better complement a voice-over.

Optimizes audio for a man’s voice.

Optimizes audio for a woman’s voice.

Applies compression and equalization to music or background audio.
Applying effects in the Waveform Editor

Techniques for restoring audio

Match volume across multiple files

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/en_US/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://help.adobe.com/en_US/audition/cs/using/WS58a04a822e3e5010548241038980c2c5-7f3e.html
http://help.adobe.com/en_US/audition/cs/using/WS58a04a822e3e5010548241038980c2c5-7f30.html#WS58a04a822e3e5010548241038980c2c5-7f2f
http://help.adobe.com/en_US/Soundbooth/2.0/WSE6F1992F-E78E-4c73-B50F-1530D387519C.html


Modulation effects

To the top

Characteristics

Voices

Delay Time

Delay Rate

Feedback

Spread

Modulation Depth

Modulation Rate

Highest Quality

Stereo Width

Average Left & Right Channel Input

Chorus effect
Chorus/Flanger effect
Flanger effect
Phaser effect

Chorus effect
The Modulation > Chorus effect simulates several voices or instruments played at once by adding multiple short delays with a small amount of
feedback. The result is lush, rich sound. You can use Chorus to enhance a vocal track or add stereo spaciousness to mono audio.

Adobe Audition uses a direct-simulation method to achieve a chorus effect, making each voice sound distinct from the original by slightly varying
timing, intonation, and vibrato. The Feedback setting lets you add extra detail to the result.

To achieve the best results with mono files, convert them to stereo before applying the Chorus effect.

Represent the characteristics of each voice in the chorus.

Determines the number of simulated voices.
Note: As you add more voices, the sound becomes richer and richer —but processing time also increases.

Specifies the maximum amount of delay allowed. Chorusing introduces short delays (often in the 15-35 millisecond range)
that vary in duration over time. If the setting is very small, all the voices start merging into the original, and an unnatural flanging effect
might occur. If the setting is too high, a warbled effect might occur, like a tape being eaten by a cassette deck.

Determines how quickly the delay cycles from zero to the maximum delay setting. Because the delay varies over time, the
pitch of the sample increases or decreases over time, giving the effect of separate, slightly out of tune voices. For example, a rate of 2 Hz
would vary the delay from zero to the maximum and back twice per second (simulating a pitch vibrato at twice per second). If this setting is
too low, the individual voices don’t vary much in pitch. If it is set too high, the voices may vary so quickly that a warbled effect might occur.

Adds a percentage of processed voices back into the effect input. Feedback can give a waveform an extra echo or reverb
effect. A little feedback (less than 10%) can provide extra richness, depending on the delay and vibrato settings. Higher settings produce
more traditional feedback, a loud ringing which can get loud enough to clip the signal.

Gives an added delay to each voice, separating them in time by as much as 200 milliseconds (1/5th of a second). High values
cause the separate voices to start at different times—the higher the value, the farther apart the onset of each voice may be. In contrast,
low values cause all voices to be in unison. Depending on other settings, low values can also produce flanging effects, which may be
undesirable if your goal is a realistic chorus effect.

Determines the maximum variation in amplitude that occurs. For example, you can alter the amplitude of a chorused
voice so that it is 5 dB louder or quieter than the original. At extremely high settings, the sound may cut in and out, creating an
objectionable warble. At extremely low settings (less than 1 dB), the depth may be unnoticeable unless the Modulation Rate is set
extremely high. Natural vibratos occur around 2 dB to 5 dB.
Note that this setting is a maximum only; the vibrato volume might not always go as low as the setting indicates. This limitation is
intentional, as it creates a more natural sound.

Determines the maximum rate at which amplitude changes occur. With very low values, the resulting voice slowly gets
louder and quieter, like a singer that cannot keep his or her breath steady. With very high settings, the result can be jittery and unnatural.

Ensures the best quality results. Increasing the quality, however, increases the processing time for previewing and
applying the effect.

Determines where the individual voices are placed in the stereo field and how the original stereo signal is interpreted. These
options are active only when you work with stereo files:

Combines the original left and right channels. If deselected, the channels are kept separate to
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Initial Delay Time

preserve the stereo image. Leave this option deselected if the stereo source audio was originally monophonic—it won’t have any effect
other than increasing processing time.

Adds separate delays to the left and right outputs of each voice. This delay can make each voice seem to come from
a different direction when you listen through headphones. For greater stereo separation, deselect this option for audio that will be played
through standard speakers .

Specifies where chorused voices are placed across the left and right stereo image. At lower settings, voices are closer to
the center of the stereo image. At a setting of 50%, voices are spaced evenly from left to right. At higher settings, voices move to the outer
edges. If you use an odd number of voices, one is always directly in the center.

Sets the ratio of original (Dry) signal to chorused (Wet) signal. Extremely high settings may cause clipping.

In the Multitrack Editor, you can vary the Wet level over time with automation lanes. (See Automating track settings.)This technique is handy for
emphasizing vocal or instrumental solos.

Chorus/Flanger effect
The Modulation > Chorus/Flanger effect combines two popular delay-based effects. The Chorus option simulates several voices or instruments
played at once by adding multiple short delays with a small amount of feedback. The result is lush, rich sound. Use this effect to enhance vocal
tracks or add stereo spaciousness to mono audio.

The Flanger option creates a psychedelic, phase-shifted sound by mixing a varying, short delay with the original signal. This effect was originally
created by sending an identical audio signal to two reel-to-reel tape recorders, and periodically pressing the flange of one reel to slow it down.

Simulates several voices or instruments playing at once.

Simulates the delayed, phase-shifted sound originally heard in psychedelic music.

Controls the rate at which the delay time cycles from zero to the maximum setting.

Specifies the maximum amount of delay.

Controls the ratio of original to processed audio.

Emphasizes transients, giving them a sharper, more distinct sound.

Flanger effect
Flanging is an audio effect caused by mixing a varying, short delay in roughly equal proportion to the original signal. It was originally achieved by
sending an identical audio signal to two reel-to-reel tape recorders, and then pressing the flange of one reel to slow it down. Combining the two
resulting recordings produced a phase-shifted, time-delay effect, characteristic of psychedelic music of the 1960s and 1970s. The Modulation >
Flanger effect lets you create a similar result by slightly delaying and phasing a signal at specific or random intervals.

Sets the point in milliseconds at which flanging starts behind the original signal. The flanging effect occurs by cycling over time
from an initial delay setting to a second (or final) delay setting.
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Sets the point in milliseconds at which flanging ends behind the original signal.

Sets the left and right delays at separate values, measured in degrees. For example, 180° sets the initial delay of the right
channel to occur at the same time as the final delay of the left channel. You can set this option to reverse the initial/final delay settings for the left
and right channels, creating a circular, psychedelic effect.

Determines the percentage of the flanged signal that is fed back into the flanger. With no feedback, the effect uses only the original
signal. With feedback added, the effect uses a percentage of the affected signal from before the current point of playback.

Determines how quickly the delay cycles from the initial to final delay times, measured either in cycles per second (Hz) or beats
per minute (beats). Small setting adjustments produce widely varying effects.

Provides three ways of flanging:

Inverts the delayed signal, cancelling out audio periodically instead of reinforcing the signal. If the Original - Expanded mix
settings are set at 50/50, the waves cancel out to silence whenever the delay is at zero.

Mixes the normal and inverted flanging effects. The delayed signal is added to the effect while the leading signal is
subtracted.

Makes the transition from initial delay to final delay and back follow a sine curve. Otherwise, the transition is linear, and the
delays from the initial setting to the final setting are at a constant rate. If Sinusoidal is selected, the signal is at the initial and final delays
more often than it is between delays.

Adjusts the mix of original (Dry) and flanged (Wet) signal. You need some of both signals to achieve the characteristic cancellation and
reinforcement that occurs during flanging. With Original at 100%, no flanging occurs at all. With Delayed at 100%, the result is a wavering sound,
like a bad tape player.

Phaser effect
Similar to flanging, phasing shifts the phase of an audio signal and recombines it with the original, creating psychedelic effects first popularized by
musicians of the 1960s. But unlike the Flanger effect, which uses variable delays, the Modulation > Phaser effect sweeps a series of phase-
shifting filters to and from an upper frequency. Phasing can dramatically alter the stereo image, creating unearthly sounds.

Specifies the number of phase-shifting filters. A higher setting produces denser phasing effects.

Determines the amount of phase-shifting applied to the signal.

Determines how far the filters travel below the upper frequency. Larger settings produce a wider tremolo effect; 100% sweeps from the
upper frequency to zero Hz.

Modulation rate controls how fast the filters travel to and from the upper frequency. Specify a value in Hz (cycles per second).

Determines the phase difference between stereo channels. Positive values start phase shifts in the left channel, negative values in the
right. The maximum values of +180 and -180 degrees produce a complete difference and are sonically identical.

Sets the upper-most frequency from which the filters sweep. To produce the most dramatic results, select a frequency near the
middle of the selected audio’s range.

Feeds a percentage of the phaser output back to the input, intensifying the effect. Negative values invert phase before feeding audio
back.

Controls the ratio of original to processed audio.

Adjusts the output level after processing.
Applying effects in the Waveform Editor
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Effekt „Töne generieren“

Abtasten von Frequenzen
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Ändern der Geschwindigkeit

DC-Offset

Bei ausgewählten Audiodaten

Wählen Sie „Effekte“ > „Töne generieren“, um eine einfache Wellenform anhand mehrerer Amplituden- und Frequenzeinstellungen zu erstellen.
Generierte Töne eignen sich hervorragend als Ausgangspunkte für Soundeffekte.

Erzeugt einen Tonübergang von den Einstellungen auf der Registerkarte „Start“ zu denen auf der Registerkarte
„Ende“. (Die Wellenform bleibt konstant.)

Gibt die Grundfrequenz zum Generieren der Töne an. 

Moduliert die Tonhöhe der Grundfrequenz über einen benutzerdefinierten Bereich. Bei einer Einstellung von 100 Hz wird
beispielsweise die ursprüngliche Frequenz um 50 Hz nach unten und 50 Hz nach oben moduliert.

Legt fest, wie oft pro Sekunde die Frequenz moduliert wird, wodurch ein trillernder Vibratoeffekt entsteht.

Wählen Sie eine der folgenden Optionen:
Sinus und umgekehrtes Sinus erzeugen die Grundfrequenz. Eine Tpyeneinstellung von 1,00 bewirkt reine Töne, während
niedrigere Einstellungen quadratischere Wellen und höhere Einstellungen dreieckigere Wellen erzeugen.
Die Einstellung Dreieck/Sägezahn erzeugt eine dreieckige Wellenform mit ausschließlich unregelmäßigen Harmonien bei einer
Typeneinstellung von 50 %. Einstellungen über und unter diesem Wert erzeugen sägezahnförmige Wellenformen mit
unregelmäßigen und regelmäßigen Harmonien.
Die Einstellung Quadrat erzeugt nur unregelmäßige Harmonien. Eine absolut quadratische Welle wird mit einer
Typeneinstellung von 50 % erzielt. Einstellungen über und unter diesem Wert verändern den Arbeitszyklus der Wellenform
(flache Spitze bei 100 % und flaches Tal bei 0 %). (Der obere und untere Grenzwert erzeugen nur ein hörbares Klicken.)

Fügt der Grundfrequenz bis zu fünf Obertöne hinzu. Geben Sie unter den Reglern eine bestimmte Frequenz für jeden
Oberton ein, oder geben Sie einen Multiplikator der Grundfrequenz ein. Verwenden Sie dann die Amplituden-Schieberegler, um die Obertöne
relativ zueinander zu mischen. 

Legt die Gesamtlautstärke des Effekts fest.

Legt die Länge des generierten Tons im aktuell für das Zeitlineal angegebenen Format fest. Klicken Sie mit der rechten Maustaste auf die
Zahlen, um ein anderes Zeitformat für die Option „Töne generieren“ festzulegen.

Um auf die folgenden Optionen zuzugreifen, klicken Sie auf „Erweitert“:

Gibt den Startpunkt im Wellenformzyklus an. Bei 0° beginnen die Wellen am Nullübergangspunkt. Bei 90°, beginnt die Welle
bei der vollen Amplitude (und erzeugt ein hörbares Klicken).

Passt die relative Phase von Stereokanälen an. Bei einem Wert von Null werden die Kanäle vollständig in die Phase
platziert, während sie bei einem Wert von 180 vollständig phasenverschoben platziert werden.

Ändert die relative Phase zwischen den beiden Kanälen einer Stereo-Audiodatei im Verlauf der Zeit dynamisch.
Wenn Sie beispielsweise 1 Hz eingeben, durchläuft die Phasendifferenz einen 360-Grad-Zyklus pro Sekunde.

Fügt einen DC-Offset hinzu, bei dem die Mitte der Wellenform um den angegebenen Prozentsatz nach oben oder nach unten
verschoben wird. Verwenden Sie diese Einstellung, um Audiogeräte zu kalibrieren oder Hardware-bedingten Offset zu simulieren.

Wählen Sie eine der folgenden Optionen:
Ersetzen: Tauscht vorhandene Audiodaten gegen generierte Töne aus.
Modulieren: ringmoduliert oder multipliziert vorhandene Audiodaten mit den aktuellen Toneinstellungen. Diese Option ist
hervorragend geeignet, um spezielle Effekte hinzuzufügen.
Demodulieren: ringdemoduliert vorhandene Audiodaten mit den aktuellen Toneinstellungen. Verwenden Sie diese Option, um
einzigartige Effekte zu erzeugen oder um den Ursprungszustand von mit der Option „Modulieren“ bearbeiteten Audiodaten
wiederherzustellen.

Überlappung: mischt die generierten Töne mit vorhandenen Audiodaten.
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Der Effekt „Notch-Filter“
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Frequenz

Verstärkung

Notch-Breite

Ultraleise

Dämpfungen setzen auf

Mit dem Effekt Filter und EQ > Notch-Filter können bis zu sechs benutzerdefinierte Frequenzbänder entfernt werden. Verwenden Sie diesen
Effekt, um sehr schmale Frequenzbänder zu entfernen (z. B. Netzbrummen bei 60 Hz), während die umgebenden Frequenzen unverändert
bleiben.

Um schrille, zischende Töne zu entfernen, verwenden Sie die Voreinstellung Zischminderung. Oder verwenden Sie die DTMF-Voreinstellungen,
um Standardtöne für analoge Telefonsysteme zu entfernen.

Bestimmt die Center-Frequenz für jeden Notch.

Bestimmt die Amplituden für jeden Notch.

Bestimmt den Frequenzbereich für alle Notches. Die drei Optionen reichen von „Schmal“ für einen Filter zweiter Ordnung, der
einige benachbarte Frequenzen entfernt, bis hin zu „Superschmal“ für einen sehr spezifischen Filter sechster Ordnung. 

Im Allgemeinen sollten Sie eine Dämpfung von nicht mehr als 30 dB für die Einstellung „Schmal“, 60 dB für „Sehr schmal“ und 90 dB für
„Superschmal“ verwenden. Größere Dämpfungen entfernen ggf. einen größeren Bereich benachbarter Frequenzen.

Entfernt Störgeräusche und Artefakte nahezu vollständig, erfordert jedoch eine höhere Verarbeitungsleistung. Diese Option ist nur auf
High-End-Kopfhörern und Monitorsystemen hörbar.

Bestimmt, ob Notches gleiche oder individuelle Dämpfungsstufen aufweisen. 

http://creativecommons.org/licenses/by-nc-sa/3.0/deed.de
http://help.adobe.com/de_DE/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_de
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/


Effekt „Grafischer Phasenschieber“
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Diagramm der Phasenverschiebung

Frequenzmaßstab

Bereich

Kanal

Hinweis:

FFT-Größe

Mit dem Effekt Stereoabbildung >Grafischer Phasen-Schieber können Sie die Phase einer Wellenform anpassen, indem Sie in einem Diagramm
Steuerpunkte hinzufügen. 

Klicken Sie mit der rechten Maustaste auf Punkte, um das Dialogfeld „Steuerpunkt“ anzuzeigen; somit erhalten Sie Zugriff auf die präzise,
numerische Steuerung.

Das horizontale Lineal (x-Achse) misst die Frequenz, das vertikale Lineal (y-Achse) zeigt an, um wie viel
Grad die Phase verschoben werden soll. Bei Anzeige von null findet keine Phasenverschiebung statt. Sie können Stereo simulieren, indem Sie ein
Zickzack-Muster erstellen, das am High-End eines Kanals stärker ausgeprägt ist.

Legt die Werte des horizontalen Lineals (x-Achse) auf einer linearen oder logarithmischen Skala. Wählen Sie „Logarithmisch“,
um in den tieferen Frequenzen detaillierter zu arbeiten. (Die logarithmische Skala kann die Frequenz-Emphasis des menschlichen Gehörs besser
wiedergeben.) Wählen Sie „Linear“, um in den höheren Frequenzen detaillierter zu arbeiten.

Legt die Werte des vertikalen Lineals (y-Achse) auf einer 360°- oder 180° Skala fest.

Gibt die Kanäle an, auf die Phasenverschiebung angewendet werden soll.

Die besten Ergebnisse erzielen Sie, wenn Sie einen einzelnen Kanal verarbeiten. Wenn Sie identische Phasenverschiebung auf zwei
Stereokanäle anwenden, klingt die resultierende Datei genau gleich.

Gibt die FFT-Größe (Fast Fourier Transform) an. Höhere Werte liefern normalerweise präzisere Resultate, nehmen jedoch auch mehr
Verarbeitungszeit in Anspruch.
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Effekte „Faden“ und „Verstärkungs-Hüllkurve“ (nur Wellenform-
Editor)
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Die Effekte Amplitude und Komprimierung > Faden und Verstärkungs-Hüllkurve funktionieren ähnlich, ändern die Audiodaten jedoch auf
unterschiedliche Weise:

Wählen Sie Fade-Hüllkurve, um die Amplitude zu verringern, indem Sie die Stärke im Zeitverlauf variieren.
Wählen Sie Verstärkungs-Hüllkurve, um die Amplitude im Zeitverlauf zu verstärken oder zu reduzieren.

Klicken Sie im Editorbereich auf die gelbe Linie der Hüllkurve, um Keyframes hinzuzufügen und nach oben oder unten zu ziehen, um die
Amplitude zu ändern. Informationen dazu, wie Sie schnell mehrere Keyframes auszuwählen, verschieben oder löschen finden Sie unter Anpassen
der Automatisierung mit Keyframes.

Wählen Sie die Option Spline-Kurven, um anstatt liniearer Überblendungen weichere, geschwungene Übergänge zu erstellen. Siehe Spline-
Kurven für Graphen.
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Filter and equalizer effects

To the top

Scale

Spline Curves

Reset 

Advanced options

FFT Size

Window

To the top

Gain sliders

Range

FFT Filter effect
Graphic Equalizer effect
Parametric Equalizer effect

FFT Filter effect
The graphic nature of the Filter And EQ > FFT Filter effect makes it easy to draw curves or notches that reject or boost specific frequencies. FFT
stands for Fast Fourier Transform, an algorithm that quickly analyzes frequency and amplitude.

This effect can produce broad high- or low-pass filters (to maintain high or low frequencies), narrow band-pass filters (to simulate the sound of a
telephone call), or notch filters (to eliminate small, precise frequency bands).

Determines how frequencies are arranged along the horizontal x-axis:

For finer control over low frequencies, select Logarithmic. A logarithmic scale more closely resembles how people hear sound.

For detailed, high-frequency work with evenly spaced intervals in frequency, select Linear.

Creates smoother, curved transitions between control points, rather than more abrupt, linear transitions. (See About spline curves
for graphs.)

Reverts the graph to the default state, removing filtering.

Click the triangle to access these settings:

Specifies the Fast Fourier Transform size, determining the tradeoff between frequency and time accuracy. For steep, precise
frequency filters, choose higher values. For reduced transient artifacts in percussive audio, choose lower values. Values between 1024 and
8192 work well for most material.

Determines the Fast Fourier transform shape, with each option resulting in a different frequency response curve.
These functions are listed in order from narrowest to widest. Narrower functions include fewer surrounding, or sidelobe, frequencies but
less precisely reflect center frequencies. Wider functions include more surrounding frequencies but more precisely reflect center
frequencies. The Hamming and Blackman options provide excellent overall results.

Graphic Equalizer effect

The Filter And EQ > Graphic Equalizer effect boosts or cuts specific frequency bands and provides a visual representation of the resulting EQ
curve. Unlike the Parametric Equalizer, the Graphic Equalizer uses preset frequency bands for quick and easy equalization.

You can space frequency bands at the following intervals:

One octave (10 bands)

One-half octave (20 bands)

One-third octave (30 bands)

Graphic equalizers with fewer bands provide quicker adjustment; more bands provide greater precision.

Sets the exact boost or attenuation (measured in decibels) for the chosen band.

Defines the range of the slider controls. Enter any value between 1.5 and 120 dB. (By comparison, standard hardware equalizers have a
range of about 12 to 30 dB.)
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Accuracy

Master Gain

Note:

To the top

Master Gain

Graph

Frequency

Gain

Q / Width

Band

Constant Q, Constant Width

Sets the accuracy level for equalization. Higher accuracy levels give better frequency response in the lower ranges, but they require
more processing time. If you equalize only higher frequencies, you can use lower accuracy levels.

If you equalize extremely low frequencies, set Accuracy to between 500 and 5000 points.

Compensates for an overall volume level that is too soft or too loud after the EQ settings are adjusted. The default value of 0 dB
represents no master gain adjustment.

The Graphic Equalizer is an FIR (Finite Impulse Response) filter. FIR filters better maintain phase accuracy but have slightly less frequency
accuracy than IIR (Infinite Impulse Response) filters like the Parametric Equalizer.

Parametric Equalizer effect
The Filter And EQ > Parametric Equalizer effect provides maximum control over tonal equalization. Unlike the Graphic Equalizer, which provides a
fixed number of frequencies and Q bandwidths, the Parametric Equalizer gives you total control over frequency, Q, and gain settings. For example,
you can simultaneously reduce a small range of frequencies centered around 1000 Hz, boost a broad low-frequency shelf centered around 80 Hz,
and insert a 60 Hz notch filter.

The Parametric Equalizer uses second-order IIR (Infinite Impulse Response) filters, which are very fast and provide very accurate frequency
resolution. For example, you can precisely boost a range of 40 to 45 Hz. FIR (Finite Impulse Response) filters like the Graphic Equalizer provide
slightly improved phase accuracy, however.

Compensates for an overall volume level that’s too loud or too soft after you adjust the EQ settings.

Shows frequency along the horizontal ruler (x-axis) and amplitude along the vertical ruler (y-axis). Frequencies in the graph range from
lowest to highest in a logarithmic fashion (evenly spaced by octaves).

Identifying band-pass and shelving filters in the Parametric Equalizer: 
A. High- and low-pass filters B. High and low shelving filters 

Sets the center frequency for bands 1-5, and the corner frequencies for the band-pass and shelving filters.

Use the low shelving filter to reduce low-end rumble, hum, or other unwanted low-frequency sounds. Use the high shelving filter to reduce hiss,
amplifier noise, and the like.

Sets the boost or attenuation for frequency bands, and the per-octave slope of the band-pass filters.

Controls the width of the affected frequency band. Low Q values affect a larger range of frequencies. Very high Q values (close to 100)
affect a very narrow band and are ideal for notch filters removing particular frequencies, like 60 Hz hum.

When a very narrow band is boosted, audio tends to ring or resonate at that frequency. Q values of 1-10 are best for general equalization.

Enables up to five intermediate bands, as well as high-pass, low-pass, and shelving filters, giving you very fine control over the equalization
curve. Click the band button to activate the corresponding settings above.

The low and high shelving filters provide slope buttons ( ,  ) that adjust the low and high shelves by 12 dB per octave, rather than the
default 6 dB per octave.

To visually adjust enabled bands in the graph, drag the related control points.

Describes a frequency band’s width as either a Q value (which is a ratio of width to center frequency) or an
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Ultra-Quiet

Range

absolute width value in Hz. Constant Q is the most common setting.

Virtually eliminates noise and artifacts, but requires more processing. This option is audible only on high-end headphones and
monitoring systems.

Sets the graph to a 30 dB range for more precise adjustments, or a 96 dB range for more extreme adjustments.
About process effects

Apply individual effects in the Waveform Editor

Applying effects in the Waveform Editor
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Effekt „Doppler-Verschiebung“ (nur Wellenform-Editor)
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Hinweis:

Pfadtyp

Stellt die Lautstärke auf Basis von Entfernung oder Richtung ein

Qualitätspegel

Der Effekt Spezial > Doppler-Verschiebung generiert den Anstieg und Abfall der Tonhöhe, wenn sich ein Objekt nähert und den Hörer passiert
(z. B. ein Polizeiwagen mit eingeschalteter Sirene). Wenn sich das Auto nähert, erreicht der Ton das Ohr des Hörers mit einer höheren Frequenz,
da jede akustische Welle durch die Vorwärtsbewegung des Autos komprimiert wird. Das Gegenteil passiert bei einem vorbeifahrenden Auto: Die
Wellen werden gedehnt, wodurch ein Klang mit niedriger Frequenz entsteht.

Im Gegensatz zu vielen anderen Diagrammen in Adobe Audition ist das Diagramm für die Doppler-Verschiebung nicht interaktiv: Das
Diagramm kann nicht direkt manipuliert werden. Stattdessen passt sich das Diagramm an, wenn Sie die Parameter des Effekts einstellen.

Definiert den scheinbaren Bewegungspfad der Tonquelle. Die verfügbaren Optionen sind vom Pfadtyp abhängig. 

Optionen für Gerade Linie:

Anfangsabstand von: stellt den virtuellen Startpunkt des Effekts in Metern ein.
Geschwindigkeit: definiert die virtuelle Geschwindigkeit (in Metern pro Sekunde) für den Effekt.
Kommt aus: legt die virtuelle Richtung (in Grad) fest, aus der sich der Effekt nähert.
Passiert vorn mit Abstand: gibt an, mit welchem Abstand (in Metern) der Effekt vor dem Hörer passieren soll.
Passiert rechts mit Abstand: gibt an, mit welchem Abstand (in Metern) der Effekt rechts vom Hörer passieren soll.

Optionen für Kreisförmig:

Radius: stellt die kreisförmigen Maße des Effekts in Metern ein.
Geschwindigkeit: definiert die virtuelle Geschwindigkeit (in Metern pro Sekunde) für den Effekt.
Anfangswinkel: stellt den virtuellen Anfangswinkel des Effekts in Grad ein.
Mitte nach vorn um: gibt an, wie weit (in Metern) die Tonquelle von der Vorderseite des Hörers entfernt ist.
Mitte nach rechts um: gibt an, wie weit (in Metern) die Tonquelle von der rechten Seite des Hörers entfernt ist.

Passt die Lautstärke des Effekts automatisch gemäß den angegebenen
Werten an.

Stellt sechs unterschiedliche Stufen der Verarbeitungsqualität bereit. Niedrigere Qualitätsstufen benötigen weniger
Verarbeitungszeit, höhere Qualitätsstufen produzieren dagegen besser klingende Ergebnisse. 
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Effekt „Automatische Tonhöhenkorrektur“
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Skalierung

Tonart

Ansprechzeit

Empfindlichkeit

Referenzkanal

FFT-Größe

Kalibrierung

Korrekturanzeige

Effekt „Automatische Tonhöhenkorrektur“
Der Effekt Automatische Tonhöhenkorrektur ist sowohl im Wellenform- als auch im Multitrack- Editor verfügbar. In Letzterem können die Parameter
mit Keyframes und externen Steuerungsoberflächen über einen Zeitverlauf automatisiert werden.

Wählen Sie Effekte > Zeit und Tonhöhe > Automatische Tonhöhenkorrektur und wählen Sie Werte für die folgenden Optionen:

Bestimmt den am besten für das Material geeigneten Skalierungstyp: Dur, Moll oder Chromatisch. Dur und Moll ermöglichen
umfangreichere Korrekturen, wenn das Quellaudio um mehr als einen Halbton von der Tonhöhe abweicht. Chromatisch ist am besten für kleine
Korrekturen geeignet, um die Tonhöhe zur nächsten chromatischen Note zu „ziehen“.

Stellt die gewünschte Tonart für das korrigierte Material ein. Diese Option ist nur verfügbar, wenn für Skala der Wert Größer oder Kleiner
eingestellt wurde (weil die Skala Chromatisch alle 12 Töne enthält und nicht tonartspezifisch ist).

Bestimmt, wie schnell Adobe Audition die Tonhöhe in Richtung des Skalatons korrigiert. Schnellere Einstellungen sind
normalerweise für Audiodaten am besten geeignet, die aus kurzen Noten bestehen (beispielsweise eine schnell mit der Trompete gespielte
Passage). Eine extrem kurze Ansprechzeit kann jedoch zu einem robotischen Klang führen. Kleinere Werte liefern natürlicheren Klang für länger
anhaltende Noten (wenn z. B. ein Sänger eine Note hält und Vibrato hinzufügt). Da sich das Quellmaterial während einer musikalischen
Vorführung ändern kann, erreichen Sie natürlich klingende Ergebnisse am besten durch die separate Korrektur kurzer Musikabschnitte.

Definiert den Schwellenwert, jenseits von dem Noten nicht mehr korrigiert werden. Empfindlichkeit wird in Cent gemessen. Jeder
Halbton enthält 100 Cent. Ein Wert von 50 Cent für Empfindlichkeit bedeutet, dass eine Note innerhalb von 50 Cent (halber Halbton) eines
Zielskalatons liegen muss, bevor sie automatisch korrigiert wird.

Wählen Sie einen Quellkanal aus, in dem die Tonhöhenänderungen am deutlichsten sind. Der Effekt analysiert nur den gewählten
Kanal, wendet die Tonhöhenkorrektur jedoch gleichermaßen auf alle Kanäle an.

Legt die Fast Fourier-Transformation jedes Datenelements fest, das der Effekt verarbeitet. Verwenden Sie kleinere Werte zum
Korrigieren höherer Frequenzen. Für Stimmen klingen Werte zwischen 2048 oder 4096 am natürlichsten, während eine Einstellung von 1024
robotische Effekte erzeugt.

Gibt den Abstimmungsstandard für das Quellaudio an. In westlicher Musik beträgt der Standard A4, also 440 Hz. Quellaudiodaten
können jedoch mit einem anderen Standard aufgezeichnet worden sein. Aus diesem Grund können Sie A4-Werte von 410 bis 470 Hz angeben.

Bei einer Audiovorschau wird der Korrekturumfang für Töne mit Vorzeichen (b bzw. #) angezeigt.
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Effekte zur Manipulation von Zeit- und Tonhöhe

Nach oben

Der Effekt „Dehnung und Tonhöhe“ (nur Wellenform-Editor)

Der Effekt „Dehnung und Tonhöhe“ (nur Wellenform-Editor)
Der Effekt „Zeit und Tonhöhe“ > „Dehnung und Tonhöhe“ ermöglicht das Ändern von Tonhöhe und Tempo eines Audiosignals. Sie können
beispielsweise einen Song in eine höhere Tonart transponieren, ohne das Tempo zu ändern, oder eine gesprochene Passage verlangsamen, ohne
dass sich dies auf die Tonhöhe auswirkt.

Hinweis: Dieser Effekt erfordert Offline-Verarbeitung. Während der Effekt geöffnet ist, können Sie weder die Wellenform bearbeiten, noch
Auswahlen anpassen oder die Marke für die aktuelle Zeit verschieben.

Algorithmus Wählen Sie „IZotope-Radius“, wenn Sie das Audio dehnen und gleichzeitig die Tonhöhe ändern möchten. Wählen Sie „Audition“, um
die Dehnungs- oder Tonhöheneinstellungen im Zeitverlauf zu ändern. Der Algorithmus „iZotope-Radius“ benötigt mehr Verarbeitungszeit, führt
aber zu weniger Artefakten.
Präzision Höhere Werte bieten höhere Qualität, erfordern jedoch mehr Verarbeitungszeit.
Neue Dauer Gibt die Audiolänge nach der Dehnung an. Sie können den Wert für „Neue Dauer“ entweder direkt anpassen oder indirekt, indem Sie
den Dehnungsprozentsatz ändern.

Wenn Sie häufig Dateien auf dieselbe bestimmte Dauer dehnen, klicken Sie auf das Symbol „Favorit“ , um diese Einstellung für eine spätere
Verwendung zu speichern. Informationen zum Anwenden eines Favorite auf mehrere Dateien finden Sie unter Stapelverarbeitung von Dateien.

Dehnungseinstellungen auf neue Dauer fixieren Übersteuert benutzerdefinierte oder vorgegebene Dehnungseinstellungen und berechnet diese
stattdessen anhand der Änderungen an der Dauer.

Verwenden Sie die oben beschriebene Option, um Radiospots schnell auf 30 oder 60 Sekunden Länge zu bringen.

Dehnen Kürzt oder erweitert das verarbeitete Audio relativ zum vorhandenen Audio. Beispiel: Um die Audiodaten auf die Hälfte der aktuellen
Dauer zu kürzen, legen Sie einen Dehnungswert von 50 % fest.
Transponierung Verschiebt die Tonhöhe von Audio nach oben oder unten. Jeder Halbton entspricht einem halben Schritt auf einer
Klaviertastatur.
Enddehnung oder Transponierung (Audition-Algorithmus) Ändert die Einstellung für Anfangsdehnung oder Transponierung im Zeitverlauf,
wobei die endgültige Einstellung beim letzten ausgewählten Audio-Sample erreicht wird.
Dehnung und Tonhöhe sperren (IZotope-Algorithmus) Dehnt Audio, um Änderungen der Tonhöhe abzubilden, oder umgekehrt.
Anfangsdehnung und Tonhöhe sperren (Audition-Algorithmus) Dehnt Audio, um Änderungen der Tonhöhe abzubilden, oder umgekehrt.
Enddehnung oder Transponierung sind davon nicht betroffen.
Erweiterte Einstellungen (IZotope-Radius-Algorithmus) Klicken Sie auf das Dreieck, um folgende Optionen einzublenden:

Soloinstrument oder -stimme  Beschleunigt die Bearbeitung eines Solos.
Sprachcharakteristika beibehalten  Bewahrt den natürlichen Klang einer Stimme.
Formantverschiebung  Bestimmt, wie Formanten beim Transponieren angepasst werden. Der Standardwert Null passt Formanten
gleichzeitig beim Transponieren an, wobei das Timbre und die Natürlichkeit beibehalten werden. Werte größer als Null erzeugen höhere
Timbres, wodurch beispielsweise eine Männerstimme den Klang einer Frauenstimme annehmen kann. Werte kleiner als Null haben den
gegenteiligen Effekt.
Tonhöhenkohärenz  Behält das Timbre von Solostimmen oder -instrumenten bei. Höhere Werte reduzieren Phaser-Artefakte, führen aber
zu stärkerer Modulation der Tonhöhe.

Erweiterte Einstellungen (Audition-Algorithmus) Klicken Sie auf das Dreieck, um folgende Optionen einzublenden:

Spaltfrequenz  Legt die Größe jedes Audio-Abschnitts fest, wenn Sie beim Dehnen einer Wellenform das Tempo oder die Tonhöhe
beibehalten. Je höher dieser Wert ist, desto präziser erfolgt die Platzierung der gedehnten Audiodaten im Zeitverlauf. Allerdings werden mit
höheren Werten auch Artefakte deutlicher hörbar und der Klang kann blechern und tunnelartig werden. Bei hohen Einstellungen für die
Präzision können niedrigere Spaltfrequenzen Stottern und Echos verursachen.
Überlagerung  Bestimmt, welcher Teil des aktuellen Audiodatenblocks sich mit dem vorhergehenden bzw. dem folgenden Block
überlappt. Falls die Dehnung zu einem Chorus-Effekt führt, senken Sie den Überlagerungsprozentsatz, jedoch nicht so weit, dass der
Sound abgehackt wird. „Überlagerung“ kann Werte bis 400 % annehmen. Dieser Wert ist aber nur bei extremen
Geschwindigkeitssteigerungen (200 % und mehr) sinnvoll.
Geeignete Standardeinstellungen wählen  Wendet geeignete Standardwerte für die Spaltfrequenz und Überlappung an. Diese Option ist
gut geeignet, um Tonhöhe oder Tempo beizubehalten.
Konstante Vokale  Behält den Klang von Vokalen in gedehnten Vokalen bei. Diese Option erfordert eine umfangreiche Verarbeitung;
wenden Sie diese zunächst auf eine kleine Auswahl an, bevor Sie sie auf eine größere anwenden.

Verwandte Hilfethemen
Verwenden von Effektvorgaben
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Mischen von Multitrack-Sessions

Ein Teil des auf dieser Seite verlinkten Inhalts ist möglicherweise nur in englischer Sprache verfügbar.



-->

Automatisieren von Mischungen mit Hüllkurven (CS6)

Zum Seitenanfang

Hinweis:

Automatisieren von Clip-Einstellungen
Automatisieren von Track-Einstellungen
Anpassen der Automatisierung mit Keyframes

Indem Sie Mischungen automatisieren, können Sie die Mischungseinstellungen im Zeitverlauf ändern. Sie können beispielsweise die Lautstärke
eines Clips während einer kritischen Passage automatisch erhöhen und dann allmählich ausblenden. In dieser Videoschulung sehen Sie, wie die
Automatisierung beim Mischen funktioniert.

Mit Automatisierungs-Hüllkurven werden Einstellungen an bestimmten Zeitpunkten visuell verdeutlicht. Sie können bearbeitet werden, indem Sie
die Keyframes auf Hüllkurvenlinien ziehen. Hüllkurven sind nicht zerstörerisch, d. h. sie ändern die Audiodateien in keiner Weise. Wenn Sie zum
Beispiel eine Datei im Wellenform-Editor öffnen, sind die Effekte von im Multitrack-Editor angewendeten Hüllkurven nicht hörbar.

Clip- und Track-Hüllkurven im Editor 
A. Clip-Hüllkurve B. Track-Hüllkurve 

Automatisieren von Clip-Einstellungen
Mit Clip-Hüllkurven können Sie die Clip-Lautstärke, Balance- und Effekteinstellungen automatisieren.

Bei Stereo-Tracks werden standardmäßig Lautstärke- und Balance-Hüllkurven für Clips angezeigt, die Sie an ihrer Farbe und Anfangsposition
erkennen. Lautstärke-Hüllkurven werden als gelbe Linien dargestellt und befinden sich zunächst im oberen Teil eines Clips. Balance-Hüllkurven
sind blaue Linien, die sich zunächst in der Mitte befinden. (Bei Balance-Hüllkurven bedeutet der obere Clip-Rand Balance voll links, der untere voll
rechts.)

Für Mono- und 5.1-Surround-Tracks werden keine Balance-Hüllkurven für Clips angezeigt.

Zwei Clip-Hüllkurven 
A. Balance-Hüllkurve B. Lautstärke-Hüllkurve 

So blenden Sie Clip-Hüllkurven ein oder aus
Clip-Hüllkurven werden standardmäßig angezeigt. Sie können sie aber ausblenden, wenn sie Sie beim Arbeiten stören oder ablenken.

Wählen Sie aus dem Menü „Ansicht“ beliebige der folgenden Optionen:
Clip-Lautstärke-Hüllkurven anzeigen 

Clip-Balance-Hüllkurven anzeigen

Clip-Effekt-Hüllkurven anzeigen

Anzeigen oder Ausblenden einzelner Automatisierungsparameter

Anzeigen eines Parameters für einen Effekt

Klicken Sie rechts oben in einem Clip auf das Parametermenü und wählen Sie eine Option für die Rack-Mischung oder einen
Effektparameter. (Im Menü werden sichtbare Parameter mit Häkchen gekennzeichnet. Wählen Sie einen Parameter erneut
aus, um ihn auszublenden.)

Wenn Sie Keyframes für einen Parameter bearbeitet haben, wird dieser im Menü mit einem Sternchen (*) gekennzeichnet.

Mit der Power-Option im Rack können Sie den Effekte-Rack eines Clips über die Zeit ein- und ausschalten.

Deaktivieren der Clip-Keyframe-Bearbeitung
Sie können die Keyframe-Bearbeitung deaktivieren, um versehentliches Verschieben oder Erstellen von Keyframes zu verhindern.
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Deaktivieren Sie im Menü „Multitrack“ die Option „Clip-Keyframe-Bearbeitung aktivieren“.

Automatisieren von Track-Einstellungen
Mit Hilfe von Track-Hüllkurven lassen sich die Einstellungen für Lautstärke, Balance und Effekte im Zeitverlauf ändern. In Adobe Audition werden
Track-Hüllkurven in einer Automatisierungsspur unter jedem Track angezeigt. Jeder automatisierte Parameter verfügt über eine eigene Hüllkurve,
die Sie wie Clip-Hüllkurven bearbeiten können.

Automatisieren von Track-Einstellungen im Editor 
A. Automatisierungsspur B. Hüllkurve für Parameter 

Erstellen von Track-Hüllkurven
Mit Track-Hüllkurven können Sie Track-Eigenschaften zu bestimmten Zeitpunkten präzise ändern.

Anzeigen von Automatisierungsspuren im Editor

1. Klicken Sie im Editor auf das Dreieck links neben dem Menü „Track-Automatisierungsmodus“ für den Track, den Sie
automatisieren möchten. (Das Menü ist standardmäßig auf „Lesen“ eingestellt.)

2. Wählen Sie aus dem Popup-Menü „Hüllkurven anzeigen“ den zu automatisierenden Parameter.
3. Ziehen Sie die Hüllkurvenlinie mit der Maus, um Keyframes hinzuzufügen und anzupassen.

Aufzeichnen der Track-Automatisierung
Während der Wiedergabe einer Session können Sie die an der Lautstärke, Balance und den Effekteinstellungen vorgenommenen Anpassungen
aufnehmen und so eine Mischung erstellen, die sich mit der Zeit entwickelt. In Adobe Audition werden die vorgenommenen Anpassungen
automatisch in Track-Hüllkurven konvertiert, die Sie präzise bearbeiten können.

Mit einem externen Controller, wie z. B. Mackie Control, können Sie gleichzeitig mehrere Einstellungen anpassen. Siehe Unterstützung einer
Steuerungsoberfläche.

1. Platzieren Sie die Zeitmarke im Hauptbereich an der Stelle, an der die Automatisierungsaufzeichnung beginnen soll.
2. Wählen Sie eine Option aus dem Menü „Track-Automatisierungsmodus“.
3. Um die Automatisierungsaufzeichnung zu beginnen, starten Sie die Wiedergabe. Während der Audiowiedergabe können Sie

die Track- oder Effekteinstellungen im Editor, im Mischer oder im Effekte-Rack anpassen.
4. Um die Automatisierungsaufzeichnung zu beenden, beenden Sie die Wiedergabe.

Wenn aufgenommene Keyframes zu zahlreich oder unregelmäßig sind, finden Sie weitere Informationen unter Optimieren der aufgezeichneten
Automatisierung.

Optionen für den Track-Automatisierungsmodus
Im Editor oder Mischer können Sie für jeden Track einen der folgenden Modi auswählen:

Ignoriert Track-Hüllkurven bei der Wiedergabe oder beim Abmischen, zeigt jedoch weiterhin Hüllkurven an, damit Sie Keyframes manuell
hinzufügen oder anpassen können.

Wendet Track-Hüllkurven bei der Wiedergabe oder Abmischung an, zeichnet jedoch die daran vorgenommenen Änderungen nicht auf.
(Sie können eine Vorschau solcher Änderungen anzeigen, die Keyframes kehren jedoch zu den aufgezeichneten Einstellungen zurück.)

Überschreibt beim Starten der Wiedergabe vorhandene Keyframes mit aktuellen Einstellungen. Fährt mit dem Aufzeichnen neuer
Einstellungen fort, bis die Wiedergabe angehalten wird.

Startet die Aufzeichnung von Keyframes bei der ersten Anpassung einer Einstellung und fährt mit dem Aufzeichnen neuer
Einstellungen fort, bis die Wiedergabe angehalten wird.

Ähnlich wie Verriegelung, aber die Einstellungen kehren schrittweise zu den vorher aufgezeichneten Werten zurück, wenn Sie die
Anpassung beenden. Verwenden Sie den Modus „Tasten“, um bestimmte Automatisierungsbereiche zu überschreiben, aber andere intakt zu
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lassen.

Schützen von Einstellungen bei der Automatisierungsaufzeichnung
Wenn Sie die Automatisierung aufzeichnen, sollten Sie bestimmte Parameter vor unbeabsichtigten Änderungen schützen, während andere
Parameter angepasst werden dürfen.

1. Navigieren Sie links im Editor zu den Steuerungen des spezifischen Tracks.
2. Klicken Sie auf das Symbol „Automatisierungsspuren ein-/ausblenden“ [SYMBOL].
3. Wählen Sie aus dem Menü „Hüllkurven anzeigen“ den Parameter aus.
4. Klicken Sie auf das Symbol „Parameter schützen“ [SYMBOL].

Optimieren von aufgezeichneten Automatisierungskeyframes
Um die Erstellung zu vieler oder unregelmäßiger Keyframes bei einer aufgezeichneten Automatisierung zu verhindern, optimieren Sie die
folgenden Einstellungen im Bereich „Multitrack“ des Dialogfelds „Voreinstellungen“.

Legt fest, wie schnell im Modus „Tasten“ Parameter zu den Originalwerten zurückkehren. Es können Werte
zwischen 0,00 und 5,00 Sekunden festgelegt werden. Der Standardwert beträgt 1,00 Sekunde.

Es werden alle Keyframes entfernt, die statische, unveränderbare Parametereinstellungen darstellen.

Erstellt Keyframes in Zeitintervallen, die größer als der angegebene Wert sind. Geben Sie im Feld
„Mindestzeit“ ein Intervall zwischen 1 und 2000 Millisekunden ein.

Anpassen der Automatisierung mit Keyframes
Keyframes auf Hüllkurvenlinien ändern Clip- und Track-Parameter über die Zeit. Adobe Audition berechnet bzw. interpoliert alle Zwischenwerte
zwischen Keyframes automatisch mit einer der folgenden beiden Methoden:

Halten  -Übergänge erzeugen abrupte Übergänge zwischen den Keyframes.

Lineare  Übergänge führen zu einem gleichmäßigen schrittweisen Übergang zwischen Keyframes.

Sie können auch Spline-Kurven auf eine gesamte Hüllkurve anwenden und dadurch die oben genannte Keyframe-spezifische Einstellung
übersteuern. So erzeugen Sie natürlich klingende Übergänge, deren Geschwindigkeit sich bei Keyframes ändert. (Siehe Spline-Kurven für
Graphen.)

Übergänge zwischen Keyframes 
A. Halten B. Linear (Standard) C. Spline-Kurven 

Hinzufügen von Keyframes

Führen Sie eine der folgenden Operationen aus:

Zeigen Sie mit der Maus auf eine Hüllkurvenlinie. Wenn ein Pluszeichen  angezeigt wird, klicken Sie.

Platzieren Sie den Playhead an der Stelle, an der Sie einen Track-Parameter ändern möchten. Klicken Sie anschließend in
den Track-Steuerungen auf das Symbol „Keyframe hinzufügen“ .

Navigieren zwischen Track-Keyframes

1. Wählen Sie im Editor unten in den Track-Steuerungen einen Parameter aus dem Popup-Menü „Auswählen“.

2. Klicken Sie auf das Symbol „Vorheriger Keyframe“  oder „Nächster Keyframe“ .

Auswählen mehrerer Keyframes für einen Parameter

Klicken Sie mit der rechten Maustaste auf einen beliebigen Keyframe und wählen Sie „Alle Keyframes auswählen“.

Halten Sie die Strg-Taste (Windows) bzw. Befehlstaste (Mac OS) gedrückt und klicken Sie auf bestimmte Keyframes.

Halten Sie die Umschalttaste gedrückt, um mehrere aufeinanderfolgende Keyframes auszuwählen.

Neupositionieren von Keyframes oder der Hüllkurvenlinie

Um ausgewählte Keyframes neu zu positionieren, ziehen Sie sie mit der Maus. (Um die Zeitposition oder den Parameterwert
beizubehalten, halten Sie beim Ziehen die Umschalttaste gedrückt.)
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Um ein Segment einer Hüllkurve neu zu positionieren, ohne einen Keyframe zu erstellen, halten Sie die Strg-Taste (Windows)
bzw. Befehlstaste (Mac OS) gedrückt und ziehen Sie.

Ändern des Übergangs zwischen zwei Keyframes

Klicken Sie mit der rechten Maustaste auf den ersten Keyframe, und aktivieren Sie „Keyframe halten“, um Werte abrupt zu
ändern. Deaktivieren Sie die Option, wenn Sie einen schrittweisen Übergang von einem Wert zum nächsten wünschen.

Anwenden von Spline-Kurven auf eine gesamte Hüllkurve

Klicken Sie mit der rechten Maustaste auf eine Hüllkurvenlinie, und wählen Sie „Spline-Kurven“.

Löschen von Keyframes

Klicken Sie mit der rechten Maustaste auf eine Hüllkurvenlinie und wählen Sie „Ausgewählte Keyframes löschen“. Oder ziehen
Sie einen einzelnen Keyframe aus einem Clip oder Track.

Deaktivieren der Clip-Keyframe-Bearbeitung

Sie können die Keyframe-Bearbeitung deaktivieren, um versehentliches Verschieben oder Erstellen von Keyframes zu verhindern.

Deaktivieren Sie im Menü „Multitrack“ die Option „Clip-Keyframe-Bearbeitung aktivieren“.

Bearbeiten von Multitrack-Sessions im Editor und Mischer
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Automating mixes with envelopes (CS5.5)

Note:

To the top

Note:

Automating clip settings
Automating track settings
Adjust automation with keyframes

Some features in the Windows version of Adobe Audition 3.0 are not available in CS5.5. Examples include control surface support, CD
burning, MIDI, some file formats and effects, clip grouping and time stretching, and the metronome. For a complete list, see Adobe Audition 3.0
features replaced or not implemented in CS5.5.

By automating mixes, you can change mix settings over time. For example, you can automatically increase volume during a critical musical
passage and later reduce the volume in a gradual fade out. See this video tutorial to watch mix automation in action.

Automation envelopes visually indicate settings at specific points in time, and you can edit them by dragging keyframes on envelope lines.
Envelopes are nondestructive, so they don’t change audio files in any way. If you open a file in the Waveform Editor, for example, you don’t hear
the effect of any envelopes applied in the Multitrack Editor.

Clip and track envelopes in the Editor panel 
A. Clip envelope B. Track envelope 

Automating clip settings
With clip envelopes, you can automate clip volume, pan, and effect settings.

On stereo tracks, clip volume and pan envelopes appear by default; you can identify them by color and initial position. Volume envelopes are
yellow lines initially placed across the upper half of clips. Pan envelopes are blue lines initially placed in the center. (With pan envelopes, the top of
a clip represents full left, while the bottom represents full right.)

On mono and 5.1 surround tracks, clips lack pan envelopes.

Two clip envelopes 
A. Pan envelope B. Volume envelope 

Show or hide clip envelopes
Clip envelopes are visible by default, but if they interfere with editing or are visually distracting, you can hide them.

From the View menu, choose any of the following:
Show Clip Volume Envelopes 

Show Clip Pan Envelopes

Show Clip Effect Envelopes

Show or hide individual automation parameters

http://kb2.adobe.com/cps/895/cpsid_89588.html
http://kb2.adobe.com/cps/895/cpsid_89588.html
http://tv.adobe.com/watch/adobe-evangelists-jason-levine/multitrack-mixing-automation-in-adobe-audition-cs55-/
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Showing a parameter for an effect

In the upper-right corner of a clip, click the parameter menu, and select a Rack mixing option or an effect parameter.

The Rack Power option lets you turn clip effects on and off over time.

Automating track settings
With track envelopes, you can change volume, pan, and effect settings over time. Adobe Audition displays track envelopes in an automation lane
below each track. Each automated parameter has its own envelope, which you edit just like clip envelopes.

Automating track settings in the Editor panel 
A. Automation lane B. Envelope for parameter 

Create track envelopes
Track envelopes let you precisely change track settings at specific points in time.

Showing automation lanes in Editor panel

1. In Editor panel, click the triangle to the left of the Read menu for the track you want to automate.
2. From the Show Envelopes menu, select a parameter to automate.
3. On the envelope line, click and drag to add and adjust keyframes.

Track Automation Mode options
In the Editor panel or Mixer, you can choose one of the following modes for each track:



Off

Read

To the top

Track Automation Mode menu

Ignores track envelopes during playback and mixdown, but continues to display envelopes so you can manually add or adjust edit points.

Applies track envelopes during playback and mixdown.

Adjust automation with keyframes
Keyframes on envelope lines change clip and track parameters over time. Adobe Audition automatically calculates, or interpolates, all the
intermediate values between keyframes using one of two transition methods:

Hold  transitions create an abrupt change in value at each new keyframe.

Linear  transitions create a gradual, even change between keyframes.

You can also apply spline curves to an entire envelope, overriding the keyframe-specific setting above to create natural-sounding transitions that
change in speed near keyframes. (See About spline curves for graphs.)

Transitions between keyframes 
A. Hold B. Linear (the default) C. Spline curves 

Add a keyframe

Do either of the following:

Position the pointer over an envelope line. When a plus sign  appears, click.

Position the current-time indicator where you’d like a track parameter to change. Then click the Add Keyframe icon  in the
track controls.

Navigate between track keyframes

1. In the Editor panel, choose a parameter from the Select menu near the bottom of the track controls.

2. Click the Previous Keyframe  or Next Keyframe  icon.

Select multiple keyframes for a parameter

Right-click any keyframe, and choose Select All Keyframes.

Hold down Ctrl (Windows) or Command (Mac OS), and click specific keyframes.

Hold down Shift, and click to select a series of keyframes.

Reposition keyframes or the envelope line

To reposition selected keyframes, drag them. (To maintain time position or parameter value, hold down Shift and drag.)

To reposition a segment of an envelope without creating a keyframe, hold down Ctrl (Windows) or Command (Mac OS), and
drag.

Change the transition between two keyframes

Right-click the first keyframe, and select Hold Keyframe to abruptly change values, or deselect it to gradually transition from
one value to the next.

http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
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Apply spline curves to an entire envelope

Right-click an envelope line, and choose Spline Curves.

Delete keyframes

Right-click an envelope line, and choose Delete Selected Keyframes. Or, drag an individual keyframe off a clip or track.

Disable keyframe editing

To avoid inadvertently creating or moving keyframes, disable keyframe editing.

From the Multitrack menu, deselect Enable Clip Keyframe Editing.

Editing multitrack sessions in the Editor panel and Mixer

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/en_US/legalnotices/index.html
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Arranging and editing multitrack clips
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Select and move clips
Snap to clip endpoints
Copy a clip
Trimming and extending clips
Split clips
Set audio clip properties

When you insert an audio file in the Multitrack Editor, the file becomes a clip on the selected track. You can easily move clips to different tracks or
timeline positions. You can also edit clips nondestructively, trimming their start and end points, crossfading them with other clips, and more.

To arrange clips in the Editor panel, you use the Move  or Time Selection  tools.

Select and move clips
Do any of the following:

To select an individual clip, click it in the Editor panel.

To select all clips in selected tracks, choose Edit > Select > All Clips In Selected Track.

To select all clips in a session, choose Edit >Select > Select All.

To move selected clips, select the Move tool  in the toolbar, and then drag the clips. Or choose Clip > Nudge Right or
Nudge Left to move clips one pixel at a time. (If you zoom in to see individual samples, nudging moves clips one sample at
a time.)

To move clips with the Time Selection tool , right-click and drag (similar to the Hybrid tool technique in previous versions).
You can also drag the clip header with any tool.

Snap to clip endpoints
Snapping lets you quickly align clips with other clips. If snapping is enabled, both dragged clips and the current-time indicator snap to selected
items. While you drag a clip, a white line appears in the Editor panel when snapping points meet.

1. To enable snapping for selected items, click the Toggle Snapping icon  at the top of the Editor panel.
2. Choose Edit > Snapping > Snap To Clips.

For more information, see Snap to loop beats and Snap to markers, rulers, frames, and zero crossings.

Copy a clip
You can create two types of copied audio clips: reference copies that share source files and unique copies that have independent source files.
The type of copy you choose depends upon the amount of available disk space and the nature of destructive editing you plan to perform in the
Waveform Editor.

Reference copies consume no additional disk space, letting you simultaneously edit all instances by editing the original source file. (For example,
you can add the Flanger effect to a source file in the Waveform Editor and automatically apply the effect to all 30 referenced copies in a session.)

Unique copies have a separate audio file on disk, allowing for separate editing of each version in the Waveform Editor. (For example, you can add
destructive effects to the version in an introduction while leaving the version in a verse dry.)

To quickly copy a reference, press Ctrl + C (Windows) or Cmd + C (Mac OS). Alternatively, Alt-drag (Windows) or Option-drag (Mac OS) the
clip header.

1. Click the Move tool  in the toolbar. Then right-click and drag the clip.

To copy with the Time Selection tool , right-click and drag the clip header (similar to the Hybrid tool technique in previous
versions).

2. Release the mouse button, and choose one of the following from the pop-up menu:
Copy Here (to copy a reference)
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Copy Unique Here

Trimming and extending clips
You can trim or extend audio clips to suit the needs of a mix. Because the Multitrack Editor is nondestructive, clip edits are impermanent; you can
return to the original, unedited clip at any time. If you want to permanently edit an audio clip, however, you can quickly open the source file in the
Waveform Editor. (See Comparing the Waveform and Multitrack editors.)

Remove a selected range from clips

1. In the toolbar, click the Time Selection tool .
2. Drag across one or more clips to select them and a range.
3. Do one of the following:

To remove the range from clips and leave a gap in the timeline, choose Edit > Delete.

To remove the range and collapse the gap in the timeline, choose Edit > Ripple Delete, and select one of the following
options:

Selected Clips

Removes selected clips, shifting remaining clips on the same tracks.

Time Selection in Selected Clips

Removes the range from selected clips, splitting them if necessary.

Time Selection in All Tracks

Removes the range from all clips in the session.

Time Selection in Selected Track

Removes the range only from the currently highlighted track in the Editor panel.

Collapse a gap between clips on a track
Right-click the empty area between the clips, and choose Ripple Delete > Gap.

Trim or extend clips
1. If you want to repeat a clip, right-click it and select Loop. (See Looping clips.)

2. In the Editor panel, position the cursor over the left or right edge of the clip. The edge-dragging icon  appears.
3. Drag clip edges.

Shift the contents of a trimmed or looped clip
You can slip edit a trimmed or looped clip to shift its contents within clip edges.

Shift clip contents within clip edges

1. In the toolbar, click the Slip tool .
2. Drag across the clip.

Permanently edit a clip’s source file in the Waveform Editor
Double-click the clip header.

Split clips
Split audio clips to break them into separate clips that you can independently move or edit.

Split clips with the Razor tool
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Razor Selected Clips

Razor All Clips

To the top

Clip Color

Clip Gain

Lock in Time

Loop

Mute

1. In the toolbar, hold down the Razor tool , and choose one of the following from the pop-up menu:

Splits only clips you click.

Splits all clips at the time point you click.

Tip: To switch between these modes in the Editor panel, press Shift.

2. In the Editor panel, click where you want the split to occur.

Split all clips at the current-time indicator

1. Position the current-time indicator where one or more audio clips exist.

2. Choose Clip > Split.

Set audio clip properties
In the Properties panel, you can quickly change multiple settings for selected audio clips. Clip settings for gain and mute are independent from
similar track controls.

1. Select an audio clip, and choose Window > Properties.

You can access individual properties from the Clip menu.

2. Set the following options:

To change the clip name, type in the text box at the top of the panel.

Click the swatch to customize. A swatch with a red slash indicates that the clip is using the default color for the
current Appearance preset. (See Change interface colors, brightness, and performance.)

Compensates for a low or high volume clip that is difficult to mix.

Allows only up or down moves to other tracks, with a fixed timeline position. A lock icon  appears on the clip.

Enables clip looping. For more information, see Looping clips.

Silences the clip.

Select ranges in the Multitrack Editor
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Modus

Typ

Dauer, Dehnung und Tonhöhe

Erweiterte Einstellungen

1. Wählen Sie Clip > Dehnen > Globale Clipdehnung aktivieren.

2. Ziehen Sie im Editor die weißen Dreiecke rechts bzw. links oben in den Clips.

Wählen Sie mehrere Clips aus, um sie proportional zu dehnen.

Um die Dehnungseinstellungen für ausgewählte Clips anzupassen, passen Sie im Eigenschaftenbedienfeld unter Eigenschaften die folgenden
Optionen an:

Wählen Sie eine der folgenden Optionen:
Aus deaktiviert die Dehnung und setzt den Clip auf die ursprüngliche Länge zurück.
Echtzeit lässt Sie das Ergebnis der Dehnung hören, während Sie Clips ziehen. Dieser Modus ist gut für die Verwendung
während des Bearbeitungsprozesses geeignet.
Gerendert (hohe Qualität) erfordert eine längere Bearbeitungsdauer, kann jedoch dabei helfen, hörbare Artefakte zu
vermeiden. Wählen Sie diesen Modus, wenn im Echtzeit-Modus die Wiedergabe langsam oder die Leistung eingeschränkt ist.

Wählen Sie eine der folgenden Optionen:
Monophon ist ideal für Solo-Musikinstrumente oder Dialoge.
Polyphon ist ideal für Musik mit mehreren Instrumenten oder für komplexe Umgebungsgeräusche.
Varispeed ändert neben der Dauer auch die Tonhöhe, ähnlich wie die Beschleunigung oder Verlangsamung an analogen
Bandgeräten.

Um denselben Modus schnell auf alle Clips anzuwenden, wählen Sie Clip > Dehnen > Alle gedehnten Clips in Echtzeit oder Alle gedehnten
Clips rendern.

Verwenden Sie für Anpassungen, die genauer sind als das Ziehen von Clips im Editor numerische Eingaben.

Legen Sie die folgenden Optionen fest:
Übergangsempfindlichkeit (verfügbar im Modus Polyphon) setzt die Empfindlichkeit auf Übergänge wie z. B. Trommelschläge
oder die Anfänge von Noten, die als Ankerpunkte für die Dehnung verwendet werden. Erhöhen Sie diesen Wert, wenn
Übergänge unnatürlich klingen.
Fenstergröße bestimmt die Größe (in Millisekunden) für jeden Teil der verarbeiteten Audiodaten. Passen Sie diesen Wert nur
an, wenn ein Echo oder flanschende Artefakte auftreten.
Die Einstellungen für Präzision (verfügbar im Modus Gerendert) bestimmen den Kompromiss zwischen Qualität und
Verarbeitungsgeschwindigkeit.
Formanten beibehalten (verfügbar, wenn Gerendert und Monophon ausgewählt sind) passt die Klangfarbe von Instrumenten
und Stimmen an und sorgt dafür, dass das Ergebnis bei der Transponierung realitätsnah bleibt.

Um männliche Stimmen weiblich klingen zu lassen und umgekehrt, wählen Sie „Formanten beibehalten“ aus, und führen Sie eine starke
Transponierung durch.
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Grundlegende Multitrack-Steuerungen
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Video-, Audio-, Bus- und Master-Tracks – Grundlagen
Auswählen zwischen Mono-, Stereo- und 5.1-Tracks
Hinzufügen oder Löschen von Tracks
Benennen oder Verschieben von Tracks
Vertikales Zoomen von Tracks
Stummschalten von Tracks und Kennzeichnen von Tracks als Solo
Anwenden der gleichen Einstellungen auf alle Tracks
Einstellen der Track-Ausgangslautstärke
Balance von Tracks in Stereo
Duplizieren von Tracks

Video-, Audio-, Bus- und Master-Tracks – Grundlagen
Multitrack-Sessions können vier verschiedene Track-Typen enthalten:

Video-Tracks  enthalten einen importierten Video-Clip. Eine Session kann gleichzeitig einen Video-Track und -Clip
enthalten. Sie können im Videobereich („Fenster“ > „Video“) eine Vorschau anzeigen.

Audio-Tracks  enthalten importierte Audiodaten oder Clips, die in der aktuellen Session aufgenommen wurden. Diese Tracks
bieten die umfassendste Palette an Steuerelementen, mit denen Sie Ein- und Ausgänge angeben, Effekte und Ausgleich
anwenden, Audiodaten an Sends und Busse weiterleiten und Mischvorgänge automatisieren können.

Mit Bus-Tracks  können Sie die Ausgänge mehrerer Audio-Tracks oder Sends kombinieren und sie gemeinsam steuern.

Mit dem Master-Track , der immer der letzte in einer Session ist, können Sie die Ausgänge mehrerer Tracks und Busse
mühelos kombinieren und mit einem einzigen Fader steuern.

Weitere Informationen finden Sie unter Audio an Busse, Sends und den Master-Track leiten.

Auswählen zwischen Mono-, Stereo- und 5.1-Tracks
Multitrack-Sessions unterstützen eine unbegrenzte Anzahl von Mono-, Stereo- und 5.1-Audio- und -Bus-Tracks. Wählen Sie beim Hinzufügen von
Tracks eine Kanalkonfiguration basierend auf der Konfiguration des Master-Tracks:

Fügen Sie für Mono-Master-Tracks Mono-Audio- und -Bus-Tracks hinzu.

Fügen Sie für Stereo-Master-Tracks Stereo-Audio- und -Bus-Tracks hinzu, außer für Audio-Tracks mit Mono-Quellen (wie
einem einzelnen Mikrofon).

Fügen Sie für 5.1-Master-Tracks Stereo-Audio-Tracks und 5.1-Bus-Tracks hinzu (um korrekte Verstärkungsstufen
beizubehalten). Wenn jedoch auch 5.1-Audio-Clips vorhanden sind, fügen Sie für diese Clips 5.1-Audio-Tracks hinzu.

Um Track-Kanäle zu identifizieren, beachten Sie die Messer im Editor oder im Mischerbereich:
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A.  Mono B.  Stereo C.  5.1

Hinzufügen oder Löschen von Tracks
Hinweis: In einer Multitrack-Session wird nur ein Video-Track unterstützt, der von Adobe Audition immer oben im Editor eingefügt wird.

 Führen Sie im Editor oder Mischer folgende Schritte aus:

Um einen Track einzufügen, wählen Sie den Track aus, der dem eingefügten Track vorausgehen soll, und wählen Sie
„Multitrack“ > „Track“ > „[Track-Typ] hinzufügen“.

Um einen Track zu löschen, wählen Sie ihn aus und wählen Sie „Multitrack“ > „Track“ > „Ausgewählten Track löschen“.

Weitere Informationen finden Sie in den folgenden Abschnitten:

Einfügen einer Audiodatei in eine Multitrack-Session

Benennen oder Verschieben von Tracks
Sie können Tracks zur besseren Unterscheidung benennen oder sie verschieben, um verwandte Tracks zusammen anzuzeigen.

Geben Sie im Editor oder im Mischer den Namen in das Textfeld ein.

Textfeld „Name“ im Editor

Positionieren Sie den Mauszeiger links neben dem Tracknamen und ziehen Sie dann im Editor nach oben oder unten bzw. im
Mischer nach rechts oder links.

Einen Track im Editor verschieben

Vertikales Zoomen von Tracks
Mit den vertikalen Zoom-Steuerungen rechts unten im Editor zoomen Sie alle Tracks gleichzeitig. Wenn eine Session viele Tracks umfasst, können
Sie diese jedoch auch einzeln zoomen.

 Ziehen Sie in der Track-Steuerung den oberen oder unteren Rand des Tracks nach oben oder unten.
Um alle Tracks schnell zu zoomen, drehen Sie das Mausrad über den Track-Steuerungen. Um die Größe aller Track-Steuerungen horizontal zu
ändern, ziehen Sie den rechten Rand.

http://helpx.adobe.com/en/audition/using/creating-opening-files.html#insert_an_audio_file_into_a_multitrack_session
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Vertikales Zoomen eines einzelnen Tracks

Weitere Techniken finden Sie unter Zoomen von Audio im Editor.

Stummschalten von Tracks und Kennzeichnen von Tracks als Solo
Wenn Sie einen Track vom Rest der Mischung getrennt anhören möchten, können Sie ihn als Solo kennzeichnen. Umgekehrt können Sie einen
Track stummschalten, um nur den Rest der Mischung zu hören.

Klicken Sie zum Stummschalten eines Tracks im Editor oder im Mischer auf die Schaltfläche „Stumm“ .

Klicken Sie zum Kennzeichnen eines Tracks als Solo im Editor oder im Mischer auf die Schaltfläche „Solo“ . Um den Solo-
Modus automatisch von anderen Tracks zu entfernen, klicken Sie bei gedrückter Strg-Taste (Windows) bzw. Befehlstaste
(Mac OS).

Um den Solo-Modus standardmäßig von anderen Tracks zu entfernen, aktivieren Sie im Dialogfeld „Voreinstellungen“ im
Bereich „Multitrack“ für „Track-Solo“ die Option „Exklusiv“. (Wenn Sie den Solo-Modus für einen Bus aktivieren, wird der
Solo-Modus unabhängig von dieser Einstellung für alle zugewiesenen Tracks aktiviert.)

Anwenden der gleichen Einstellungen auf alle Tracks
Sie können Ihre Effizienz steigern, indem Sie mehrere Einstellungen schnell auf eine gesamte Session anwenden.

 Halten Sie Strg+Umschalttaste (Windows) oder Befehlstaste+Umschalttaste (Mac OS) gedrückt. Wählen Sie anschließend für einen beliebigen
Track eine Einstellung für „Eingang“, „Ausgang“, „Stumm“, „Solo“, „Für Aufnahme vorbereiten“ oder „Eingangsüberwachung“.
Weitere Informationen finden Sie in den folgenden Abschnitten:

Einstellen der Track-Ausgangslautstärke
 Führen Sie einen der folgenden Schritte aus:

Ziehen Sie im Editor den Lautstärkeregler . Halten Sie die Umschalttaste gedrückt, um die Einstellungen in großen Schritten
zu ändern. Halten Sie die Strg-Taste (Windows) bzw. Befehlstaste (Mac OS) gedrückt, um die Einstellungen in extrem kleinen
Schritten zu ändern.

Ziehen Sie im Mischer den Track-Fader oder klicken Sie darüber oder darunter, um ihn schrittweise zur nächsten Unterteilung
zu verschieben. Um den Fader an einen bestimmten Punkt zu verschieben, klicken Sie bei gedrückter Alt-Taste (Windows)
bzw. Wahltaste (Mac OS) über oder unter den Fader.

Um Regler und Fader auf Null zu stellen (Verstärkungsfaktor), klicken Sie bei gedrückter Alt-Taste (Windows) bzw. Wahltaste (Mac OS) direkt
darauf.

Balance von Tracks in Stereo

 Ziehen Sie den Balanceregler  im Editor oder Mischer.
Halten Sie die Umschalttaste gedrückt, um die Einstellungen in großen Schritten zu ändern. Halten Sie die Strg-Taste (Windows) bzw.
Befehlstaste (Mac OS) gedrückt, um die Einstellungen in extrem kleinen Schritten zu ändern.

Standardmäßig verwendet der Multitrack-Editor für die Balance eine Methode gleicher Leistung, bei der die wahrgenommene Gesamtlautstärke
konstant gehalten wird, indem ein Kanal im Vergleich zum anderen leicht verstärkt wird. Um den Verstärkungsbetrag zu ändern oder zu einer
logarithmischen Balance umzuschalten (bei der ein Kanal gedämpft wird), ändern Sie in den Voreinstellungen unter „Multitrack“ den Balance-
Modus.

http://helpx.adobe.com/en/audition/using/viewing-zooming-navigating-audio.html#zoom_audio_in_the_editor_panel
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Um alle Clips, Effekte, den gesamten Ausgleich und alle Hüllkurven in einem Track zu kopieren, duplizieren Sie den Track. Das Duplizieren von
Tracks bietet einen guten Ausgangspunkt für neue Anpassungen und unterstützt Sie beim Vergleichen verschiedener Verarbeitungs- und
Automatisierungseinstellungen.

1. Wählen Sie im Editor oder im Mischer einen Track aus.
2. Wählen Sie „Multitrack“ > „Track“ > „Ausgewählten Track duplizieren“.

Verwandte Hilfethemen
Automatisieren von Track-Einstellungen

Anwenden von Effekten im Multitrack-Editor

  |  

http://helpx.adobe.com/audition/using/automating-mixes-envelopes1.html#automating_track_settings
http://helpx.adobe.com/audition/using/applying-effects-multitrack-editor.html
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Anpassen der Lautstärke von Multitrack-Clips
Überblenden von Multitrack-Clips
Erstellen eines einzelnen Audio-Clips aus mehreren Clips
Erstellen eines Audio-Clips aus einem Bus- oder Master-Track

Nähere Informationen zum Überblenden einzelner Audiodateien finden Sie unter Überblenden und Ändern der Amplitude. (Die untenstehenden
Themen beziehen sich auf Multitrack-Clips.)

Anpassen der Lautstärke von Multitrack-Clips
Wenn Multitrack-Clips stark unterschiedliche Lautstärken aufweisen und so das Mischen erschweren, können Sie die Lautstärken anpassen. Da
Änderungen im Multitrack-Editor nicht zerstörerisch sind, können Sie diese Anpassungen vollständig rückgängig machen. Siehe Angleichen der
Lautstärke mehrerer Dateien, um die Lautstärke von Quelldateien stattdessen dauerhaft zu ändern.

1. Zum Auswählen mehrerer Clips aktivieren Sie das Verschieben-  oder Zeitauswahlwerkzeug  und klicken Sie bei
gedrückter Strg-Taste (Windows) bzw. Befehlstaste (Mac OS).

2. Wählen Sie „Clip“ > „Clip-Lautstärke anpassen“.

3. Wählen Sie im Popup-Menü eine der folgenden Optionen:

Lautstärke Führt die Anpassung basierend auf einer angegebenen Durchschnittslautstärke durch.

Wahrgenommene Lautstärke Führt die Anpassung basierend auf einer angegebenen wahrgenommen Lautstärke durch,
wobei die Empfindlichkeit des menschlichen Gehörs für mittlere Frequenzen besonders berücksichtigt wird. Diese Option
eignet sich gut, sofern die Frequenzbetonung nicht stark variiert (wenn beispielsweise in einer kurzen Passage Frequenzen im
mittleren Bereich stark ausgeprägt sind, Bassfrequenzen dagegen an einer anderen Stelle).

Spitzenlautstärke Führt die Anpassung basierend auf einer angegebenen Spitzenamplitude durch und normalisiert die Clips.
Da durch diese Option der Dynamikbereich erhalten bleibt, eignet sie sich gut für Clips, die weiter verarbeitet werden sollen,
oder für hochdynamische Audiodaten wie klassische Musik.

RMS-Amplitude insgesamt Führt die Anpassung basierend auf einer angegebenen RMS-Gesamtlautstärke durch. Beispiel:
Wenn zwei Dateien überwiegend Abschnitte mit –50 dBFS enthalten, bilden die RMS-Werte dies ab, selbst wenn eine Datei
lautere Passagen enthält.

4. Geben Sie eine Ziellautstärke ein.

Überblenden von Multitrack-Clips
Mit On-Clip-Fade- und Überblendungssteuerungen können Sie Kurven und Dauer der Überblendung optisch anpassen. Steuerungen zum Ein-
und Ausblenden werden immer in der oberen linken und rechten Ecke von Clips angezeigt. Steuerungen für Überblendungen werden nur
angezeigt, wenn Sie Clips überlagern.

On-Clip-Steuerungen
A.  Steuerelemente in Clip-Ecken zum Ein- und Ausblenden ziehen B.  Clips für Überblendung überlagern

To

http://helpx.adobe.com/en/audition/using/automating-common-tasks-cs6.html#match_volume_across_multiple_filesMatch-
http://helpx.adobe.com/en/audition/using/automating-common-tasks-cs6.html#match_volume_across_multiple_filesMatch-
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Ein- oder Ausblenden eines Clips
 Ziehen Sie das Fade-Symbol   in der oberen linken oder rechten Ecke des Clips nach innen, um die Fade-Länge festzulegen, und ziehen

Sie das Symbol nach oben oder unten, um die Fade-Kurve anzupassen.

Überblenden überlagerter Clips
Wenn Sie Clips im selben Track überblenden, überlagern Sie die Clips, um die Größe des Übergangsbereichs festzulegen (je größer der
überlappende Bereich ist, desto länger ist der Übergang).

1. Platzieren Sie zwei Clips im selben Track und verschieben Sie sie so, dass sie einander überlappen. (Siehe Auswählen und
Verschieben von Clips.)

2. Ziehen Sie oben im Überlappungsbereich das linke  oder rechte  Fade-Symbol nach oben oder unten, um die Fade-
Kurven anzupassen.

Überblendungsoptionen
Um auf die folgenden Überblendungsoptionen zuzugreifen, wählen Sie einen Clip aus und klicken Sie entweder im Editor mit der rechten
Maustaste auf ein Überblendungssymbol oder wählen Sie „Clip“ > „Einblenden“ bzw. „Ausblenden“.

Kein Überblenden Löscht den Fade oder die Überblendung.
Einblenden, Überblenden oder Ausblenden Wenn sich Clips überlappen, können Sie den Überblendungstyp auswählen.
Symmetrisch oder Asymmetrisch (nur bei Überblendungen) Legt fest, wie die linke und rechte Fade-Kurve interagiert, wenn Sie sie nach
oben oder unten ziehen. Mit der Option „Symmetrisch“ werden beide Fades identisch angepasst, mit „Asymmetrisch“ können Sie die Fades
individuell anpassen.
Linear oder Kosinus Wendet einen gleichmäßigen, linearen Fade oder einen S-förmigen Fade an, der langsam beginnt, dann die Amplitude
schnell ändert und langsam endet.

Um während des Ziehens der Fade-Symbole zwischen linearem und Kosinus-Modus umzuschalten, halten Sie die Strg-Taste (Windows) bzw.
Befehlstaste (Mac OS) gedrückt.

Automatische Überblendungen aktiviert Überblendet überlagerte Clips. Deaktivieren Sie diese Option, wenn automatische Überblendungen
nicht erwünscht sind oder mit anderen Aufgaben, wie z. B. dem Zuschneiden von Clips, in Konflikt stehen.

Erstellen eines einzelnen Audio-Clips aus mehreren Clips
Sie können den Inhalt mehrerer Clips im selben Zeitbereich kombinieren und so einen einzelnen Clip erstellen, den Sie im Multitrack- oder
Wellenform-Editor schnell bearbeiten können.

Erstellen eines einzelnen Clips aus mehreren Clips im Multitrack-Editor

1. Führen Sie im Editor einen der folgenden Schritte aus:

Wählen Sie einen bestimmten Zeitbereich aus. (Siehe Auswählen von Bereichen im Multitrack-Editor.)

Wählen Sie bestimmte Clips aus, wenn Sie einen Bounce in einen neuen Track durchführen.

Wählen Sie keine Option aus, um eine vollständige Session abzumischen.

2. Führen Sie einen der folgenden Schritte aus, um den Inhalt der ursprünglichen Clips zu kombinieren:

Zum Erstellen eines Tracks und Clips im Multitrack-Editor wählen Sie „Multitrack“ > „Bounce in neuen Track“.

Zum Erstellen einer Datei im Wellenform-Editor wählen Sie „Multitrack“ > „In neuer Datei abmischen“.

http://helpx.adobe.com/en/audition/using/arranging-editing-multitrack-clips.html#select_and_move_clips
http://helpx.adobe.com/en/audition/using/arranging-editing-multitrack-clips.html#select_and_move_clips
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Informationen zum Abmischen einer gesamten Sitzung finden Sie unter Exportieren von Multitrack-Abmischdateien.

Erstellen eines Audio-Clips aus einem Bus- oder Master-Track
Wenn Sie Audiodaten aus einem Bus- oder Master-Track bearbeiten möchten, erstellen Sie einen Clip aus dem Track.

1. Wählen Sie im Editor einen Zeitbereich für den neuen Clip aus. (Siehe Auswählen von Bereichen im Multitrack-Editor.)
2. Klicken Sie in der Zeitleiste mit der rechten Maustaste auf einen Bus- oder Master-Track und wählen Sie „Bounce des

[Tracktyps] in neuen Track“.

In Adobe Audition wird ein neuer Track mit einem Clip erstellt, der die Bus- oder Master-Mischung wiedergibt.

Verwandte Hilfethemen
Exportieren von Multitrack-Abmischdateien

  |  
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Zugreifen auf freie Loops aus dem Fenster „Resource Central“
Einrasten am Looprhythmus
Aktivieren eines Loop-Clips und Ändern der Länge

Hinweis: Einige Eigenschaften der Windows-Version von Adobe Audition 3.0 sind nicht in CS5.5 verfügbar. Dazu gehören das Looptempo und
die Tonartanpassung, das Dehnen von Clip-Zeit, MIDI, das Metronom sowie einige Dateiformate und Effekte. Eine vollständige Liste finden Sie
unter Adobe Audition 3.0 features replaced or not implemented in CS5.5 (Funktionen aus Adobe Audition 3.0, die in CS5.5 ersetzt oder nicht
implementiert wurden).
In vielen Musikrichtungen werden gerne Loops eingesetzt. Dies gilt für grundlegende Rhythmustracks ebenso wie für umfangreiche Kompositionen.
Mit Adobe Audition können Sie eigene Loops erstellen oder über das Fenster „Resource Central“ aus Tausenden kostenlosen Loops wählen.

Mit Loops können Sie äußerst flexible Multitrack-Sessions erstellen. Obwohl Loops normalerweise nur einen oder zwei Musiktakte (vier bis acht
Beats) umfassen, können Sie sie durch einfaches Ziehen mit der Maus erweitern und wiederholen.

Loops in der Track-Anzeige identifizieren
A.  Keine Loop B.  Einzelne Loop C.  Erweiterte (wiederholte) Loop

Zugreifen auf freie Loops aus dem Fenster „Resource Central“
Das Fenster „Resource Central“ bietet eine umfangreiche Online-Bibliothek mit Loops, Soundeffekten und Musikhintergründen, auf die Sie in
Adobe Audition direkt zugreifen können.

1. Wählen Sie „Fenster“ > „Resource Central“.
2. Klicken Sie oben im Fenster „Resource Central“ auf „Loops“, „Soundeffekte“ oder „Musikhintergründe“.
3. Wählen Sie im Menü unter dem Suchfeld ein Genre.
4. Klicken Sie in der Liste der Ergebnisse auf die Wiedergabeschaltfläche, um eine Vorschau abzuspielen, oder auf den Pfeil

nach unten, um die Datei in Audition zu laden. (Häkchen in der Liste kennzeichnen bereits heruntergeladene Elemente.)

Einrasten am Looprhythmus
Um eine loopbasierte Session besser zu synchronisieren, müssen Sie das Zeitformat „Takte und Beats“ verwenden und „Einrasten“ aktivieren.
Fügen Sie anschließend Loops hinzu, um eine rhythmische Grundlage zu bilden, auf der Sie mit der Aufzeichnung neuer Audio-Clips aufbauen
können. (Sie können auch bestehende Audio-Clips hinzufügen. In diesem Fall werden jedoch nur die Start- und Endpunkte mit dem Looprhythmus
synchronisiert.)

1. Wählen Sie „Ansicht“ > „Zeitanzeige“ > „Takte und Beats“. (In diesem Lineal-Format wird die optische Abstimmung von Loops
und Beats erleichtert.)

2. Wählen Sie „Bearbeiten“ > „Einrasten“, und klicken Sie im Untermenü auf einen der folgenden Befehle:

http://kb2.adobe.com/cps/895/cpsid_89588.html
http://kb2.adobe.com/cps/895/cpsid_89588.html
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Einrasten bei Lineal (Grob) Rastet an Beats in Takten ein. Verwenden Sie diese Option für die Arbeit mit 1/4- oder 1/2-Takt-
Loopdateien.

Einrasten bei Clips Rastet am Anfang und Ende von Audio-Clips ein.

An Loops einrasten Rastet am Anfang und Ende von Loops in Audio-Clips ein.

Aktivieren eines Loop-Clips und Ändern der Länge
1. Klicken Sie im Multitrack-Editor mit der rechten Maustaste auf einen Audio-Clip und wählen Sie „Loop“ aus dem Kontextmenü.

2. Zeigen Sie mit der Maus auf den linken oder rechten Rand des Clips. Das Loop-Bearbeitungssymbol  wird angezeigt.
3. Ziehen Sie, um die Loop zu erweitern oder zu kürzen.

Je nachdem, wie weit Sie ziehen, wird die Loop vollständig oder teilweise wiederholt. Sie können beispielsweise eine Loop mit
einer Länge von einem Takt auf 3,5 Takte erweitern und sie auf einem Beat innerhalb des Takts enden lassen. Während Sie
die Maus bewegen, wird im Clip an jedem Takt eine vertikale weiße Linie angezeigt. Diese Einrastlinie zeigt die optimale
Ausrichtung an Beats in anderen Tracks an.

Eine Loop erweitern

Verwandte Hilfethemen
Einrasten an Clip-Endpunkten

Ändern des Zeitanzeigeformats

  |  
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Multitrack-Sessions
Bearbeiten von Multitrack-Sessions im Editor und Mischer
Auswählen von Bereichen im Multitrack-Editor
Anpassen von Start-Offset und Zeitanzeige für Multitrack-Sessions

Multitrack-Sessions
Im Multitrack-Editor können Sie mehrere Audiodateien zusammenmischen, um überlagerte Soundtracks und Musikkompositionen zu erstellen. Sie
können beliebig viele Tracks aufzeichnen und mischen; jeder Track kann so viele Clips wie benötigt enthalten – Einschränkungen ergeben sich
allein durch den Festplattenspeicherplatz und die Prozessorleistung. Wenn Ihnen eine Mischung zusagt, exportieren Sie die Abmischdatei und
verwenden sie auf einer CD, im Web oder andere Weise.

Der Multitrack-Editor ist eine äußerst flexible Echtzeit-Bearbeitungsumgebung, in der Sie Einstellungen während der Wiedergabe ändern und die
Ergebnisse direkt hören können. Beim Anhören einer Session können Sie zum Beispiel die Track-Lautstärke anpassen, um Tracks richtig zu
überblenden. Die vorgenommenen Änderungen sind nicht dauerhaft, d. h. nicht zerstörerisch. Wenn sich eine Mischung schon nächste Woche
oder auch im nächsten Jahr nicht mehr gut anhört, können Sie die ursprünglichen Quelldateien einfach neu abmischen und dabei Effekte beliebig
anwenden bzw. entfernen, um andere akustische Texturen zu erhalten.

In Adobe Audition werden Informationen über Quelldateien und Mischungseinstellungen in Sessiondateien (SESX-Dateien) gespeichert. Die
Sessiondateien sind relativ klein, da sie nur die Pfadnamen der Quelldateien und Referenzen auf Mischungsparameter enthalten (z. B. Lautstärke,
Balance und Effekte). Damit Sie die Sessiondateien leichter verwalten können, sollten Sie sie in demselben Ordner speichern wie die Quelldateien,
die sie referenzieren. Wenn Sie eine Session später auf einen anderen Computer übertragen möchten, kopieren Sie einfach den gesamten
Ordner.

Bearbeiten von Multitrack-Sessions im Editor und Mischer
Der Editor im Multitrack-Editor verfügt über mehrere Elemente zum Mischen und Bearbeiten von Sessions. Mit den Track-Steuerungen auf der
linken Seite stellen Sie trackspezifische Einstellungen, wie z. B. Lautstärke und Balance, ein. In der Timeline rechts bearbeiten Sie die Clips und
Automatisierungs-Hüllkurven in den einzelnen Tracks.

Editor im Multitrack-Editor
A.  Track-Steuerungen B.  Zoom-Navigator C.  Vertikale Bildlaufleiste D.  Track

Der Mischer („Fenster“ > „Mischer“) zeigt eine andere Ansicht einer Session an, in der gleichzeitig mehrere Tracks und Steuerungen, jedoch keine
Clips sichtbar sind. Der Mischer eignet sich insbesondere für das Mischen umfangreicher Sessions mit vielen Tracks.
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Steuerungen im Mischer:
A.  Eingänge B.  Effekte C.  Sends D.  Entzerrung E.  Lautstärke F.  Ausgänge

Auswählen von Bereichen im Multitrack-Editor

Gleichzeitige Auswahl eines Bereichs und mehrerer Clips

1. Wählen Sie in der Symbolleiste das Zeitauswahlwerkzeug .
2. Führen Sie im Editor einen der folgenden Schritte aus:

Wenn Sie einen Bereich markieren möchten, klicken Sie in einem leeren Bereich der Track-Anzeige und ziehen Sie den
Mauszeiger nach rechts oder links.

Um einen Bereich und Clips auszuwählen, klicken Sie in die Mitte eines Clips und ziehen Sie einen Auswahlrahmen.

Anpassen von Start-Offset und Zeitanzeige für Multitrack-Sessions
1. Klicken Sie im Editor auf einen beliebigen freien Bereich in der Track-Anzeige, um sicherzustellen, dass keine Clips

ausgewählt sind.



 

2. Wählen Sie „Fenster“ > „Eigenschaften“.

3. Passen Sie im Fenster „Eigenschaften“ folgende Optionen an:

Startzeit Legt den Offset der Startzeit fest, damit Sie Audiodaten in Adobe Audition an die Zeitanzeige in Videoanwendungen
anpassen können.

Erweiterte Einstellungen Um die Einstellungen für die Zeitanzeige in der aktuellen Session anzupassen, stellen Sie die
Optionen „Zeitformat“ und „Benutzerdefinierte Framerate“ ein. Nähere Informationen finden Sie unter Ändern des
Zeitanzeigeformats.

Verwandte Hilfethemen
Vergleich zwischen Wellenform- und Multitrack-Editor

Erstellen einer neuen Multitrack-Session

Speichern von Multitrack-Sessions

Anordnen und Bearbeiten von Multitrack-Clips

Automatisieren von Mischungen mit Hüllkurven

  |  
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Anzeigen oder Ausblenden von Track-Weiterleitung und EQ-Steuerungen
Zuweisen von Audio-Eingängen und -Ausgängen zu Tracks
Audio an Busse, Sends und den Master-Track leiten
Einrichten eines Sends
Angleichen von Tracks

Anzeigen oder Ausblenden von Track-Weiterleitung und EQ-Steuerungen
Lassen Sie sich von der Vielzahl der Weiterleitungs- und EQ-Steuerungen nicht verunsichern. Da sie für alle Tracks identisch sind, müssen Sie
den Umgang mit ihnen nur ein einziges Mal erlernen.

Ein- und Ausblenden von Sätzen von Audio-Track-Steuerungen
A.  Editor B.  Mischer

 Führen Sie eine der folgenden Operationen aus:

Klicken Sie links im Mischer auf das Dreieck zum Einblenden/Ausblenden für mindestens einen Steuerungssatz.

Klicken Sie links oben im Editor auf die Schaltfläche „Eingang/Ausgang“ , „Effekte“ , „Sends“  oder „EQ“ .

Ziehen Sie im Editor den rechten oder unteren Rand der Track-Steuerungen, um mehr oder weniger Details anzuzeigen.

Ziehen des rechten Rands der Track-Steuerungen, um mehr oder weniger Details anzuzeigen

Weitere Informationen finden Sie unter Vertikales Zoomen von Tracks.

Zuweisen von Audio-Eingängen und -Ausgängen zu Tracks

 Führen Sie im Bereich „Eingang/Ausgang“  des Editors oder Mischers folgende Schritte aus:

Wählen Sie im Eingangsmenü einen Hardware-Eingang.

Wählen Sie im Ausgangsmenü einen Bus, einen Master-Track oder einen Hardware-Ausgang.

Welche Hardware-Anschlüsse in der Liste angezeigt werden, hängt von den unter „Audiogeräte“ gewählten Voreinstellungen ab. (Siehe
Konfigurieren von Audio-Eingängen und -Ausgängen.)

Weitere Informationen finden Sie in den folgenden Abschnitten:
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Umkehren der Polarität eines Eingangs
Wenn ein Paar Stereoeingänge, wie z. B. Overhead-Schlagzeugmikrofone, phasenverschoben sind, hören Sie einen dumpferen Klang und ein
engeres Stereobild. Um dieses Problem zu beheben, können Sie die Polarität eines Eingangs umkehren.

 Klicken Sie im Bereich der Eingangssteuerungen  des Mischers auf die Schaltfläche „Polarität umkehren“ .
Nähere Informationen zur Audiophase finden Sie unter Interaktion von Klangwellen.

Audio an Busse, Sends und den Master-Track leiten
Mit Bussen, Sends und dem Master-Track können Sie mehrere Track-Ausgaben an einen Steuerungssatz leiten. Mit diesen kombinierten
Steuerungen können Sie eine Session effizient organisieren und mischen.

Informationen zum Speichern der Ausgabe eines Audio- Bus- oder Mastertracks in einer Datei finden Sie unter Exportieren von Multitrack-
Abmischdateien.

Beispiel für die Audio-Leitung von Tracks
A.  Gesang B.  Hall-Bus empfängt Gesangs- und Gitarren-Sends C.  Gitarre D.  Schlagzeug-Bus mit kombinierten Schlagzeugausgängen E.
Bass mit direktem Ausgang an Hardware F.  Master-Track G.  Hardware-Ausgaben

Erläuterungen zu Bus-Tracks
Mit Bus-Tracks können Sie die Ausgänge mehrerer Audio-Tracks oder Sends kombinieren und sie gemeinsam steuern. Um zum Beispiel die
Lautstärke mehrerer Schlagzeug-Tracks mit einem einzigen Fader zu steuern, geben Sie alle Tracks in einen einzigen Bus aus. Zum Optimieren
der Systemleistung können Sie auch einen einzelnen Halleffekt auf einen Bus-Track anwenden und anschließend das Send-Output aus mehreren
Tracks in diesen Bus ausgeben. (Die einzelne Anwendung des gleichen Hall-Effekts auf mehrere Tracks führt zu einer nicht effizienten Nutzung
der Prozessorressourcen.)

Obwohl Bus-Tracks nicht über einen Hardware-Eingang verfügen, verfügen sie über alle anderen Funktionen von Audio-Tracks. Sie können
Effekte und Ausgleich anwenden und die Änderungen im Zeitverlauf automatisieren. Bei den meisten Mischungen geben Sie Busse an Hardware-
Ports oder den Master-Track aus. Wenn Sie Busse kombinieren müssen, können Sie sie auch in andere Busse ausgeben.

http://helpx.adobe.com/en/audition/using/saving-exporting-files1.html#export_multitrack_mixdown_files
http://helpx.adobe.com/en/audition/using/saving-exporting-files1.html#export_multitrack_mixdown_files


Beispiel für die Bus-Leitung:
A.  Schlagzeugkit-Bus B.  Hand-Drum-Bus C.  Kombinierter Schlagzeug-Bus als Ausgang an Master-Track oder Hardware

Sends
Mit Sends können Sie Audiodaten von einem Track an mehrere Busse leiten und verfügen so über eine enorme Flexibilität bei der Signalleitung.
Jeder Track stellt bis zu 16 Sends bereit, die Sie unabhängig vom Track-Ausgang konfigurieren können. Sie können zum Beispiel einen noch nicht
verarbeiteten Track direkt an einen Hardware-Anschluss ausgeben, dabei jedoch Send 1 an einen Hall-Bus und Send 2 an einen Kopfhörer-Bus.
(Mit einem Kopfhörer-Bus hören die Künstler bei der Aufnahme eine besondere Mischung. Schlagzeuger bevorzugen so zum Beispiel
möglicherweise einen lauteren Bass-Track.)

Tracks an mehrere Busse senden
A.  Send 1 mit Ausgang an Verzögerungs-Bus B.  Send 2 mit Ausgang an Hall-Bus C.  Master-Track kombiniert Gesangs-, Gitarren-,
Verzögerungs- und Hall-Ausgänge

Erläuterungen zum Master-Track
Eine Session umfasst immer einen Master-Track, so dass Sie die Ausgänge mehrerer Tracks und Busse auf einfache Weise kombinieren und mit
einem einzigen Fader steuern können. Da der Master-Track ganz am Ende des Signalpfads vorhanden ist, bietet er weniger Leitungsoptionen als
Audio- und Bus-Tracks. Der Master-Track kann keine direkte Verbindung zu Audio-Eingängen herstellen oder in Sends bzw. Busse ausgeben; die
Ausgabe kann nur direkt in Hardware-Anschlüsse erfolgen.
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Der Master-Track befindet sich immer am Ende des Signalpfads.
A.  Editor B.  Mischer

Einrichten eines Sends
Beim Einrichten eines Sends legen Sie die Lautstärke und Stereo-Balance fest, die er an einen zugewiesenen Bus ausgibt. Sie platzieren den
Send entweder als Pre- oder Post-Fader. Die Track-Lautstärke hat keine Auswirkungen auf Pre-Fader-Sends, jedoch auf Post-Fader-Sends. (Sie
können zum Beispiel einen Pre-Fader-Send an einen Hall-Bus ausgeben, so dass der Nachhall nach dem Ausblenden des Audiodirektsignals
fortgesetzt wird. Bei der Ausgabe eines Post-Fader-Sends wird der Hall-Nachklang gleichzeitig mit dem Audiodirektsignal ausgeblendet.)

Pre- und Post-Fader-Effekt und Send-Weiterleitung für jeden Track
A.  Eingang B.  EQ C.  Track-Lautstärke D.  Track-Stummschalten E.  Send F.  Effekte-Rack

1. Klicken Sie im Sends-Bereich  des Mischers auf die Ein/Aus-Schaltfläche .

2. Klicken Sie auf die Schaltfläche „Pre-Fader/Post-Fader“, um den Send vor der Track-Lautstärke  oder danach  zu
platzieren.

3. Stellen Sie die Lautstärke  und Balance  ein.
4. Wählen Sie aus dem Popup-Menü „Send“ einen Bus.

Weitere Informationen finden Sie unter Einfügen der Effekte vor und nach Sends und EQ.

Angleichen von Tracks
Der Multitrack-Editor bietet für jeden Track einen parametrischen Equalizer.

http://helpx.adobe.com/en/audition/using/applying-effects-multitrack-editor.html#insert_effects_before_or_after_sends_and_eq


 

 Führen Sie im EQ-Bereich  des Editors oder Mischers einen der folgenden Schritte aus:

Doppelklicken Sie auf den Graphen, um auf die detaillierten Steuerungen im Fenster „Track-EQ“ zuzugreifen. (Siehe Der Effekt
„Parametrischer Equalizer“.)

Klicken Sie auf die EQ-Power-Schaltfläche , um das Audio mit und ohne Equalizer zu vergleichen.

Verwandte Hilfethemen
Verwenden von Effektvorgaben
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Video- und Surroundsound

Ein Teil des auf dieser Seite verlinkten Inhalts ist möglicherweise nur in englischer Sprache verfügbar.



5.1 Surroundsound
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Monitoring von 5.1 Surroundsound
Bearbeiten von 5.1-Surround-Dateien
Balance von Tracks in einer 5.1-Surround-Mischung
Schwenken von Sends zu einem 5.1-Bus-Track

Monitoring von 5.1 Surroundsound
Das von Adobe Audition unterstützte Verfahren 5.1 Surroundsound erfordert fünf Lautsprecher und einen Niederfrequenz-Subwoofer (LFE). Damit
Sie 5.1-Surroundsound korrekt wahrnehmen können, muss Ihr Computer über eine Soundkarte mit mindestens sechs Ausgängen verfügen.
Außerdem müssen diese Ausgänge in Audition den korrekten Kanälen zugewiesen werden.

1. Wählen Sie „Bearbeiten“ > „Voreinstellungen“ > „Audiokanalzuordnung“ (Windows) bzw. „Audition“ > „Voreinstellungen“ >
„Audiokanalzuordnung“ (Mac OS).

2. Ordnen Sie jeden 5.1-Kanal einem Ausgang der Soundkarte zu:

L: Linker Frontlautsprecher.

R: Rechter Frontlautsprecher.

C: Center-Lautsprecher.

LFE: Subwoofer

Ls: Linker Surround-Lautsprecher.

Rs: Rechter Surround-Lautsprecher.

Weitere Informationen finden Sie unter Konfigurieren von Audio-Eingängen und -Ausgängen.

Bearbeiten von 5.1-Surround-Dateien
Im Wellenform-Editor können Sie 5.1-Surround-Dateien mit denselben Werkzeugen bearbeiten, die Sie auch für Mono- und Stereodateien
verwenden. Siehe Bearbeiten von Audiodateien.

Informationen zum Beschränken der Bearbeitung auf einen Teil der 5.1-Kanäle finden Sie unter Angeben der zu bearbeitenden Kanäle.

Balance von Tracks in einer 5.1-Surround-Mischung
1. Öffnen oder erstellen Sie eine 5.1.-Multitrack-Session. (Siehe Erstellen einer neuen Multitrack-Session.)

2. Um den Spurtonschwenk zu öffnen, führen Sie einen der folgenden Schritte aus:

Wählen Sie „Fenster“ > „Spurtonschwenk“. Wählen Sie anschließend im Editor einen Mono- oder Stereo-Track aus.

Doppelklicken Sie im Editor oder im Mischer auf das Surround-Diagramm für einen Mono- oder Stereo-Track.

Hinweis: Sie können nur Mono- oder Stereo-Tracks schwenken, nicht jedoch 5.1.-Tracks. Wenn Sie die relative Lautstärke
der Kanäle in einer 5.1-Datei anpassen möchten, öffnen Sie sie im Wellenform-Editor.

Doppelklicken auf ein Surround-Diagramm, um den Spurtonschwenk zu öffnen

3. Führen Sie im Spurtonschwenk einen der folgenden Schritte aus:

http://helpx.adobe.com/en/audition/using/creating-opening-files.html#create_a_new_multitrack_session
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Zum Aktivieren bzw. Deaktivieren eines Kanals klicken Sie auf die Schaltflächen L, C, R, Ls und Rs. Oder klicken Sie auf
„Nur LFE“, um Audio nur an den Subwoofer zu senden.

Ziehen Sie im großen Surround-Diagramm mit der Maus, um die Position des Signals zu ändern.

Während Sie ziehen, ändern sich die Längen der von den Lautsprechern ausgehenden weißen Linien, wodurch die
Signalleistung der einzelnen Lautsprecher dargestellt wird. Im Hintergrund stellen grüne und violette Bereiche die
Platzierung des linken und rechten Stereobilds dar. Blaue Bereiche zeigen an, wo es zu Überlappungen im Stereobild
kommt.

Legen Sie unterhalb des Surround-Diagramms folgende Optionen fest:

Winkel Gibt an, aus welcher Position im Surround-Feld der Ton wahrgenommen wird. Beispiel: –90° bedeutet direkt von
links, 90° direkt von rechts.

Stereobreite Bestimmt die Trennung zwischen Stereo-Audio-Tracks. Null und –180° führen zu einem Monosignal, –90°
generiert die maximale Trennung.

Radius Bestimmt, wie weit um das Surround-Feld sich der Ton erstreckt. Beispiel: 100 % führt zu einem konzentrierten
Klang aus nur wenigen Lautsprechern, während 0 % zu einem unkonzentrierten Klang aus allen Lautsprechern führt.

Mitte Legt bei Tracks, die im Surround-Feld vorne liegen, den Prozentsatz des Center-Kanals relativ zum Pegel des
linken und rechten Kanals fest.

LFE Steuert den Pegel des Signals, das an den Subwoofer gesendet wird.

4. Wenn Sie die Balance weiterer Tracks einstellen möchten, wählen Sie sie einfach im Editor aus. Im Spurtonschwenk werden
automatisch die individuellen Einstellungen für jeden Track angezeigt.

Informationen zum dynamischen Schwenken von Tracks in Abhängigkeit der Zeit finden Sie unter Automatisieren von Track-Einstellungen.

Schwenken von Sends zu einem 5.1-Bus-Track
1. Erstellen Sie im Multitrack-Editor einen 5.1-Bus-Track. (Siehe Hinzufügen oder Löschen von Tracks.)

2. Wählen Sie aus dem Send-Menü eines Audio-Tracks den 5.1-Bus-Track. (Siehe Einrichten eines Sends.)

Im Sends-Bereich  des Editors und Mischers wird ein Surround-Diagramm angezeigt. Doppelklicken Sie auf das
Diagramm, um den Spurtonschwenk für den Send zu öffnen.

Verwandte Hilfethemen

  |  

http://helpx.adobe.com/en/audition/using/automating-mixes-envelopes1.html#automating_track_settings
http://creativecommons.org/licenses/by-nc-sa/3.0/


Importieren von Videos und Arbeiten mit Video-Clips
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Einfügen einer Videodatei in eine Multitrack-Session
Einrasten an Frames in einem Video-Clip
Anpassen des Videobereichs

Einfügen einer Videodatei in eine Multitrack-Session
Im Multitrack-Editor können Sie Videodateien einfügen, um eine Session präzise mit einer Videovorschau synchronisieren zu können. Wenn Sie
eine Videodatei einfügen, wird deren Video-Clip oben in der Track-Anzeige angezeigt und der Audio-Clip wird im Track darunter angezeigt.

Sie können einen Video-Clip unabhängig vom Audio-Clip mit dem Original-Soundtrack verschieben. Wenn Sie solche Clips allerdings synchron
halten möchten, wählen Sie vor dem Verschieben beide Clips aus. Klicken Sie hierfür bei gedrückter Strg-Taste (Windows) bzw. Befehlstaste
(Mac OS) auf die Clips.

Hinweis: Eine Session kann jeweils nur einen Video-Clip enthalten.

Verknüpfte Video- und Audio-Clips (zum Synchronisieren beide auswählen)

1. Platzieren Sie im Multitrack-Editor die Marke für die aktuelle Zeit an der gewünschten Einfügeposition.
2. Wählen Sie „Multitrack“ > „Datei einfügen“ und wählen Sie eine Videodatei in einem unterstützten Format aus. (Siehe

Videodateiformate.)
3. Wenn Sie das Mischen der Audiodaten für das Video abgeschlossen haben, exportieren Sie eine Abmischung und

importieren Sie sie in die Videoanwendung. (Siehe Exportieren von Multitrack-Abmischdateien.)

Um die Audiokomponenten einer Videodatei schnell zu bearbeiten, wählen Sie „Datei“ > „Öffnen“. Dieses Vorgehen eignet sich beispielsweise
zur Bearbeitung von Soundtracks, für die keine Videovorschau erforderlich ist, und zur Anpassung von Soundtracks, die für Audiomedien wie
Radio oder CD bestimmt sind.

Einrasten an Frames in einem Video-Clip
Um eine Multitrack-Session mit dem Video zu synchronisieren, lassen Sie Audio-Clips und die Marke für die aktuelle Zeit an Frames einrasten.

1. Wählen Sie „Ansicht“ > „Zeitanzeige“ und wählen Sie das SMPTE-Zeitformat, das der Framerate des Clips entspricht.
2. Wählen Sie „Bearbeiten“ > „Einrasten“ > „Einrasten bei Frames“.

Anpassen des Videobereichs
Im Videobereich können Sie während einer Multitrack-Session Video-Clips in der Vorschau wiedergeben, um einen Soundtrack mit bestimmten
Ereignissen (Szenenwechseln, Titelsequenzen, Spezialeffekten usw.) zu synchronisieren.

Um den Videobereich ein- oder auszublenden, wählen Sie „Fenster“ > „Video“.

http://helpx.adobe.com/de/audition/using/supported-file-formats.html#video_file_formats
http://helpx.adobe.com/en/audition/using/saving-exporting-files1.html#export_multitrack_mixdown_files


 

Videobereich und verknüpfter Clip im Editor

Klicken Sie zum Anpassen des Videobereichs mit der rechten Maustaste und wählen Sie eine der folgenden Optionen:
Einen Zoom-Prozentwert Vergrößert oder verkleinert den Bereich.
Am geeignetsten Passt die Vorschau an den Bereich an.
Verwandte Hilfethemen
Videodateiformate

Auswählen und Verschieben von Clips

Einrasten an Clip-Endpunkten

Zoomen von Audio im Editor

  |  

http://helpx.adobe.com/de/audition/using/supported-file-formats.html#video_file_formats
http://helpx.adobe.com/en/audition/using/arranging-editing-multitrack-clips.html#select_and_move_clips
http://helpx.adobe.com/audition/using/arranging-editing-multitrack-clips.html#snap_to_clip_endpoints
http://helpx.adobe.com/en/audition/using/viewing-zooming-navigating-audio.html#zoom_audio_in_the_editor_panel
http://creativecommons.org/licenses/by-nc-sa/3.0/


Arbeiten mit Videoanwendungen
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Bearbeiten von Audio-Clips aus Adobe Premiere Pro CS5.5 oder After Effects
Exportieren einer Multitrack-Mischung nach Premiere Pro CS5.5
Verknüpfen von Sessions mit exportierten Abmischdateien

Adobe empfiehlt Verfügen Sie über eine Schulung,
die Sie anderen anbieten möchten?

Integration von Premiere Pro
und Audition
Jason Levine
Nutzen Sie komplette Mischungen für maximale
Flexibilität in beiden Anwendungen.

Der Workflow von After
Effects nach Audition
Chris Meyer
Verbessern Sie Videoanimationen schnell mit
leistungsfähigen Audiotools.

Bearbeiten von Audio-Clips aus Adobe Premiere Pro CS5.5 oder After Effects
Sie können ausgewählte Clips im Wellenform-Editor schnell aus Adobe Premiere Pro® CS5.5 oder After Effects® heraus öffnen, um sie zu
reparieren oder zu optimieren. Beim Speichern der Änderungen werden die aktualisierten Audiodaten automatisch in Ihren Videoprojekten
angezeigt.

Wählen Sie in Adobe Premiere Pro „Bearbeiten“ > „In Adobe Audition bearbeiten“ > „Clip“.

Wählen Sie in After Effects „Bearbeiten“ > „In Adobe Audition bearbeiten“.

Weitere Informationen finden Sie, wenn Sie in der Hilfe zu Premiere Pro oder After Effects nach „Adobe Audition“ suchen.

Exportieren einer Multitrack-Mischung nach Premiere Pro CS5.5
Adobe Premiere Pro und Audition CS5.5 können Audio direkt zwischen Sequenzen und Multitrack-Sessions austauschen. Alle
Sequenzmarkierungen erscheinen in Audition. Separate Spuren können beibehalten werden und gewährleisten so maximale Flexibilität bei der
Bearbeitung.

Die Anwendungen tauschen Sequenzen und Sessions über ein gemeinsames XML-Format aus, das gemeinsam mit allen referenzierten
Audiodateien in einen Ordner exportiert wird.

Wenn Sie eine einzelne Abmischdatei an Premiere senden möchten und die Möglichkeit, individuelle Tracks zu exportieren, nicht benötigen,
finden Sie weitere Informationen unter Verknüpfen von Sessions mit exportierten Abmischdateien.

Mehrere Clips aus Audition, in Premiere zu Stämmen kombiniert

1. Wählen Sie „Multitrack“ > „Nach Adobe Premiere Pro exportieren“.

2. Geben Sie Namen und Speicherort des Ordners für die exportierte Session an und legen Sie folgende Optionen fest:

Abtastrate Standardmäßig ist die Abtastrate der Originalsequenz ausgewählt. Wählen Sie eine andere Rate aus, um ein
Resampling der Datei für verschiedene Ausgabemedien durchzuführen. (Siehe Abtastrate – Grundlagen.)

Jeden Track/Bus als Stamm exportieren Konvertiert die gesamte Dauer der Zeitleiste jedes Tracks in einen einzelnen Clip
und kombiniert ggf. mehrere Clips. Aktivieren Sie diese Option, um Clips zu erweitern und an den Start- und Endpunkten der
Sequenz auszurichten.

http://www.adobe.com/community/publishing/download.html
http://www.adobe.com/community/publishing/download.html
http://tv.adobe.com/watch/cs-55-production-premium-feature-tour-/experience-an-integrated-audioforvideo-workflow/
http://tv.adobe.com/watch/cs-55-production-premium-feature-tour-/experience-an-integrated-audioforvideo-workflow/
http://tv.adobe.com/show/adobe-evangelists-jason-levine/
http://tv.adobe.com/watch/after-effects-cs55-new-creative-techniques/ae-cs55-the-after-effectsaudition-workflow/
http://tv.adobe.com/watch/after-effects-cs55-new-creative-techniques/ae-cs55-the-after-effectsaudition-workflow/
http://www.crishdesign.com/
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Session abmischen nach Exportiert die Session in eine einzelne Mono-, Stereo- oder 5.1-Datei.

In Adobe Premiere Pro öffnen Öffnet die Sequenz automatisch in Premiere Pro. Deaktivieren Sie diese Option, wenn Sie die
Sequenz bearbeiten oder später auf einen anderen Computer übertragen möchten.

3. Klicken Sie auf „Exportieren“.

4. Wenn die exportierte XML-Datei in Premiere Pro geöffnet wird (entweder automatisch oder über den Befehl „Datei“ >
„Importieren“), wird das Dialogfeld „Adobe Audition-Spuren kopieren“ angezeigt.

Wählen Sie im Menü „In aktive Sequenz kopieren“ aus, wo die kopierten Audition-Tracks beginnen. Neue Tracks werden
unterhalb von vorhandenen hinzugefügt.

Informationen zum Senden von Sequenz-Audio aus Premiere Pro an Audition finden Sie in der Hilfe zu Premiere Pro unter Exportieren von
Sequenzspuren nach Adobe Audition.

Verknüpfen von Sessions mit exportierten Abmischdateien
Um mehrschichtige Video-Soundtracks zu erstellen, die auf einfache Weise aktualisiert werden können, verknüpfen Sie Multitrack-Sessions mit
exportierten Abmischdateien. Wenn Sie die exportierten Dateien in Anwendungen wie Adobe Premiere Pro auswählen, können Sie sie in Adobe
Audition neu mischen oder bearbeiten. Wiederholen Sie im weiteren Verlauf des Videoprojekts diesen Vorgang einfach, um einen optimalen
fertigen Soundtrack zu erhalten.

Wenn Sie Premiere Pro CS5.5 verwenden und statt Abmischdateien vollständige Multitrack-Mischungen freigeben möchten, finden Sie weitere
Informationen unter Exportieren einer Multitrack-Mischung nach Premiere Pro CS5.5.

Einbetten von „Original bearbeiten“-Daten in exportierte Abmischdateien

1. Öffnen Sie eine Multitrack-Session.

2. Wählen Sie „Bearbeiten“ > „Voreinstellungen“ > „Marker & Metadaten“ (Windows) bzw. „Audition“ > „Voreinstellungen“ >
„Marker & Metadaten“ (Mac OS).

3. Aktivieren Sie die Option „"Original bearbeiten"-Linkdaten in Multitrack-Abmischungen einbetten“.

4. Wenn Sie Abmischungen exportieren, aktivieren Sie die Option „Marker und andere Metadaten einschließen“.

Bearbeiten einer Abmischdatei über eine Videoanwendung

1. Wählen Sie in der Videoanwendung eine aus Adobe Audition exportierte Abmischdatei.

2. Wählen Sie „Bearbeiten“ > „Original“.

3. Wählen Sie eine der folgenden Optionen und klicken Sie auf „OK“:

Audition-Multitrack-Session öffnen, in der die Datei erstellt wurde

Datei im Audition-Wellenform-Editor öffnen

4. Mischen Sie die verknüpfte Session im Multitrack-Editor neu ab oder bearbeiten Sie die Abmischdatei im Wellenform-Editor.

5. Führen Sie zum Überschreiben der Originaldatei in der Videoanwendung einen der folgenden Schritte aus:

Wählen Sie im Multitrack-Editor „Datei“ > „Exportieren“ > „Multitrack-Abmischung“ und geben Sie den Namen und
Speicherort der Originaldatei an.

Wählen Sie im Wellenform-Editor „Datei“ > „Speichern“.

Verwandte Hilfethemen
Der Effekt „Mastering“

Vergleich zwischen Wellenform- und Multitrack-Editor

Exportieren von Sessions in das OMF- oder Final Cut Pro Interchange-Format

  |  

http://help.adobe.com/de_DE/premierepro/cs/using/WS367138A8-E5E3-49f3-8719-0EFDC91D329C.html
http://help.adobe.com/de_DE/premierepro/cs/using/WS367138A8-E5E3-49f3-8719-0EFDC91D329C.html
http://helpx.adobe.com/audition/using/special-effects.html#mastering_effect
http://helpx.adobe.com/en/audition/using/viewing-zooming-navigating-audio.html#comparing_the_waveform_and_multitrack_editors
http://helpx.adobe.com/en/audition/using/saving-exporting-files1.html#export_sessions_to_omf_or_final_cut_pro_interchange_format
http://creativecommons.org/licenses/by-nc-sa/3.0/
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Dateien speichern und exportieren (CS6)
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Formateinstellungen

Marker und andere Metadaten einschließen

Hinweis:
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Speichern von Audiodateien
Extrahieren von Audiokanälen in Monodateien
Speichern von Multitrack-Sessions
Exportieren von Sessions in das OMF- oder Final Cut Pro Interchange-Format
Exportieren von Sessionvorlagen
Exportieren von Session-Archiven
Exportieren von Multitrack-Abmischdateien
Audioformateinstellungen
Schließen von Dateien

Speichern von Audiodateien
Im Wellenform-Editor können Sie Audiodateien in einer Vielzahl gängiger Formate speichern. Das geeignete Format hängt von der weiteren
Verwendung der Datei ab. (Siehe Audioformateinstellungen.) Bedenken Sie, dass mit jedem Format bestimmte Informationen gespeichert werden,
die unter Umständen verloren gehen, wenn Sie die Datei in einem anderen Format speichern.

1. Führen Sie im Wellenform-Editor einen der folgenden Schritte durch:
Um Änderungen in der aktuellen Datei zu speichern, wählen Sie „Datei“ > „Speichern“.

Wählen Sie „Datei“ > „Speichern unter“, um die Änderungen unter einem anderen Dateinamen zu speichern. Oder wählen
Sie Datei“ > „Exportieren“ > „Datei“, damit die aktuelle Datei geöffnet bleibt.

Um die aktuell ausgewählten Audiodaten als neue Datei zu speichern, wählen Sie „Datei“ > „Auswahl speichern unter“.

Wählen Sie „Datei“ > „Alle speichern“, um alle geöffneten Dateien in ihren derzeitigen Formaten zu speichern.

Wählen Sie die „Datei“ > „Alle Audiodaten als Stapelprozess speichern“ aus, um alle geöffneten Dateien zu verarbeiten.
Weitere Informationen finden Sie unter Stapelverarbeitung von Dateien.

2. Geben Sie einen Dateinamen, einen Speicherort und ein Dateiformat an.
3. Folgende Optionen sind verfügbar:

Gibt die Abtastrate und Bittiefe an. Um diese Optionen zu ändern, klicken Sie auf „Ändern“. (Siehe Konvertieren
der Abtastrate einer Datei.)

Zeigt die Modi für die Datenkomprimierung und die Speicherung an. Um diese Einstellungen zu
ändern, klicken Sie auf „Ändern“. (Siehe Audioformateinstellungen.)

Fügt Audiomarker und Informationen aus dem Metadaten-Bedienfeld in die
gespeicherten Dateien ein. (Siehe Arbeiten mit Markern und Anzeigen und Bearbeiten von XMP-Metadaten.)

Einige CD-Brennprogramme interpretieren Nicht-Audio-Informationen wie Marker und Metadaten falsch, so dass zu
Beginn jedes Tracks unangenehme Störgeräusche entstehen.

Extrahieren von Audiokanälen in Monodateien
Wenn Sie die einzelnen Kanäle einer Datei mit Stereo- oder Surroundsound separat bearbeiten oder ausgeben wollen, können Sie die Daten in
Monodateien extrahieren. Adobe Audition hängt an den Namen jeder extrahierten Datei den Kanalnamen an. Beispiel: Eine Stereodatei namens
„Jazz.aif“ generiert z. B. Monodateien namens „Jazz_L“ und „Jazz_R“.

Wählen Sie im Wellenform-Editor „Bearbeiten“ > „Kanäle in Monodateien extrahieren“.

Audition öffnet jede extrahierte Datei automatisch im Editor.

Speichern von Multitrack-Sessions
Eine Multitrack-Session-Datei ist eine kleine Nicht-Audio-Datei. Sie speichert lediglich Informationen über den Speicherort der zugehörigen

http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
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OMF-Einstellungen

Medien

Hinweis:

Medienoptionen

Handle-Dauer

Audiodateien auf Ihrer Festplatte, die Dauer der einzelnen Audiodateien innerhalb der Session, die auf verschiedene Tracks angewendeten
Hüllkurven und Effekte und so weiter. Sie können eine gespeicherte Session später neu öffnen, um weitere Änderungen an der Mischung
vorzunehmen.

Wenn Sie Multitrack-Mischungen vollständig in Adobe Audition erstellen, speichern Sie Sessiondateien im systemeigenen SESX-Format. Wenn
Sie Multitrack-Kompositionen jedoch für andere Anwendungen freigeben möchten, lesen Sie die Informationen im Abschnitt Exportieren von
Sessions in das OMF- oder Final Cut Pro Interchange-Format.

Sie können Sessions mit einer Liste aller offenen Dateien speichern und diese automatisch mit den Sessions öffnen lassen. Wählen Sie in den
Multitrack-Voreinstellungen die Option „Beim Speichern von Sessions alle offenen Audio- und Videodateien referenzieren“.

1. Führen Sie im Multitrack-Editor einen der folgenden Schritte aus:
Um Änderungen in der aktuellen Session zu speichern, wählen Sie „Datei“ > „Speichern“.

Wählen Sie „Datei“ > „Speichern unter“, um die Änderungen unter einem anderen Dateinamen zu speichern. Oder wählen
Sie „Datei“ > „Exportieren“ > „Session“, damit die aktuelle Session geöffnet bleibt.

Um die Sessiondatei und alle darin enthaltenen Audiodateien zu speichern, wählen Sie „Datei“ > „Alle speichern“.

2. Geben Sie einen Dateinamen und den Speicherort an.
3. Um Audio-Marker und Informationen aus dem Metadaten-Bedienfeld einzuschließen, aktivieren Sie die Option „Marker und

andere Metadaten einschließen“.

Exportieren von Sessions in das OMF- oder Final Cut Pro Interchange-Format
Um vollständige Mischungen in andere Anwendungen zu übertragen, exportieren Sie sie in das OMF- oder Final Cut Pro Interchange-Format.
OMF wurde ursprünglich für Avid Pro Tools entwickelt, ist inzwischen aber ein verbreitetes Austauschformat für Multitrack-Dateien aus vielen
Audiomischungs-Anwendungen. Das Final Cut Pro Interchange-Format basiert auf XML-Dateien in Klarschrift, die Sie offline bearbeiten können,
um Textverweise, Mischungseinstellungen usw. anzupassen.

Exportieren nach OMF

1. Wählen Sie im Multitrack-Editor „Datei“ > „Exportieren“ > „OMF“.

2. Geben Sie einen Dateinamen und den Speicherort an.

3. Folgende Optionen sind verfügbar:

Klicken Sie auf „Ändern“, um das Dialogfeld „Sample-Typ umwandeln“ zu öffnen. (Siehe Umwandeln von
Sample-Typen.)

Klicken Sie auf „Ändern“, um auf folgende Optionen zuzugreifen:

„Encapsulated“ speichert Audio-Clips in der eigentlichen OMF-Datei, was die Organisation erleichtert. „Mit
Verweis“ speichert die Audio-Clips im selben Ordner wie die OMF-Datei, so dass Sie sie bei Bedarf offline bearbeiten
können.

Encapsulated OMF-Dateien sind auf eine Größe von maximal 2 GB beschränkt.

Legt fest, ob die Clip-Quelldateien auf die Clip-Länge im Editor zugeschnitten werden oder ob die
gesamte Originaldatei übernommen wird.

Gibt bei zugeschnittenen Clips die Dauer an, die über die Clip-Grenzen hinaus eingeschlossen wird.
Das Einschließen von zusätzlichem Audio bietet mehr Flexibilität beim Aus- und Einblenden sowie beim Bearbeiten.

Im Bereich „Warnungen“ werden alle Sessionelemente angezeigt, die ausgeschlossen oder geändert werden. Wenn Sie diese Daten in die
Zwischenablage kopieren möchten, klicken Sie auf die Schaltfläche „Warnungen kopieren“ .

Exportieren in das Final Cut Pro Interchange-Format

1. Wählen Sie im Multitrack-Editor „Datei“ > „Exportieren“ > „FCP XML-Interchange-Format“.

2. Geben Sie einen Dateinamen und den Speicherort an.

3. Um Audio-Marker und Informationen aus dem Metadaten-Bedienfeld einzuschließen, aktivieren Sie die Option „Marker und
andere Metadaten einschließen“.

4. Um Session- und Quelldateien für eine einfache Übertragung auf andere Systeme zu kombinieren, wählen Sie „Kopien der

http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
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Sampletyp

Formateinstellungen

Marker und andere Metadaten einschließen

zugehörigen Dateien speichern“. Klicken Sie auf „Optionen“, um das Format und den Sampletyp für exportierte Quelldateien
zu ändern.

Die folgenden Sessionelemente sind in der exportierten Datei nicht enthalten:

Der zweite Kanal von Stereo-Clips. (Alle Clips und Tracks werden in Mono ausgegeben.)

Überlappende Clips.

Effekte und Track-EQ.

Automatisierungs-Hüllkurven außer Clip-Lautstärke und Spurtonschwenks von Mono nach Stereo.

Ausgangs-Routing, Sends, Busse und der Master-Track.

Exportieren von Sessionvorlagen
Sessionvorlagen enthalten alle Multitrack-Eigenschaften und Clips, damit Sie schnell Projekte mit ähnlichen Einstellungen und Aufgaben starten
können. Die Beispiele enthalten ein Anfangsthema oder Hintergrundgeräusche, die viele verwandte Shows gemeinsam haben.

1. Wählen Sie „Datei“ > „Exportieren“ > „Session als Vorlage“ aus. Geben Sie einen Namen und einen Speicherort an.
2. Um eine Vorlage auf eine neue Sitzung anzuwenden, wählen Sie „Datei“ > „Neu“ > „Multitrack-Session“ aus. Wählen Sie

dann eine der Optionen im Menü „Vorlage“ aus.

Exportieren von Session-Archiven
Um Session- und Quelldateien für eine einfache Übertragung auf andere Computer oder Speichergeräte zu kombinieren, exportieren Sie Session-
Archive.

Verwenden Sie diesen Vorgang, um die Abtastrate und die Bittiefe einer Session zu ändern.

1. Wählen Sie „Datei“ > „Exportieren“ > „Session“.
2. Wählen Sie „Kopien der zugehörigen Dateien speichern“, und klicken Sie auf „Optionen“.
3. Um Quelldateien in einem anderen Format zu speichern, wählen Sie „Dateien konvertieren“ und stellen Sie die Optionen wie

gewünscht ein.
4. Um vollständige oder zugeschnittene Quelldateien zu exportieren, wählen Sie die jeweilige Option aus dem Menü

„Medienoptionen“.

Die Handle-Dauer legt fest, wie viele zusätzliche Audiodaten am Anfang und am Ende von zugeschnittenen Clips eingefügt werden. Um bei
zukünftigen Zuschneide- und Überblendungsanpassungen mehr Flexibilität zu haben, fügen Sie Handles mit einer Länge von bis zu
10 Sekunden hinzu.

Exportieren von Multitrack-Abmischdateien
Nach dem Mischen der Session können Sie einen Teil oder die ganze Session in verschiedene gängige Formate exportieren. (Siehe
Audiodateiformate.) In der Exportdatei bleiben die aktuelle Lautstärke, der Tonschwenk und die an den Mastertrack weitergeleiteten
Effekteinstellungen erhalten.

Wenn Sie bestimmte Audio-Clips in einem einzelnen Track abmischen möchten, verwenden Sie den Befehl „Multitrack“ > „Neuberechnung in
neuer Mischung“. (Siehe Erstellen eines einzelnen Audio-Clips aus mehreren Clips.)

1. Wenn Sie einen Teil einer Session exportieren möchten, verwenden Sie das Zeitauswahlwerkzeug , um den gewünschten
Bereich auszuwählen.

2. Wählen Sie „Datei“ > „Exportieren“ > „Multitrack-Abmischung“.

(Alternativ können Sie „Multitrack“ > „In neuer Datei abmischen“ wählen, um die Abmischung im Wellenform-Editor zu öffnen
und die unten stehenden Schritte zu überspringen.)

3. Geben Sie einen Dateinamen, einen Speicherort und ein Dateiformat an.
4. Folgende Optionen sind verfügbar:

Gibt die Abtastrate und Bittiefe an. Um diese Optionen zu ändern, klicken Sie auf „Ändern“. (Siehe Konvertieren
der Abtastrate einer Datei.)

Zeigt die Modi für die Datenkomprimierung und die Speicherung an. Um diese Einstellungen zu
ändern, klicken Sie auf „Ändern“. (Siehe Audioformateinstellungen.)

Fügt Audiomarker und Informationen aus dem Metadaten-Bedienfeld in die
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Sampletyp (nur für 32-Bit-Dateien)

Hinweis:

Bytereihenfolge (nur für 16-Bit-Dateien)

Komprimierung

Kanalmodus

Bitrate

gespeicherten Dateien ein. (Siehe Arbeiten mit Markern und Anzeigen und Bearbeiten von XMP-Metadaten.)

Ermöglichen das Abmischen von Spuren als separate Dateien oder die gleichzeitige Ausgabe von
Mono-, Stereo- und 5.1-Abmischungen. Klicken Sie auf „Ändern“, um diese und andere Einstellungen anzupassen.

Wählen Sie im Wellenform-Editor „Bearbeiten“ > „Original bearbeiten“, um die Multitrack-Session zu öffnen, aus der eine
Abmischdatei erstellt wurde. Damit dieser Befehl verfügbar ist, müssen Metadaten in der Datei eingebettet sein. (Siehe
Einbetten von „Original bearbeiten“-Daten in exportierte Abmischdateien.)

Audioformat-Einstellungen
In den meisten Fällen sollten Sie unkomprimiertes Audio in den Formaten AIFF oder WAV speichern. Speichern Sie Dateien nur im komprimierten
MP3-Format, wenn die Dateien für das Internet oder für tragbare Medienwiedergabegeräte erstellt werden.

Klicken Sie im Dialogfeld „Speichern unter“ bzw. „Exportieren“ rechts neben dem Bereich „Formateinstellungen“ auf „Ändern“,
um die folgenden Optionen aufzurufen.

Welchen Effekt die Änderungen haben, können Sie unten im Dialogfeld unter „Geschätzte Dateigröße“ ablesen.

AIFF-Formateinstellungen (*aif, *.aiff, *.aifc)
AIFF ist das unkomprimierte Standardformat für Mac OS-Audiodateien.

Stellt die Bittiefe der Audiodaten ein. Höhere Bittiefen liefern einen größeren Dynamikbereich und reduzieren
Verzerrungen, gleichzeitig steigen allerdings Dateigröße und Verarbeitungszeit. Informationen zum Ermitteln der richtigen Einstellung für typische
Ausgabetypen finden Sie unter Bittiefe – Grundlagen.
Bei Integer-Einstellungen werden Audiodaten beschnitten, die sich über den Amplitudenbereich der jeweiligen Bittiefe hinaus erstrecken.
Gleitkomma-Einstellungen benötigen etwas mehr Speicherplatz, allerdings bleibt ein wesentlich größerer Dynamikbereich erhalten.
Wählen Sie „32-Bit Gleitkomma“, wenn Sie die Datei mehrmals verarbeiten und nur minimale Amplitudendaten verlieren möchten.

Um einer AIFF-Datei Metadaten über den Autor hinzuzufügen, verwenden Sie im Metadaten-Bedienfeld in der Registerkarte „XMP“ das
Feld „Dublin Core: Ersteller“. (Siehe Anzeigen und Bearbeiten von XMP-Metadaten.)

Gibt die numerische Reihenfolge für die Datenbytes an. Wählen Sie auf Systemen mit Intel-
Prozessoren die Little-Endian-Methode und auf System mit PowerPC-Prozessoren die Big-Endian-Methode.

Audioformateinstellungen „Monkey's Audio“ (.ape)
Über die Audioformateinstellungen „Monkey's Audio“ werden Dateien auf fast die Hälfte ihrer Originalgröße komprimiert, wobei ein verlustfreier
Algorithmus eingesetzt wird, um die Aufrechterhaltung der Klangtreue sicherzustellen.

Legt das Verhältnis zwischen Verarbeitungsgeschwindigkeit und Dateigröße fest. (Durch schnelle Verarbeitung entstehen
größere Dateien und umgekehrt.)

MP2-Audioformateinstellungen
MP2 (MPEG-1 Audio Layer II) ist ein verlustbehaftetes Komprimierungsformat, das im Rundfunkbereich besonders verbreitet wird.

Wählen Sie eine der folgenden Optionen:
Bei „Automatisch“ wird eine der unten stehenden Optionen basierend auf der aktuellen Kanalkonfiguration der Datei
ausgewählt.

„Mono“ erzeugt Datei mit einem Kanal.
„Dual Mono“ erzeugt eine Datei mit zwei Kanälen mit den gleichen Audiodaten in beiden Kanälen.

„Stereo“ erzeugt eine Datei mit zwei Kanälen, bei der die Kanäle unabhängig voneinander verarbeitet werden, damit die
Stereodarstellung beibehalten wird.

Bei „Joint-Stereo“ werden beide Kanäle gemeinsam verarbeitet, wodurch sich die Dateigröße reduziert, aber oft auch die
Stereodarstellung beeinträchtigt wird.

Bestimmt den Kompromiss zwischen Dateigröße und Audioqualität. Höhere Einstellungen erhöhen die Dateigröße und die Qualität,
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„Bitrate“ (für konstante Bitraten) oder „Qualität“ (für variable Bitraten)

Sampletyp (nur für 32-Bit-Dateien)

Hinweis:

4GB Plus-Unterstützung

Format

Kodierung

Bytereihenfolge

VBR-Qualität (nur OGG-Dateien)
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niedrigere Einstellungen verringern die Dateigröße und die Qualität.

Weitere Informationen über erweiterte Optionen, erhalten Sie, wenn Sie den Mauszeiger darüber positionieren, bis eine QuickInfo angezeigt wird.

MP3-Formateinstellungen
MP3 ist das Standard-Audiokomprimierungsformat für die Onlineverwendung.

Wählen Sie „Konstante“ für eine konstante Bitrate oder „Variabel“, um die Bitrate je nach Audioinhalt zu variieren.

Bestimmt den Kompromiss zwischen Dateigröße und Audioqualität.
Höhere Einstellungen erhöhen die Dateigröße und die Qualität, niedrigere Einstellungen verringern die Dateigröße und die Qualität.

Komprimieren Sie eine Audiodatei nicht mehrfach in das MP3-Format. Beim Öffnen und Speichern einer MP3-Datei wird diese erneut
komprimiert, wodurch sich die Komprimierung immer deutlicher auswirkt.

QuickTime-Formateinstellungen (nur Audio *.mov)
Sie können die Formateinstellungen für QuickTime-Audiodateien nicht anpassen, da diese immer als unkomprimierte PCM-Daten (Pulse Code
Modulation) gespeichert werden.

Wave PCM-Formateinstellungen (.wav, .bwf)
Wave PCM ist das Standardformat für unkomprimierte Audiodateien unter Windows.

Sie können Broadcast Wave-Metadaten in Windows PCM-Dateien einfügen. (Siehe Anzeigen und Bearbeiten von XMP-Metadaten.)

Stellt die Bittiefe der Audiodaten ein. Höhere Bittiefen liefern einen größeren Dynamikbereich und reduzieren
Verzerrungen, gleichzeitig steigen allerdings Dateigröße und Verarbeitungszeit. Informationen zum Ermitteln der richtigen Einstellung für typische
Ausgabetypen finden Sie unter Bittiefe – Grundlagen.
Bei Integer-Einstellungen werden Audiodaten beschnitten, die sich über den Amplitudenbereich der jeweiligen Bittiefe hinaus erstrecken.
Gleitkomma-Einstellungen benötigen etwas mehr Speicherplatz, allerdings bleibt ein wesentlich größerer Dynamikbereich erhalten.

Die Nicht-Standardoptionen „16.8 Gleitkomma“ und „24.0 Gleitkomma“ dienen der Kompatibilität mit früheren Versionen von Adobe
Audition. (16.8 war das interne Format von Audition 1.0. 24.0 war eine optionale Einstellung aus derselben Version.)

Speichert Dateien, die über 4 GB groß sind, entweder im RF64-Format, das dem aktuellen EBU-Standard (European
Broadcasting Union) entspricht, oder im Format „Multiple Data Chunks“, das von älteren Versionen von Audition unterstützt wird.
Hinweis: Wählen Sie bei Dateien mit über 4 GB Größe das RF64-Format, um die Kompatibilität mit möglichst vielen Anwendungen
sicherzustellen.

libsndfile-, FLAC- und OGG-Formateinstellungen
Viele Formate haben die folgenden Optionen gemeinsam.

Das FLAC-Format ist das einzige Format, das sowohl komprimiert (geringere Dateigröße) als auch verlustfrei (Erhalt der Audiotreue) ist.

Gibt das Dateiformat und die Dateierweiterung an.

Gibt das Datenspeicherschema für die Datei an.

Gibt die numerische Reihenfolge für die Datenbytes an. Die Option „Standard-Bytereihenfolge“ wendet automatisch den für Ihren
Systemprozessor gültigen Standard an und ist in der Regel die beste Wahl.

Bestimmt den Kompromiss zwischen Dateigröße und Audioqualität. (Wenn Sie Einstellungen höher gewählt
werden, sind die Dateien größer, und die Qualität ist besser.)

Schließen von Dateien
Führen Sie einen der folgenden Schritte aus:

Um die aktuelle Audiodatei im Editor zu schließen, wählen Sie „Datei“ > „Schließen“.

Um alle geöffneten Audio-, Video-, und Sessiondateien zu schließen, wählen Sie „Datei“ > „Alle schließen“.

Um Dateien zu schließen, die von keiner geöffneten Multitrack-Session referenziert werden, wählen Sie „Datei“ > „Nicht
verwendete Medien schließen“.

Um die aktuelle Session und die zugehörigen Audio-Clips im Multitrack-Editor zu schließen, wählen Sie „Datei“ > „Session

http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/de-de/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/


  Twitter™- und Facebook-Beiträge fallen nicht unter die Bestimmungen von Creative Commons.

Rechtliche Hinweise   |   Online-Datenschutzrichtlinien

und enthaltene Medien schließen“.

Exportieren einer Multitrack-Mischung nach Premiere Pro

Erstellen eines Audio-Clips aus einem Bus- oder Master-Track
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Saving and exporting files (CS5.5)

Note:

To the top

Sample Type

Format Settings

Include Markers and Other Metadata

Note:

To the top

To the top

Save audio files
Extract audio channels to mono files
Save multitrack sessions
Export sessions to OMF or Final Cut Pro Interchange format
Export multitrack mixdown files
Audio format settings
Close files

Some features in the Windows version of Adobe Audition 3.0 are not available in CS5.5. Examples include some file formats and effects,
CD burning, MIDI, the metronome, clip grouping and time stretching, and control surface support. For a complete list, see Adobe Audition 3.0
features replaced or not implemented in CS5.5.

Save audio files
In the Waveform Editor, you can save audio files in a variety of common formats. The format you choose depends on how you plan to use the file.
(See Audio format settings.) Keep in mind that each format stores unique information that might be discarded if you save a file in a different format.

1. In the Waveform Editor, do one of the following:
To save changes in the current file, choose File > Save.

To save changes under a different filename, choose File > Save As. Or choose File > Export > File to keep the current file
open.

To save currently selected audio as a new file, choose File > Save Selection As.

To save all open files in their current formats, choose File > Save All.

Use the Save Selection As command to break up a long recording into smaller, more manageable files.

2. Specify a filename and location, and choose a file format.
3. Set the following options:

Indicates the sample rate and bit depth. To adjust these options, click Change. (See Convert the sample rate
of a file.)

Indicates data compression and storage modes; to adjust these, click Change. (See Audio format settings.)

Includes audio markers and information from the Metadata panel in saved files. (See
Working with markers and Viewing and editing XMP metadata.)

Some CD-burning applications misinterpret non-audio information such as markers and metadata, producing an
unpleasant burst of noise at the beginning of each track.

Extract audio channels to mono files
If you want to edit or output individual channels of a stereo or surround-sound file, extract them to mono files. Adobe Audition appends the channel
name to each extracted filename. For example, a stereo source file named Jazz.aif produces mono files named Jazz_L and Jazz_R.

In the Waveform Editor, choose Edit > Extract Channels To Mono Files.

Audition automatically opens each extracted file in the Editor panel.

Save multitrack sessions
A multitrack session file is a small, non-audio file. It merely stores information about locations of related audio files on your hard drive, the duration
of each audio file within the session, the envelopes and effects applied to various tracks, and so forth. You can reopen a saved session file later to
make further changes to the mix.

If you create multitrack mixes entirely in Adobe Audition, save session files in the native SESX format. If you plan to share multitrack compositions
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Sample Type

OMF Settings

Media

Note:

Media Options

Handle Duration

To the top

with other applications, however, see Export sessions to OMF or Final Cut Pro Interchange format.

1. In the Multitrack Editor, do one of the following:
To save changes to the current session file, choose File > Save

To save changes under a different filename, choose File > Save As. Or choose File > Export > Session to keep the
current session open.

To save the session file and all the audio files it contains, choose File > Save All .

2. Specify a filename and location.
3. To include audio markers and information from the Metadata panel, select Include Markers And Other Metadata.

Export sessions to OMF or Final Cut Pro Interchange format
To transfer complete mixes to other applications in your workflow, export to OMF or Final Cut Pro Interchange format. OMF was originally created
for Avid Pro Tools, but now is a common multitrack exchange format for many audio mixing applications. Final Cut Pro Interchange format is
based on human-readable XML files, which you can edit offline to revise text references, effect settings, and so on.

Export to OMF

1. In the Multitrack Editor, choose File > Export > OMF.

2. Specify a filename and location.

3. Set the following options:

Click Change to access the Convert Sample Type dialog box. (See Converting sample types.)

Click Change to access the following:

Encapsulated stores audio clips in the OMF file itself for easier organization. Referenced stores audio clips in
the same folder as the OMF file, letting you edit them offline if necessary.

Encapsulated OMF files are limited to 2 GB in size.

Determines whether clip source files are trimmed to clip length in the Editor panel or reflect the entire
original file.

For trimmed clips, specifies the time duration to include beyond clip edges. Including additional
audio provides more flexibility for fades and editing.

The Warnings section indicates elements of the session that will be excluded or changed. To copy this information to clipboard, click the Copy
Warnings button .

Export to Final Cut Pro Interchange format

1. In the Multitrack Editor, choose File > Export > FCP XML Interchange Format.

2. Specify a filename and location.

3. To include audio markers and information from the Metadata panel, select Include Markers And Other Metadata.

The following session elements are excluded from the exported file:

The second channel of stereo clips. (All clips and tracks become mono.)

Overlapping clips

Effects and track EQ.

Automation envelopes other than clip volume and mono-to-stereo track panning.

Output routing, sends, buses, and the Master track.

Export multitrack mixdown files
After you finish mixing a session, you can export all or part of it in a variety of common formats. (See Audio file formats.) When you export, the
resulting file reflects current volume, pan, and effects settings routed to the Master track.
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Sample Type (available only for 32-bit files)

Note:

Byte Order (available only for 16-bit files)

Type

Bitrate (for constant bitrates) or Quality (for variable)

To quickly mix specific audio clips down to a single track, use the Multitrack  > Bounce To New Track command. (See Create a single audio
clip from multiple clips.)

1. If you want to export part of a session, use the Time Selection tool  to select the desired range.
2. Choose File > Export > Multitrack Mixdown.

(Alternatively, choose Multitrack > Mixdown To New File to open the mixdown in the Waveform Editor and skip the steps
below.)

3. Specify a filename and location, and choose a file format.
4. Set the following options:

Indicates the sample rate and bit depth. To adjust these options, click Change. (See Convert the sample rate
of a file.)

Indicates data compression and storage modes; to adjust these, click Change. (See Audio format settings.)

Includes audio markers and information from the Metadata panel in saved files. (See
Working with markers and Viewing and editing XMP metadata.)

In the Waveform Editor, choose Edit > Edit Original to open the multitrack session that created a mixdown file. This
command requires embedded metadata in the file. (See Embed edit-original data in exported mixdown files.)

Audio format settings
In most cases, you should save uncompressed audio to the AIFF or WAV formats. Save to the compressed mp3 format only when creating files for
the web or portable media players.

In a Save As or Export dialog box, click Change to the right of Format Settings to access the options below.

To see the effect of settings changes, note the Estimated File Size at the bottom of the dialog box.

AIFF format settings (*aif, *.aiff, *.aifc)
AIFF is the standard uncompressed audio file format on Mac OS.

Sets the audio bit depth. Higher bit depths provide more dynamic range and reduce distortion,
though they increase file size and processing time. To determine the proper setting for common output types, see Understanding bit depth.
Integer settings clip audio that extends beyond the amplitude range for a given bit depth. Floating Point settings require slightly more storage
space, but retain much greater dynamic range.
Choose 32-bit Floating Point if you want to repeatedly process the file and discard minimal amplitude data.

To add Author metadata to an AIFF file, use the Dublin Core: Creator field on the XMP tab of the Metadata panel. (See Viewing and editing
XMP metadata.)

Specifies the numerical sequence for bytes of data. Choose the Little-Endian method for systems
with Intel processors and the Big-Endian method for systems with PowerPC processors.

mp3 format settings
mp3 is the standard compressed audio format across platforms.

Choose Constant to apply a consistent bitrate or Variable to change the bitrate based on audio content.

Adjusts the tradeoff between file size and audio quality. Higher settings increase size
and quality; lower settings reduce size and quality.

Avoid compressing the same audio to mp3 more than once. Opening and resaving an mp3 file causes it to be recompressed, so any artifacts
from the compressing process become more pronounced.

QuickTime format settings (audio-only *.mov)
You cannot adjust format settings for audio-only QuickTime files, which are always saved as uncompressed PCM (Pulse Code Modulation) data.

Wave PCM format settings (.wav, .bwf)
Wave PCM is the standard uncompressed audio format on Windows.

You can include Broadcast Wave metadata in Windows PCM files. (See Viewing and editing XMP metadata.)
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Sets the audio bit depth. Higher bit depths provide more dynamic range and reduce distortion,
though they increase file size and processing time. To determine the proper setting for common output types, see Understanding bit depth.
Integer settings clip audio that extends beyond the amplitude range for a given bit depth. Floating Point settings require slightly more storage
space, but retain much greater dynamic range.

The nonstandard 16.8 and 24.0 Floating Point options are provided for compatibility with previous versions of Adobe Audition. (16.8 was the
internal format used by Audition 1.0. 24.0 was an optional setting from the same version.)

Stores files larger than 4GB using either RF64 format, which reflects the current European Broadcasting Union standard, or
the Multiple Data Chunks format supported by previous versions of Audition.
note: To ensure compatibility with a wide range of applications, choose the RF64 format for files greater than 4GB.

Close files
Do any of the following:

To close the current file in the Editor panel, choose File > Close.

To close all open audio, video, and session files, choose File > Close All.

To close files that aren’t referenced by an open multitrack session, choose File > Close Unused Media.

To close the current session and related audio clips in the Multitrack Editor, choose File > Close Session and Its Media.

Export a multitrack mix to Premiere Pro CS5.5

Create an audio clip from a bus or master track
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In Adobe Audition, the Metadata panel provides BWF, ID3, and RIFF tabs that let you quickly access this common audio metadata. The XMP tab
provides the same information, combined with a longer list of metadata common to Adobe video applications. (For example, the Display Title field
on the RIFF tab corresponds to the Title field in the Dublin Core section of the XMP tab.)

To preserve metadata when you save files, select Include Markers and Other Metadata in the Save or Export dialog box.

The BWF tab applies to Broadcast Wave files, which let you specify a time offset for playback, as well as standard descriptive metadata. To
include Broadcast Wave metadata in a file, you must save in WAV format; see Save audio files. To insert a Broadcast Wave file in the Multitrack
Editor, see Spot-insert a Broadcast Wave file into a session.

The ID3 and RIFF tabs apply to mp3 and radio industry metadata, respectively.

About the Metadata panel and XMP
To streamline your workflow and organize your files, use XMP metadata. Metadata is a set of descriptive information about a file. Video and audio
files automatically include basic metadata properties, such as date, duration, and file type. You can add details with properties such as location,
director, copyright, and much more.

With the Metadata panel, you can share this information about assets throughout Adobe video and audio applications. Unlike conventional clip
properties, which are limited to only one application’s Project or Files panel, metadata properties are embedded in source files, so the data
automatically appears in other applications. This sharing of metadata lets you quickly track and manage video assets as they move through your
production workflow.

Properties in the Metadata panel also appear in Adobe Bridge, providing additional details that help you quickly browse assets.

For a video about the Metadata panel, see the Adobe website.

Maxim Jago explains XMP metadata in a video from, “Premiere Pro CS5 for Avid Editors.”

About schemas and properties
A metadata schema is a collection of properties specific to a given workflow. The Dynamic Media schema, for example, includes properties like
Scene and Shot Location that are ideal for digital video projects. Exif schemas, by contrast, include properties tailored to digital photography, like
Exposure Time and Aperture Value. More general properties, like Date and Title, appear in the Dublin Core schema. To display different
properties, see Show or hide metadata.

For information about a specific schema and property, hover the pointer over it in the Metadata panel. For most items, a tool tip appears with
details.

About the XMP standard
Adobe applications store metadata using the Extensible Metadata Platform (XMP). XMP is built on XML, which facilitates the exchange of
metadata across a variety of applications and publishing workflows. Metadata in most other formats (such as Exif, GPS, and TIFF) automatically
transfers to XMP so you can more easily view and manage it.

In most cases, XMP metadata is stored directly in source files. If a particular file format doesn’t support XMP, however, metadata is stored in a
separate sidecar file.

Project assets without corresponding files don’t support XMP. Examples from Adobe Premiere Pro include Bars and Tone, Universal Counting
Leader, Color Matte, Titles, Black Video, and Transparent Video.

To customize the creation and exchange of metadata, use the XMP Software Development Kit. For more information about XMP, see
Extensible Metadata Platform.

Show or hide XMP metadata
To optimize the Metadata panel for your workflow, show or hide entire schemas or individual properties, displaying only those that you need.

1. From the options menu  for the Metadata panel, select Metadata Display.

http://www.adobe.com/go/lrvid4104_xp
http://www.video2brain.com/en/videos-1925.htm
http://www.adobe.com/products/xmp/
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2. To show or hide schemas or properties, select or deselect them from the list.

Save, switch, or delete metadata sets
If you use multiple workflows, each requiring different sets of displayed metadata, you can save sets and switch between them.

1. From the options menu  for the Metadata panel, select Metadata Display.

2. Do any of the following:

To save a customized set of displayed metadata, click Save Settings. Then enter a name, and click OK.

To display a previously saved set of metadata, select it from the menu.

To delete a previously saved set of metadata, select it from the menu, and click Delete Settings.

Create schemas and properties
If you have a unique, customized workflow that the default metadata options don’t address, create your own schemas and properties.

1. From the options menu  for the Metadata panel, select Metadata Display.

2. Click New Schema, and enter a name.

3. In the list, click Add Property to the right of the schema name.

4. Enter a property name, and select one of the following for Type:

Displays whole numbers that you drag or click to change.

Displays fractional numbers that you drag or click to change.

Displays a text box (for properties similar to Location).

Displays a check box (for On or Off properties).

Edit XMP metadata
Similarly named properties are linked in the Metadata and Files panels. However, the Metadata panel provides more extensive properties.

1. In the Editor panel, open the desired file or session.

2. In the Metadata panel, edit text or adjust values as needed.

Search XMP metadata

1. In the Editor panel, open the file or session you want to search.

2. In the Metadata panel, click the XMP tab.

3. In the search box, enter the text you want to find.

The list of metadata collapses to reveal only properties that contain your search string.

4. To navigate through the search results, click the Previous and Next buttons   to the right of the search box, or press Tab.

5. To exit the search mode and return to the full list of metadata, click the close button  to the right of the search box.
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Adobe Audition provides a default set of keyboard shortcuts to help you speed up the editing process. In menus and tool tips, available keyboard
shortcuts appear to the right of command and button names. You can customize nearly all default shortcuts and add shortcuts for other functions.

Find shortcuts
Do any of the following:

For menu commands, look for shortcuts to the right of command names.

For tools or buttons, look for shortcuts to the right of tool tips. (To display tool tips, hold the pointer over a tool or button.)

For a complete list of all shortcuts, choose Edit > Keyboard Shortcuts.

Customize shortcuts
You can customize nearly all default keyboard shortcuts and add shortcuts for other commands.

1. Choose Edit > Keyboard Shortcuts.
2. In the Command column, select the command you want to customize.
3. If you want to replace or remove an existing shortcut, choose it from the Shortcuts For Command menu.
4. Do any of the following:

To create a shortcut, click inside the Press Shortcut box, and press the desired key combination. Then click Assign.

To remove a shortcut, click Remove.

If you enter a key combination that’s already in use, Audition displays an alert. Click Yes to transfer the shortcut to a different
command, or No to retain the existing assignment.

Assign shortcuts to the Workspace commands to quickly switch between custom panel layouts.

Save or delete custom sets of shortcuts
1. Choose Edit > Keyboard Shortcuts.
2. Do either of the following:

To save a custom set, click Save As, enter a name, and click OK.

To delete a custom set, choose it from the Set menu, and then click Delete.

Restore the default shortcuts
1. Choose Edit > Keyboard Shortcuts.
2. From the Set menu, choose Default Set.

http://creativecommons.org/licenses/by-nc-sa/3.0/
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Keys for playing and zooming audio
Keys for editing audio files
Keys for mixing multitrack sessions

These partial lists include the shortcuts that Adobe Audition experts find most useful. For a complete list of shortcuts, choose Edit > Keyboard
Shortcuts.

Keys for playing and zooming audio

Keys for editing audio files
The following keyboard shortcuts apply only in the Waveform Editor.

Result Windows shortcut Mac OS shortcut

Repeat previous command (opening its
dialog box and clicking OK)

Shift+R Shift+R

Repeat previous command (opening its
dialog box but not clicking OK)

Ctrl+R Command+R

Open Convert Sample Type dialog box Shift+T Shift+T

Capture a noise reduction profile for the
Noise Reduction effect

Shift+P Shift+P

Result Windows shortcut Mac OS shortcut

Toggle between Waveform and Multitrack
Editor

8 8

Start and stop playback Spacebar Spacebar

Move current-time indicator to beginning
of timeline

Home Home

Move current-time indicator to end of
timeline

End End

Move current-time indicator to previous
marker, clip, or selection edge

Ctrl+left arrow Command+left arrow

Move current-time indicator to next
marker, clip, or selection edge

Ctrl+right arrow Command+right arrow

Toggle preference for Return CTI To Start
Position On Stop

Shift+X Shift+X

Zoom in horizontally = =

Zoom in vertically Alt+= Option+=

Zoom out horizontally - -

Zoom out vertically Alt+minus sign Option+minus sign

Add marker M or * (asterisk) M or * (asterisk)
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Activate left channel of a stereo file for
editing

Up arrow Up arrow

Activate right channel of a stereo file for
editing

Down arrow Down arrow

Make spectral display more logarithmic or
linear

Ctrl+Alt+up or down arrow Option+Command+up or down arrow

Make spectral display fully logarithmic or
linear

Ctrl+Alt+Page Up or Down Option+Command+Page Up or Down

Increase or decrease spectral resolution Shift+Ctrl+up or down arrow Shift+Command-up or down arrow

Keys for mixing multitrack sessions
The following keyboard shortcuts apply only in the Multitrack Editor.

Result Windows shortcut Mac OS shortcut

Select the same input or output for all
audio tracks

Ctrl+Shift-select Command+Shift-select

Activate or deactivate Mute, Solo, Arm For
Record, or Monitor Input in all tracks

Ctrl+Shift-click Command+Shift-click

Adjust knobs in large increments Shift-drag Shift-drag

Adjust knobs in small increments Ctrl-drag Command-drag

Nudge selected clip to the left Alt+comma Option+comma

Nudge selected clip to the right Alt+period Alt+period

Maintain keyframe time position or
parameter value

Shift-drag Shift-drag

Reposition envelope segment without
creating keyframe

Ctrl-drag Command-drag
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